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1 Базовая теория

Чтобы воспользоваться 
всеми преимуществами 

программы Photoshop, 
важно понимать основы 

теории цвета.

Растровые и векторные изображения

Пиксели и разрешение

Цветовые модели RGB и CMYK

Управление цветом
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Растровые и векторные 
изображения
Программа Photoshop —  это приложение для редактирования изобра-
жений, имеющее множество инструментов и команд для работы с ра-
стровыми изображениями. В этой программе есть средства для рету-
ширования, коррекции цвета, композиции и многого другого. Кроме 
того, она содержит более 100 функциональных и творческих фильтров, 
которые могут быть применены к целым изображениям, выделенным 
областям или конкретным слоям.

Растровое изображение состоит из прямоугольной сетки, или растра 
пикселей, подобно мозаике. При редактировании растрового изобра-
жения вы изменяете значения цвета отдельных пикселей или их групп.

Приложения для редактирования растровых изображений принци-
пиально отличаются от векторных графических редакторов, таких как 
Adobe Illustrator. В этих редакторах вы работаете с объектами, которые 
можно перемещать, масштабировать, трансформировать, помещать 
в стопки и удалять как отдельные или сгруппированные объекты, од-
нако каждый из них при этом является самостоятельным.

Такие приложения называются пакетами для редактирования век-
торной графики, поскольку каждый объект определяется с помощью 
математической формулы. По этой причине они не зависят от разре-
шения —  вы можете масштабировать векторные изображения (либо 
в приложении, в котором они были созданы, либо в программе предпе-
чатной подготовки, наподобие QuarkXPress или Adobe InDesign), и их 
резкость при печати не пострадает.

Всегда старайтесь сканировать 
изображение в том же разме-
ре, в котором вы собираетесь 
его использовать, или же чуть 
большем. Тогда вам не придется 
увеличивать его размер, снижая 
разрешение и, соответственно, 
качество.
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В отличие от  векторных, растровые изображения создаются с  задан-
ным разрешением —  фиксированным количеством пикселей на дюйм. 
Если вы отсканируете изображение с определенным разрешением, а за-
тем удвоите его размер, то вы фактически вдвое уменьшите разрешение 
(если только при этом не увеличите количество пикселей). Скорее всего, 
у вас получится зазубренная и состоящая из квадратов картинка, по-
скольку вы увеличили размер отдельных пикселей, из которых состоит 
растровое изображение.

Растровые изображения и битовая глубина

Важным фактором при захвате цифровых данных изображения (что, 
как правило, делается с помощью цифровой камеры или сканера) яв-
ляется его битовая глубина. Битовая глубина —  это объем цифрового 
пространства, заполняемый информацией о цвете того или иного пик-
селя. Чем больше битов вы используете, тем больше вы можете хранить 
информации для описания цвета пикселя и тем больше размер итого-
вого файла.

Для вывода реалистичных картинок с  использованием технологии 
PostScript изображение должно отображать 256 уровней серого. 24-бит-
ное сканирование позволяет записать 256 оттенков серого цвета для 
каждого из  трех каналов: красного, зеленого и  синего (по  8 бит для 
каждого канала), что обеспечивает возможное сочетание более чем  
16 миллионов цветов.

В идеале, обрабатывая изображения в  программе Photoshop, вы дол-
жны использовать монитор, отображающий более 16 миллионов цве-
тов. Это позволяет увидеть все цветовые детали изображения. Конеч-
но, вы можете использовать и изображения с тысячами цветов, но для 
достижения наилучших результатов, особенно там, где цветопередача 
имеет значение, следует задействовать как можно больше цветов.

Для цифровых изображений, 
как правило, желательно иметь 
как можно больше цветовой 
информации, поскольку в этом 
случае картинка может переда-
вать больше оттенков. Тонкие 
цветовые переходы и высокая 
плотность цвета обеспечивают 
более реалистичное изображе-
ние.

Программа Photoshop позволя-
ет обрабатывать изображения 
с глубиной 16 или 32 бита на ка-
нал, которые создаются высоко-
классными цифровыми камера-
ми, сканерами и микроскопами. 
Картинки с глубиной 16/32 бита 
на канал содержат гораздо бо-
лее широкий диапазон цветов, 
чем изображения с глубиной  
8 бит на канал. Недостатком при 
работе с такими изображения-
ми является большой размер 
их файлов. Значение битовой 
глубины картинки указывается 
в строке с именем файла или 
в заголовке окна изображения, 
если вы работаете с плавающи-
ми окнами:
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Пиксели и разрешение
Пиксели

Пиксель —  это наименьший элемент растрового изображения, создан-
ного цифровой камерой или сканером. Слово «pixel»  —  сокращение 
от «picture element» («элемент изображения»). Увеличьте масштаб изо-
бражения в программе Photoshop, и вы увидите отдельные пиксели —  
основные строительные блоки, из которых состоит картинка. При ра-
боте в программе Photoshop вы перемещаете, копируете и редактируете 
пиксели, изменяете их цвет, оттенок и яркость для обеспечения разно-
образных модификаций изображения.

Разрешение

Ключевым фактором при работе с растровыми изображениями является 
разрешение, которое измеряется в пикселях на дюйм (ppi, pixel per inch).

Пиксели могут различаться по размеру. Если у вас есть изображение 
с разрешением 100 ppi, то размер каждого пикселя будет соответство-
вать 1/100 квадратного дюйма. Размер пикселя картинки с разрешени-
ем 300 ppi составляет 1/300 квадратного дюйма, что обеспечивает го-
раздо более качественный результат.

Если вы планируете печатать изображение в типографии, оно должно 
иметь высокое разрешение. Картинки с разрешением, в два раза превы-
шающим линиатуру * растра (измеряется в линиях на дюйм —  lpi, line 
per inch), будут использоваться для итогового вывода на пленку или 
непосредственно на печатную плату.

Например, при использовании линиатуры растра в 150 lpi, характерной 
для глянцевых журналов, вам нужно подготовить изображение с раз-
решением 300 ppi.

Разрешения, равные удвоенной линиатуре растра, подходят для изо-
бражений с  тонкими линиями, повторяющимися узорами или тек-
стурами. Вы можете достичь приемлемых результатов, особенно при 
значениях линиатуры выше 133 lpi, используя разрешение, в 1 ½ раза 
превышающее итоговую линиатуру растра.

При работе с  некоторыми изображениями вы можете использовать 
и более низкое разрешение, если их отображение на мониторе и проб-
ные распечатки на лазерном принтере устраивают вас по качеству.

* Линиатура —  характеристика качества печати, обозначающая плотность по-
лиграфического растра. —  Прим. ред.

Изображения, предназна-
ченные для мультимедийных 
презентаций или публикации 
в Интернете, должны иметь 
разрешение 72 ppi, которое 
соответствует разрешению 
экрана.
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Цветовые модели RGB 
и CMYK
Перед началом работы с программой Adobe Photoshop вам следует по-
знакомиться с двумя цветовыми моделями: RGB (Red, Green, Blue (крас-
ный, зеленый, синий)) и CMYK (Cyan, Magenta, Yellow и blacK (голубой, 
пурпурный, желтый и черный)).

Модель RGB имеет большое значение, поскольку она соответствует 
тому, как человеческий глаз воспринимает цвет. Эта модель использу-
ется сканерами и цифровыми камерами для захвата, а мониторами для 
отображения цветовой информации.

Красный, зеленый и  синий цвета считаются «аддитивными первич-
ными цветами». Смешав 100% красного, зеленого и синего цвета, вы 
получите белый цвет. «Вторичные» цвета создаются путем смешения 
красного и синего для получения пурпурного, зеленого и синего —  для 
получения голубого, красного и  зеленого  —  для получения желтого 
цвета. Вы можете складывать цвета в различных пропорциях, получая 
миллионы различных цветов, диапазон которых будет, тем не  менее, 
уже того, что мы наблюдаем в природе. Это обусловлено ограничения-
ми монитора компьютера.

Цветовая модель CMYK называется «субтрактивной» и  широко ис-
пользуется в полиграфии. В отличие от модели RGB, абстрактная мо-
дель CMYK основана не на сложении, но на «вычитании» цветов. Если 
убрать голубой, пурпурный и желтый цвета при печати, у вас останется 
белый, то есть цвет будет полностью отсутствовать.

Строго говоря, буква «K» в аб-
бревиатуре «CMYK» соответ-
ствует слову «key» («ключ»), 
потому что в процессе четы-
рехцветной печати голубые, 
пурпурные и желтые цвета 
должны быть точно выверены 
с «ключом» черного цвета.
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Цветовые гаммы

Цветовая гамма представляет собой диапазон цветов, который может 
быть воспроизведен конкретным устройством. Человеческий глаз спо-
собен воспринимать миллионы цветов видимой части спектра. Скане-
ры, мониторы и печатные машины не показывают все цвета видимого 
спектра —  диапазон воспроизводимых ими цветов представляет собой 
их гамму.

В печатном устройстве голубой, 
пурпурный, желтый и черный 
объединяются для имитации ог-
ромного разнообразия цветов. 
Принтеры добавляют черный, 
поскольку, хотя в теории при 
смешении 100% голубого, 
пурпурного и желтого получа-
ется черный, на практике (из-за 
примесей в красителях) может 
получиться грязно-коричневый 
цвет.

CIE (Commission Internationale 
de L'Eclairage, Международ-
ная комиссия по освещению) 
использует модель XYZ для 
определения видимой обыч-
ным человеческим глазом части 
спектра.

Цвета с одинаковым значением 
яркости попадают в плоскость 
примерно треугольной формы 
(область видимого спектра 
на диаграмме справа). Ось x  
представляет количество 
красного цвета, а ось y —  зеле-
ного. По оси z откладываются 
значения яркости цветов.
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При изменении режима с RGB 
на CMYK программа Photoshop 
преобразует не входящие в гам-
му цвета (цвета, которые можно 
увидеть на экране, но нельзя 
напечатать) в их ближайшие 
печатаемые эквиваленты.

В типографиях процесс преобразования цифровой информации о цве-
те в  напечатанное изображение довольно сложен, потому что гамма 
цветного монитора отличается от гаммы чернил CMYK и PANTONE. 
Есть цвета (особенно ярко-желтые и  темно-синие), которые отобра-
жаются на мониторе, но не могут быть напечатаны с использованием 
традиционных чернил CMYK.

Скорее всего, вы будете работать в  режиме RGB, если изображение 
предназначено для использования в Интернете или мультимедийном 
формате. Если картинка предназначена для печати, вы также можете 
работать в  режиме RGB, но  перед сохранением/экспортом в  формат 
EPS или TIFF вы должны будете преобразовать изображение в CMYK, 
чтобы использовать его для создания макета страницы. Программа 
Adobe InDesign импортирует CMYK или RGB изображения в формат 
Photoshop (.PSD).
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Если вы видите, что не може-
те обеспечить подходящий 
цвет изображения в процессе 
печати, проконсультируйтесь 
с сотрудниками типографии 
по вопросу создания пользова-
тельских параметров управле-
ния цветом.

Управление цветом
На практике ни одно устройство для работы с цифровыми изображе-
ниями, будь то камера, сканер, монитор или принтер, не воспроизво-
дит цвет одинаково. Задача системы управления цветом заключается 
в обеспечении максимального соответствия цветов на вашем мониторе 
цветам готового материала как в печати, так и на другом экране.

Вы можете получить доступ к параметрам управления цветом, чтобы 
выбрать наиболее подходящий для ваших нужд вариант.

Используя диалоговое окно Настройка цветов (Color Settings), вы мо-
жете выбрать вариант управления цветом изображения.

1 Для настройки параметров управления цветом в  программе 
Photoshop выберите команду меню Редактирование → Настрой-
ка цветов (Edit → Color Settings) (Shift + Ctrl/� + K).

2 Выберите наиболее подходящий для окончательного вывода ва-
риант в раскрывающемся списке Настройки (Settings). Напри-
мер, если вы используете Photoshop для создания изображений, 
которые будут использоваться в каких-либо мультимедийных 
материалах или в Интернете, выберите пункт Web/Интернет 
(Web/Internet) или Цвет для монитора (Monitor Color). Если вы 
работаете с изобра-
жениями, которые 
подвергнутся цве-
тоделению, а затем 
будут напечатаны 
с использованием 
чернил в CMYK, 
выберите вариант 
Допечатная подго-
товка для Европы 
(Europe Prepress).

3 Настройки по  умолчанию следует менять только после приоб-
ретения достаточного опыта и при наличии веских на то осно-
ваний, либо в случае, если внести изменения вам посоветовали 
в типографии для соответствия техническим требованиям.

4 Чтобы узнать больше о параметрах диалогового окна Настройка 
цветов (Color Settings), проведите указателем мыши по пунктам 
раскрывающихся списков. В  области Описание (Description) 
в нижней части диалогового окна будет представлена информа-
ция о том, как выбранный параметр влияет на изображение.
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Калибровка монитора

Чтобы принимать правильные решения относительно цветов, отобра-
жаемых на экране, вам следует откалибровать монитор. При калибров-
ке монитора будет создан его профиль, который потом будет использо-
ваться как часть рабочего процесса для управления цветом.

Аппаратные средства калибровки обеспечивают бóльшую точность 
по сравнению с утилитой Adobe Gamma, ранее доступной в програм-
ме Photoshop. Существует широкий спектр средств для калибровки 
монитора сторонних производителей. Запустите поиск в  Интернете 
по запросу «калибровка монитора» или поищите такие продукты, как 
i1Basic Pro 2 компании X-Rite, Spyder4™ EXPRESS Datacolor или huey™ 
PRO компании Pantone.

Система CMS (Color Manage-
ment System, Система управ-
ления цветом) применяется 
для точного преобразования 
цвета при переходе от одно-
го устройства к другому. Она 
обеспечивает соответствие 
оттенка из цветового простран-
ства, в котором было создано 
изображение, оттенку цветово-
го пространства, используемого 
при выводе, внося необходи-
мые корректировки, чтобы цвет 
представлялся как можно более 
похожим образом на различных 
мониторах и других устрой-
ствах.

Производите калибровку мони-
тора регулярно, поскольку ото-
бражение цветов на нем может 
со временем измениться.



2 Рабочая среда

Эта глава знакомит 
вас с рабочей средой 

Photoshop. Изучив ее, вы 
научитесь использовать 
окна программы, панель 
инструментов и другие 

панели, а также 
познакомитесь с рядом 
стандартных приемов 

Photoshop, которые 
окажутся полезными 

в работе с ним.

Рабочая среда

Использование панели инструментов

Размер документа и рабочих дисков

Направляющие и сетки

Масштабирование и навигация

Панель Инфо

Методы работы с панелями

Настройка рабочего пространства

Сохранение и загрузка пользовательских 

настроек

Печать

История
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Рабочая среда
При работе с изображениями в програм-
ме Photoshop можно выбрать один из трех 
режимов экрана. В  этом вам поможет 
кнопка в  нижней части панели инстру-
ментов.

Режим Во весь экран 
с главным меню (Full 
Screen Mode with Menu 
Bar) полезен при работе 
с отдельными изобра-
жениями, поскольку он 
освобождает рабочее 
пространство от строки 
меню (macOS) или панели 
задач (Windows). Ис-
пользуйте режим Во весь 
экран (Full Screen Mode) 
для просмотра картинки 
на черном фоне, не отвле-
каясь на другие элементы 
экрана, чтобы какие-ли-
бо посторонние цвета 
не смешивались с цвета-
ми вашего изображения.

В режиме Во весь экран (Full Screen Mode) на-
жмите клавишу Tab, чтобы отобразить/скрыть 
строку меню и панели.

Вы можете использовать клавишу F для пе-
реключения между различными режимами 
экрана.

Режим Стандартное окно

Режим Во весь экран с главным меню

Режим Во весь экран
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Операционная система Windows

Функциональность Photoshop одинакова вне зависимости от операци-
онной системы Windows или macOS. Это иллюстрируют снимки экрана, 
представленные в этой главе.

Плавающее окно изображения

Кнопка � (которая часто 
называется «Apple» («Яблоко») 
на Mac) и кнопки Ctrl и Alt 
(в Windows), а также их альтер-
натива в macOS —  кнопка� —  

применяются одинаковым 
образом —  как кнопки-модифи-
каторы. Кнопка Shift является 
стандартной на обеих платфор-
мах.

Слово Alt (с большой буквы «А») 
в этой книге обозначает одно-
именную кнопку в обеих опе-
рационных системах Windows 
и macOS.

Кнопка  
закрытия

Заголовок

Изображение

Полоса  
прокрутки

Маркер  
изменения  
размера

Масштаб в %

Пользователи Windows могут 
применять правую кнопку 
мыши для получения доступа 
к контекстному меню. Пользо-
ватели macOS для этих целей 
могут щелкнуть кнопкой мыши, 
удерживая нажатой клавишу �.

Для получения информации 
о работе с «плавающими» 
окнами обратитесь к разделу 
«Настройка рабочего простран-
ства» далее в этой главе.
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Использование панели 
инструментов
Существует несколько удобных способов выбора инструментов, в том 
числе из  различных скрытых всплывающих меню на  панели инстру-
ментов.В книге для удобства чтения 

используются снимки экрана 
со светлым интерфейсом про-
граммы. Изменить цвет интер-
фейса программы можно в окне 
настроек.

В версии 2015 вместо названия инструмента всплывающая панель

Вы можете использовать ин-
струмент Поворот вида (Rotate 
View) только при наличии 
видеокарты, поддерживающей 
спецификацию OpenGL, которая 
обеспечивает аппаратное уско-
рение графики. Этот инструмент 
позволяет повернуть изобра-
жение на экране. Тем не менее 
это лишь временное изменение 
угла, под которым вы рассма-
триваете изображение при ра-
боте с ним —  в данном случае 
не происходит фактического 
вращения пикселей. (Для полу-
чения информации о вращении 
изображения обратитесь к раз-
делу «Вращение изображений» 
главы 4.)
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Методы работы с панелью инструментов

1 Нажмите кнопку, указанную во всплы-
вающей подсказке, чтобы выбрать 
нужный инструмент.

2 Нажмите и удерживайте кнопку инструмента, в правом нижнем 
углу которой находится маленький треугольник, чтобы отобра-
зить все инструменты соответствующей группы.

3 Удерживая нажатой клавишу Alt/�, щелкайте по  кнопке ин-
струмента, перебирая все доступные варианты в данной группе. 
Вместо этого вы можете несколько раз нажать клавишу, преду-
смотренную для конкретной группы инструментов, удерживая 
нажатой клавишу Shift. Например, нажмите клавишу O три раза, 
чтобы перебрать все инструменты в  группе с  инструментом 
Осветлитель (Dodge).

4 Нажмите клавишу Tab, чтобы скрыть/отобразить все панели, 
включая панель инструментов. Удерживая нажатой клавишу 
Shift, нажмите клавишу Tab, чтобы скрыть/отобразить все пане-
ли, кроме панели инструментов.

5 Нажмите клавишу Caps Lock, чтобы курсор инструмента Кисть 
(Brush) принял вид перекрестия, которое обозначает центр дан-
ного инструмента. Нажмите клавишу Caps Lock еще раз, для 
восстановления стандартного вида указателя этого инструмента.

6 При выборе инструмента на панели с параметрами в верхней ча-
сти окна Photoshop эта панель изменяет свой вид в соответствии 
с выбранным инструментом. Приучите себя проверять настрой-
ки на панели параметров перед использованием любого инстру-
мента.

Редактирование в режиме  
«Быстрая маска» (Q)

Цвет переднего и заднего плана 
по умолчанию (D)

Выбор основного цвета

Переключение цветов  
переднего и заднего плана (X)

Выбор фонового цвета 

Смена режима  
экранного отображения (F)

Выберите в меню Редакти-

рование (Edit)/Photoshop 
команду Настройки → Курсоры 

(Preferences → Cursors), чтобы 
изменить внешний вид ука-
зателей мыши, используемых 
по умолчанию.
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Выберите в меню Редакти-

рование (Edit)/Photoshop 
пункт Настройки → Произво-

дительность (Preferences → 
Performance), чтобы изменить 
значение объема памяти, 
выделенной для программы 
Photoshop.

Чтобы повысить производи-
тельность при работе с боль-
шими файлами, рабочий диск 
должен отличаться от того, 
на котором хранится изобра-
жение.

Чтобы повысить производи-
тельность при работе с боль-
шими файлами, рабочий диск 
должен отличаться от того, 
на котором хранится изобра-
жение.

Размер документа и рабочих 
дисков
Панель Размеры (Sizes) позволяет оценить объем используемого диско-
вого пространства и памяти при работе с изображениями.

Размер документов

Размер документа обозначается двумя 
числами, разделенными слешем. Первое 
число соответствует размеру изображения с объединенными слоями. 
Второе число может быть больше, если файл содержит дополнительные 
слои и/или созданные вами альфа-каналы. В случае с изображениями, 
состоящими всего лишь из одного слоя и без дополнительных каналов, 
оба числа будут одинаковыми.

Размеры рабочих дисков

Рабочий диск является важной технической деталью, которую стоит 
иметь в виду при использовании приложения Photoshop. Рабочий диск —  
это тот жесткий диск, который программа будет использовать для «вир-
туальной» памяти, если во время работы над одним или несколькими 
изображениями она израсходует всю оперативную память компьютера.

При выборе пункта Размеры рабочих дисков 
(Scratch Sizes) в раскрывающемся списке меню 
вы снова увидите два числа, разделенные сле-
шем. Первое число соответствует объему 
оперативной памяти, который требуется про-
грамме Photoshop для обработки всех откры-
тых в  данный момент изображений; второе 
число показывает фактический объем памяти, 
доступной программе в  данный момент. Ко-
гда первое число больше второго, приложение 
Photoshop начинает использовать рабочий диск для виртуальной памяти.

Как правило, при работе в Photoshop объем свободного дискового про-
странства должен не менее чем в 3–5 раз превышать размер файла изо-
бражения, с которым вы работаете. Это связано с тем, что программа 
Photoshop использует рабочий диск в  качестве виртуальной памяти 
и  хранит несколько копий текущего изображения для команд Отме-
нить (Undo), Восстановить (Revert) и панели История (History).
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Направляющие и сетки
Вы можете 
отобразить 
сетку в окне 
изображения 
для облегчения 
процесса вырав-
нивания и из-
мерения. Кроме 
того, вы можете перетаскивать направляющие. Направляющие и сетка 
не печатаются. Настроить вид сетки и направляющих можно, выбрав 
в меню Редактирование (Edit)/Photoshop пункт Настройки → Направ-
ляющие, сетка и фрагменты (Preferences → Guides, Grid & Slices).

1 Для отображения или 
сокрытия сетки выберите 
команду меню Просмотр → 
Показать → Сетку (View → 
Show → Grid).

2 Для создания направляющей 
сначала выберите команду 
меню Просмотр → Линей-
ки (View → Rulers), чтобы 
отобразить линейки вдоль 
верхнего и левого края окна 
с  изображением. Установите курсор на  линейку, а  затем, нажав 
и удерживая кнопку мыши, перетащите указатель на изображение 
для создания вертикальной или горизонтальной направляющей.

3 Чтобы переместить направляющую, выберите ин-
струмент Перемещение (Move), установите курсор 
на направляющую и, удерживая нажатой кнопку 
мыши, перетащите курсор. Указатель примет вид 
двунаправленной стрелки, когда вы установите его 
на направляющую. Чтобы удалить направляющую, перетащите ее 
на исходную линейку. Вы также можете выбрать пункт меню Про-
смотр → Удалить направляющие (View → Clear Guides).

4 Чтобы временно скрыть сетку или направляющие и  просмо-
треть изображение, не загроможденное непечатаемыми элемен-
тами, выберите команду меню Просмотр → Вспомогательные 
элементы (View → Extras) (Ctrl/�+H). Эту  же команду нужно 
использовать, чтобы снова отобразить направляющие и сетку.

Убедитесь в том, что в меню 
Просмотр → Привязать 

к (View → Snap to) выбран пункт 
Направляющим (Guides) и/или 
Линиям сетки (Grid), если вы 
хотите, чтобы указатели мыши 
и выделения привязывались 
к направляющим и/или лини-
ям сетки. Эти варианты очень 
полезны, когда вам необходимо 
точно выровнять элементы.

Используйте сочетание клавиш 
Ctrl/�+; для скрытия и отобра-
жения направляющих, а со-
четание Ctrl/�+' для скрытия 
и отображения сетки.

При перемещении направляю-
щих старайтесь не переместить 
случайно весь слой. Убедитесь, 
что вы видите двунаправлен-
ную стрелку, которая означает, 
что вы перетаскиваете именно 
направляющую.
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Масштабирование 
и навигация
Используйте панель Навигатор (Navigator), инструменты Масштаб 
(Zoom) и  Рука (Hand), а  также полосы прокрутки для перемещения 
по экрану и масштабирования изображения.

1 Выберите команду меню Окно → Навигатор (Window → 
Navigator), чтобы отобразить соответствующую панель, 
если она еще не отображена. В этой панели вы можете 
дважды щелкнуть по полю %,  
ввести значение от  0.08 
до  3200, а  затем нажать кла-
вишу Enter/�. Кроме того, 
вы можете перетащить пол-
зунковый регулятор вправо 
для увеличения или влево 
для уменьшения масштаба. 
Каждый раз при изменении масштаба вид в области предвари-
тельного просмотра будет обновляться.

2 Перетащите красный прямоугольник в области предварительно-
го просмотра для быстрого перемещения по изображению.

3 Для использования инструмента Масштаб (Zoom) вы-
берите его, установите курсор на изображение и щелк-
ните кнопкой мыши, чтобы увеличить область вокруг 
указателя с заданным шагом приближения. Выбрав инструмент 
Масштаб (Zoom), нажмите и удерживайте клавишу Alt/�. Ука-
затель примет вид лупы со знаком «минус», после чего вы смо-
жете уменьшать масштаб с заданным шагом.

4 При выбранном инструменте Масштаб (Zoom), вы также може-
те, нажав и удерживая кнопку мыши, переместить курсор для 
задания области, которую вы хотите увеличить.

5 Вы можете использовать инструмент Рука (Hand) вме-
сте с полосами прокрутки, чтобы перемещаться по сво-
ему изображению после увеличения его масштаба. Вы-
берите инструмент, установите курсор на изображение, а затем, 
нажав и удерживая кнопку мыши, передвигайте указатель.

Выбрав инструмент Масштаб 
(Zoom), установите курсор 
на область изображения, 
которую вы хотите увеличить, 
а затем нажмите и удерживайте 
кнопку мыши для обеспечения 
постепенного увеличения.

Удерживайте нажатыми 
клавиши Ctrl/� и Пробел для 
получения временного доступа 
к инструменту Масштаб (Zoom) 
при другом выбранном инстру-
менте. Добавьте клавишу Alt/� 
в эту комбинацию для уменьше-
ния масштаба.

При любом другом выбранном 
инструменте удерживайте на-
жатой клавишу Пробел, чтобы 
временно получить доступ к ин-
струменту Рука (Hand). Старай-
тесь не использовать данный 
метод при работе с текстом.
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Панель Инфо
Панель Инфо (Info) (доступная из меню Окно (Window)) содержит по-
лезные числовые значения, зависящие от положения курсора на вашем 
изображении.

Вы можете использовать ее 
в  качестве экранного ана-
лизатора для изучения цве-
товых значений в точке, где 
находится указатель мыши. 
В  этой панели присутству-
ют два цветовых показа-
ния. По умолчанию, первый 
показатель соответствует 
фактическому цвету в  точ-
ке под курсором. Например, 
значение красной, зеленой 
и  синей цветовой компо-
ненты в RGB-изображении. 
Второй показатель по умол-
чанию содержит значения 
для голубого, пурпурного, 
желтого и черного цветов.

Эта панель также предо-
ставляет координаты x и  у  точ-
ного местоположения указате-
ля мыши при его перемещении 
по изображению.

При создании выделения вы увидите его ширину и высоту. Кроме того, 
в этой панели отображаются значения некоторых параметров, напри-
мер, вращения, искажения и масштабирования.

1 Чтобы изменить параметры панели Инфо (Info) по  умол-
чанию, выберите пункт Параметры панели (Panel Options) 
в меню, расположенном в ее правом верхнем углу ( ).

2 Используйте раскрывающиеся списки Режим (Mode), чтобы 
выбрать первое и второе показания, относящиеся к цвету.

3 Вы также можете выбрать единицы измерения, в которых 
будут отображаться координаты указателя мыши.

Восклицательный знак рядом 
со значениями CMYK сообщает 
о том, что цвет не входит в печа-
таемый диапазон гаммы CMYK.
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Методы работы с панелями
В Основной рабочей среде (Essentials) док-панель, находящаяся 
по умолчанию в правой части окна Photoshop, содержит восемь пане-
лей, а также два значка панелей История 
(History) и  Предпросмотр устройств 
(Device Preview). Вы можете развернуть 
или свернуть док-панель, или  же поме-
нять панели в ней местами в соответствии 
со  своими личными предпочтениями. 
По  умолчанию док-панель является раз-
вернутой.

1 Щелкните мышью по кнопке Свер-
нуть в  пиктограммы (Collapse to 
Icons) ( ), и  панели отобразят-
ся в  виде вкладок. Чтобы развер-
нуть док-панель, щелкните мышью 
по  кнопке Развернуть панели 
(Expand Panels) ( ) в  ее пра-
вом верхнем углу.

2 Щелкните мышью по вкладке, 
чтобы сделать панель актив-
ной и  получить доступ к  со-
ответствующим элементам управления.

3 Для удаления панели из док-панели, убедитесь в том, что она ак-
тивна, и выберите команду Закрыть (Close) в ее меню. Перейди-
те в меню Окно (Window) и выберите название панели, чтобы 
восстановить ее в исходном положении на вашем экране.

4 Для отображения панели, которая по  умолчанию отсутству-
ет в  док-панели, перейдите в  меню Окно (Window) 
и выберите имя нужной панели. Эта панель появится 
во второстепенной док-панели слева от  главной пане-
ли. Вы можете контролировать внешний вид панелей 
во второстепенной док-панели, используя те же методы, 
которые применяются к основной панели.

Используйте раскрывающий-
ся список Выбрать рабочую 

среду (Workspace Switcher) 

в правом верхнем углу окна 
программы Photoshop, чтобы 
выбрать расположение пане-
лей, которое наиболее соответ-
ствует вашим потребностям. За-
тем в случае закрытия панелей 
в процессе работы вы сможете 
восстановить их расположение 
по умолчанию, выбрав в этом 
списке пункт Сбросить (Reset).

Для некоторых панелей преду-
смотрена возможность перета-
скивания нижнего угла панели 
для увеличения или уменьше-
ния ее размера.

Чтобы вручную изменить 
ширину док-панели, установите 
курсор на ее левый край. Когда 
он примет вид двунаправленной 
стрелки ( ), нажав и удерживая 
кнопку мыши, тяните в сторону.
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Группы панелей

Изначально панели расположены в док-панели в виде групп вкладок. 
Например, панели Слои (Layers), Каналы (Channels) и Контуры (Paths) 
образуют группу вкладок. Существует несколько способов для управле-
ния внешним видом этих групп.

1 Чтобы скрыть все панели 
в  группе вкладок, выберите 
команду Закрыть группу 
вкладок (Close Tab Group) в меню активной панели ( ). Если 
вы скроете всю группу панелей, а затем выберете любую из них 
в меню Окно (Window), будет отображена вся группа вкладок.

2 Чтобы свернуть панели 
и  отобразить только вклад-
ки, дважды щелкните мышью в любом месте названия вкладки. 
Щелкните один раз по  свернутой вкладке, чтобы развернуть 
группу панелей.

Плавающие и объединенные панели

Для удобства управления каждую панель можно преобразовать в пла-
вающую панель или объединить в пользовательскую группу.

1 Чтобы создать плавающую панель, установите указатель мыши 
на вкладку панели, а затем перетащите ее из группы, например, 
в  окно изображения. Для 
перемещения плавающей 
панели перетащите соот-
ветствующую вкладку или 
серую строку заголовка па-
нели.

2 Чтобы объединить панель с груп-
пой панелей, перетащите вклад-
ку или серый заголовок в группу. 
Отпустите кнопку мыши, когда 
группа панелей будет выделена 
синим цветом.

Все панели имеют отдельные 
меню, в которых перечислены 
команды и параметры. Щелкни-
те мышью по кнопке меню ( ), 
чтобы получить к нему доступ.

Нажмите клавишу Tab, чтобы 
скрыть/отобразить все панели, 
включая панель инструментов. 
Удерживая нажатой клавишу 
Shift, нажмите клавишу Tab, 
чтобы скрыть/отобразить 
видимые в данный момент 
панели, за исключением панели 
инструментов.

Выберите команду меню  
Окно → Рабочая среда →  
Новая рабочая среда (Window →  
Workspace → New Workspace), 
чтобы сохранить текущее рас-
положение ваших панелей. Вве-
дите название рабочей среды 
в диалоговом окне Новая рабо-

чая среда (Save Workspace).

Откройте меню Окно → Рабочая 

среда (Window → Workspace), 
а затем выберите название со-
храненной рабочей среды, чтобы 
расположить панели в соответ-
ствии с ней.
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Настройка рабочего 
пространства
Очень часто при работе в программе Photoshop бывает необходимо иметь 
несколько открытых одновременно изображений. По умолчанию окна 
изображений или документов организуются в виде панели с вкладками.

1 По мере открытия документов вкладка с  именем каждого но-
вого файла появляется под панелью с параметрами. Щелкните 
мышью по вкладке, чтобы сделать активным соответствующее 
окно. Щелкните мышью по кнопке Закрыть (Close) ( ), чтобы 
закрыть документ.

2 Для просмотра изображений 
в  отдельных плавающих окнах 
выберите команду меню Окно →  
Упорядочить → Свободно пе-
ремещать все окна (Window → 
Arrange → Float All in Windows). 
Щелкните мышью в любой части 
окна документа, чтобы сделать 
его активным, или перейдите 
в меню Окно (Window) и выберите имя файла из списка, распо-
ложенного в нижней части меню.

3 Чтобы документы по  умол-
чанию открывались в  виде 
плавающих окон, в меню Ре-
дактирование (Edit)/Photo-
shop выберите команду Настройки → Рабочая среда (Preferences →  
Workspace), а  затем сбросьте флажок Открыть документы 
во вкладках (Open Documents as Tabs).

4 Используйте верхний и средний набор команд в меню Упорядо-
чить (Arrange Documents), чтобы сравнить различные варианты 
расположения окон документов и  выбрать наиболее подходя-
щий вам.

На компьютере Mac выберите 
команду меню Окно →  
Рамка приложения (Window →  
Application Frame) для созда-
ния окна приложения, размер 
которого можно изменять так же, 
как в операционной системе 
Windows. При выборе этого 
варианта панель с названием, 
по умолчанию находящаяся 
поверх вкладок документов, 
исчезает.

Чтобы документы отобража-
лись не в плавающих окнах, 
а во вкладках, выберите команду 
меню Окно → Упорядочить →  
Объединить все на вкладках 
(Window → Arrange →  
Consolidate All to Tabs).
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Сохранение и загрузка 
пользовательских настроек
Панели Образцы (Swatches), Стили (Styles), Операции (Actions), Слои 
(Layers), Коррекция (Adjustments), а также такие диалоговые окна, как 
Дуплекс (Duotones), предусматривают кнопки Сохранить (Save) и За-
грузить (Load), которые позволяют вам сохранять пользовательские 
настройки, сделанные на панели или в диалоговом окне, а затем при 
необходимости загружать их в Photoshop. Следующий пример демон-
стрирует работу с панелью Образцы (Swatches).

1 После создания пользова-
тельской панели Образцы 
(Swatches) (см. раздел «Об-
разцы» главы 4) выберите 
команду Сохранить образ-
цы (Save Swatches) в  меню 
данной панели.

2 Диалоговое окно Сохране-
ние (Save) предоставит вам 
возможность указать имя 
сохраняемого файла и  его 
расположение. По  умолча-
нию папка Color Swatches 
находится в  папке Presets, 
которая расположена в  ка-
талоге Photoshop CC. Файлы цветовых образцов имеют расшире-
ние .aco. Убедитесь в том, что вы сохраняете файл с правильным 
расширением.

3 Чтобы загрузить ранее сохраненный набор образцов, выбери-
те команду Загрузить образцы (Load Swatches) в меню панели. 
В открывшемся диалоговом окне выберите имя нужного файла 
и щелкните мышью по кнопке Загрузить (Load). После этого но-
вые образцы будут добавлены в соответствующую панель.

В нижней части панели Кисть 

(Brushes) щелкните мышью 
по кнопке Управление набора-

ми кистей (Brush Presets). В от-
крывшемся диалоговом окне 
щелкните мышью по значку 
в виде шестеренки и, начав с ва-
рианта Разные кисти (Assorted 
Brushes), поэкспериментируйте 
с различными типами кистей.

Выберите команду Восстано-

вить образцы (Reset Swatches) 
в меню панели для восстановле-
ния настроек по умолчанию.
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Печать
После внесения всех необходимых корректировок, вы можете присту-
пить к печати изображения. Диалоговое окно Печатать (Print) содер-
жит эскиз изображения с параметрами, относящимися к управлению 
цветом. Кроме того, оно позволяет вам получить доступ к  дополни-
тельным настройкам печати и посмотреть, как печатаемое изображе-
ние будет выглядеть при выбранном формате бумаги.

1 Выберите команду меню Файл → Печатать (File → Print). Убеди-
тесь, что в  раскрывающемся списке Принтер (Printer) выбран 
нужный принтер. Введите необходимое количество копий. Не-
которые параметры доступны только при выборе принтера, со-
вместимого с PostScript.

2 Щелкните мышью по кнопке Параметры печати (Print Settings), 
чтобы настроить параметры в соответствии с вашим принтером. 
В частности, убедитесь в правильности таких параметров, как 
тип и размер бумаги, а также ориентация и качество. Обратитесь 
к  руководству по  использованию принтера для получения ин-
формации о доступных для него параметрах. Щелкните мышью 
по кнопке ОК.

3 При необходимости отмасштабируйте изображение по размеру 
страницы, чтобы оно поместилось на листе выбранного размера.

4 Щелкните мышью по кнопке Печать (Print) в диалоговом окне 
Настройки печати (Print Settings), чтобы распечатать изображе-
ние. Щелкните мышью по кнопке Готово (Done), если вы хотите 
сохранить изменения в диалоговом окне и вернуться к изобра-
жению, не печатая его.

Точный вид диалогового окна 
Настройка печати (Page Setup) 
варьируется в зависимости 
от принтера.

Изменяйте параметры раздела 
Управление цветом (Color 
Management) в диалоговом 
окне Настройки печати (Print 
Settings) только в том случае, 
если вы не удовлетворены 
напечатанным изображением. 
Запоминайте, какие параметры 
вы изменяете, чтобы можно 
было сравнить результаты 
и, при необходимости, вернуть-
ся к предыдущим настройкам.

В диалоговом окне Настройки 

печати (Print Settings) щелкните 
мышью по треугольнику в раз-
деле Метки печати (Printing 
Marks), чтобы указать дополни-
тельные печатаемые данные, 
например, Угловые метки 

обреза (Crop Marks) и Метки 

приводки (Registration Marks). 
По мере выбора различных 
параметров они отображаются 
в области предварительного 
просмотра. Используйте значки 
в виде треугольников в правой 
части диалогового окна, чтобы 
отобразить элементы управ-
ления в разделах Положение 

и размер (Position and Size), 
Управление цветом (Color 
Management) и т. д.
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История
Каждый раз, когда вы вносите изменение в  изображение, Photoshop 
фиксирует его в качестве нового состояния на панели История (History). 
В этой панели сохраняются последние 20 состояний изображения. Ис-
пользуйте панель История (History), чтобы вернуться к предыдущему 
состоянию изображения в пределах текущей рабочей сессии. Последнее 
состояние изображения расположено на панели в конце списка.

1 Чтобы вернуться к предыдущему 
состоянию изображения, щелк-
ните мышью по  соответствую-
щему пункту списка на  панели 
История (History). После этого 
изображение вернется в выбран-
ное состояние текущей рабочей 
сессии, а  следующие за  ним со-
стояния выделятся серым цве-
том. Если вы продолжите работать с  выбранным состоянием, 
то эти следующие состояния заменятся новыми.

2 Кроме того, вы можете выбрать пункт Шаг вперед/Шаг назад 
(Step Forward/Step Backward) в  меню панели ( ) для перехода 
между состояниями.

Удаление состояний

Удалите состояния из  панели История (History), чтобы отменить из-
менения, внесенные в изображение на данном и последующих этапах 
редактирования.

Чтобы удалить состояние, щелкните мышью по его имени, а затем вы-
берите пункт Удалить (Delete) в меню панели История (History). Кроме 
того, вы можете перетащить состояние на значок в виде мусорной кор-
зины в нижней части панели.

Сброс истории

Очистка панели История (History) оставляет изображение в текущем 
состоянии, удаляя все предыдущие состояния.

Чтобы очистить панель История (History), выберите в меню пункт Очи-
стить палитру «История» (Clear History). Все состояния будут удалены 
из панели, а изображение останется в последнем состоянии.

Вы также можете исполь-
зовать сочетание клавиш 
Ctrl/�+Shift+Z, чтобы перейти 
к следующему состоянию. Для 
перехода к предыдущему со-
стоянию используйте сочетание 
Ctrl/�+Alt/�+Z.

Оба метода приводят к уда-
лению выбранного состояния 
и всех состояний, которые сле-
дуют за ним. Другими словами, 
вы возвращаетесь к состоянию, 
предшествующему удаляемому.

Используйте команду Файл → 
Восстановить (File → Revert), 
чтобы вернуться к состоянию 
изображения в момент по-
следнего сохранения. Команда 
Восстановить (Revert) будет 
указана в качестве состояния 
на панели История (History).
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Удаление состояний из памяти

Возможность удаления состояний из памяти полезна, когда вы полу-
чаете сообщение о  недостатке свободной памяти. Как правило, это 
связано с тем, что буфер отмены заполняется данными об изменениях, 
внесенных в изображение. При удалении состояний из памяти они уда-
ляются из буфера отмены, что приводит к освобождению памяти.

Для удаления состояний из памяти, удерживая нажатой клавишу Alt/�, 
выберите команду меню Очистить палитру «История» (Clear History). 
Эта команда удаляет состояния активного изображения. Если вы хо-
тите удалить из  памяти состояния, относящиеся ко  всем открытым 
изображениям, выберите команду меню Редактирование → Удалить 
из памяти → История (Edit → Purge → Histories).

Снимки

В процессе работы над изображением на панели История (History) со-
храняются результаты последних 20 операций. Первый «снимок» со-
здается по умолчанию при открытии изображения. Он отображается 
в верхней части панели История (History). Старые состояния изобра-
жения автоматически удаляются, чтобы освободить память для про-
граммы Photoshop. Вы можете сохранить конкретные состояния изо-
бражения во время рабочей сессии, создав дополнительные снимки.

1 Для создания дополнитель-
ных снимков щелкните мы-
шью по  любому состоянию 
на панели История (History). 
Выберите в  меню панели пункт Но-
вый снимок (New Snapshot). В  от-
крывшемся диалоговом окне введите 
имя и щелкните мышью по кнопке ОК. 
Новый снимок отобразится в верхней 
части панели История (History).

2 Щелкните мышью по  имени снимка, 
чтобы вернуться к состоянию изображения, соответствующему 
моменту создания снимка. Если после этого вы продолжите ра-
ботать с изображением, то все состояния будут удалены.

3 Для удаления снимка выделите его, а  затем щелкните мышью 
по значку в виде мусорной корзины в нижней части панели.

С помощью пункта меню Редак-

тирование → Отменить (Edit →  
Undo) вы можете отменить 
команду Очистить палитру 

«История» (Clear History), 
но не команду Удалить из па-

мяти (Purge).

Снимки позволяют записать 
состояние изображения в кон-
кретный момент времени. Они 
полезны, когда вы хотите со-
хранить определенное состоя-
ние изображения, к которому 
сможете вернуться позднее.

Как только вы закроете изобра-
жение, все состояния Истории 
и снимки будут удалены.



3 Открытие 
и сохранение файлов

Одной из самых сильных 
сторон приложения 
Photoshop является 

возможность открывать 
и конвертировать файлы 

в различные форматы. 
Это позволяет 

соответствовать 
строгим техническим 

требованиям к выходным 
данным. В этой 

главе описываются 
основные методы 

открытия и сохранения 
изображений в программе 

Photoshop.

Открытие изображений в программе 

Photoshop

Сканирование в программе Photoshop

Открытие и помещение файлов в формате EPS

Приложение Bridge

Модуль Adobe Camera Raw

Градуированный фильтр

Формат TIFF

Формат Photoshop EPS

Сохранение файла в формате JPEG

Создание нового файла

Создание панорам
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Открытие изображений 
в программе Photoshop
После запуска программы Photoshop, вы можете открывать изображе-
ния с помощью меню Файл (File). Дополнительное приложение Adobe 
Bridge обеспечивает мощный и гибкий альтернативный способ навига-
ции по изображениям и их открытия (для получения дополнительной 
информации обратитесь к разделу «Приложение Bridge» далее в этой 
главе).

1 Чтобы открыть изображение в  программе Photoshop, выбери-
те команду меню Файл → Открыть (File → Open). После этого 
появится диалоговое окно Открытие (Open). Найдите папку 
с нужным файлом, выберите его, щелкнув по его имени, а затем 
нажмите кнопку Открыть (Open). Или просто дважды щелкните 
мышью по имени файла.

2 Выберите пункт Все форма-
ты (All Formats) (Windows) 
или Все доступные для 
чтения документы (Show 
All Readable Documents) 
(macOS) в раскрывающемся 
списке выбора типа файлов, 
чтобы показать все файлы, 
находящиеся в выбранной папке.

3 Вы также можете обратиться к файлу, с которым недавно рабо-
тали, выбрав пункт меню Файл → Последние документы (File → 
Open Recent) и щелкнув по имени файла в списке.

4 (macOS) Чтобы найти файл, 
который вы хотите открыть 
через диалоговое окно 
Открыть (Open), восполь-
зуйтесь поисковой панелью 
в правом верхнем углу окна.

В операционной системе 
Windows щелкните правой 
кнопкой мыши по значку 
изображения на рабочем столе, 
выберите в контекстном меню 
пункт Открыть с помощью → 
Выбрать программу (Open 
with → Choose Default Program), 
а затем выберите вариант 
Photoshop CC. В дальнейшем, 
при двойном щелчке по значку 
файла того же типа, программа 
Photoshop будет запускаться 
автоматически.

Выберите в меню Редактирова-

ние (Edit)/Photoshop команду 
Настройки → Обработка фай-

лов (Preferences → File Handling), 
а затем введите число в поле 
Длина списка недавних фай-

лов (Recent File List Contains), 
чтобы указать количество 
файлов, которые будут ото-
бражаться в меню Последние 

документы (Open Recent).
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Сканирование в программе 
Photoshop
Вы можете сканировать изображение в  программе Photoshop с  по-
мощью команды, доступной в  меню Файл → Импортировать (File → 
Import). Перед началом процесса сканирования убедитесь в том, что вы 
установили программу для вашего сканера.

1 Чтобы отсканировать изображение в программе Photoshop, вы-
полните команду меню Файл → Импортировать (File → Import), 
а затем в появившемся списке выберите подходящий сканер.

Как правило, вы можете сканировать изображение, используя настрой-
ки сканера по умолчанию, либо настроив такие параметры, как режим 
сканирования (градации серого, цветное изображение, черно-белое 
изображение и т. д.), разрешение, масштаб, контраст, яркость и гамма. 
Обратитесь к справке программы для сканирования, чтобы получить 
дополнительную информацию относительно этих параметров.

Многие элементы управления, относящиеся к процессу сканирования, 
имеют эквивалентные функции в программе Photoshop. Эти параметры 
варьируются от  сканера к  сканеру, 
кроме того, нужно будет указать, 
что вы сканируете: прозрачный 
материал или фотографию. Также 
на  данном этапе следует опреде-
литься с  режимом сканирования, 
разрешением и  масштабом. Поми-
мо этого, вам нужно будет опреде-
лить область обрезки в  окне пред-
варительного просмотра.

2 Щелкните мышью по кнопке 
Сканировать (Scan). Дожди-
тесь завершения процесса 
сканирования и  появления 
изображения в  окне про-
граммы Photoshop. Сохрани-
те это изображение.

Если вы хотите импортировать 
изображение с помощью интер-
фейса TWAIN, сначала установи-
те плагин TWAIN, который можно 
скачать с сайта: download.

adobe.com/pub/adobe/

photoshop/win/13.x/Win_

Optional_Plug-Ins.zip (Windows) 
или download.adobe.com/pub/

adobe/photoshop/mac/13.x/

Optional_Plug_Ins_Release.dmg 
(macOS). Интерфейс TWAIN недо-
ступен для 64-разрядной версии 
программы Photoshop.

После ввода ссылки в адресную 
строку браузера и нажатия клави-
ши Enter поищите загруженный 
файл.zip или.dmg в папке загрузок.

При использовании сканеров, 
совместимых с моделью WIA 
(Windows Image Acquisition), 
выберите команду меню Файл →  
Импортировать → Поддерж-

ка WIA (File → Import → WIA 
Support). В диалоговом окне 
Поддержка WIA (WIA Support) 
щелкните мышью по кнопке 
Обзор (Browse), чтобы указать 
место, где следует сохранить 
отсканированное изображе-
ние, а затем щелкните мышью 
по кнопке Начало (Start). Выбе-
рите свой сканер в диалоговом 
окне Выбор устройства (Select 
Device). Для начала сканирова-
ния щелкните мышью по кнопке 
ОК. При необходимости на-
стройте параметры, относящие-
ся к сканеру. Обратитесь к ру-
ководству по эксплуатации для 
получения подробной информа-
ции о доступных параметрах.
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Открытие и помещение 
файлов в формате EPS
Аббревиатура EPS расшифровывается как Encapsulated Postscript. EPS-
файлы могут содержать как растровую, так и векторную информацию. 
EPS-файлы, созданные в таких приложениях, как Adobe Illustrator, как 
правило, содержат информацию об объектах, или векторную инфор-
мацию.

Открытие EPS-файла

Когда вы открываете EPS-файл в  программе Photoshop, он растриру-
ется, или, другими словами, векторная информация преобразуется 
в формат Photoshop на основе пикселей.

1 Чтобы открыть файл EPS как новый документ, выберите команду 
меню Файл → Открыть (File → Open). Найдите и выделите нужный 
файл EPS, а затем щелкните мышью по кнопке Открыть (Open). 
Вы также можете дважды щелкнуть мышью по имени файла.

2 В диалоговом окне Растрировать (Rasterize) при необходимости 
введите новые значения ширины и высоты. Укажите разрешение, 
требуемое для устройства вывода, а также выберите режим изо-
бражения в соответствующем всплывающем меню.

3 Установите флажок Сохра-
нить пропорции (Constrain 
Proportions), чтобы сохранить 
оригинальные соотношения 
сторон EPS-файла. Устано-
вите флажок Сглаживание 
(Anti-aliased), чтобы немного 
размыть пиксели вдоль краев 
и избежать появления рваных краев изображения. 
Щелкните мышью по кнопке ОК. Файл EPS отобра-
зится в собственном окне в качестве растрового изображения.

Помещение встроенного файла Photoshop  
или Illustrator

Вы также можете «поместить» другой файл формата Photoshop или 
Illustrator в  открытый документ Photoshop. Это изображение бу-
дет находиться в  новом слое со  смарт-объектом. (Дополнительную 

Вы также можете использовать 
пункт меню Файл → Открыть 
(File → Open), чтобы открыть 
файлы программы Illustrator (.ai) 
как документы Photoshop.

Файл Photoshop (.psd) со слоями 
сохраняет свою первоначаль-
ную структуру слоев, если его 
редактировать с помощью 
двойного щелчка по слою 
со смарт-объектом.

Перед тем как поместить EPS-
файл, вы также можете исполь-
зовать панель параметров, 
чтобы настроить положение, 
размер, поворот и искажение 
изображения.
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информацию о  помещении файлов Photoshop и  Illustrator в  качестве 
внешних связанных файлов вы можете найти в  разделе «Связанные 
смарт-объекты» главы 8).

1 Создайте новый документ Photoshop.

2 Выберите команду меню 
Файл → Поместить встро-
енные (File → Place Em-
bedded). В открывшемся 
диалоговом окне укажите 
местоположение и имя 
нужного файла, а затем 
щелкните мышью по кноп-
ке Поместить (Place).

3 В окне документа Photoshop появит-
ся ограничительная рамка с  восемью 
«маркерами» и перекрестием.

4 При необходимости перетащите угловой маркер, чтобы изме-
нить размер помещенного изображения. Удерживайте нажатой 
клавишу Shift при перетаскивании, чтобы сохранить пропорции. 
Установите курсор внутри ограничительной рамки помещенно-
го изображения и, нажав и удерживая кнопку мыши, перетащи-
те, чтобы изменить его положение.

5 По достижении нужного 
результата нажмите кноп-
ку Подтвердить преобра-
зование (Commit) на  па-
нели параметров, нажмите 
клавишу Enter/� или два-
жды щелкните мышью 
внутри ограничительной 
рамки.

6 «Сведенная» версия многослойного файла Photoshop поме-
щается в  новом слое смарт-объекта. Тем не  менее при двой-
ном щелчке по встроенному многослойному файлу Photoshop 
структура его слоев остается доступной для редактирования 
в  качестве смарт-объекта. Кроме того, при редактировании 
слоя смарт-объекта вы можете манипулировать всеми объек-
тами во  встроенном файле программы Illustrator. (Дополни-
тельную информацию о слоях смарт-объекта вы можете найти 
в разделе «Смарт- объекты» главы 8.)

Если вы не хотите принимать 
помещенное изображение, 
нажмите клавишу Esc при ото-
бражаемой ограничительной 
рамке. Если вы уже помести-
ли изображение, вы можете 
удалить новый слой (см. раздел 
«Работа со слоями» главы 8).

Вы можете скопировать век-
торную иллюстрацию из про-
граммы Illustrator в приложение 
Photoshop, используя буфер 
обмена. В приложении Illustrator 
скопируйте выбранную иллю-
страцию, используя команду 
меню Редактирование → Ко-

пировать (Edit → Copy), а затем 
в программе Photoshop выбе-
рите команду меню Редактиро-

вание → Вставить (Edit → Paste). 
Выберите вариант Контур 
(Path) в диалоговом окне, чтобы 
импортировать иллюстрацию 
в виде контуров.

Для создания сглаженных краев 
помещенного EPS-файла вам 
нужно установить флажок Сгла-

живание (Anti-aliased) на панели 
параметров, прежде чем подтвер-
дить преобразование (см. раздел 
«Работа со слоями» главы 8).
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Приложение Bridge
Приложение Adobe Bridge предоставляет мощную визуальную среду 
для поиска, организации и  отслеживания изображений и  других ре-
сурсов, находящихся на вашем компьютере. Выберите команду меню 
Файл → Обзор в Bridge (File → Browse in Bridge), чтобы запустить при-
ложение из программы Photoshop.

Вкладка «Избранное»

Вкладка Избранное (Favorites) пре-
доставляет быстрый доступ к часто 
используемым папкам с  изображе-
ниями. Вы можете создавать свои 
собственные папки с  избранным. 
Раздел избранного позволяет сэко-
номить много времени при навига-
ции по папкам, которые вы исполь-
зуете на регулярной основе.

1 Чтобы создать новую папку 
с избранным, перейдите 
на вкладку Избранное 
(Favorites), а затем щелкните 
мышью по значку Компью-
тер (Computer). Найдите 
папку на панели Содержи-
мое (Contents). Щелкните 
мышью по папке, чтобы ее 
выделить, а затем, нажав 
и удерживая кнопку мыши, 
перетащите папку на панель 
Избранное (Favorites).

2 Чтобы удалить папку из панели Избранное (Favorites), щелкните 
по ней правой кнопкой (Windows) или щелкните, удерживая на-
жатой клавишу � (macOS). В появившемся контекстном меню вы-
берите команду Удалить из Избранного (Remove from Favorites).

Вкладка «Папки»

Перейдите на вкладку Папки (Folders), чтобы получить возможность 
просматривать, управлять, сортировать и открывать изображения, на-
ходящиеся на вашем компьютере. Кроме того, вы можете использовать 

Приложение Adobe Bridge уста-
навливается отдельно. Запуск 
установки происходит автома-
тически при первом выборе 
команды меню Файл → Обзор 

в Bridge (File → Browse in Bridge).

Вы можете запустить прило-
жение Bridge отдельно, как 
любую другую программу, 
с помощью начального экрана 
или меню Пуск (Start) (Windows) 
или из папки Программы 

(Applications) (macOS).

Вы можете создать папку 
«Избранное» на вкладке Папки 
(Folders). Перейдите к нужной 
папке, щелкните по ней правой 
кнопкой (Windows) или щелкни-
те, удерживая нажатой клави-
шу � (macOS). В появившемся 
контекстном меню выберите 
команду Добавить в Избран-

ное (Add to Favorites).
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данную вкладку для создания новых папок, а также для переименова-
ния, перемещения, удаления и сортировки изображений.

1 В окне приложения Bridge щелкните мышью по вкладке Папки 
(Folders). В одноименной панели перейдите к конкретным пап-
кам на  своем жестком диске, используя стандартные методы 
Windows/macOS.

2 На панели Содержимое (Content) в  середине рабочего про-
странства отображаются миниатюры файлов, содержащихся 
в выбранной папке. Когда вы щелкаете по миниатюре на панели 
Содержимое (Content) на панели Просмотр (Preview) отобража-
ется более крупная версия изображения.

3 Рабочая область Основы (Essentials) является рабочей областью 
по  умолчанию. Используйте одноименный раскрывающийся 
список или щелкните мышью по одному из видимых вариантов, 
чтобы изменить расположение панелей в окне программы Bridge 
в соответствии со своими потребностями.

4 Сведения о  выбранном файле ото-
бражаются в  панелях Метадан-
ные (Metadata) и  Ключевые слова 
(Keywords). Вы также можете исполь-
зовать пункты меню каждой вкладки, 
чтобы добавить и  отредактировать 
метаданные и  ключевые слова для 
изображений. Используйте треуголь-
ники Развернуть/Свернуть (Expand/

Чтобы переместить файл, 
нажав и удерживая кнопку 
мыши на миниатюре изобра-
жения на панели Содержи-

мое (Content), перетащите 
его в другую папку на панели 
Папки (Folders) в окне програм-
мы Bridge. Чтобы скопировать 
файл в новое место, перетащите 
его в другую папку, удерживая 
нажатой клавишу Ctrl (Windows) 
или � (macOS).

Перетащите ползунковый 
регулятор Размер миниатю-

ры (Thumbnail Size) в нижней 
части окна, чтобы изменить ее 
размер на панели Содержимое 
(Content).

Три кнопки в правом нижнем 
углу окна программы Bridge 
позволяют вам контролировать 
расположение миниатюр и объ-
ем отображаемых данных на па-
нели Содержимое (Content). Вы 
можете просмотреть содержи-
мое подробно в виде миниатюр 
или списка.
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Collapse) ( ) для отображения или сокрытия информации, от-
носящейся к каждой категории.

1 Чтобы открыть файл из  области Содержимое (Content), выде-
лите миниатюру изображения, щелкнув по ней, а затем нажмите 
клавишу Enter/�. Вы также можете дважды щелкнуть по миниа-
тюре мышью. При открытии изображения в  формате Raw по-
является окно модуля Adobe Camera Raw. (См. раздел «Модуль 
Adobe Camera Raw» далее в главе).

2 Для назначения рейтинга (1–5 звезд) вы-
бранной миниатюре щелкните мышью 
по  точке под ней, чтобы преобразовать 
ее в звездочку. Для понижения рейтинга 
щелкните мышью по  звездочке, находя-
щейся слева от курсора мыши, либо сле-
ва от всех звезд, чтобы удалить рейтинг 
вообще. Кроме того, вы можете исполь-
зовать меню Метка (Label), чтобы назна-
чить рейтинг выбранному изображению.

3 Используйте панель Фильтр 
(Filter), чтобы отобразить 
миниатюры с  конкретным 
рейтингом. При необходимо-
сти щелкните мышью по тре-
угольнику Ratings (Рейтинги), а затем выберите количество звезд, 
чтобы просмотреть изображения с конкретным рейтингом.

4 Для отображения миниа-
тюр на панели Содержи-
мое (Content) согласно их 
рейтингу выберите команду 
меню Просмотр → Сорти-
ровать → Рейтинг (View →  
Sort → By Rating). Для 
этой же цели вы можете 
использовать раскрываю-
щийся список Сортировка 
по (Sort By) в верхней части 
окна.

5 Вы можете применить цветные метки к выделенным миниатю-
рам, используя меню Метка (Labels). Затем вы можете использо-
вать панель Фильтр (Filter), чтобы сортировать и фильтровать 
миниатюры, используя критерии метки.

Выберите один из пунктов 
в меню Просмотр → Сортиро-

вать (View → Sort), чтобы упоря-
дочить миниатюры на панели 
Просмотр (Preview).

Чтобы удалить файл, выделите 
его, щелкнув по соответствую-
щей миниатюре, а затем либо 
щелкните мышью по значку 
в виде мусорной корзины 
на панели инструментов, либо 
перетащите миниатюру файла 
на этот значок.

Выберите рабочую область 
Диафильм (Filmstrip), которая 
предусматривает бóльшую 
область предварительного про-
смотра, а затем выберите две 
или более миниатюры на па-
нели Содержимое (Contents), 
чтобы сравнить их в области 
предварительного просмотра.

Выберите команду меню Файл →  
Получить фотографии с ка-

меры (File → Get Photos from 
Camera) или щелкните мышью 
по одноименной кнопке ( ), 
чтобы загрузить изображения 
с подключенной камеры на свой 
компьютер в приложение Bridge.



5
1

Модуль Adobe Camera Raw
При захвате снимка в  формате Raw камера не  обрабатывает данные 
о цвете, не производит тональной корректировки и сжатия (например, 
по алгоритму JPEG), а также не устанавливает баланс белого и другие 
значения. Окно модуля Camera Raw предоставляет вам точный кон-
троль над необработанной цифровой информацией, полученной с ма-
трицы камеры.

1 Чтобы открыть файл в формате Raw из приложения Bridge, за-
пустите его. (Информацию об использовании программы Bridge 
вы можете найти ранее в разделе «Приложение Bridge» этой гла-
вы.) Дважды щелкните мышью по  миниатюре нужного файла 
в программе Bridge, чтобы открыть изображение в окне модуля 
Camera Raw.

2 Если вы работаете в  программе Photoshop, выберите команду 
меню Файл → Открыть (File → Open). Перейдите к Raw-файлу, вы-
делите его, а затем щелкните мышью по кнопке Открыть (Open).

Окно модуля Camera Raw содержит многочисленные команды для ма-
нипулирования необработанными данными изображения, захваченно-
го камерой.

3 Благодаря гистограмме в правом верхнем углу окна вы можете 
в реальном времени наблюдать за результатами изменений пара-
метров, расположенных на панели с вкладками. В начале работы 
с изображениями в формате Raw используйте элементы управле-
ния на вкладке Основные (Basic) ( ), чтобы настроить баланс 

Вы можете узнать файл необра-
ботанного снимка в приложе-
нии Bridge по расширению .CR

В диалоговом окне Открыть 
(Open) программы Photoshop 
вы можете узнать этот Raw-файл 
по значку.

Если вы дважды щелкнете 
по значку Raw-файла в окне про-
водника, то изображение также 
откроется в окне Camera Raw.

Щелкните мышью 
по кнопке Переклю-

чить в полноэкран-

ный режим (Toggle Full Screen), 
чтобы окно модуля Camera Raw 
заполнило весь экран.
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белого, тон и насыщенность. Более продвинутые настройки, рас-
положенные на остальных вкладках, позволяют вам точно кон-
тролировать значения первоначальных параметров (см. следую-
щий совет).

4 Область гистограммы предоставляет полезную информацию 
о камере и некоторых параметрах экспозиции, использованных 
при захвате изображения.

5 Панель инструментов, находящаяся в верхней части окна, содер-
жит основные инструменты для масштабирования, панорамиро-
вания, установки цветовых точек, кадрирования, выпрямления 
и вращения, которые аналогичны элементам управления в про-
грамме Photoshop. Также эта панель включает инструмент для 
удаления эффекта «красных глаз», удаления точек, корректирую-
щую кисть и градуированный фильтр.

6 Используйте элементы управления масштабом в нижнем левом 
углу окна, чтобы увеличить или уменьшить изображение. Вы 
также можете использовать любой другой стандартный метод 
масштабирования, предусмотренный в программе Photoshop.

7 В нижней части окна отображается полезная информация о цве-
товом пространстве, размере файла, битовой глубине и  разре-
шении. Для изменения любого из  этих параметров щелкните 
мышью по ссылке, чтобы открыть диалоговое окно Управление 
файлами (Workflow Options).

Сохранение Raw-файлов

1 Когда будете довольны результатом изменения параметров, мо-
жете щелкнуть по кнопке Открыть изображение (Open Image), 
чтобы открыть копию Raw-файла в программе Photoshop, если 
вы хотите продолжить над ним работу.

2 Щелкните мышью по  кнопке Сохранить 
изображение (Save Image), чтобы сохранить 
копию Raw-файла в формате JPEG, PSD, TIFF или DNG.

3 Щелкните мышью по  кнопке Готово (Done), чтобы сохранить 
текущие настройки с оригиналом Raw-файла, и закройте окно 
модуля Camera Raw.

Окно модуля Camera Raw содер-
жит следующие вкладки:

 Основные (Basic)

 Тоновая кривая (Tone 
Curve)

 Детализация (Detail)

 HSL/Градации серого (HSL/
Grayscale)

 Разбиение тонов (Split 
Toning)

 Коррекция дисторсии 
(Lens Correction)

 Эффекты (Effects)

 Калибровка камеры 
(Camera Calibration)

 Наборы (Presets)

 Снимки (Snapshots)

Значок обработанного изображе-
ния ( ) появится среди миниа-
тюр в приложении Bridge после 
изменения настроек Raw-файла.

Формат DNG (Digital Negative, 
цифровой негатив) является не-
патентованным форматом, раз-
работанным компанией Adobe, 
обеспечивающим доступность 
в будущем заархивированных 
в нем изображений.
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Градуированный фильтр
Инструмент Градуированный фильтр (Graduated Filter) отлично ил-
люстрирует возможности и гибкость формата Raw. Он позволяет про-
изводить выборочную локальную коррекцию изображения, а  также 
имитировать традиционный градуированный фильтр нейтральной 
плотности, используемый фотографами для корректировки уровня 
освещенности при съемке неба и переднего плана пейзажей.

1 В окне модуля Camera Raw щелкни-
те мышью по  значку инструмента 
Градуированный фильтр (Gradu-
ated Filter). Параметры фильтра 
отобразятся в  правой части диа-
логового окна под гистограммой, 
а  переключатель будет установлен 
в положение Создать (New).

2 Измените один из  параметров, на-
пример, Экспонир (Exposure), что-
бы выбрать тип корректировки для 
фильтра. Эта настройка применяет-
ся изначально, когда вы определяете 
область изображения, подлежащую 
коррекции, методом перетаскива-
ния, как описано в следующем шаге.

3 Выполните перетаскивание 
в  окне предварительного 
просмотра, чтобы опреде-
лить область изображения, 
которую необходимо откор-
ректировать. В  процессе пе-
ретаскивания, зеленая точка 
и пунктирная линия опреде-
ляют начало градиента, а красная точка и пунктирная линия —  
его окончание. Удерживайте нажатой клавишу Shift при перета-
скивании, чтобы ограничить направление фильтра.

4 В настройках фильтра станет активным переключатель Редакти-
ровать (Edit) . Продолжайте настраивать 
параметры с  помощью ползунковых регуляторов, пока не  до-
стигнете нужных результатов. По  окончании щелкните мышью 
по кнопке Сохранить изображение (Save Image), Открыть изо-
бражение (Open Image), Отменить (Cancel) или Готово (Done).

Инструмент Градуирован-

ный фильтр (Graduated Filter) 
применяет созданные вами 
параметры по градиенту —  
сила эффекта является наи-
большей в начале градиента, 
а в его конце эффект оказывает 
минимальное воздействие 
на изображение. Это обеспечи-
вает постепенный переход, при 
котором настроенные параме-
тры реалистично встраиваются 
в изображение.

Щелкните мышью 
по кнопке До/После 
(Before/After), чтобы 
в окне отобразились ориги-
нальная и отредактированная 
версии изображения. Про-
должайте щелкать по кнопке 
До/После (Before/After) для 
просмотра вариантов. Нажми-
те и удерживайте кнопку До/

После (Before/After), чтобы 
получить доступ к одноименно-
му подменю.

Сбросьте флажок Наложение 
(Show Overlay), чтобы просмо-
треть результаты без направ-
ляющих фильтра.
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Сохранение файлов

Основные принципы сохранения файлов с  помощью команд Сохра-
нить (Save) и Сохранить как (Save As) программы Photoshop аналогич-
ны принципам любого другого приложения в операционной системе 
macOS или Windows. По мере работы над изображением регулярно вы-
полняйте сохранение, чтобы не потерять изменения в случае системно-
го сбоя. Используйте команду Сохранить как (Save As) для первона-
чального сохранения нового файла, а также для создания копии файла, 
сохранения файла в новом месте или в другом формате.

Программа Photoshop позво-
ляет открывать и  сохранять 
изображения различных фор-
матов. Как правило, вы сохра-
няете изображение в том или 
ином формате, чтобы обеспе-
чить его соответствие опреде-
ленным параметрам вывода 
или печати, сжать изображе-
ние для экономии дискового 
пространства, либо чтобы открыть или импортировать изображение 
в приложение, которое требует определенного формата файла.

1 При первом сохранении изображения выберите команду меню 
Файл → Сохранить как (File → Save As). Выберите папку, в кото-
рой вы хотите сохранить файл. Введите имя файла. Используйте 
раскрывающийся список Тип файла (Format), чтобы выбрать 
нужный формат. Щелкните мышью по кнопке Сохранить (Save). 
Расширение файла добавится автоматически.

2 Для сохранения изменений при работе с  изображением выбе-
рите пункт Файл → Сохранить (File → Save). Ранее сохраненный 
файл будет обновлен.

Формат Photoshop

Используйте этот формат в процессе работы над вашим изображением, 
поскольку в таком случае все параметры, в частности слои, останутся 
доступными. Кроме того, при использовании данного формата про-
грамма Photoshop быстрее производит открытие и сохранение файла.

Чтобы генерировались эски-
зы, отображаемые в области 
миниатюр диалогового окна 
Открыть (Open), выберите 
в меню Редактирование (Edit)/
Photoshop команду Настрой-

ки → Обработка файлов 
(Preferences → File Handling). 
В раскрывающемся списке 
Сохранять миниатюры (Image 
Previews) выберите пункт Все-

гда (Always Save).

В области Параметры сохране-

ния файла (File Saving Options) 
диалогового окна Обработка 

файлов (File Handling) оставь-
те установленным флажок 
Сохранить в фоне (Save in 
Background), чтобы при сохра-
нении файла вам не пришлось 
дожидаться завершения про-
цесса сохранения и вы могли бы 
продолжать работу.

При сохранении изображения 
со слоями в формате Photoshop 
вы получаете возможность 
обеспечить максимальную 
совместимость. Для большей 
гибкости при использовании 
картинки в сочетании с другими 
продуктами компании Adobe 
следует выбрать данный пара-
метр, хотя это может немного 
увеличить размер файла.
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Формат TIFF
Формат TIFF (Tagged Image File Format) стал стандартным для отскани-
рованных изображений на заре эпохи настольных издательских систем. 
Он используется на платформах Mac и Windows и совместим с боль-
шинством графических редакторов и приложений для верстки страниц.

1 Чтобы сохранить изображение в формате TIFF, выберите коман-
ду меню Файл → Сохранить как (File → Save As). В открывшемся 
диалоговом окне выберите папку, в которой вы хотите сохранить 
изображение и  введи-
те имя в соответствую-
щее поле ввода. В рас-
крывающемся списке Тип файла/Сохранить как (Format/Save 
as) выберите вариант TIFF, а затем щелкните мышью по кнопке 
Сохранить (Save).

2 В открывшемся диалоговом окне Параметры TIFF (TIFF 
Options) укажите нужный вариант сжатия и другие параметры, 
а затем щелкните мышью по кнопке ОК.

Порядок пикселей

Ранние версии программы Photoshop записывали файлы в  формате 
TIFF, используя перемежающийся порядок пикселей. Вариант По  ка-
налам (Per Channel), как правило, обеспечивает лучшее сжатие. Оба 
варианта совместимы с более ранними версиями Photoshop.

Порядок байтов

Этот параметр позволяет указать, на каком компьютере будет исполь-
зоваться данный TIFF-файл —  на Mac или на PC, поскольку форматы 
TIFF для Mac и PC несколько отличаются друг от друга. Последние вер-
сии большинства приложений поддерживают оба варианта.

На компьютере Mac выберите 
команду меню Photoshop → На-

стройки → Обработка файлов 
(Photoshop → Preferences → File 
Handling) и укажите, хотите ли 
вы, чтобы при сохранении фай-
ла автоматически добавлялось 
расширение, например, .tif.

В нижней части диалогового 
окна Сохранение (Save) ото-
бражается предупреждение, 
если в изображении использу-
ются такие функции, как слои 
или альфа-каналы, которые 
не поддерживаются конкрет-
ным форматом файла. Вам будет 
предложено сохранить копию 
файла. Программа Photoshop 
автоматически добавит к имени 
файла слово «копия».
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Сжатие LZW

Алгоритм Лемпеля-Зива-Велча (Lempel-Ziv-Welch) —  формат сжатия, 
который ищет повторяющиеся элементы компьютерного кода, описы-
вающего изображение, и заменяет их более короткими последователь-
ностями. Это схема сжатия «без потерь», когда детали изображения 
не теряются. Такие приложения, как QuarkXPress и Adobe InDesign по-
зволяют импортировать файлы TIFF со сжатием LZW.

Формат Zip

Zip —  это формат сжатия без потерь, лучше всего подходящий для изо-
бражений, содержащих области, занятые сплошным цветом. Сжатие 
Zip поддерживается форматами PDF и TIFF.

Формат JPEG

Формат JPEG обеспечивает сжатие с потерями. Сжатие в формате JPEG 
лучше всего подходит для изображений типа фотографий, где при-
сутствуют вариации в уровнях освещенности. (Обратитесь к разделу 
«Сохранение файла в формате JPEG» далее в этой главе для получения 
дополнительной информации о выборе параметров качества для сжа-
тия JPEG).

Сохранение структуры изображения

Хотя программа Photoshop сама по себе не может работать с нескольки-
ми разрешениями в одном и том же файле, вы можете выбрать вариант 
Сохранить структуру (Save Image Pyramid) для сохранения различ-
ных разрешений, уже присутствующих в  фай-
ле. Некоторые приложения (например, Adobe 
InDesign) позволяют открывать такие файлы.

Сохранение прозрачности

Для изображений, которые содержат прозрачные области, вы можете 
выбрать вариант Сохранить прозрачность (Save Transparency). Про-
зрачные области сохраняются в дополнительном альфа-канале, исполь-
зуемом при открытии файла в другом приложении. Прозрачность все-
гда сохраняется при открытии файла в программе Photoshop.

Максимальный допустимый 
размер файла TIFF в программе 
Photoshop составляет 4 Гб.

Формат TIFF позволяет сохра-
нять изображения в режимах 
CMYK, RGB, Lab, Индексирован-
ные цвета (Index Color) и Града-
ции серого (Grayscale).



5
7

Сжатие слоев

Программа Photoshop может считывать информацию о  слоях файла, 
сохраненного в формате TIFF, в отличие от большинства других при-
ложений. Размер файлов, включающих несколько слоев, больше разме-
ра графических файлов с объединенными слоями. Выберите вариант 
в разделе Сжатие слоев (Layer Compression), чтобы определить, как бу-
дут сжаты данные пикселей в слоях. Вариант RLE (Run Length Encoding) 
обеспечивает сжатие без потерь. Этот вариант поддерживается многи-
ми форматами файлов Windows. Выберите вариант Удалить слои и со-
хранить копию (Discard Layers and Save a Copy), если вы не хотите со-
хранять слои в изображении.
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Формат Photoshop EPS
Формат EPS генерирует файлы, размеры которых могут в 2–4 раза пре-
вышать размеры файлов TIFF со сжатием LZW. Чтобы сохранить файл 
в формате EPS, выполните следующие действия.

Следуйте инструкциям по сохранению файла в формате TIFF, но выберите 
в раскрывающемся списке Тип файла/Сохранить как (Format/Save as) вари-
ант Photoshop EPS. Щелкните мышью по кнопке ОК. В открывшемся диало-
говом окне Параметры EPS (EPS Options) укажите свои настройки, а затем 
щелкните мышью по кнопке ОК.

Просмотр

Этот параметр определяет качество изображения с  низким разре-
шением, которое вы видите при импорте файла в такие приложения, 
как Adobe InDesign и QuarkXPress. На компьютере Mac для создания 
цветного изображения используйте вариант Macintosh (8 бит/пиксел) 
(Macintosh (8-bits/pixel)). Вариант Macintosh (JPEG) использует алго-
ритм сжатия JPEG, но поддерживается только принтерами PostScript 
Level 2 или выше. Выберите один из вариантов TIFF, если хотите ис-
пользовать изображение в операционной системе Windows.

Кодировка

С помощью раскрывающегося списка Кодировка (Encoding) вы може-
те определить, как данные изображения передаются устройству печати. 
Используйте вариант Двоичная (Binary), если хотите экспортировать 
изображение для использования в программе Adobe Illustrator. Данный 
вариант, как правило, производит файл меньшего размера. Некоторые 
приложения не распознают двоичную кодировку, в этом случае вы дол-
жны выбрать вариант ASCII. При использовании варианта JPEG дан-
ные изображения удаляются, чтобы создать файл меньшего размера.

Используя формат Photoshop 
EPS, вы можете сохранить изо-
бражение в режиме CMYK, RGB, 
Lab, Дуплекс (Duotone), Битовый 
формат (Bitmap) и Градации 
серого (Grayscale).

Если при сохранении изобра-
жения в формате Photoshop 
EPS у вас возникнут проблемы 
с печатью или сетевым подклю-
чением, попробуйте выбрать 
вариант ASCII или ASCII85.

Установите флажок Включить 

векторные данные (Include 
Vector Data), чтобы включить 
такие векторные данные, как 
формы или шрифт, присут-
ствующие в изображении.
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Сохранение файла  
в формате JPEG
JPEG  —  это формат сжатия с  потерями, широко используемый при 
подготовке изображений для Интернета, а в некоторых случаях и для 
печати. Используйте формат JPEG при работе с фотографиями, когда 
небольшие потери качества изображений менее критичны, чем время 
и объем памяти, требуемые для загрузки изображений. Формат JPEG 
не позволяет сохранить прозрачность, а размеры файлов, в зависимо-
сти от выбранной степени сжатия, могут превышать размеры изобра-
жений, экспортируемых в формат GIF.

1 Чтобы сохранить изображение в формате JPEG, выберите коман-
ду меню Файл → Сохранить как (File → Save As). Выберите папку, 
введите имя, а затем укажите вариант JPEG в раскрывающемся 
списке Тип файла/Сохранить как (Format/Save as). Щелкните 
мышью по кнопке ОК в диалоговом окне.

2 Выберите цвет в раскрывающемся списке Подложка (Matte), что-
бы имитировать прозрачность фона в изображении. Вам нужно 
знать фоновый цвет страницы, на которой будет расположено 
изображение, чтобы обеспечить соответствие цвета подложки.

3 Используйте раскрываю-
щийся список Качество 
(Quality), чтобы указать сте-
пень сжатия или перетащите 
соответствующий ползунко-
вый регулятор. Вариант Наи-
лучшее (Maximum) обес-
печивает лучшее качество, 
сохраняя большую часть 
деталей изображения и при-
меняя наименьшее сжатие. Вариант Низкое (Low) обеспечивает 
самое низкое качество изображения при максимальном сжатии.

4 В разделе Разновидность формата (Format Options) установи-
те переключатель в  положение Базовый оптимизированный 
(Baseline Optimized), чтобы оптимизировать качество цвето-
передачи изображения. Выберите вариант Прогрессивный 
(Progressive) и  введите значение в  поле Количество шагов 
(Scans), чтобы загрузить изображение в  несколько подходов 
с постепенным добавлением деталей до тех пор, пока изображе-
ние не отобразится полностью. Щелкните мышью по кнопке ОК, 
чтобы экспортировать файл.

Сохраняйте изображения 
с градиентами в формате JPEG, 
поскольку этот формат, как пра-
вило, обеспечивает меньший 
размер файла по сравнению 
с файлами GIF с адаптивной 
палитрой.

Формат JPEG лучше всего под-
ходит для сжатия изображений 
с полутонами, без резкой разни-
цы между цветами соседних 
пикселей. JPEG —  не лучший 
формат для сохранения изо-
бражений, содержащих резкие 
границы цвета.
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Создание нового файла
Когда вам требуется новый совершенно пустой холст, вы можете со-
здать новый файл.

1 Чтобы создать новый файл, выберите команду меню Файл → Со-
здать (File → New). Введите имя нового документа (или оставьте 
его без имени, чтобы сохранить позже).

2 Укажите значения ширины и  высоты или выберите категорию 
в раскрывающемся списке Набор (Preset), а затем установите кон-
кретные размеры в раскрывающемся списке Размер (Size). Если 
в  буфере обмена содержатся скопированные пиксели, то  в  рас-
крывающемся списке Набор (Preset) автоматически выбирает-
ся вариант Буфер обмена (Clipboard), а в полях ввода Ширина 
(Width) и Высота (Height) появляются соответствующие значения.

3 Укажите разрешение и  выберите цветовой режим. Вы также 
можете указать значение битовой глубины (1, 8, 16 или 32 бита 
на канал).

4 Выберите один из пунктов меню Содержимое фона (Background 
Contents), чтобы задать начальный фон холста, а затем щелкните 
мышью по кнопке ОК в диалоговом окне.

5 Чтобы изменить цвет холста после щелчка по кнопке ОК в диа-
логовом окне Новый (New), выберите основной цвет (см. раздел 
«Основной и фоновой цвета» главы 4). Далее выберите команду 
меню Редактирование → Выполнить заливку (Edit → Fill). Вы-
берите вариант Основной цвет (Foreground color) в  раскры-
вающемся списке Содержание (Use). Убедитесь в  том, что не-
прозрачность равна 100%, а в раскрывающемся списке Режим 
(Mode) выбран вариант Нормальный (Normal). Щелкните мы-
шью по кнопке ОК.

Пока диалоговое окно Новый 
(New) активно вы можете 
выбрать имя любого открыто-
го файла в раскрывающемся 
списке Набор (Preset), после 
чего параметры в диалоговом 
окне обновятся в соответ-
ствии с параметрами выбран-
ного файла.

Чтобы выбрать другой вариант 
попиксельной пропорции для 
существующего изображения, 
в меню Просмотр → Попик-

сельная пропорция (View → 
Pixel Aspect Ratio) выберите 
нужный пункт.

Программа Photoshop создает 
новый файл с квадратными 
пикселями по умолчанию. 
В разделе Дополнительно 
(Advanced) вы можете исполь-
зовать раскрывающийся список 
Попиксельная пропорция 
(Pixel Aspect Ratio), чтобы вы-
брать другой вариант:
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Создание панорам
Функция Photomerge автоматизирует процесс объединения двух или 
более изображений в панорамное изображение. Эта функция объеди-
няет исходные изображения на  основе перекрывающихся участков, 
«сшивая» их для предотвращения появления видимых швов в областях 
с разницей в уровне освещенности.

1 Откройте изображения, к которым вы хотите применить функ-
цию Photomerge. Выберите команду меню Файл → Автомати-
зация → Photomerge (File → Automate → Photomerge). В открыв-
шемся диалоговом окне Photomerge щелкните мышью по кнопке 
Добавить открытые файлы (Add Open Files), чтобы импорти-
ровать изображения, которые требуется объединить. Убедитесь 
в том, что вы выделили все изображения, подлежащие объеди-
нению. Для достижения наилучших результатов оставьте уста-
новленным флажок Наложение изображений (Blend Images 
Together), чтобы разрешить программе Photoshop совместить 
изображения на основе цвета и создать плавный переход вдоль 
границ изображений.

Вариант Перемещение 
(Reposition) позволяет про-
грамме Photoshop совместить 
и выровнять исходные изобра-
жения, но не изменяет ни одну 
их деталь. Вариант Коллаж 

(Collage) совмещает пере-
крывающиеся области и при 
необходимости производит 
масштабирование и поворот.
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2 Выберите тип 
макета. Вариант 
Авто (Auto), как 
правило, дает хо-
рошие результаты. 
Он производит 
анализ изобра-
жения и автома-
тически решает, 
какой из методов 
обеспечит наи-
лучший результат: 
Перспектива 
(Perspective), 
Цилиндр 
(Cylindrical) или 
Сферическая (Spherical).

3 После щелчка по кноп-
ке ОК программа 
Photoshop поместит 
каждый из исходных 
файлов в отдельном слое 
на новой вкладке Пано-
рама_без_названия1 
(untitled_Panorama1) 
и применит слой-маску 
для смешения изобра-
жений в областях их 
перекрытия.



4 Основы работы 
с изображением 
и цветом

В этой главе 
рассматривается 

решение таких базовых 
задач, как кадрирование 

и масштабирование, 
а также изменение 

разрешения изображения 
в соответствии 

с выходными 
требованиями. 

Определение цветов — 
 еще один важный 

аспект использования 
программы Photoshop.

Вращение изображений

Масштабирование без передискретизации

Повышение частоты дискретизации

Понижение частоты дискретизации

Кадрирование изображения

Сохранение деталей (при увеличении)

Добавление границы

Режимы изображения

Основной и фоновый цвета

Пипетка и Цветовой эталон

Палитра цветов

Цвет

Образцы
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Вращение изображений
Вы можете быстро повернуть изображение, отсканированное в непра-
вильной ориентации или, например, импортированное в  пейзажной 
ориентации с цифровой камеры.

1 Чтобы повернуть изобра-
жение с заданным шагом, 
используйте один из вари-
антов в меню Изображе-
ние → Вращение изобра-
жения (Image → Image 
Rotation). Сокращение 
по ч. с. (CW) означает «по 
часовой стрелке», а про-
тив ч. с. (CCW) —  «против часовой 
стрелки». В приведенном примере 
вы бы выбрали вариант 90° по ч. с. (90 °CW), чтобы поменять 
ориентацию изображения с пейзажной на портретную.

Иногда вам нужно выполнить поворот на несколько градусов, чтобы 
исправить исходную фотографию или немного перекошенное отскани-
рованное изображение.

2 Чтобы указать конкретное 
значение угла поворота, 
выберите команду меню 
Изображение → Вращение 
изображения → Произвольно 
(Image → Image Rotation → Arbitrary). 
Введите значение угла поворота. 
Установите переключатель в поло-
жение ° по ч. с. (CW) или ° про-
тив ч. с. (CCW), а затем щелкните 
мышью по кнопке ОК в диалого-
вом окне.

3 Возможно, вам потребуется выпол-
нить повторное кадрирование изо-
бражения. Используйте фильтры 
«Умная» резкость (Smart Sharpen) 
или Контурная резкость (Unsharp 
Mask), чтобы компенсировать сма-
зывание изображения, вызванное 
его вращением.

Выберите команду меню 
Изображение → Вращение 

изображения → Отразить 

холст по горизонтали/верти-

кали (Image → Image Rotation → 
Flip Canvas Horizontal/Vertical), 
чтобы отразить по вертикали 
или по горизонтали изображе-
ние целиком.

При произвольном вращении 
используйте направляющие  
(см. раздел «Направляющие 
и сетки» главы 2), чтобы опре-
делить необходимую степень 
вращения.
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Масштабирование  
без передискретизации
При масштабировании изображения без передискретизации вы увели-
чиваете или уменьшаете его, не изменяя общее количество пикселей. 
Высота и ширина изображения изменяются, а размер файла остается 
прежним. Имейте в виду, что разрешение увеличивается при уменьше-
нии картинки и уменьшается при увеличении.

1 Чтобы умень-
шить размер 
изображения без 
передискрети-
зации, выберите 
команду меню 
Изображение → 
Размер изобра-
жения (Image → Image Size). Убедитесь 
в том, что флажок Ресэмплинг (Resample) 
сброшен. Задайте меньшие значения в по-
лях Ширина (Width) или Высота (Height) 
или увеличьте разрешение. Остальные 
параметры обновятся авто-
матически. Размер 
файла изображения 
останется прежним, 
поскольку не было 
добавлено пикселей. 
Разрешение увеличилось 
в связи с тем, что прежнее 
количество пикселей теперь 
помещается в пределах обла-
сти меньшего размера.

2 Чтобы увеличить размер 
изображения без передискрети-
зации, введите большие значения 
в поля Ширина (Width) или 
Высота (Height) или уменьши-
те разрешение. Размер файла 
изображения остался прежним, 
но разрешение уменьшилось.

Когда вы уменьшаете изобра-
жение без передискретизации, 
уменьшается размер пикселей. 
Фактически вы увеличиваете 
разрешение изображения. 
Когда вы увеличиваете изобра-
жение без передискретизации, 
пиксели становятся больше, что 
может сделать изображение за-
зубренным. При этом разреше-
ние изображения фактически 
уменьшается.

Уменьшенное  
без передискретизации

Исходное

Увеличенное  
без передискретизации
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Повышение частоты 
дискретизации
Повышение частоты дискретизации называется интерполяцией. Ин-
терполяция используется в случаях, когда программе Photoshop требу-
ется добавить информацию (новые пиксели), отсутствующую в изобра-
жении до этого момента. Выберите вариант в раскрывающемся списке 
Ресемплинг (Resample) диалогового окна Размер изображения (Image 
Size). Вариант Сохранить детали (с  увеличением) (Preserve Details 
(enlargement)) обеспечивает наилучшие результаты, когда вам нужно 
увеличить размер или разрешение изображения, однако обработка за-
нимает больше всего времени. Вариант По соседним пикселям (Nearest 
Neighbor) является самым быстрым, но наименее точным. Вариант Би-
линейная (Bilinear) обеспечивает среднее качество. Вариант Бикубиче-
ская (с увеличением) (Bicubic Smoother (enlargement)) основан на мето-
де Бикубическая (плавные градиенты) (Bicubic (smooth gradients)), он 
предназначен для увеличения изображений и обеспечивает более сгла-
женный результат. Вариант Бикубическая (с уменьшением) (Bicubic 
Sharper (reduction)) подходит для уменьшения размера изображения 
при его подготовке к  публикации в  Ин-
тернете. Выберите вариант Автомати-
чески (Automatic), чтобы программа 
Photoshop могла выбрать наилучший ме-
тод, исходя из результатов анализа содер-
жимого изображения.

При повышении частоты дискретизации в изображение добавляются 
новые пиксели, в связи с чем увеличивается размер файла. Передискре-
тизация имеет место, когда увеличивается разрешение или значения 
ширины/высоты при установленном флажке Ресэмплинг (Resample). 
В приведенном далее примере исходный размер изображения состав-
ляет 5×5 см, а разрешение —  150 ppi.

1 Выберите команду 
меню Изображение →  
Размер изображе-
ния (Image → Image 
Size). Чтобы увели-
чить разрешение, 
сохранив исходные 
размеры, убедитесь в том, что флажок Ресемплинг (Resample) 
установлен, а значок Сохранять пропорции (Constrain Aspect 
Ratio) ( ) является активным. Введите более высокое значение 
в поле Разрешение (Resolution).

По возможности старайтесь 
избегать повышения частоты 
дискретизации, поскольку при 
этом в изображение добавля-
ются пиксели без увеличения 
качества и детализации. Ска-
нировать изображение лучше 
всего в том размере, в котором 
вы собираетесь его использо-
вать, и с разрешением, тре-
буемым устройством вывода. 
При использовании цифровой 
камеры убедитесь в том, что 
вы установили достаточно 
большое значение параметра 
качества, для обеспечения 
необходимого уровня детализа-
ции изображения.

При работе в диалоговом окне 
Размер изображения (Image 
Size) для сброса параметров 
к исходным значениям нажмите 
и удерживайте клавишу Alt/�. 
При этом кнопка Отменить 
(Cancel) заменяется кнопкой 
Сбросить (Reset). Щелкните мы-
шью по кнопке Сбросить (Reset).

Вы можете использовать 
данный прием и в других 
диалоговых окнах программы 
Photoshop.
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2 Размер файла и об-
щее количество пик-
селей увеличиваются, 
но ширина и высота 
изображения остают-
ся прежними.

Теперь ваше изображение имеет прежний размер, но содержит боль-
ше пикселей на той же площади и, следовательно, имеет более высокое 
разрешение.

3 Чтобы увеличить раз-
мер изображения, со-
хранив исходное раз-
решение, убедитесь 
в том, что флажок Ре-
семплинг (Resample) 
установлен, а  значок 
Сохранять пропорции (Constrain Aspect Ratio) ( ) является 
активным. Введите более высокое значение высоты или ширины. 
(При активном значке Сохранять пропорции (Constrain Aspect 
Ratio) второе значение обновляется автоматически.)

4 Теперь ваше изображение имеет больший размер. Размер файла 
и общее количество пикселей также увеличились, однако разре-
шение осталось прежним.

При передискретизации 
в результате интерполяции 
может произойти размытие 
изображения. Чтобы частично 
компенсировать это, вы можете 
использовать фильтры «Умная» 

резкость (Smart Sharpen) или 
Контурная резкость (Unsharp 
Mask) (см. раздел «Контурная 
резкость и Усиление резкости» 
главы 13).
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Понижение частоты 
дискретизации
Иногда для поддержания оптимального баланса между необходимым 
разрешением и размером файла вам может потребоваться понизить ча-
стоту дискретизации. Нет смысла работать над изображением со слиш-
ком высоким разрешением, если часть информации является излишней.

Понижение частоты дискретизации означает удаление пикселей. В ре-
зультате уменьшается размер файла. Понижение частоты дискретиза-
ции происходит, когда вы уменьшаете значение разрешения или шири-
ны/высоты при установленном флажке Ресемплинг (Resample).

В приведенном далее примере исходный размер изображения состав-
ляет 2×2 дюйма, а разрешение —  300 ppi.

1 Выберите 
команду меню 
Изображение → 
Размер изобра-
жения (Image →  
Image Size). Что-
бы уменьшить 
разрешение, со-
хранив исходные размеры, убедитесь в том, что флажок Ресем-
плинг (Resample) установлен, а значок Сохранять пропорции 
(Constrain Aspect Ratio) ( ) является активным. Введите более 
низкое значение в поле Разрешение (Resolution).

2 Размер файла 
и общее коли-
чество пикселей 
уменьшаются, 
а ширина и вы-
сота изображе-
ния остаются 
прежними.

Выберите команду меню Про-

смотр → Размер при печати 

(View → Print Size), чтобы увидеть 
на экране физический размер 
печатаемого изображения.

Щелкните мышью по значку Со-

хранять пропорции (Constrain 
Aspect Ratio), чтобы отключить  
( ) или включить ( ) данную 
функцию.
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Теперь ваше изображение имеет прежний размер, но содержит меньше 
пикселей на той же площади, следовательно, имеет более низкое раз-
решение.

3 Чтобы уменьшить размер изображения, сохранив исходное раз-
решение убедитесь в том, что флажок Ресемплинг (Resample) 
установлен, а значок Сохранять пропорции (Constrain Aspect 
Ratio) ( ) является активным. Введите более низкое значе-
ние высоты 
или ширины. 
(При активном 
значке Сохра-
нять пропор-
ции (Constrain 
Aspect Ratio) 
второе значение 
обновляется автоматически.)

4 Теперь ваше изображение имеет меньший 
размер. Размер файла и общее количество 
пикселей также уменьшились, но  разре-
шение осталось прежним.
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Кадрирование  
изображений
Используйте инструмент Рамка (Crop), 
чтобы определить область изображения, 
которую вы хотите использовать в качестве 
композиции. Вы можете удалить пиксели 
за  пределами этой области (и  уменьшить 
размер файла) или оставить их невидимы-
ми, чтобы позднее иметь возможность вы-
полнить повторное кадрирование.

1 Выберите инструмент Рамка (Crop). По  краям изображения 
появятся маркеры. Установите курсор на любой из них. Когда 
курсор примет вид двунаправленной стрелки, нажав и удержи-
вая кнопку мыши, перетащите его, чтобы определить область 
обрезки. При перетаскивании область обрезки автоматически 
центрируется в окне программы Photoshop. Части изображения, 
находящиеся вне рамки, затемняются, —  они будут удалены. Вы 
также можете выбрать инструмент Рамка (Crop), навести курсор 
на изображение, а затем, нажав и удерживая кнопку мыши, пере-
тащить его, чтобы определить область обрезки.

2 Чтобы изменить положение рамки, нажав и  удерживая кнопку 
мыши внутри области обрезки, перетащите мышь. Чтобы изме-
нить размер области обрезки, установите курсор на один из вось-
ми маркеров, расположенных по ее краям (указатель примет вид 
двунаправленной стрелки), затем, нажав и  удерживая кнопку 
мыши, перетащите. Чтобы повернуть рамку, установите указатель 
сразу за пределом рамки (он примет вид курсора вращения ( )), 
а затем щелкните и выполните перетаскивание по кругу.

3 Для выравнивания изображения при кадрирова-
нии выберите инструмент Выпрямить (Straighten) 
на панели параметров. Нажав и удерживая кнопку мыши, пере-
тащите ее поперек изображения, чтобы определить нужную вер-
тикальную или горизонтальную плоскость.

4 Щелкните мышью по  кнопке Выполнить кадриро-
вание (Commit) на панели параметров или нажмите 
клавишу Enter/�, чтобы обрезать изображение. Части, находя-
щиеся за  пределами рамки, будут удалены. Щелкните мышью 
по кнопке Отменить кадрирование (Cancel) или нажмите кла-
вишу Esc, если вы хотите оставить изображение в исходном со-
стоянии.

Используйте раскрывающиеся 
списки на панели параметров, 
чтобы скрыть или отобразить 
экран кадрирования. Вы также 
можете изменить цвет и степень 
прозрачности экрана.

Используйте флажок Удалить 

отсеч. пикс. (Delete Cropped 
Pixels) на панели параметров, 
чтобы указать, следует ли 
удалять пиксели, находящиеся 
за пределами области обрезки. 
Если вы хотите сохранить отсе-
ченную часть изображения, что-
бы позднее иметь возможность 
выполнить повторное кадри-
рование, выберите инструмент 
Рамка (Crop), а затем щелкните 
мышью внутри области обрез-
ки, чтобы отобразить пиксели 
исходного изображения.

При кадрировании по умол-
чанию используется правило 
третей. Оно помогает выполнить 
кадрирование в соответствии 
с нужными пропорциями. Вы мо-
жете выбрать другой вариант пе-
рекрытия или вообще отключить 
его, используя раскрывающееся 
списки на панели параметров.
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Сохранение деталей  
(при увеличении)
При передискретизации, когда вы сохраняете размер изображения, 
увеличивая разрешение, или увеличиваете размер изображения, со-
храняя разрешение, программе Photoshop приходится добавлять пик-
сели, которые отсутствовали в  изображении изначально. При этом 
приложение Photoshop использует сложные компьютерные алгоритмы, 
чтобы задать цветовые значения добавляемых пикселей. Метод «ин-
терполяции» Сохранение деталей (при увеличении) (Preserve Details 
Enlargement) лучше всего подходит, когда вы хотите увеличить изобра-
жение и/или увеличить его разрешение.

1 Для увеличения размера изображения с сохранением разреше-
ния, выберите команду меню Изображение → Размер изобра-
жения (Image → Image Size). Убедитесь в том, что в открывшемся 
диалоговом окне установлен флажок Ресемплинг (Resample). 
Выберите вариант Сохранение деталей (при увеличении) 
(Preserve Details (enlargement)) в одноименном раскрывающемся 
списке. Введите более высокое значение ширины или высоты.

2 Используйте ползунковый регулятор 
Уменьшить шум (Reduce Noise) или вве-
дите конкретное значение в поле ввода.

3 Чтобы сохранить размер изображе-
ния, но увеличить разрешение, убе-
дитесь в том, что флажок Ресемплинг 
(Resample) установ-
лен, а затем введи-
те новое значение 
в поле Разрешение 
(Resolution).

Оригинал: 10×15 см, 
разрешение 300ppi. 
Изображение на стра-
нице увеличено на 40%.

Шум —  это появление класте-
ров нежелательных и визуально 
не вписывающихся пикселей, 
добавляющих в изображение 
ненужные детали. Используйте 
ползунковый регулятор Умень-

шить шум (Reduce Noise) для 
устранения шума, который мо-
жет появиться в изображении 
при изменении частоты дискре-
тизации. Будьте осторожны при 
использовании этого ползун-
кового регулятора, поскольку 
чрезмерное уменьшение шума 
может привести к нежелатель-
ной потере деталей в некото-
рых областях изображения.

Уменьшение 
шума 0%

Уменьшение 
шума 12%

Уменьшение 
шума 100%

Детализация ори-
гинала увеличена 
до 17×25 см, раз-
решение 300ppi. 
Изображение 
на странице увели-
чено на 40%.
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Добавление границы
Границы полезны, когда вам нужно дополнительное пространство 
по краям изображения.

1 Выберите 
команду меню 
Изображе-
ние → Размер 
холста (Image → 
Canvas Size). 
Используйте 
раскрываю-
щийся список 
для выбора 
единиц изме-
рения. Введите 
более высокие значения ширины  
и/или высоты.

2 Чтобы указать, где относительно изображения должна быть 
добавлена граница, щелкните мышью по одному из квадратов 
в  группе Расположение (Anchor). Это позволяет указать отно-
сительное расположение изображения и границы. Квадрат ( ) 
соответствует положению изображения, а остальные квадраты —  
положению границы.

3 Выберите цвет в  раскрывающемся списке Цвет расширения 
холста (Canvas extension color), чтобы указать цвет границы. 
Щелкните мышью по кнопке ОК в диалоговом окне, чтобы до-
бавить границу. Это приведет к увеличению размера файла, по-
скольку в изображение будут добавлены пиксели.

Установите флажок Относи-

тельная (Relative), а затем 
введите положительное или 
отрицательное число, чтобы 
указать, насколько вы хотите 
увеличить или уменьшить раз-
мер холста.
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Режимы изображения
Режимы изображения являются основополагающим аспектом при ра-
боте в программе Photoshop. Когда вы открываете изображение, режим 
отображается в заголовке окна изображения. Приложение Photoshop 
предусматривает восемь различных режимов изображения. Исполь-
зуйте режим, соответствующий вашим рабочим нуждам. Затем при не-
обходимости измените режим в зависимости от требований устройства 
вывода или печати.

RGB

Обычно изображения сканируются или захватываются в режиме RGB. 
Когда вы начинаете работу с цветным изображением, как правило, луч-
ше работать в режиме RGB, поскольку он быстрее, чем режим CMYK, 
и позволяет использовать все команды и функции Photoshop, обеспе-
чивая максимальную гибкость.

Недостатком при работе в режиме RGB, если вы планируете печатать 
свое изображение в типографии, является то, что количество цветов 
гаммы RGB превышает количество цветов, которые можно напечатать. 
Некоторые из самых ярких цветов могут потерять свою насыщенность 
при преобразовании изображения в режим CMYK.

CMYK

После окончания редактирования изображения, если вы собираетесь 
печатать его в типографии, преобразуйте его в режим CMYK.

Чтобы поместить цветное изображение в  приложение предпечатной 
подготовки, где будет произведено цветоделение, вам нужно изменить 
режим RGB на  CMYK. При преобразовании режима RGB в  CMYK, 
программа Photoshop заменяет цвета RGB-изображения, отсутствую-
щие в цветовой гамме CMYK, их ближайшей печатаемой версией. (Для 
получения подробной информации о предупреждениях, касающихся 
гаммы, обратитесь к разделу «Палитра цветов» далее в этой главе.)

Вы также можете выбрать пункт меню Просмотр → Предупреждение 
при выходе за  пределы цветового охвата (View → Gamut Warning) 
(Ctrl/�+Shift+Y), чтобы выделить (серым цветом) пиксели изображе-
ния, цвет которых отсутствует в гамме.

Чтобы сохранить гибкость, 
характерную для режима RGB, 
и при этом видеть на экране 
изображение в режиме CMYK, 
убедитесь, что в меню Про-

смотр → Варианты цветопро-

бы (View → Proof Setup) выбран 
вариант Формы CMYK (Working 
CMYK), а затем выберите коман-
ду меню Просмотр → Цвето-

проба (View → Proof Colors). 
Строка заголовка изображения 
изменится, чтобы показать, что 
вы работаете с RGB-изображе-
нием, но просматриваете его 
в режиме CMYK.



4
. 

О
с

н
о

в
ы

 р
а

б
о

т
ы

 с
 и

з
о

б
р

а
ж

е
н

и
е

м
 и

 ц
в

е
т

о
м

7
4

Индексированные цвета

Режим Индексированные цвета (Indexed Color) уменьшает количество 
цветов в изображении до 256 или меньше. Он часто используется для 
мультимедиа и веб-изображений.

Дуплекс

Дуплекс —  это популярный эффект, который используется для добав-
ления глубины тона изображениям в  градациях серого путем его пе-
чати краской черного и другого цвета. При сохранении изображения 
в режиме Дуплекс (Duotone) используйте формат EPS или PDF, чтобы 
обеспечить корректное цветоделение в приложениях для верстки.

Градации серого

При отсутствии необходимости 
в цветной печати вы можете 
конвертировать изображение 
в режим Градации серого 
(Grayscale), чтобы ускорить 
работу и уменьшить размер 
файла.

Lab

Режим Lab использует модель CIE Lab, которая предусматривает один 
канал для свечения, канал «а», представляющий цвета от синего до жел-
того, и канал «b» для цветов от пурпурного до зеленого. Существенным 
преимуществом этого режима является то, что его гамма включает цве-
та, входящие в пространство CMYK и RGB.

Битовый формат

Режим Битовый формат (Bitmap) создает 1-битное изображение, со-
стоящее из черных и белых пикселей.

Перед преобразованием изо-
бражения в битовый формат 
или дуплекс вам необходимо 
изменить его режим на Града-

ции серого (Grayscale).

Для большей свободы твор-
чества при преобразовании 
изображения в градации 
серого выберите команду 
меню Изображение → Коррек-

ция → Черно-белое (Image → 
Adjustments → Black & White). 
(Более подробную информацию 
вы можете найти в разделе 
«Черно-белое» главы 12.)
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Многоканальный режим

Режим Многоканальный (Multichannel) использует 256 уровней серого 
в каждом канале. При преобразовании RGB- или CMYK-изображений 
в  многоканальный режим, их оригинальные каналы превращаются 
в  каналы смешанных цветов. Многоканальный режим является про-
двинутой функцией, используйте его только в том случае, если полно-
стью разбираетесь в процессе печати.

Для изменения режима выбе-
рите нужную команду в  меню 
Изображение → Режим (Image → 
Mode). В  зависимости от  того, 
с  какого и  на  какой режим вы 
переходите, вы можете получить 
предупреждение о последствиях 
преобразования с просьбой под-
твердить выполнение действия.
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Основной  
и фоновый цвета
Основной цвет применяется, когда вы создаете текстовую надпись или 
используете инструменты Заливка (Paint Bucket), Линия (Line), Каран-
даш (Pencil) и Кисть (Brush).

Фоновый цвет появляется, когда вы удаляете или перемещаете выде-
ленную область на фоновом слое или применяете к нему инструмент 
Ластик (Eraser).

Переключить основной и фоновый цвета также можно с помощью со-
ответствующих элементов управления, кроме того, с их помощью вы 
можете быстро восстановить цвета по умолчанию (черный и белый).

Вы можете изменить основной и фоновый цвета, используя инструмент 
Пипетка (Eyedropper), диалоговое окно Палитра цветов (Color Picker), 
панель Цвет (Color) и панель Образцы (Swatches).

1 Чтобы поменять местами основной и фоновый цвета, щелкните 
мышью по значку Переключение цветов переднего и заднего 
плана (Switch Colors).

2 Чтобы восстановить цвета по умолчанию (черный 
и  белый), щелкните мышью по  значку Цвет пе-
реднего и  заднего плана по  умолчанию (Default 
Colors).

Нажмите клавишу X, чтобы 
поменять местами основной 
и фоновый цвета. Нажмите 
клавишу D, чтобы восстановить 
основной и фоновый цвета 
по умолчанию.
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Пипетка  
и Цветовой эталон

Пипетка

Инструмент Пипетка (Eyedropper) 
обеспечивает быстрый и  удобный 
способ выбора основного и фонового 
цвета из области изображения, с кото-
рым вы работаете, или из другого не-
активного окна программы Photoshop.

1 Чтобы задать основной цвет, выберите инструмент 
Пипетка (Eyedropper). Установите курсор на  изо-
бражение и щелкните кнопкой мыши. Теперь инди-
катор Выбор основного цвета (Set foreground color) 
отражает цвет области, по которой вы щелкнули.

2 Чтобы задать фоновый цвет, удерживая нажатой клавишу Alt/�, 
щелкните мышью по изображению. Цвет области, по которой вы 
щелкнули, теперь отображается на индикаторе Выбор фонового 
цвета (Set background color).

3 Чтобы выбрать размер об-
разца, используйте раскры-
вающийся список Размер 
образца (Sample Size) на  панели параме-
тров. При выборе варианта Точка (Point 
Sample) считывается точное значение пик-
селя, по которому вы щелкаете. При выбо-
ре других вариантов берется среднее значение цвета пикселей, 
составляющих область, по которой вы щелкнули.

Используйте раскрывающий-
ся список Образец (Sample) 
на панели параметров, чтобы 
указать, к каким слоям будет 
применяться инструмент Пи-

петка (Eyedropper).
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Цветовой эталон

Используйте инструмент Цветовой эталон 
(Color Sampler) (совместно с панелью Инфо 
(Info)), чтобы установить до 10 точек выбор-
ки, к  которым вы можете обратиться при 
корректировке цветовых значений. Каждый 
раз, щелкая по  изображению при выбран-
ном инструменте Цветовой эталон (Color 
Sampler), вы устанавливаете мар-
кер цвета. Каждый маркер создает 
дополнительный раздел на  панели 
Инфо (Info). Чтобы удалить маркер 
цвета, перетащите его из  окна изо-
бражения с  помощью инструмента 
Цветовой эталон (Color Sampler).

При выбранном инструмен-
те Цветовой эталон (Color 
Sampler) вы можете щелкнуть 
по кнопке Удалить все (Clear 
All) на панели параметров, что-
бы быстро удалить все маркеры 
цвета из изображения.

Чтобы скрыть или отобразить 
маркеры цвета, выберите пункт 
Цветовые эталоны (Color 
Samplers) в меню панели Инфо 
(Info).
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Палитра цветов
Использование диалогового окна Палитра цветов (Color Picker) —  это 
мощный и гибкий способ выбора основного и фонового оттенков. Для 
создания цвета вы можете использовать различные цветовые модели.

1 Чтобы выбрать цвет с  по-
мощью диалогового окна 
Палитра цветов (Color 
Picker), щелкните мышью 
по  индикатору основного 
или фонового цвета. Введи-
те значения в поля ввода C, 
M, Y и  K. Новый цвет ото-
бразится над цветовым индикатором Текущий (Current).

2 Щелкните мышью по кнопке ОК в диалоговом окне. Указанный 
вами цвет станет основным или фоновым в зависимости от ин-
дикатора, выбранного в шаге 1.

Вы также можете выбирать цвета, используя ползунковый регулятор 
и поле для выбора цвета. В следующем примере используются значения 
тона, насыщенности и яркости. Используйте те же методы для моделей 
RGB и Lab.

1 Чтобы выбрать цвет, 
используя значения тона, 
насыщенности и яркости 
(HSB), сначала установи-
те переключатель в поло-
жение H, соответствую-
щий тону.

2 Щелкните мышью по цветовой панели или перетащите ползун-
ковый регулятор, чтобы выбрать тон или цвет. Это позволяет 
указать одно из трех значений HSB. Значение в поле ввода тона —  
H —  представляет выбранный вами оттенок.

3 Затем щелкните мышью по  цветовому полю, чтобы задать две 
оставшиеся переменные —  насыщенность и яркость в полях S и B, 
соответственно. Щелчок в левой части поля уменьшает насыщен-
ность выбранного оттенка, а щелчок в правой части —  увеличи-
вает ее. Щелчок в основании поля уменьшает яркость выбранного 
тона, а щелчок в верхней части поля  увеличивает ее.

4 Если вы установите переключатель в положение S, ползунковый 
регулятор позволит указать степень насыщенности (от 0 до 100), 

Нажмите клавишу Tab для 
перемещения по полям ввода 
в диалоговом окне.

При выборе цвета, который 
не может быть напечатан 
с помощью красок CMYK, рядом 
с индикатором с новым цветом 
появится значок предупрежде-
ния в виде треугольника. Щелк-
ните мышью по этому значку, 
чтобы выбрать ближайшую 
печатаемую версию цвета.

Небольшой индикатор цвета 
под значком предупреждения 
содержит ближайшую допусти-
мую к печати версию цвета.
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а цветовое поле позволит задать тон и яркость. Когда вы устанав-
ливаете переключатель в положение B, ползунковый регулятор 
позволяет настроить яркость, а цветовое поле —  тон и насыщен-
ность.

Выбор пользовательских цветов

Вы можете получить доступ к ряду таких систем подбора цвета, как 
PANTONE, Toyo Color Finder и Focoltone Color System, с помощью диа-
логового окна Библиотеки цветов (Color Libraries).

1 В диалоговом окне Палитра цветов (Color Picker) щелкните 
мышью по кнопке Библиотеки цветов (Color Libraries). Исполь-
зуйте раскрывающийся список Библиотека (Book) для выбора 
системы подбора цвета.

2 Если вы знаете номер нуж-
ных чернил, то можете ввести 
значение с клавиатуры. Кроме 
того, вы можете использовать 
ползунковый регулятор справа 
от образцов цвета чернил. 
Этот регулятор предоставляет 
вам доступ к полному диа-
пазону цветов. Используйте 
элементы управления про-
круткой в верхней и нижней 
части ползункового регулятора, 
чтобы найти 
нужный цвет. 
Выберите его, 
а затем щелк-
ните мышью 
по кнопке ОК.

Чтобы создать веб-безопасные 
цвета, установите флажок Только 

Web-цвета (Only Web Colors). Веб-
палитра состоит из 216 цветов.

Если при сброшенном флажке 
Только Web-цвета (Only Web 
Colors) вы создаете цвет, отсут-
ствующий в веб-палитре, то вы 
увидите предупреждение. Щелк-
ните мышью по значку предупре-
ждения, чтобы перейти к ближай-
шему веб-безопасной цвету.

В диалоговом окне Библиотеки 

цветов (Color Libraries) щелкни-
те мышью по кнопке Палитра 
(Picker), чтобы вернуться в диа-
логовое окно Палитра цветов 
(Color Picker).
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Цвет
Для создания новых цветов вы также можете использовать панель Цвет 
(Color) (команда меню Окно → Цвет (Window → Color)).

1 Определите, какой из  индикаторов цвета является 
активным. Существуют два индикатора  —  для ос-
новного и для фонового цвета. Активный индикатор 
обведен черной рамкой.

2 Если активным является нужный индикатор, перейдите к шагу 3, 
или щелкните мышью по неактивному индикатору, чтобы сде-
лать его активным, если это необходимо.

3 Перетащите ползунковый 
регулятор справа от  панели 
( ), чтобы выбрать цвето-
вой диапазон. Затем щелк-
ните мышью по  цветовому 
кубу или перетащите целе-
вой круг, чтобы настроить 
яркость и насыщенность.

4 Используйте кнопку меню ( ) 
в правом верхнем углу панели, что-
бы изменить элементы управления 
цветовой моделью.

5 При необходимости установите 
указатель мыши на нижний, левый 
или правый край панели, а  затем 
перетащите, чтобы изменить ее 
размер.

Щелкните мышью по активно-
му индикатору цвета, чтобы 
открыть диалоговое окно Пали-

тра цветов (Color Picker).

Выберите пункт Модель RGB 
(RGB Sliders) в меню панели, 
если хотите, чтобы панель Цвет 

(Color) выглядела, как в пре-
дыдущих версиях программы 
Photoshop.

В шаге 3, если вы создаете цвет, 
отсутствующий в цветовом 
пространстве CMYK, появится 
значок предупреждения в виде 
треугольника. Вы можете щелк-
нуть по нему, чтобы выбрать 
ближайший CMYK-эквивалент, 
который отобразится в поле 
рядом с предупреждением.
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Образцы
Вы можете использовать панель Образцы (Swatches) (команда меню 
Окно → Образцы (Window → Swatches)) для выбора основного и фоно-
вого цвета, а также для создания пользовательских цветовых палитр, 
которые вы можете сохранить, а затем загрузить в другое изображение. 
Панель Образцы (Swatches) также является одной из панелей по умол-
чанию основной рабочей среды.

1 Чтобы выбрать основной цвет из па-
нели Образцы (Swatches), щелкните 
мышью по  образцу цвета. Чтобы 
выбрать фоновый цвет, щелкните 
мышью по  образцу цвета, удержи-
вая нажатой клавишу Ctrl/�.

Вы можете настроить панель Образцы (Swatches), добавляя и удаляя 
из нее цвета.

2 Чтобы добавить образец 
цвета, выберите основной 
цвет. Установите курсор 
на пустое пространство 
панели Образцы (Swatches). 
(Он примет вид ведерка с крас-
кой.) Щелкните кнопкой мыши. 
Введите название нового образца, 
а затем щелкните по кнопке ОК, 
чтобы добавить текущий основ-
ной цвет на панель Образцы 
(Swatches).

3 Чтобы удалить образец цвета, щелк-
ните мышью по нему, удерживая на-
жатой клавишу Alt/� (macOS) или 
Alt (Windows).

4 Используйте меню панели Образ-
цы (Swatches) ( ), чтобы восстано-
вить настройки по умолчанию или 
выбрать другую цветовую палитру 
из списка.

Дополнительную информацию 
о загрузке и сохранении поль-
зовательских настроек панели 
вы можете найти в разделе «Со-
хранение и загрузка пользова-
тельских настроек» главы 2.

В верхнем ряду панели Образ-

цы (Swatches) отображаются 
16 образцов цвета, которые 
использовались последними. 
Выберите команду меню По-

казать недавние цвета (Show 
Recent Colors), чтобы скрыть или 
отобразить этот ряд.

Щелкните правой кнопкой 
мыши или щелкните мышью, 
удерживая нажатой клавишу �,  
по образцу цвета на панели 
Образцы (Swatches), чтобы 
получить доступ к контекстному 
меню.



5 Инструменты 
рисования

Инструменты для 
рисования, в общем 

случае, применяют цвет 
к пикселям изображения. 

Инструменты 
рисования также могут 

использоваться для 
редактирования масок. 
Панель Наборы кистей 
(Brush Preset) и панель 

Кисть (Brush), а также 
элементы управления, 
доступные на панели 

параметров, позволяют 
вам контролировать 
все аспекты процесса 

рисования.

Выбор набора кистей

Панель Кисть

Параметры пользовательской кисти

Параметры формы отпечатка кисти

Наборы кистей

Микс-кисть

Карандаш

Градиент

Заливка

Режимы наложения

Создание растрированных фигур
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Для получения информации 
о режимах наложения обрати-
тесь к разделу «Режимы наложе-
ния» далее в этой главе.

Выбор набора кистей
Инструмент выбора кистей на панели параметров предоставляет бы-
стрый и удобный доступ к стандартным кистям.

1 Чтобы выбрать кисть, щелк-
ните мышью по инструмен-
ту Кисть (Brush), а  затем 
щелкните мышью по  тре-
угольнику панели Выбор 
набора кистей (Brush Preset 
Picker) на  панели параме-
тров.

2 Выберите нужную кисть. 
Миниатюра отображает 
форму отпечатка кисти. 
Число под миниатюрой 
соответствует диаметру 
кисти в пикселях.

3 Для изменения размера кисти перетащите ползунковый регуля-
тор Размер (Size), чтобы увеличить/уменьшить ее диаметр или 
введите конкретное значение в пикселях в соответствующее поле 
ввода. Щелкните мышью по  кнопке Восстановить исходный 
размер (Restore to original size) ( ), чтобы вернуться к исходно-
му размеру кисти после его изменения (эта возможность доступ-
на только для кисти, созданной из выборки пикселей).

4 Укажите значения параметров Режим (Mode), Непрозрачность 
(Opacity) и Нажим (Flow) на панели параметров или включите 
эффект аэрографа.

5 Установите курсор на окно изображения, а затем, нажав и удер-
живая кнопку мыши, перетащите, чтобы рисовать основным 
цветом, используя текущие характеристики кисти и настройки, 
заданные на панели параметров.

Непрозрачность

Параметр Непрозрачность (Opacity) (инструмента Кисть (Brush), Ка-
рандаш (Pencil), Архивная кисть (History Brush), Архивная художе-
ственная кисть (Art History Brush), Gradient (Градиент), Заливка (Paint 

Установите указатель мыши 
на миниатюру кисти на панели 
Выбор набора кистей (Brush 
Preset Picker), чтобы увидеть опи-
сание выбранного инструмента.

Для круглых кистей исполь-
зуйте ползунковый регулятор 
Жесткость (Hardness), чтобы 
увеличить/уменьшить пара-
метр жесткости краев кисти 
(для получения дополнитель-
ной информации о параметре 
жесткости обратитесь к разделу 
«Параметры формы отпечатка 
кисти» далее в этой главе).
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Bucket), Штамп (Clone Stamp) и Узорный штамп (Pattern Stamp)) опре-
деляет степень покрытия пикселей основным цветом при перетаскива-
нии по ним указателя мыши.

Убедитесь в  том, что для параметра Непрозрачность (Opacity) зада-
но значение 100%, если вы хотите полностью покрыть пиксели. При 
этом эффект кисти с мягкими краями достигается за счет частичного 
покрытия пикселей по краям мазка. Уменьшение значения параметра 
Непрозрачность (Opacity) обеспечивает полупрозрачное частичное 
покрытие.

  100%

  60%

  20%

Нажим

Параметр Нажим (Flow) определяет скорость нанесения краски при 
движении кисти по изображению.

  100%

  60%

  20%

Аэрограф

Щелкните мышью по кнопке Включить эффект аэрографа (Airbrush 
build-up), чтобы имитировать эффект распыления краски. Данный эф-
фект лучше всего работает с мягкими кистями и малыми значениями 
параметров Непрозрачность (Opacity) и Нажим (Flow).

  Мягкая кисть 90 пикселей
  Непрозрачность: 80%
  Нажим: 40%

Не забудьте выбрать нужный 
основной цвет перед исполь-
зованием инструмента для 
рисования.

(Windows) Удерживая нажатыми 
клавишу Alt и кнопку мыши, пе-
ретащите ее влево, чтобы умень-
шить, и вправо, чтобы увеличить 
размер курсора кисти. 

(macOS) Удерживая нажатыми 
сочетание клавиш �+� и кноп-
ку мыши, перетащите влево или 
вправо. Используйте описан-
ный выше метод, но перетащите 
вниз, чтобы уменьшить степень 
непрозрачности, или вверх, 
чтобы увеличить ее.

Нажатая кнопка Включить 

эффект аэрографа (Airbrush 
build-up) на панели параметров 
имеет темный фон.
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Панель Кисть
Панель Кисть (Brush) обеспечивает доступ к разнообразным параме-
трам, позволяющим контролировать вид и характеристики мазков. Вы 
можете изменить параметры кистей или создать собственные кисти, 
используя различные настройки.

1 Чтобы создать 
пользователь-
скую кисть, 
выберите 
инструмент 
для рисова-
ния. Выберите 
команду меню 
Окно → Кисть 
(Window → 
Brush) (или 
нажмите клави-
шу F5), чтобы 
отобразить со-
ответствующую 
панель, если это 
необходимо.

2 Щелкните мышью по предустановке кисти в списке в правой ча-
сти панели. Параметры, которые вы задаете в левой части панели, 
остаются выделенными, когда вы выбираете другую кисть.

3 Чтобы настроить параметры выбранной кисти, добавив свои 
собственные настройки, установите флажки ( ) слева от назва-
ний характеристик кисти. Область предварительного просмотра 
в нижней части панели обновится, чтобы показать, какое влия-
ние оказывает на кисть изменение параметров. (В данном при-
мере выбрана мягкая кисть с диаметром 21 пиксель, к которой 
применены такие эффекты, как Рассеивание (Scattering), Сгла-
живание (Smoothing), Накладка (Build Up) и  Влажные края 
(Wet Edges)).

4 Перетащите ползунковый регулятор Кегль (Size), чтобы изме-
нить диаметр кисти, или введите значение в  пикселях в  поле 
ввода.

Если панель Кисть (Brush) ото-
бражается серым цветом, это 
говорит о том, что вы не выбра-
ли соответствующий инстру-
мент для редактирования или 
рисования.

Если вы используете чувстви-
тельный к нажатию графи-
ческий планшет, вы можете 
щелкнуть по кнопкам Всегда 

использовать нажим для 

определения непрозрачности 
(Always use Pressure for Opacity) 
( ) и Всегда использовать 

нажим для определения 

размера (Always use Pressure for 
Size) ( ) на панели параме-
тров, чтобы переопределить 
значения непрозрачности 
и размера на панели Кисть 
(Brush).

Вы также можете использо-
вать панель Кисть (Brush) для 
настройки параметров кисти 
инструмента редактирования 
(см. главу 6).
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5 При необходимости скорректируйте такие параметры формы, 
как Угол (Angle), Форма (Roundness), Жесткость (Hardness) 
и Интервалы (Spacing) (для получения дополнительной инфор-
мации обратитесь к разделу «Параметры формы отпечатка ки-
сти» далее в главе).

6 Щелкните мышью по на-
званию характеристики 
(справа от флажка), чтобы 
получить доступ к соот-
ветствующим элементам 
управления. (Для полу-
чения информации о со-
здании пользовательских 
кистей обратитесь к раз-
делу «Параметры пользо-
вательской кисти» далее 
в главе). Щелкните мышью 
по названию характеристи-
ки Форма отпечатка кисти 
(Brush Tip Shape), чтобы 
в правой части панели сно-
ва отобразилась панель выбора кисти.

7 Задайте значения Режим (Mode), Непрозрачность (Opacity) 
и Нажим (Flow) на панели параметров.

8 Если вы выберете другую кисть, для нее сохранятся пользо-
вательские параметры предыдущей. Создайте предустановку 
инструмента, если хотите оставить 
текущие настройки (для получения 
информации о создании пользова-
тельских кистей обратитесь к разделу 
«Наборы кистей» далее в главе).

9 Установите указатель мыши в  окно 
изображения, а  затем, нажав и  удер-
живая кнопку мыши, перетащите, что-
бы создать нужный штрих.

Активация кнопки Включить 

эффекты аэрографа (Airbrush 
build-up) на панели параметров 
эквивалентна установке флажка 
Накладка (Build-up) в списке эф-
фектов на панели Кисть (Brush).

Используйте панель Выбор 

набора кистей (Brush Presets 
Picker) на панели параметров 
(см. раздел «Выбор набора 
кистей» ранее в главе), когда 
вам нужно быстро выбрать 
кисть из существующего набо-
ра. Выберите предустановку 
на панели Кисть (Brush), а затем 
настройте ее в соответствии 
со своими потребностями.
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Параметры  
пользовательской кисти
Предустановленные кисти можно настроить, используя элементы 
управления в  левой части панели Кисть (Brush), а  также элементы 
управления для настройки формы отпечатка кисти. Первые семь эф-
фектов (разделенные полосами) предусматривают элементы управле-
ния, которые позволяют настроить каждый эффект. Последние пять 
параметров не предусматривают возможности изменения.

1 Для создания 
такого поль-
зовательского 
эффекта, как Ди-
намика формы 
(Shape Dynamics), 
щелкните мышью 
по соответ-
ствующей строке, 
но не по флаж-
ку. Элементы 
управления для 
настройки эф-
фекта отобразят-
ся в правой части 
диалогового окна.

2 Поэксперименти-
руйте с доступ-
ными настрой-
ками. Изменения отобразятся в области предварительного 
просмотра в нижней части панели.

Динамика формы

Параметр Динамика формы (Shape Dynamics) определяет то, как из-
меняется след от  кисти при перетаскивании указателя мыши в  окне 
изображения.

Рассеивание

Параметр Рассеивание (Scattering) позволяет указать, как варьируется 
положение следа от кисти, а также количество следов в штрихе.

Чтобы понять, что в программе 
Photoshop подразумевается 
под понятием «след от кисти», 
выберите на панели Кисть 

(Brush) простую предустанов-
ленную кисть, щелкните мышью 
по пункту Форма отпечатка 

кисти (Brush Tip Shape), а затем 
перетащите вправо ползун-
ковый регулятор Интервалы 
(Spacing).

В области предварительно-
го просмотра показано, как 
отдельные следы от кисти 
образуют штрих при перетаски-
вании указателя мыши по окну 
изображения.

Для нанесения прямых штри-
хов выберите инструмент для 
рисования, установите курсор 
в точку начала штриха, а затем, 
удерживая нажатой клавишу 
Shift, щелкните мышью в точке 
окончания штриха.
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Текстура

Используйте настройку Текстура (Texture) для ассоциации кисти с узо-
ром, чтобы создать видимость штрихов на холсте.

Двойная кисть

Эффект Двойная кисть (Dual Brush) предусматривает использование 
двух отпечатков кисти для создания штриха. Настройте параметры для 
первого отпечатка, используя настройки в разделе Форма отпечатка 
кисти (Brush Tip Shape). Настройте параметры для второго отпечатка 
в разделе Двойная кисть (Dual Brush).

Динамика цвета

Параметр Динамика цвета (Color Dynamics) определяет, как изменя-
ется цвет штриха.

Передача

Элементы управления в  разделе Передача (Transfer) определяют сте-
пень изменения скорости нанесения краски, а  также степень непро-
зрачности штриха.

Положение кисти

Используйте параметр Положение кисти (Brush Pose), чтобы задать 
угол наклона, поворота и нажима кисти.

Шум

Параметр Шум (Noise) оказывает самое очевидное влияние на  края 
штриха при использовании мягких кистей, создавая случайное рассеи-
вание пикселей.

Влажные края

Параметр Влажные края (Wet Edges) создает штрих с темными краями 
и  просвечивающей серединой, имитируя неравномерное распределе-
ние акварельной краски.
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Накладка

Эффект Накладка (Build-up), примененный к мягкой кисти со средней 
или низкой степенью непрозрачности, имитирует эффект распыления 
краски с помощью аэрографа.

Сглаживание

Параметр Сглаживание (Smoothing) позволяет создать плавные изги-
бы штрихов.

Защита текстуры

Выберите параметр Защита текстуры (Protect Texture), чтобы обеспе-
чить соответствие эффектов текстуры при использовании различных 
текстурированных отпечатков кистей. Данный параметр применяет 
один и тот же узор и масштаб ко всем кистям с текстурой.
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Параметры формы  
отпечатка кисти
Раздел Форма отпечатка кисти (Brush Tip Shape) панели Кисть (Brush) 
предусматривает дополнительные элементы управления для настройки 
вида штриха.

Чтобы создать поль-
зовательскую форму 
отпечатка кисти, 
сначала выберите 
кисть в списке На-
боры кистей (Brush 
Presets). Убедитесь 
в том, что выбран 
раздел Форма отпе-
чатка кисти (Brush 
Tip Shape). Задайте 
значения параметров 
Размер (Size), Жест-
кость (Hardness), 
Отразить (Flip), 
Интервалы (Spacing), 
Угол (Angle) и Форма 
(Roundness).

Размер

Введите в поле Размер (Size) значение в пикселях (от 1 до 5000), чтобы 
указать диаметр кисти.

Жесткость

Значение 100% параметра Жесткость (Hardness) создает штрих с жест-
кими краями. Меньшие значения обеспечивают имитацию мягкой ки-
сти. Чем ниже данное значение, тем мягче края кисти. Даже при значе-
нии 100% край штриха является сглаженным.

Щетинные кисти предусматри-
вают свой собственный набор 
параметров отпечатка на па-
нели Кисть (Brush). Поэкспе-
риментируйте с настройками 
качества щетины, чтобы создать 
разнообразные и интересные 
мазки. Параметр Твердость 
(Stiffness) полезен, если вы ис-
пользуете для рисования мышь.

Чтобы узнать, как сохранить 
пользовательские настройки 
отпечатка кисти для использо-
вания в будущем, обратитесь 
к разделу «Наборы кистей» 
далее в главе.
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Интервалы

Значение параметра Интервалы (Spacing) измеряется в  процентах 
от размера кисти. Для стандартных круглых кистей значением по умол-
чанию является 25%. Более высокие значения начинают производить 
прерывистые штрихи.

Угол и форма

Используйте элементы управ-
ления Угол (Angle) и  Форма 
(Roundness) совместно для со-
здания штриха, который утол-
щается и  становится тоньше 
подобно штриху, нарисованному каллиграфическим пером. Вы можете 
ввести значения в поля ввода или перетащить треугольный маркер для 
изменения угла, кроме того, вы можете перетащить квадратные марке-
ры на индикаторе, чтобы изменить диаметр.

Установите флажки Отразить X 
(Flip X) или Отразить Y (Flip 
Y), чтобы отразить след кисти 
по вертикали или горизонтали 
для изменения направления 
эффекта.
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Наборы кистей
Сохраните набор кистей, если вы создали пользовательские настройки, 
которые хотите использовать повторно.

1 Для создания набора 
кистей выберите ин-
струмент Кисть (Brush), 
а затем используйте 
панель Кисть (Brush) для 
создания пользователь-
ских настроек.

2 В меню панели Кисть 
(Brush) ( ) выберите 
пункт Новый набор 
параметров кисти (New 
Brush Preset).

3 В диалоговом 
окне Имя 
кисти (Brush 
Name) введите 
имя. Щелкните 
мышью по кнопке ОК. Но-
вый набор кистей появится 
на панели Наборы кистей 
(Brush Presets) и на пане-
ли Выбор набора кистей 
(Brush Presets Picker).

Наборы кистей позволяют 
сохранить пользовательские 
настройки кисти, чтобы иметь 
возможность легко и быстро 
воспользоваться ими в будущем.
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Вы можете щелкнуть по кноп-
ке Включение/выключение 

панели кистей (Toggle Brush 
Panel) на панели параметров, 
чтобы отобразить/скрыть па-
нель Кисть (Brush).

Микс-кисть
Инструмент Микс-кисть (Mixer Brush) позволяет смешивать цвета 
на кисти с цветами в изображении при перетаскивании по нему, чтобы 
создавать реалистичные живописные эффекты. Благодаря инструменту 
Микс-кисть (Mixer Brush) вы можете использовать смешанные цвета 
и изменять динамику эффекта, в том числе влажность и смешивание, 
для обеспечения интересных и разнообразных результатов.

1 Выберите инструмент Микс-кисть (Mixer Brush) в  группе ин-
струментов Кисть (Brush).

2 Выберите кисть на панели Выбор набора кистей (Brush Presets 
Picker) на  панели параметров или на  панели Наборы кистей 
(Brush Presets). С инструментом Микс-кисть (Mixer Brush) хоро-
шо работают щетинные кисти.

3 При необходимости отредакти-
руйте параметры качества щети-
ны на  панели Кисть (Brush) (об-
ратитесь к  разделу «Параметры 
пользовательской кисти» данной 
главы, чтобы получить дополни-
тельную информацию о создании 
пользовательских кистей).

4 Чтобы задать чистый цвет в поле 
Текущая заполненность кисти 
(Current Brush Load), выберите 
основной цвет (см. раздел «Ос-
новной и  фоновый цвета» главы 
4 для получения информации 
о выборе основного цвета). Чтобы 
заполнить кисть смешанным цве-
том, установите указатель мыши 
на  изображение, а  затем, удержи-
вая нажатой клавишу Alt/�, щелкните, чтобы 
выбрать цвет вокруг точки, по которой вы щелк-
нули.

5 Используйте переключатели Заполнять кисть после каждого 
штриха (Load brush after each stroke) и  Чистить кисть после 
каждого штриха (Clean brush after each stroke) для обеспечения 

Выберите пункт Заполнить 

только чистые цвета (Load 
Solid Colors only) в раскрываю-
щемся списке Текущая запол-

ненность кисти (Current Brush 
Load), если вы хотите заполнить 
соответствующее поле чистым 
цветом, выполнив щелчок 
по изображению, удерживая 
нажатой клавишу Alt/�.
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большего контроля над поведением кисти. 
Оставьте кнопку Заполнять кисть (Load 
brush) нажатой, чтобы заполнить кисть цве-
том, выбранным в поле Текущая заполненность кисти (Current 
Brush Load), после нанесения штриха. При отключении этой 
кнопки кисть перестанет заполняться цветом,  —  при перета-
скивании по изображению кисть будет смешивать только цвета 
существующих пикселей. Оставьте кнопку Чистить кисть (Clean 
brush) нажатой, чтобы цвета из предыдущего штриха не добав-
лялись к цветам для следующего штриха. Отключите ее, если вам 
нужно, чтобы цвета из предыдущего штриха оставались на ки-
сти и использовались при нанесении следующего штриха.

6 Задайте значения параметров Влажность (Wet), Заполненность 
(Load), Смешение (Mix) и Нажим (Flow).

7 Перетащите мышь, чтобы нанести штрихи на изображение.

Влажность

Параметр Влажность (Wet) опре-
деляет влажность пикселей, уже 
присутствующих в изображении, 
а не влажность кисти. Этот параметр 
контролирует количество краски, 
собираемой с холста.

Заполненность

Параметр Заполненность (Load) кон-
тролирует количество краски на кисти. 
Более высокие значения позволяют 
наносить более длинные штрихи. При 
низких значениях краска заканчивается 
быстрее.

Щелкните мышью по кнопке 
Переключение динамиче-

ского просмотра кончика 

кисти (Toggle Live Brush Tip 
Preview) ( ) в нижней части 
панели Наборы кистей (Brush 
Presets), чтобы отобразить/
скрыть область предваритель-
ного просмотра кисти в левом 
верхнем углу окна программы 
Photoshop.

Влажность: 80%

Влажность: 5%

Заполненность: 90%

Заполненность: 5%

В раскрывающемся списке 
Полезные комбинации микс-

кисти (Presets) содержатся 
разнообразные параметры, 
которые можно использовать 
в качестве отправной точки при 
экспериментах с инструментом 
Микс-кисть (Mixer Brush).
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Смешение

Параметр Смешение (Mix) определяет 
количество краски, взятой из поля Те-
кущая заполненность кисти (Current 
Brush Load), по сравнению с коли-
чеством краски, собранной с холста. 
Низкие значения данного параметра 
обеспечивают применение большего 
количества цвета из поля Текущая 
заполненность кисти (Current Brush 
Load).

Нажим

Параметр Нажим (Flow) регулирует скорость расхода краски при пере-
таскивании кисти по изображению.

Смешение: 90%

Смешение: 5%
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Карандаш
Вы можете использовать инструмент Карандаш (Pencil) для рисования 
произвольных линий. Линии, нарисованные с  помощью данного ин-
струмента, всегда имеют резкие края. Другими словами, края ваших ли-
ний не сглажены. При использовании инструмента Карандаш (Pencil) 
применяется основной цвет.

1 Чтобы нарисовать линию, сначала 
выберите инструмент Карандаш 
(Pencil). Настройте размер кисти 
с помощью панели Выбор набора 
кистей (Brush Preset Picker) (см. 
раздел «Выбор набора кистей» 
данной главы). Или используйте 
панель Кисть (Brush), чтобы со-
здать пользовательскую кисть для 
инструмента (см. раздел «Кисть» 
данной главы).

2 Используйте панель параметров, чтобы указать режим наложения 
в раскрывающемся списке Режим (Mode) и задать значения для па-
раметров Непрозрачность (Opacity) и Автостирание (Auto Erase).

3 Нажав и удерживая кнопку 
мыши, перетащите, что-
бы создать произвольный 
штрих с помощью каран-
даша. Перетащите мышь, 
удерживая нажатой кла-
вишу Shift, чтобы ограни-
чить направление штриха 
вертикальной или горизонтальной осью.

4 Чтобы создать прямой штрих между двумя точками, щелкни-
те, переместите указатель мыши в новое положение (не следует 
щелкать и перетаскивать), а затем, нажав и удерживая клавишу 
Shift, щелкните еще раз.

Автостирание

Установите флажок Автостирание (Auto Erase), чтобы использовать 
инструмент Карандаш (Pencil) для закрашивания или стирания запол-
ненных основным цветом областей, используя фоновый цвет.

Удерживая нажатой кнопку 
мыши и клавишу Shift, перета-
щите мышь, чтобы ограничить 
направление штриха вертикаль-
ной или горизонтальной осью. 
Снова щелкните по кнопке ин-
струмента для рисования, если 
вы хотите создать еще один 
штрих, используя данный метод.
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Градиент
Вы можете использовать инструмент Градиент (Gradient) для создания 
переходов от одного цвета к другому. Вы также можете создавать раз-
ноцветные градиенты. Существуют Линейный (Linear), Радиальный 
(Radial), Конусовидный (Angle), Зеркальный (Reflected) и Ромбовид-
ный (Diamond) градиенты. Вы можете применить градиентную заливку 
к выделенной области или ко всему активному слою.

1 Для создания градиентной заливки выберите инструмент Гради-
ент (Gradient). Выберите тип градиента на панели параметров.

2 Выберите режим наложения 
в раскрывающемся списке 
Режим (Mode) и задайте 
значение параметра Непро-
зрачность (Opacity). Ис-
пользуйте раскрывающийся 
список, чтобы выбрать один 
из предустановленных градиентов.

3 Установите курсор в  точку начала градиента, а  затем, нажав 
и удерживая кнопку мыши, перетащите его. Угол и расстояние, 
на которое вы перемещаете указатель мыши, определяют угол 
и длину линейного градиента или радиус радиального градиен-
та. (Для создания Радиального (Radial), Конусовидного (Angle), 
Зеркального (Reflected) и Ромбовидного (Diamond) градиента, 
нажав и удерживая кнопку мыши, перетащите ее из центра об-
ласти, подлежащей заливке.)

4 При создании простых градиентов вы можете оставить уста-
новленными флажки Прозрачность (Transparency) и Дизеринг 
(Dither). Установите флажок Инверсия (Reverse), чтобы обра-
тить порядок цветов в градиенте.

      Линейный         Радиальный    Конусовидный    Зеркальный     Ромбовидный

По умолчанию для создания 
градиента используются теку-
щие основной и фоновый цвета.

Удерживайте нажатой клави-
шу Shift при перетаскивании, 
чтобы ограничить шаг прираще-
ния угла линейного градиента 
значением 45°.

В случае с линейным гради-
ентом начальный и конечный 
цвета заполняют любую часть 
выделения или слоя, поперек 
которой вы не перетаскиваете 
указатель мыши. В случае с ра-
диальным градиентом конеч-
ный цвет заполняет оставшуюся 
область.
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Заливка
Вы можете использовать инструмент Заливка (Paint Bucket) для запол-
нения пикселей основным цветом, основываясь на значении параметра 
Допуск (Tolerance). Этот параметр работает подобно инструменту Вол-
шебная палочка (Magic Wand), однако в данном случае заполняются 
соседние пиксели, которые находятся в области, ограниченной параме-
тром допуска. Вы можете применить инструмент Заливка (Paint Bucket) 
к выделенной области или ко всему слою.

1 Чтобы заполнить область основным цветом, выберите инструмент 
Заливка (Paint Bucket). На панели параметров в раскрывающемся 
списке Определение источника для заливки (Fill) оставьте вы-
бранным вариант Основной цвет (Foreground). Введите значение 
от 0 до 255 в поле Допуск (Tolerance). Чем выше значение вы устано-
вите, тем больший диапазон цветов заполнит данный инструмент.

2 Настройте параметры 
Непрозрачность (Opacity), 
Режим наложения (Blending 
Mode), Сглаживание 
(Anti-aliased) и Все слои 
(All Layers). Установите 
курсор в нужное место, 
а затем щелкните мышью 
по изображению.

3 Вы можете использовать инстру-
мент Заливка (Paint Bucket), чтобы 
заполнить область узором, ранее со-
храненным в библиотеке шаблонов. 
Используйте раскрывающийся спи-
сок Определение источника для за-
ливки (Fill), чтобы выбрать вариант 
Узор (Pattern), а  затем используйте 
раскрывающуюся панель для выбо-
ра нужного шаблона.

4 Сбросьте флажок Смежные пиксели (Contiguous), чтобы ин-
струмент Заливка (Paint Bucket) мог заполнить цветом пиксели 
в  любом месте изображения, при условии, что они попадают 
в область, ограниченную параметром допуска.

Установка флажка Сглажи-

вание (Anti-aliased) создает 
немного мягкие края у тех 
областей, которые заполняются 
инструментом Заливка (Paint 
Bucket).

Вы не можете применить ин-
струмент Заливка (Paint Bucket) 
к изображениям в режиме 
Битовый формат (Bitmap).

Щелкните мышью по кнопке 
меню ( ) на панели узоров, 
чтобы получить доступ к раз-
личным шаблонам.
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Режимы наложения
Для каждого инструмента рисования выберите режим наложения в со-
ответствующем раскрывающемся списке на  панели параметров. Раз-
личные режимы рисования в  комбинации с  параметрами непрозрач-
ности/нажима предоставляют выборочный контроль того, на  какие 
пиксели оказывает влияние тот или иной инструмент рисования или 
редактирования. Результатом является скорее смешение цвета краски 
с цветом базовых пикселей, чем простая замена одного цвета другим.

Затухание
Режим Затухание (Dissolve) производит зернистый 
«меловой» эффект. При перетаскивании окрашивают-
ся не все пиксели, благодаря чему в штрихе образуют-
ся пробелы и дыры. Настройте данный эффект с помо-
щью параметра Непрозрачность (Opacity).

Очистить
Режим Очистить (Clear) делает пиксели прозрачными. 
Этот режим становится доступным только для слоя 
с  отключенной функцией Сохранить прозрачность 
пикселей (Lock Transparency). Данный режим досту-
пен для инструментов Кисть (Brush), Заливка (Paint 
Bucket), Карандаш (Pencil) и Линия (Line).

На заднем плане
Режим На заднем плане (Behind) доступен только, когда вы работае-
те над слоем с  прозрачным фоном. Убедитесь в  том, что для рабоче-
го слоя сброшен флажок Сохранить прозрачность пикселей (Lock 
Transparency). Используйте режим На  заднем плане (Behind), чтобы 
рисовать за  существующими на  слое пикселями. Краска наносится 
на прозрачные области, но не влияет на существующие пиксели.

Затемнение
Режим Затемнение (Darken) применяет цвет краски 
к пикселям, цвет которых светлее цвета краски. Дан-
ный режим не затрагивает пиксели, чей цвет темнее 
цвета краски.

Режимы наложения позволяют 
вам изменять изображение, 
используя инструменты для 
рисования и редактирования 
более избирательным и тонким 
образом, по сравнению с обыч-
ным нанесением основного 
цвета. Цвет, которым вы рисуете 
(цвет наложения), смешивается 
с цветом пикселей, по которым 
вы перетаскиваете указатель 
мыши (базовый цвет), в резуль-
тате чего, в зависимости от вы-
бранного режима наложения, 
получается другой цвет.
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Умножение
Режим Умножение (Multiply) комбинирует цвет крас-
ки с цветом пикселей, по которым вы перетаскиваете, 
что создает более темный, по сравнению с оригиналь-
ным, цвет.

Затемнение основы
Режим Затемнение основы (Color Burn) затемняет ос-
новной цвет за счет увеличения контрастности базо-
вых пикселей в зависимости от цвета наложения. Эф-
фект бывает более выраженным при использовании 
краски темного цвета. Использование белого цвета 
не производит никакого эффекта.

Линейный затемнитель
Режим Линейный затемнитель (Linear Burn) затем-
няет основной цвет, уменьшая яркость в зависимости 
от  используемого режима наложения. Смешивание 
с белым цветом не производит никакого эффекта.

Замена светлым
Режим Замена светлым (Lighten) заменяет пиксели, 
цвет которых темнее цвета краски, но не затрагивает 
более светлые пиксели.

Осветление
Режим Осветление (Screen) производит эффект об-
ратный режиму Умножение (Multiply). Данный ре-
жим смешивает противоположный оригиналу цвет 
с основным цветом, обеспечивая осветление пикселей.

Осветление основы
Режим Осветление основы (Color Dodge) делает базо-
вый цвет ярче, уменьшая контраст. Более выраженный 
эффект достигается при использовании светлой крас-
ки. Смешивание с  черным цветом не  дает никакого 
эффекта.

Для сравнения обратитесь 
к представленному ниже исход-
ному изображению. В этом изо-
бражении используется режим 
Нормальный (Normal).
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Линейный осветлитель
Режим Линейный осветлитель (Linear Dodge) повы-
шает яркость базового цвета за счет увеличения ярко-
сти в зависимости от смешиваемого цвета. Смешива-
ние с черным цветом не имеет никакого эффекта.

Перекрытие
Режим Перекрытие (Overlay) увеличивает контраст-
ность и  насыщенность, комбинируя основной цвет 
с цветом пикселей, по которым вы перетаскиваете ука-
затель мыши. Света и тени в базовом цвете сохраняются.

Мягкий свет
Режим Мягкий свет (Soft Light) создает эффект мяг-
кого освещения. Осветляет, если цвет краски светлее, 
чем 50% серого, затемняет, если цвет краски темнее, 
чем 50% серого.

Жесткий свет
Режим Жесткий свет (Hard Light) умножает (затемня-
ет) или экранирует (осветляет) пиксели в зависимости 
от цвета краски, а также увеличивает контраст.

Яркий свет
Режим Яркий свет (Vivid Light) затемняет или освет-
ляет цвет базовых пикселей, увеличивая или уменьшая 
контрастность в зависимости от цвета.

Линейный свет
Режим Линейный свет (Linear Light) затемняет или 
осветляет цвет базовых пикселей, увеличивая или 
уменьшая яркость в зависимости от цвета наложения.

Точечный свет
Режим Точечный свет (Pin Light) заменяет пиксели ос-
новного цвета в зависимости от того, светлее или тем-
нее цвет наложения по сравнению с 50% серого.

Режимы наложения также 
доступны на панели Слои 
(Layers) и в диалоговых окнах 
Выполнить заливку конту-

ра (Fill Path), Заполнить (Fill), 
Выполнить обводку (Stroke) 
и Ослабить (Fade).



1
0

3

Разница
Режим Разница (Difference) анализирует яркость пик-
селей и цвет краски, а затем вычитает значение ярко-
сти краски из значения яркости пикселей. В зависимо-
сти от результата данный режим инвертирует пиксели.

Исключение
Результат работы режима Исключение (Exclusion) ана-
логичен результату от  применения режима Разница 
(Difference), но отличается пониженным контрастом.

Цветовой тон
В цветных изображениях режим Цветовой тон (Hue) 
применяет оттенок (цвет) краски, не затрагивая насы-
щенность или свечение базовых пикселей.

Насыщенность
Режим Насыщенность (Saturation) изменяет насыщен-
ность пикселей, основываясь на насыщенности цвета 
наложения, но не влияет на цветовой тон или светлоту.

Свечение
Режим Свечение (Luminosity) изменяет относительное 
свечение пикселей, не затрагивая их оттенка или насы-
щенности.

Цветность
Режим Цветность (Color) применяет оттенок и насы-
щенность цвета наложения, не влияя на свечение ба-
зовых пикселей.

Режимы Светлее (Lighter Color) 
и Темнее (Darker Color) не со-
здают третьего «смешанного» 
цвета путем комбинирования 
основного и базового цветов. 
После сравнения суммы зна-
чений во всех каналах режим 
Светлее (Lighter Color) ото-
бражает самый светлый цвет, 
а режим Темнее (Darker Color) 
отображает самый темный цвет.
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Создание  
растрированных фигур
Растрированная фигура состоит из пикселей. Она не основана на век-
торном контуре и не может быть изменена так же, как слой-фигура.

1 Чтобы создать растрированную фигуру, выберите слой или со-
здайте новый. Выберите основной цвет для фигуры.

2 Выберите один из инструмен-
тов Прямоугольник (Rectangle), 
Прямоугольник с закругленны-
ми углами (Rounded Rectangle), 
Эллипс (Ellipse), Линия (Line), Многоугольник (Polygon) или 
Произвольная фигура (Custom Shape).

3 Выберите вариант Пиксели (Pixels) в  раскры-
вающемся списке Режим инструмента выбора 
(Pick tool mode) на панели параметров.

4 Установите курсор 
в окно изображения. 
Нажав и удерживая 
кнопку мыши, перета-
щите ее по диагонали, 
чтобы определить 
размер фигуры, кото-
рая появится в окне. Это 
не приведет автоматиче-
ски к созданию нового 
слоя. Растрирование 
фигуры эквивалентно 
созданию выделения и за-
полнению его цветом.

5 Для каждого из инструмен-
тов фигур вы можете задать 
пользовательские настройки. 
Щелкните мышью по значку 
в виде шестеренки с треуголь-
ником, чтобы отобразить 
панель, содержащую специфические для каждого инструмента 
параметры.

Вы не можете создать растриро-
ванную форму на слое-фигуре 
или текстовом слое.

Чтобы создать произвольную 
фигуру, выберите инструмент 
Произвольная фигура (Custom 
Shape), а затем щелкните мы-
шью по треугольнику на панели 
параметров, чтобы получить до-
ступ к библиотеке фигур. Щелк-
ните по фигуре, чтобы выбрать 
ее, а затем, нажав и удерживая 
кнопку мыши в окне изображе-
ния, перетащите мышь, чтобы 
задать размер фигуры.



6 Инструменты 
редактирования

Инструменты 
редактирования, 

описанные 
здесь, позволяют 

различными способами 
редактировать или 

изменять пиксели. 
Эти инструменты 

могут применяться 
к выделенной области 

или к любой части 
изображения. Многие 

из упомянутых 
методов и комбинаций 

клавиш относятся 
как к инструментам 

для рисования, так 
и к инструментам для 

редактирования.

Размытие, Резкость и Палец

Штамп

Осветлитель, Затемнитель и Губка

Ластик

Волшебный ластик

Фоновый ластик

Восстанавливающая кисть

Точечная восстанавливающая кисть

Заплатка

Замена цвета

Перемещение с учетом содержимого
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Размытие,  
Резкость и Палец

Размытие и Резкость

Инструменты Размытие (Blur) и Резкость (Sharpen) позволяют изменять 
«фокус» изображения. Инструмент Размытие (Blur) уменьшает контраст 
между пикселями и может быть полезен для маскировки нежелательных, 
неровных краев, а  также для смягчения границ между фигурами. Ин-
струмент Резкость (Sharpen) увеличивает контраст между пикселями.

Чтобы размыть или сделать более резкими области изображения, вы-
берите соответствующий инструмент. На панели параметров задайте 
значения параметров Режим (Blend mode), Интенсивность (Strength) 
и Образец со всех слоев (Use All Layers), а затем, нажав и удерживая 
на изображении кнопку мыши, перетащите, чтобы размыть пиксели 
или увеличить их резкость. Отпустите кнопку, а  затем снова, нажав 
и удерживая ее, перетащите курсор по пикселям, чтобы усилить эффект. 
Вы можете добиться грубого, зернистого эффекта, если злоупотребите 
инструментом Резкость (Sharpen). Используйте низкое значение пара-
метра Интенсивность (Strength) и  наращивайте эффект постепенно, 
выполняя последовательное перетаскивание по изображению.

Палец

Используйте инструмент Палец (Smudge) для создания эффекта пере-
таскивания пальца по сырой краске. Инструмент Палец (Smudge) со-
бирает краску в точке, в которой вы начинаете перетаскивать, а затем 
смешивает ее с соседними цветами.

1 Выберите инструмент Палец 
(Smudge). Задайте значение пара-
метра Интенсивность (Strength), 
установите указатель мыши 
на изображение, а затем выполни-
те перетаскивание, чтобы раз-
мазать цвета. Чем больше значе-
ние параметра Интенсивность 
(Strength), тем более выраженным 
будет эффект.

Не забудьте установить необ-
ходимый размер кисти, прежде 
чем использовать инструменты 
Размытие (Blur) и Резкость 
(Sharpen).

В документе с несколькими 
слоями установите флажок Об-

разец со всех слоев (Sample All 
Layers) на панели параметров, 
если вы хотите размыть, уве-
личить резкость или размазать 
пиксели более чем на одном 
слое.
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2 Установите флажок Рисование 
пальцем (Finger Painting), что-
бы начать смазывать, используя 
текущий основной цвет. Уста-
новите флажок Образец со всех 
слоев (Use All Layers), чтобы 
смазать цвета из других слоев 
изображения на слой, с которым вы работаете. Оставьте этот 
флажок сброшенным, если вы хотите, чтобы инструмент Палец 
(Smudge) собирал краску только с пикселей активного слоя.

Каждый инструмент редактиро-
вания сохраняет свои параме-
тры при переключении на дру-
гие инструменты в группе.
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Штамп
Вы можете использовать инструмент Штамп (Clone Stamp) для рету-
ширования изображения путем клонирования или дублирования обла-
стей пикселей. Это очень полезно, когда вам необходимо удалить пятна, 
царапины и другие нежелательные детали.

1 Чтобы клонировать область изображения, выберите инструмент 
Штамп (Clone Stamp). Задайте нужный размер кисти, используя 
панель Выбор набора кистей (Brush Preset Picker) на панели па-
раметров. Убедитесь в том, что флажок Выравнивание (Aligned) 
установлен.

2 Удерживая нажатой клавишу Alt/�, щелк-
ните мышью в той части изображения, кото-
рую хотите клонировать, чтобы определить 
нужную область пикселей.

3 Отпустите клавишу Alt/�. Переместите 
курсор в другую часть изображения, а за-
тем, нажав и удерживая кнопку мыши, пе-
ретащите его. Пиксели в области, по ко-
торой вы перетаскиваете курсор, будут 
заменены пикселями, взятыми из  того 
места, где вы щелкнули в  первый раз. 
Перекрестие в точке первичного щелчка 
указывает на  клонированные пиксели, 
то есть на их источник.

Клон —  С выравниванием

При установленном флажке Выравнивание (Aligned) расстояние от ис-
точника (обозначен перекрестием) до  курсора инструмента Штамп 
(Clone Stamp) остается неизменным. Когда вы отпускаете кнопку мыши, 
перемещаете указатель, а затем продолжаете использовать инструмент 
Штамп (Clone Stamp), положение курсора относительно источни-
ка остается прежним, однако теперь вы будете клонировать пиксели 
из другой части изображения.

Используйте клавиши [и] для 
уменьшения и увеличения раз-
мера кисти инструмента редак-
тирования в процессе работы.

После того как вы совершите 
щелчок, удерживая нажатой 
клавишу Alt/�, курсор инстру-
мента Штамп (Clone Stamp) 
отобразит пиксели, захвачен-
ные в качестве образца.
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Клон —  Без выравнивания

При снятом флажке Выравнивание (Aligned) источник (точка первич-
ного щелчка) остается прежним. Если вы прекратите перетаскивать 
курсор инструмента Штамп (Clone Stamp), перейдете к другой части 
изображения, а затем начнете перетаскивание снова, клонируемые пик-
сели по-прежнему будут браться из исходной точки.

В раскрывающемся списке Об-

разец (Sample) выберите, какие 
слои вы хотите использовать 
в качестве образца. Щелкните 
мышью по кнопке Пропускать 

корректирующие слои (Ignore 
Adjustment Layers), чтобы ис-
ключить корректирующие слои 
из образца.



6
. 

И
н

с
т

р
у

м
е

н
т

ы
 р

е
д

а
к

т
и

р
о

в
а

н
и

я
1

1
0

Осветлитель,  
Затемнитель и Губка
Инструменты Осветлитель (Dodge), Затемнитель (Burn) и  Губка 
(Sponge) иногда называются «тонирующими». Принцип работы ин-
струментов Осветлитель (Dodge) и  Затемнитель (Burn) основан 
на традиционных фототехниках уменьшения количества света, попа-
дающего на конкретную область снимка (экспозиции), для его освет-
ления (Осветлитель (Dodge)) или увеличения экспозиции для затемне-
ния областей снимка (Затемнитель (Burn)).

Осветлитель и Затемнитель

Используйте инструмент Осветлитель (Dodge) для осветления пиксе-
лей вашего изображения, а инструмент Затемнитель (Burn) —  для их 
затемнения.

1 Для осветления или затемнения области изображения выберите 
соответствующий инструмент. Не забудьте задать подходящий 
размер кисти. Мягкие кисти, как правило, обеспечивают самый 
сглаженный результат.

2 В раскрывающемся списке Диапазон (Range) на панели параме-
тров выберите вариант Средние тона (Midtones), Тени (Shadows) 
или Подсветка (Highlights), чтобы затронуть изменениями соот-
ветственно области средних тонов, темные или светлые области. 
Кроме того, вам следует задать значение параметра Экспониро-
вание (Exposure), чтобы контролировать интенсивность инстру-
мента.

3 Нажав и удерживая кнопку мыши на изображении, перетащите 
ее, чтобы осветлить/затемнить пиксели. Отпустите кнопку и вы-
полните повторное перетаскивание по тем же пикселям для уси-
ления эффекта.

Хорошей идеей является ис-
пользование низкого значения 
экспозиции при осветлении или 
затемнении области изображе-
ния, поскольку это позволяет 
наращивать эффект постепенно.

Не сбрасывайте флажок Защи-

тить тона (Protected Tones), что-
бы минимизировать отсечение 
теней и светов.
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Губка

Вы можете использовать инструмент Губка (Sponge), чтобы немного 
увеличить или уменьшить насыщенность цвета в отдельных областях 
изображения.

Для увеличения/уменьшения насыщенно-
сти выберите инструмент Губка (Sponge). 
Не  забудьте выбрать нужный размер ки-
сти. Выберите в раскрывающемся списке 
Режим (Menu) вариант Повысить насыщенность (Saturate) или Снизить 
насыщенность (Desaturate). Нажав и удерживая кнопку мыши на изо-
бражении, перетащите мышь, чтобы изменить степень насыщенности.

Каждый инструмент тонирова-
ния сохраняет свои параметры 
при переключении на другой 
инструмент той же группы.
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Ластик
Используйте инструмент Ластик (Eraser), чтобы стереть часть вашего 
изображения. Ластик стирает цвет фона при работе с фоновым слоем. 
Он стирает до прозрачности, когда вы работаете на любом другом слое, 
при условии, что на панели Слои (Layers) не нажата кнопка Сохранить 
прозрачность пикселей (Lock Transparency) ( ).

1 Для удаления области изображения выберите инструмент Ла-
стик (Eraser), чтобы отобразить его настройки на  панели па-
раметров. Укажите размер кисти, настройте параметры Режим 
(Mode), Непрозрачность (Opacity), Нажим (Flow), Включить 
эффекты аэрографа (Airbrush build-up) и Восстановить исто-
рию (Erase to History).

2 Нажав и удерживая кнопку мыши, перетащите курсор по изо-
бражению, чтобы стереть до фонового цвета или прозрачности 
в зависимости от активного слоя.

Непрозрачность

Используйте параметр Непрозрачность (Opacity), чтобы обеспечить 
эффект частичного стирания пикселей в изображении.

Режимы

Используйте раскрывающийся список Ре-
жим (Mode) для выбора режима стирания. 
По  умолчанию в  данном раскрывающемся 
списке выбран вариант Кисть (Brush). Вари-
ант Блок (Block) полезен, когда вам необходи-
мо стереть часть изображения вдоль прямых краев, при этом ластик 
имеет форму квадрата фиксированного размера.

Восстановление истории

Установите флажок Восстановить историю (Erase to History), чтобы 
вернуть пиксели в состояние, соответствующее определенному состоя-
нию на панели История (History). Щелкните мышью по столбцу Архив-
ная кисть (History Brush) на панели История (History), чтобы указать 
состояние, к которому должны будут вернуться пиксели при активации 
функции Восстановить историю (Erase to History).

Используйте параметр Размер 
(Size) на панели Выбор набора 

кистей (Brush Presets Picker), 
чтобы указать размер ластика 
при использовании инстру-
мента в режиме Кисть (Brush) 
и Карандаш (Pencil).

Удерживайте нажатой клавишу 
Alt/� при выбранном инстру-
менте Ластик (Eraser), чтобы 
обеспечить временный доступ 
к параметру Восстановить ис-

торию (Erase to History). Нажав 
и удерживая кнопку мыши, пере-
тащите курсор по измененным 
областям изображения, чтобы 
вернуть их в состояние, выбран-
ное на панели История (History).
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Волшебный ластик
Используйте инструмент Волшебный ластик (Magic Eraser), чтобы сте-
реть пиксели на слое до прозрачности. Данный инструмент работает 
лучше всего, когда вам необходимо удалить фоновые пиксели вокруг 
объекта с  четкими краями. Инструмент Волшебный ластик (Magic 
Eraser) удаляет пиксели, основываясь на значении параметра Допуск 
(Tolerance) подобно инструменту Волшебная палочка (Magic Wand) 
(см. раздел «Волшебная палочка» главы 7).

1 Чтобы использовать инструмент Волшебный ластик (Magic Eraser), 
сначала выберите слой, с которым вы хотите работать. Выберите ин-
струмент Волшебный ластик (Magic Eraser), чтобы отобразить его 
настройки на панели параметров. Введите значение в поле Допуск 
(Tolerance). Задайте низкое значение данного параметра, чтобы сте-
реть пиксели, цвет которых близок к цвету пикселя, по которому 
вы щелкнули изначально. Задайте высокое значение в поле Допуск 
(Tolerance) для выбора более широкого диапазона пикселей.

2 Задайте значение 100% для параметра Непрозрачность (Opacity), 
чтобы стереть пиксели полностью. Установите более низкое 
значение непрозрачности для обеспечения эффекта частичной 
прозрачности. Установите флажок Сглаживание (Anti-aliased), 
чтобы создать более гладкий край при стирании пикселей  
(см. раздел «Параметры инструментов выделения» главы 7).

3 Установите флажок Смежные пиксе-
ли (Contiguous), чтобы стереть только 
те пиксели, которые попадают в область, 
ограниченную значением параметра 
Допуск (Tolerance), и  являются смеж-
ными. Эта функция позволяет стереть 
непрерывные области пикселей (рис. А). 
Сбросьте флажок Смежные пиксели 
(Contiguous), если вам нужно стереть 
все пиксели, попадающие в  область, 
ограниченную значением параметра До-
пуск (Tolerance), и находящиеся в любой 
части изображения (рис. Б).

4 Установите указатель мыши, а затем щелк-
ните, чтобы стереть пиксели, которые на-
ходятся в пределах области, ограниченной 
значением параметра Допуск (Tolerance).

Инструмент Волшебный 

ластик (Magic Eraser) находится 
в той же группе, что и инстру-
мент Ластик (Eraser). Нажмите 
и удерживайте кнопку инстру-
мента Ластик (Eraser), чтобы 
получить доступ к остальным 
инструментам данной группы. 
Вы также можете использовать 
сочетание клавиш Shift+E для 
переключения между этими 
инструментами.

Установите флажок Образец 

со всех слоев (Sample All 
Layers), чтобы стереть пиксели, 
исходя из выборки, которая 
учитывает цветовые значения 
всех видимых слоев, а не только 
активного слоя.

Если вы применяете инструмент 
Волшебный ластик (Magic 
Eraser) к фоновому слою, то про-
грамма Photoshop автомати-
чески преобразует этот слой 
в Слой 0.

�

�
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Фоновый ластик
Примените инструмент Фоновый ластик (Background Eraser) к слою, 
чтобы стереть пиксели до прозрачности. Вы можете установить значе-
ния параметров допуска и  ограничения, чтобы контролировать уро-
вень прозрачности и степень резкости краев.

1 Для удаления пикселей на слое, сначала выберите нужный слой. 
Выберите инструмент Фоновый ластик (Background Eraser), 
чтобы отобразить его настройки на  панели параметров. Выбе-
рите кисть на панели Выбор набора кистей (Brush Presets Picker).

2 Выберите вариант Смежные пиксели 
(Contiguous) в  раскрывающемся спис-
ке Ограничения (Limits), чтобы удалить 
смежные пиксели, находящиеся в  области, ограниченной зна-
чением параметра Допуск (Tolerance). (Вариант Все пиксели 
(Discontinuous) стирает пиксели по всему изображению, а вариант 
Выделение краев (Find Edges) сохраняет резкие края объектов.)

3 Введите значение параметра Допуск 
(Tolerance) или перетащите соответ-
ствующий ползунковый регулятор. За-
дайте малое значение, чтобы применить 
инструмент только к  пикселям, цвет которых близок к  цвету 
пикселей в  «горячей точке». Установка высокого значения по-
зволяет стереть пиксели более широкого диапазона цветов.

4 Щелкните мышью по  кнопке Проба: не-
прерывно (Continuous), чтобы удалить все 
цвета, по которым вы перетаскиваете кур-
сор. Вариант Проба: однократно (Once), чтобы стереть пиксели 
одного цвета с пикселом, по которому вы совершили первый щел-
чок. Этот вариант полезен, если вы хотите удалить области, за-
полненные сплошным цветом. Выберите вариант Проба: образец 
фона (Background Swatch), чтобы удалить области, заполненные 
текущим фоновым цветом.

5 Установите курсор на  нужную 
часть изображения, а  затем щелк-
ните или, нажав и  удерживая 
кнопку мыши, перетащите, чтобы 
стереть пиксели на  слое до  про-
зрачности, используя заданные па-
раметры.

Установите флажок Основной 

цвет (Protect Foreground Color) 
на панели параметров, чтобы 
предотвратить стирание пиксе-
лей, цвет которых соответствует 
основному цвету.

Перекрестие в центре курсора 
кисти обозначает «горячую 
точку» инструмента —  точку, 
на которую инструмент оказы-
вает наибольшее воздействие. 
Эффект уменьшается по мере 
удаления от «горячей точки».
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Восстанавливающая  
кисть
Используйте инструмент Восстанавливающая кисть (Healing Brush), что-
бы исправить недостатки и дефекты изображения. Принципом работы 
восстанавливающая кисть похожа на инструмент Штамп (Clone Stamp), 
однако она также учитывает текстуру, свечение и затенение пикселей об-
разца и применяет эти параметры к области, которую вы хотите «восста-
новить», благодаря чему достигается плавный бесшовный результат.

1 Чтобы исправить недостаток изображения, выберите инструмент 
Восстанавливающая кисть (Healing Brush). Используйте панель 
Выбор набора кистей (Brush Presets Picker), чтобы задать размер 
кисти. При необходимости выберите режим наложения. Исполь-
зуйте режим Заменить (Replace), чтобы сохранить текстуру, шум 
и  любую зернистость пленки по  краям штрихов. В  группе эле-
ментов управления Источник (Source) оставьте нажатой кнопку 
Семпл. (Sampled), чтобы использовать пиксели изображения.

2 Установите флажок Выравни-
вание (Aligned) на панели па-
раметров (подробнее о  функ-
ции Выравнивание (Aligned) 
вы можгли узнать в  разделе 
«Штамп» данной главы).

3 Установите указатель мыши 
на  часть изображения, из  ко-
торой вы хотите взять обра-
зец для коррекции недостатка. 
Удерживая нажатой клавишу 
Alt/�, щелкните кнопкой мыши. Это позволит определить область, 
пиксели которой будут использоваться в качестве образца.

4 Отпустите клавишу Alt/�. Переме-
стите курсор на ту область, которую 
вы хотите восстановить. Для вос-
становления щелкните или, нажав 
и  удерживая кнопку мыши, перета-
щите ее. При щелчке или перетаски-
вании значок + определяет область 
изображения, из  которой берутся 
пиксели в качестве образца.

Выберите вариант в раскры-
вающемся списке Образец 
(Sample), чтобы указать, какие 
пиксели будут включены в вы-
борку при щелчке с нажатой 
клавишей Alt/�.

При работе с инструментами 
редактирования вы можете 
использовать клавиши [и] для 
уменьшения и увеличения раз-
мера кисти.
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Точечная  
восстанавливающая кисть
Как и  восстанавливающая кисть, инструмент Точечная восстанав-
ливающая кисть (Spot Healing Brush) удаляет нежелательные детали 
и  корректирует недостатки изображения. Точечная восстанавливаю-
щая кисть не требует создания выделения. Она автоматически захва-
тывает образец в той области, где находится кисть.

Оставьте выбранным вариант С учетом содержимого (Content-Aware) 
на панели параметров, поскольку он, как правило, обеспечивает наилуч-
шие результаты. Данный параметр производит подробный анализ сосед-
них областей для создания реалистичного и бесшовного заполнения.

1 Выберите инструмент Точечная восстанавливающая кисть 
(Spot Healing Brush), а затем задайте достаточно большой размер 
кисти, чтобы закрыть недостаток.

2 Установите указатель мыши на ненужное пятно, а затем щелкни-
те один раз, чтобы удалить его.

3 В случае с большими об-
ластями вы можете, нажав 
и удерживая кнопку мыши, 
перетащить указатель мыши 
по той части 
изображения, 
которое следует 
откорректиро-
вать. Точечная 
восстанавли-
вающая кисть 
обеспечит 
соответствующее затенение, 
свечение, текстуру и прозрач-
ность пикселей, чтобы уда-
лить нежелательную деталь.

Вариант Соответствие при-

ближения (Proximity Match), 
доступный на панели параме-
тров для инструмента Точечная 

восстанавливающая кисть 
(Spot Healing Brush), исполь-
зует пиксели вокруг курсора 
инструмента, чтобы настроить 
текстуру, свечение, затенение 
и прозрачность для коррекции 
изображения.

Вариант Создание текстуры 
(Create Texture) анализирует 
пиксели вокруг кисти, чтобы со-
здать текстуру, которая заменит 
ненужную часть изображения.
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Заплатка
Инструмент Заплатка (Patch) позволяет скрыть проблемы и недостат-
ки в  изображении путем клонирования или копирования пикселей 
из другой похожей его части. Инструмент Заплатка (Patch) старается 
обеспечить соответствие текстуры и затенения копируемых или захва-
ченных в качестве образца пикселей аналогичным параметрам пиксе-
лей, к которым вы применяете данный инструмент.

1 Активируйте инструмент Заплат-
ка (Patch). Выберите источник 
на  панели параметров. Перета-
щите указатель мыши по  изобра-
жению, чтобы выделить пиксели, 
к  которым вы хотите применить 
инструмент.

2 При выбранном инструменте За-
платка (Patch) установите курсор 
внутри выделенной области, а  за-
тем, нажав и  удерживая кнопку 
мыши, перетащите эту область 
на часть изображения, из которой 
вы хотите скопировать пиксели.

3 Отпустите кнопку мыши. Ориги-
нальное выделение будет заполне-
но пикселями, взятыми из области, 
в  которую был установлен указа-
тель мыши, когда вы отпустили ее 
кнопку.

4 Кроме того, вы можете выбрать 
вариант Назначение (Destination), 
чтобы изменить принцип работы инструмента на  противопо-
ложный. Используйте инструмент Заплатка (Patch), чтобы вы-
брать область пикселей, которую вы хотите использовать для 
коррекции изображения. Перетащите выделение на  часть изо-
бражения, подлежащую коррекции. Отпустите кнопку мыши, 
чтобы скопировать изначально выделенную область на дефект 
изображения.

Чтобы исправить эффект «крас-
ных глаз», вызванный вспышкой 
камеры, выберите инструмент 
Красные глаза (Red Eye), уста-
новите курсор на красный глаз 
в изображении, а затем щелкни-
те кнопкой мыши. В большин-
стве случаев настройки по умол-
чанию работают хорошо. При 
необходимости отрегулируйте 
значения Размер зрачка (Pupil 
Size) и Величина затемнения 

(Darken Pupil) на панели 
параметров.

Вариант С учетом содержимо-

го (Content-Aware), доступный 
в раскрывающемся списке 
Заплатка (Patch) на панели 
параметров, позволяет исполь-
зовать новейшую технологию 
с инструментом Заплатка 
(Patch). В отличие от команды За-

ливка с учетом содержимого 
(Content-Aware Fill) команда За-

платка с учетом содержимого 
(Content-Aware Patch) позволяет 
указать конкретную область 
изображения, пиксели которой 
будут использоваться в качестве 
источника для коррекции.

Для получения информации 
об использовании раскры-
вающегося списка Адаптация 
(Adaptation) обратитесь к раз-
делу «Перемещение с учетом 
содержимого» далее в главе.
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Замена цвета
Используйте инструмент Замена цвета (Color Replacement), чтобы за-
красить конкретные цвета в изображении.

1 Чтобы закрасить цвет, выберите инструмент Замена цвета (Color 
Replacement). Выберите основной цвет. Задайте такие параметры, 
как Размер (Size), используя панель Выбор набора кистей (Brush 
Preset Picker) на панели параметров. В раскрывающемся списке 
Режим (Mode) оставьте выбранным вариант Color (Цветность).

2 В раскрывающемся списке Проба (Sampling) выберите вариант 
Проба: непрерывно (Continuous), чтобы отбирать и  заменять 
цвета пикселей непрерывно в процессе перетаскивания. Выбе-
рите вариант Проба: однократно (Once), чтобы заменить только 
целевой цвет, по которому вы совершаете первый щелчок. Это 
делает инструмент очень избирательным, что обеспечивает из-
менение только ограниченного количества пикселей. Выдели-
те образец фонового цвета, чтобы изменить только те пиксели, 
цвет которых соответствует цвету фона.

3 В раскрывающемся списке Ограничения (Limits) выберите ва-
риант Смежные пиксели (Contiguous), чтобы окрасить пиксели, 
прилежащие к пикселям, по которым вы перетаскиваете, и попа-
дающие в область, ограниченную значением Допуск (Tolerance). 
Выберите вариант Все пиксели (Discontinuous), чтобы закрасить 
пиксели в пределах диаметра кисти, даже если они не находятся 
в  непосредственной близости от  пикселей, по  которым вы пе-
ретаскиваете. Выберите вариант Выделение краев (Find Edges), 
чтобы сохранить резкость краев при замене цвета.

4 Установите указатель мыши 
на пиксели, которые вы хотите 
изменить. В центре курсора ин-
струмента Замена цвета (Color 
Replacement) отобразится пере-
крестие, определяющее «горя-
чую точку» —  точку, на которую 
инструмент оказывает наиболь-
шее воздействие. Нажав и удер-
живая кнопку мыши, перетащи-
те, чтобы закрасить пиксели.

Оставьте флажок Сглаживание 
(Anti-aliased) установленным, 
чтобы обеспечить сглаживание 
краев в областях, в которых вы 
заменяете цвет.

Введите значение в поле До-

пуск (Tolerance) или перетащите 
соответствующий ползунковый 
регулятор. Установите низкое 
значение, чтобы применить 
инструмент только к пикселям, 
цвет которых очень близок 
к цвету пикселей в центре 
кисти. Установите высокое зна-
чение, чтобы затронуть более 
широкий диапазон пикселей.
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Перемещение с учетом 
содержимого
Инструмент Перемещение с  учетом содержимого (Content-Aware 
Move) обеспечивает быстрый способ перемещения содержимого изо-
бражения из  одной области в  другую. Этот инструмент анализирует 
и смешивает перемещаемые пиксели с их новым окружением и в то же 
время применяет заливку с учетом содержимого к области, из которой 
вы перемещаете пиксели.

1 Для начала выделите 
объект, который вы 
хотите переместить.

2 Выберите инструмент 
Перемещение с уче-
том содержимого 
(Content-Aware Move) 
в группе инструмен-
тов Точечная восста-
навливающая кисть 
(Spot Healing Brush). Убе-
дитесь в том, что в раскры-
вающемся списке Режим 
(Mode) на панели параметров выбран вариант Перемещение 
(Move).

3 Установите курсор 
инструмента Пе-
ремещение с уче-
том содержимого 
(Content-Aware Move) 
на выделенную об-
ласть, а затем, нажав 
и удерживая кнопку 
мыши, перетащите, 
чтобы переместить 
выделение в другую 
часть изображения.

На панели параметров вве-
дите значение в поле Струк-

тура (Structure) (в диапазоне 
от 1 до 7), чтобы определить 
степень сохранения текстуры 
фона при смешивании переме-
щаемого объекта с его новым 
окружением. Меньшие значе-
ния обеспечивают большую 
степень смешивания. В поле 
Цвет (Color) введите значение 
в диапазоне от 0 до 10, чтобы 
определить степень смешива-
ния цветов. Более высокие зна-
чения обеспечивают большую 
степень смешивания.
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4 Когда вы отпусти-
те кнопку мыши, 
программа Photoshop 
проанализирует 
пиксели в выделен-
ной области и новый 
фоновый контекст, 
чтобы смешать пере-
мещаемые пиксели 
с новым окружением. 
В то же время программа применит заливку с учетом содержи-
мого к области, из которой были перемещены пиксели. Выбери-
те команду меню Выделение → Отменить выделение (Select → 
Deselect), чтобы изменения вступили в силу.

Чтобы избежать появления фан-
томных изображений (см. ниже) 
и обеспечить более сглаженный 
результат, расширьте выделенную 
область, чтобы включить в нее не-
которые фоновые пиксели вокруг 
объекта, который вы хотите пере-
местить. Для этого после выде-
ления нужной области выберите 
команду меню Выделение →  
Модификация → Расширить 

(Select → Modify → Expand). Вве-
дите значение для расширения 
выделенной области.



7 Выделение

Одним из наиболее 
частых действий 

при использовании 
программы Photoshop 

является выделение. 
При создании выделения 

вы выбираете часть 
изображения или слоя, 

в которую хотите 
внести изменения, 

изолируя при этом 
остальное изображение. 

Выделенная область 
очерчена на экране 

пунктирной рамкой.

Инструменты для выделения

Параметры инструментов для выделения

Перемещение выделенных пикселей

Инструменты группы Лассо

Волшебная палочка

Быстрое выделение

Уточнение края

Растушевка выделенной области

Модификация выделенной области

Смежные пиксели и Подобные оттенки

Вставка в выделенную область

Заливка выделенной области

Копирование и вставка выделенной области

Область фокусировки

Трансформирование выделенной области
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Инструменты выделения
Инструменты выделения позволяют вам задать область изображения 
путем перетаскивания указателя мыши. Вы можете выделить прямо-
угольную или овальную область, выбрав соответствующий инструмент.

1 Чтобы создать прямоугольную или овальную область выделе-
ния, выберите инструмент Прямоугольная область (Rectangular 
Marquee) или Овальная область (Elliptical Marquee).

2 Установите кур-
сор на изобра-
жение, а затем, 
нажав и удер-
живая кнопку 
мыши, пере-
тащите, чтобы 
задать область, 
которую необ-
ходимо выде-
лить. Отпустив 
кнопку, вы увидите прямоугольную или овальную пунктирную 
рамку, определяющую выделенную область.

3 Удерживайте нажатой клавишу Shift в  процессе перетаскива-
ния курсора инструмента Прямоугольная область (Rectangular 
Marquee) или Овальная область (Elliptical Marquee), чтобы со-
здать квадратную или круглую область. Удерживайте нажатой 
клавишу Alt/�, чтобы создать выделение от центра. Удерживай-
те нажатыми клавиши Alt+Shift, чтобы создать квадратную или 
круглую область выделения от центра.

4 При необходимости вы можете переместить выделение. Убеди-
тесь в том, что инструмент выделения все еще активен, устано-
вите курсор внутри выделенной области (он изменит свой вид 
[зн]), а  затем, нажав и  удерживая кнопку мыши, перетащите. 
Вы можете перемещать выделенную область, используя любой 
из  инструментов выделения за  исключением инструмента Бы-
строе выделение (Quick Selection).

5 При активном инструменте выделения вы можете сбросить вы-
деление, щелкнув внутри или за пределами выделенной области. 
Кроме того, вы можете выбрать команду меню Выделение → От-
менить выделение (Select → Deselect) (или нажмите сочетание 
клавиш Ctrl/�+D).

Если вы работаете с изображе-
нием, содержащим несколько 
слоев, убедитесь в том, что вы 
выбрали нужный целевой слой, 
прежде чем применять инстру-
менты выделения.

Одновременно может быть 
активна только одна область 
выделения, однако она может 
состоять из нескольких несо-
прикасающихся частей.

В процессе создания выделения 
вы можете удерживать нажатой 
клавишу Пробел для переме-
щения выделенной области.
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Параметры  
инструментов выделения
Вы можете использовать панель параметров для изменения принципа 
работы инструментов выделения.

1 Выберите инструмент Прямоугольная область (Rectangular 
Marquee) или Овальная область (Elliptical Marquee). Убедитесь 
в том, что на панели параметров нажата кнопка Новая выделен-
ная область (New Selection).

2 Используйте раскрывающийся список 
Стиль (Style), чтобы задать параметры 
для создания пропорциональных об-
ластей выделения или выделений за-
данного размера. При выборе варианта Заданный размер (Fixed 
Size) вам нужно будет ввести значения в поля Ширина (Width) 
и Высота (Height).

3 Установите фла-
жок Сглажива-
ние (Anti-aliased), 
чтобы создать 
несколько размы-
тый, мягкий край 
вокруг выделения 
и окружающих 
его пикселей. 
Использова-
ние сглажива-
ния помогает 
предотвратить 
появление неже-
лательных зазуб-
ренных краев.

4 Используйте 
команды Расту-
шевка (Feather) 
или Уточнить край (Refine Edge) для создания мягкого расту-
шеванного края (см. раздел «Уточнение края» далее в главе).

Выберите команду меню Вы-

деление → Выделить снова 
(Select → Reselect), чтобы ото-
бразить последнюю выделен-
ную область. Вы можете исполь-
зовать данную команду, даже 
если после отмены выделения 
вы применили к изображению 
какие-либо команды.

Флажок Сглаживание (Anti-
aliased) также присутствует 
на панели параметров инстру-
ментов Лассо (Lasso) и Волшеб-

ная палочка (Magic Wand).
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Перемещение выделенных 
пикселей
Вы можете использовать инструменты выделения, чтобы переместить 
границу выделенной области, но для перемещения пикселей изображе-
ния вам следует использовать инструмент Перемещение (Move).

1 Выделите часть изображе-
ния. Выберите инструмент 
Перемещение (Move), а затем 
установите курсор внутри 
выделенной области. Нажав 
и  удерживая кнопку мыши, 
перетащите, чтобы переме-
стить выделенные пиксели.

При перемещении пикселей фонового слоя, та область, из которой пе-
ремещаются пиксели, заполняется текущим фоновым цветом. Пока 
граница области выделена, вы можете продолжать перемещать пиксели. 
При активной области выделения ее пиксели «парят» над находящими-
ся под ними пикселями, не заменяя их.

2 Чтобы «парящие» пиксели заменили пиксели, находящиеся под 
ними, выберите команду меню Выделение → Отменить выделе-
ние (Select → Deselect) при активном инструменте Перемещение 
(Move) или Волшебная палочка (Magic Wand). Если вы исполь-
зовали клавишу Ctrl/� при выбранном инструменте выделения 
или Лассо (Lasso), щелкните кнопкой мыши за пределами рамки 
выделения. После снятия выделения лежащие под выделением 
пиксели фонового слоя будут полностью заменены перемещен-
ными пикселями.

3 Чтобы переместить выделение и одно-
временно сделать его копию, нажмите 
и  удерживайте клавишу Alt/� перед 
перетаскиванием курсора инструмен-
та Перемещение (Move). Он примет 
вид двойной стрелки ( ), указывая 
на  то, что вы копируете выделенную 
область.

4 Вы можете превратить «плавающую» область выделения в слой, 
выбрав в меню Слои → Новый (Layers → New) команду Скопи-
ровать на новый слой (Layer Via Copy) или Вырезать на новый 
слой (Layer Via Cut) (см. главу 8).

Выберите один из инструментов 
выделения, Лассо (Lasso) или Вол-

шебная палочка (Magic Wand), 
а затем установите указатель 
мыши в область выделения и на-
жмите клавишу Ctrl/�. Указатель 
временно примет вид курсора ин-
струмента Перемещение (Move). 
Нажав и удерживая кнопку мыши, 
перетащите, чтобы переместить 
выделенные пиксели.

Для перемещения выделенной 
области с шагом в один пиксель 
с помощью инструмента Пере-

мещение (Move) используйте 
клавиши �, �, � и �. Используй-
те эти же клавиши, удерживая 
нажатой клавишу Shift, для пе-
ремещения выделенной области 
с шагом в десять пикселей.

В растровом изображении 
не может быть области, не со-
держащей пикселей. При пере-
мещении пикселей фонового 
слоя с помощью инструмента 
Перемещение (Move) изначаль-
но выделенная область заполня-
ется текущим фоновым цветом.
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Инструменты  
группы Лассо
Вы можете использовать инструменты группы Лассо (Lasso) для созда-
ния произвольной области выделения с помощью метода перетаскива-
ния. Это полезные инструменты для выделения областей неправильной 
формы, а также для быстрого добавления или вычитания частей из об-
ласти выделения, сделанной с помощью других инструментов выделе-
ния, например, Волшебная палочка (Magic Wand).

Выберите инструмент Лассо (Lasso). Настрой-
те параметры Растушевка (Feather) и  Сгла-
живание (Anti-aliased). Установите указатель 
на изображение. Он превратится в курсор ин-
струмента Лассо (Lasso). Нажав и удерживая 
кнопку мыши, перетащите, чтобы определить 
часть изображения, которую вы хотите вы-
делить. Убедитесь в том, что указатель мыши 
вернулся в исходную точку. Если вы отпустите 
кнопку мыши до достижения исходной точки, 
программа Photoshop завершит область выде-
ления прямой линией. Выделенная область 
будет обозначена пунктирной границей.

Многоугольное лассо

Инструмент Многоугольное лассо (Polygon 
Lasso) создает выделение многоугольной формы, состоящее из прямо-
линейных отрезков.

Выберите инструмент Многоугольное лассо (Polygon Lasso). Устано-
вите указатель на изображение, а затем щелкните кнопкой мыши, пе-
реместите курсор, еще раз щелкните кнопкой мыши и продолжайте так 
до тех пор, пока не зададите область выделения. Щелкните по исходной 
точке для завершения выделения или выполните двойной щелчок, что-
бы замкнуть область выделения.

Выполните перетаскивание, 
удерживая нажатой клавишу 
Shift, чтобы добавить область 
в выделение —  указатель при-
мет вид . Выполните перета-
скивание, удерживая нажатой 
клавишу Alt/�, чтобы удалить 
область из выделения —  указа-
тель примет вид .

Когда курсор инструмента 
Многоугольное лассо (Polygon 
Lasso) вернется в исходную 
точку, в его правом нижнем 
углу появится маленький круг, 
указывающий на то, что вы 
можете замкнуть область выде-
ления с помощью однократного 
щелчка
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Магнитное лассо
Инструмент Магнитное лассо (Magnetic Lasso) является наиболее по-
лезным, когда вам нужно выделить объект или область изображения, 
сильно контрастирующую со своим окружением.

1 Выберите инструмент Магнитное лассо (Magnetic 
Lasso). Щелкните мышью по краю объекта, кото-
рый вы хотите выделить, чтобы установить пер-
вую опорную точку. Переместите курсор вдоль 
края объекта или, нажав и  удерживая кнопку 
мыши, перетащите вдоль края, чтобы нарисовать 
границу от руки. В процессе перемещения вдоль 
края объекта «активный» участок границы выде-
ленной области привязывается к наиболее четко 
определенному краю объекта рядом с курсором. Опорные точки 
добавляются при перетаскивании автоматически.

2 Чтобы закрыть границу выделенной области, по-
местите курсор в исходную точку (на это указыва-
ет маленький круг около него), а  затем щелкните 
кнопкой мыши. Кроме того, вы можете выполнить 
двойной щелчок или нажать клавишу Enter/�. 
Программа Photoshop создаст отрезок, соединяю-
щий последнюю точку с  начальной. Чтобы завер-
шить границу прямым отрезком, выполните двой-
ной щелчок, удерживая нажатой клавишу Alt/�.

Ширина
Инструмент Магнитное лассо (Magnetic Lasso) обнаруживает края 
в пределах заданного расстояния от курсора. Введите в поле Ширина 
(Width) значение от 1 до 256 пикселей.

Частота
Параметр Частота (Frequency) определяет частоту добавления опор-
ных точек. Введите значение от 0 до 100. Чем выше значение, тем мень-
ше интервал между опорными точками.

Контрастность
Присвойте параметру Контрастность (Contrast) значение в  диапазо-
не от 1 до 100%. Данное значение определяет степень чувствительно-
сти инструмента Магнитное лассо (Magnetic Lasso) к краям объектов 
изображения. Более высокие значения обеспечивают выделение краев, 
сильно контрастирующих с фоном. Более низкие значения обеспечива-
ют выделение краев, отличающихся меньшим контрастом.

Вы не можете применять 
инструмент Магнитное лассо 
(Magnetic Lasso) к изображе-
ниям с глубиной цвета 32 бита 
на канал.

Щелкните мышью по краю фи-
гуры, чтобы добавить опорную 
точку вручную.

Если объект, который вы хотите 
выделить, обладает высокой 
контрастностью (то есть имеет 
четко определенные края), 
используйте более высокие 
значения параметров Шири-

на (Width) и Контрастность 
(Contrast). Для объектов с менее 
четкими краями используйте 
более низкие значения.

Инструмент Магнитное лассо 
(Magnetic Lasso) добавляет 
опорные точки с интервалом 
в процессе перетаскивания 
указателя мыши при создании 
области выделения. Точки 
привязки закрепляют границу 
выделенной области на месте, 
но исчезают при ее закрытии.
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Волшебная палочка
Инструмент Волшебная палочка (Magic Wand) выделяет непрерыв-
ные области цвета в изображении, основываясь на значении параметра 
Допуск (Tolerance). Низкие значения этого параметра обеспечивают 
очень ограниченный выбор цвета. Более высокие значения позволяют 
выбрать более широкий диапазон пикселей. Данный инструмент под-
ходит для выделения области, заполненной достаточно равномерным 
цветом.

1 Перед созданием выделения с  помощью инструмента Волшеб-
ная палочка (Magic Wand) обратите внимание на параметр До-
пуск (Tolerance). Введите значение в диапазоне от 0 до 255. Зна-
чение 255 обеспечит выделение всех пикселей изображения.

2 Щелкните мышью по изо-
бражению, чтобы выделить 
пиксели с аналогичным цве-
товым значением. При этом 
будут выделены все смеж-
ные пиксели, находящиеся 
в пределах области, ограни-
ченной значением параме-
тра Допуск (Tolerance). При 
необходимости измените 
значение 32, выбранное 
по умолчанию, для создания 
нужного выделения.

3 Сбросьте флажок Смежные 
пиксели (Contiguous), чтобы выделить пиксели по всему изобра-
жению, попадающие в область, ограниченную значением параме-
тра Допуск (Tolerance). В данном случае результат будет похож 
на результат применения команды Подобные оттенки (Similar) 
(см. раздел «Смежные пиксели и Подобные оттенки» далее в главе).

4 Чтобы отменить выделение при использовании инструмента Вол-
шебная палочка (Magic Wand), щелкните мышью внутри выделен-
ной области. Если вы щелкнете за пределами этой области, вы со-
здадите другую область вокруг пикселя, по которому вы щелкнули.

5 При необходимости используйте команду Уточнить край 
(Refine Edge), чтобы определить и уточнить выделенную область 
(см. раздел «Уточнение края» далее в главе).

Чтобы увеличить область 
выделения при использова-
нии инструмента Волшебная 

палочка (Magic Wand), щелк-
ните мышью по невыделенной 
части изображения, удерживая 
нажатой клавишу Shift.

Как правило, вы можете 
уточнить область, выделен-
ную с помощью инструмента 
Волшебная палочка (Magic 
Wand), используя сочетание 
других инструментов выделе-
ния, а также команды Смежные 

пиксели (Grow), Подобные 

оттенки (Similar) и Уточнить 

край (Refine Edge).

Вы не можете применять ин-
струмент Волшебная палочка 
(Magic Wand) к изображению 
в режиме Битовый формат 
(Bitmap).
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Быстрое выделение
Использование инструмента Быстрое выделение (Quick Selection) яв-
ляется одним из самых простых и быстрых способов выделения обла-
стей и объектов с четкими краями.

1 Щелкните один раз по инструменту Бы-
строе выделение (Quick Selection), что-
бы выбрать его. Используйте панель Вы-
бор набора кистей (Brush Presets Picker) 
на  панели параметров, чтобы задать 
размер кисти (см. раздел «Параметры 
формы отпечатка кисти» главы 5 для по-
лучения дополнительной информации 
о настройке параметров кисти).

2 Нажав и  удерживая кнопку мыши, перетащите курсор, чтобы 
выделить нужную часть изображения. Инструмент возьмет 
пробу цвета в области, а затем создаст выделение, ограниченное 
четкими контрастными краями в изображении.

3 После создания первоначального выделения с  помо-
щью инструмента Быстрое выделение (Quick Selection) 
на панели параметров автоматически выбирается вари-
ант Добавить к выделенной области (Add to Selection). Нажав 
и удерживая кнопку мыши, перетащите ее по изображению, что-
бы добавить в выделение новые области.

4 На панели параметров нажмите кнопку Вычитание 
из выделенной области (Subtract from selection), а  за-
тем выполните щелчок или перетаскивание по  суще-
ствующему выделению, чтобы удалить из него области.

При использовании инструмен-
та Быстрое выделение (Quick 
Selection) вы также можете 
использовать щелчок кнопкой 
мыши вместо перетаскивания. 
Иногда это может обеспечить 
более точное выделение.

Увеличьте масштаб и примените 
кисть меньшего размера, чтобы 
более точно определить добав-
ляемые или удаляемые области.
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Также вы можете использовать следующие параметры:

Образец со всех слоев (Sample All Layers) —  установите этот флажок, 
чтобы включить в выделенную область пиксели не только активного 
слоя, но и других слоев.

Усилить автоматически (Auto Enhance)  —  установите этот флажок, 
чтобы создать более точное выделение. При использовании данного ва-
рианта программа Photoshop тратит немного больше времени на оцен-
ку цветовых значений и создание области выделения.

При использовании варианта 
Добавить к выделенной обла-

сти (Add to Selection) удержи-
вайте нажатой клавишу Alt/�, 
чтобы временно переключиться 
в режим Вычитание из выде-

ленной области (Subtract from 
selection).
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Уточнение края
После создания выделения с помощью любого из описанных в этой гла-
ве инструментов, вы можете определить и уточнить край выделенной 
области, используя диалоговое окно Уточнить край (Refine Edge).

1 Для уточнения выделенной 
области при выбранном 
инструменте выделения 
щелкните мышью по кноп-
ке Уточнить край (Refine 
Edge) на панели параметров 
или выберите команду меню 
Выделение → Уточнить 
край (Select → Refine Edge).

2 Используйте раскрывающийся 
список Вид (View), чтобы выбрать 
фон, на  котором вы можете оце-
нить результат применения пара-
метров, задаваемых в диалоговом 
окне. Использование различных 
вариантов предварительного про-
смотра позволяет вам эффективно 
оценить результаты применения 
настроек.

В диалоговом окне Уточнить 

край (Refine Edge) предусмо-
трены инструменты Масштаб 
(Zoom) и Рука (Hand), так что 
вы можете перейти к любой 
части изображения и отмасшта-
бировать его, чтобы оценить 
влияние изменения параметров 
на край выделенной области.

Установите флажок Показать 

радиус (Show Radius) в группе 
элементов управления Режим 

просмотра (View Mode), чтобы 
отобразить область, в которой 
программа Photoshop пытает-
ся уточнить край выделения 
в соответствии с указанными 
параметрами. Следующий рису-
нок демонстрирует выделенную 
область на черном фоне:

Во время использования 
диалогового окна Уточнить 

край (Refine Edge) вы можете 
нажимать клавишу F, чтобы 
перебрать варианты предвари-
тельного просмотра.

На черном

Наложение
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3 Перетащите ползунковый регуля-
тор Радиус (Radius) или введите 
значение в  соответствующее поле 
ввода, чтобы указать размер области, в  которой программа 
Photoshop попытается проанализировать и  уточнить выделе-
ние. Как правило, для областей с мягкими краями используются 
большие значения параметра Радиус (Radius).

4 Используйте инструмент Уточ-
нить радиус (Refine Radius) для 
изменения области уточнения. Вы 
можете применить данный инстру-
мент к частям изображения 
с такими деталями, как волосы, 
чтобы добавить эти детали в вы-
деленную область.

Настройка края

Настройте параметры в разделе Настройка края (Adjust Edge), исполь-
зуя ползунковые регуляторы Сгладить (Smooth), Растушевка (Feather), 
Контрастность (Contrast) и Сместить край (Shift Edges), чтобы уточ-
нить область выделения. Они выполняют следующие функции:

Сгладить (Smooth) —  позволяет сгладить неровные края области выде-
ления, что иногда может размыть мелкие детали.

Растушевка (Feather) —  создает мягкую область выделения с помощью 
размытия.

Контрастность (Contrast)  —  позволяет удалить артефакты (нежела-
тельные детали) и сделать область выделения резче и четче.

Сместить край (Shift Edges) —  сжимает или расширяет общую площадь 
выделенной области.

Вывод

1 Выберите вариант в раскрывающемся списке Вывод в (Output), 
чтобы превратить уточненную область в выделение, новый слой, 
слой-маску или новый слой со слоем-маской. Вы также можете 
создать для уточненного выделения новый документ.

2 Щелкните мышью по кнопке ОК, чтобы применить параметры 
к изображению.

В случае с областью выделения, 
в которой присутствуют мягкие 
и жесткие края, установите 
флажок «Умный» радиус (Smart 
Radius), чтобы автоматически 
адаптировать радиус в соответ-
ствии с типом обнаруженных 
краев.

Установите флажок Очистить 

цвета (Decontaminate Colors), 
а затем используйте ползун-
ковый регулятор Эффект 
(Amount), если вам требуется 
удалить явно выраженные цве-
товые окантовки, которые могут 
появиться вокруг областей 
с мягкими краями.

Нажмите и удерживай-
те кнопку инструмента 
Уточнить радиус 
(Refine Radius), чтобы получить 
доступ к инструменту Стереть 

уточнение (Erase Refinements).

Используйте инструмент 
Стереть уточнение (Erase 
Refinements) для удаления ча-
стей из области уточнения. Вы 
можете переключаться между 
этими двумя инструментами 
в процессе работы с помощью 
клавиши Alt/�.
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Растушевка  
выделенной области
Вы можете использовать параметр Растушевка (Feather) для указания 
степени смягчения края выделенной области. Растушевка выделенной 
области создает границу перехода между выделением и окружающими 
пикселями, что может привести к потере деталей.

1 Выберите один из инструментов группы Лассо (Lasso) или инстру-
мент Прямоугольная область (Rectangular Marquee) или Овальная 
область (Elliptical Marquee). На панели параметров введите значе-
ние в поле Растушевка (Feather), например, 10. Величина введен-
ного значения зависит от того, какого эффекта вы хотите добиться. 
Применяйте более высокие значения к изображениям с высоким 
разрешением. Создайте выделение с помощью соответствующего 
инструмента. Кроме того, после создания выделения вы можете 
выбрать пункт меню Выделение → Уточнить край (Select → Refine 
Edge). Введите значение в поле Растушевка (Feather) или перета-
щите соответствующий ползун-
ковый регулятор.

2 При перемещении выделенной 
области с  помощью инструмента 
Перемещение (Move) вы увидите 
растушеванный край вокруг этой 
области, а также в том месте, отку-
да вы ее перемещаете.

Создание виньетки
Вы можете использовать параметр Растушевка 
(Feather), чтобы создать виньетку или мягкий «рас-
творяющийся» край изображения.

Введите значение параметра Растушевка (Feather) 
на панели параметров для выбранного вами инстру-
мента выделения. Затем создайте область выделения 
правильной или неправильной формы. Выберите 
команду меню Выделение → Инверсия (Select  → 
Inverse). Эта команда оборачивает выделение, 
то есть выделяет пиксели, которые ранее не были 
выделены, и наоборот. Нажмите клавишу Backspace 
(Windows) или � (macOS). В диалоговом окне Запол-
нить (Fill) выберите вариант Цвет фона (Background) 
в меню Содержание (Use), чтобы удалить область, окру-
жающую выделение, в результате чего получится расту-
шеванный край.

Возьмите за привычку про-
верять значение параметра 
Растушевка (Feather) на панели 
параметров перед выделением, 
чтобы не создать растушеван-
ную область непреднамеренно.

В отличие от сглаживания, 
растушевка размывает изо-
бражение и внутри, и снаружи 
границы области выделения

Вы также можете растушевать 
область выделения после ее со-
здания, выбрав команду меню 
Выделение → Модификация → 
Растушевка (Select → Modify → 
Feather) (или нажав сочетание 
клавиш Shift+F6).

Прежде чем выделить область 
для создания виньетки, убеди-
тесь в том, что фоновым цветом 
является белый (см. раздел 
«Основной и фоновый цвета» 
главы 4).
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Модификация выделенной 
области
Во многих случаях вам может понадобиться изменить область выделе-
ния, добавив к ней область или вычтя участок выделения. Вы можете 
использовать любое сочетание инструментов для создания нужной об-
ласти выделения. Например, вы можете сделать первоначальный выбор 
с помощью инструмента Волшебная палочка (Magic Wand), а затем доба-
вить участок к выделенной области, используя инструмент Лассо (Lasso).

1 Чтобы добавить область к уже 
существующему выделению, 
нажмите и удерживайте кла-
вишу Shift, а затем, нажав 
и удерживая кнопку мыши, 
перетащите ее, чтобы создать 
другую область выделения, 
пересекающуюся с уже суще-
ствующей.

2 Вы можете использовать эту же 
технику для создания неприлегаю-
щих друг к другу областей выделе-
ния. Хотя области выделения могут 
находиться в разных частях изобра-
жения, они могут действовать как 
одна область. Например, если вы 
примените фильтр, его эффект будет 
виден во всех областях выделения.

3 Для расширения области выделения 
нажмите и  удерживайте клавишу 
Shift, а  затем используйте инстру-
мент Лассо (Lasso), чтобы быстро 
обвести небольшие участки, которые 
обычно пропускает инструмент Вол-
шебная палочка (Magic Wand).

4 Чтобы вычесть участок из выде-
ленной области, нажмите и удер-
живайте клавишу Alt/�, а затем, 
нажав и удерживая кнопку мыши, 
перетащите, пересекая существую-
щую выделенную область. Участок, 
заданный пересекающейся рамкой, 
будет удален из исходного выделения.

Чтобы изменить существующую 
область выделения, выберите 
инструмент выделения, а затем 
нажмите кнопку Добавить к… 
(Add to…), Вычитание из… 
(Subtract from…) или Пересече-

ние с выделенной областью 
(Intersect with Selection) на пане-
ли параметров. Эти настройки 
останутся действующими для 
инструмента.

Следует повторно щелкнуть 
по кнопке Новая выделен-

ная область (New Selection), 
чтобы настройки предыдущего 
инструмента не привели к не-
ожиданному результату при его 
следующем применении.

В случае со сложными областя-
ми выделения бывает полезно 
временно скрыть пунктирную 
рамку, чтобы более четко раз-
глядеть выделенные пиксели. 
Выберите команду меню Про-

смотр → Показать → Границы 

выделенных областей (View → 
Show → Selection Edges), чтобы 
скрыть границу выделенной 
области. Выделенная область 
останется активной, но ее 
граница будет скрыта. Выберите 
тот же пункт меню, чтобы снова 
отобразить границу выделен-
ной области.
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Смежные пиксели  
и Подобные оттенки
Команды Смежные пиксели (Grow) и Подобные оттенки (Similar) бы-
вают очень полезны при использовании в сочетании с инструментом 
Волшебная палочка (Magic Wand) для расширения области выделе-
ния. Действие обеих команд связано со значением параметра Допуск 
(Tolerance), установленного для инструмента Волшебная палочка 
(Magic Wand) на панели параметров.

Команда Смежные пиксели (Grow) выделяет смежные или прилегаю-
щие друг к другу области цвета, исходя из значения параметра Допуск 
(Tolerance), установленного на  панели параметров для инструмента 
Волшебная палочка (Magic Wand).

1 Создайте область выделения. Убеди-
тесь в том, что на панели параметров 
для инструмента Волшебная палочка 
(Magic Wand) установлено нужное зна-
чение параметра Допуск (Tolerance).

2 Выберите команду меню Выделение → 
Смежные пиксели (Select → Grow), что-
бы добавить в существующее выделение 
пиксели, которые попадают в диапазон, 
определенный значением параметра До-
пуск (Tolerance) и являются смежными 
с уже выделенными пикселями.

Команда Подобные оттенки (Similar) обеспечивает выбор несмежных 
пикселей, которые попадают в диапазон, определенный значением па-
раметра Допуск (Tolerance).

1 Создайте выделенную область, ис-
пользуя любой инструмент выде-
ления. Удостоверьтесь в том, что 
на панели параметров инструмента 
Волшебная палочка (Magic Wand) 
установлено подходящее значение 
параметра Допуск (Tolerance).

2 Выберите команду меню Выделение → 
Подобные оттенки (Select → Similar), 
чтобы выбрать пиксели по всему изо-
бражению, попадающие в диапазон, 
определенный значением параметра 
Допуск (Tolerance).

При необходимости измените 
значение параметра Допуск 
(Tolerance) для инструмента 
Волшебная палочка (Magic 
Wand) перед использованием 
команды Смежные пиксели 
(Grow), чтобы обеспечить более 
подходящий результат.

Использование инструмента 
Волшебная палочка (Magic 
Wand) при сброшенном флажке 
Смежные пиксели (Contiguous) 
на панели параметров эквива-
лентно использованию коман-
ды Подобные оттенки (Similar).
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Вставка  
в выделенную область
Вставка в выделенную область может быть полезна при комбинирова-
нии изображений.

1 Создайте область выделения в окне назначения.

2 Откройте исходный документ, а затем создайте выделение, кото-
рое вы хотите вставить в документ назначения. Выберите коман-
ду меню Редактирование → Копировать (Edit → Copy), чтобы 
скопировать выделение в буфер обмена.

3 Щелкните кнопкой мыши в  окне назначе-
ния. Выделение должно быть по-прежне-
му активно. Выберите команду меню Ре-
дактирование → Специальная вставка → 
Вставить в (Edit → Paste Special → Paste Into), 
чтобы вставить содержимое буфера обмена 
в выделенную область.

4 Используйте инструмент Перемещение 
(Move), чтобы переместить вставленное вы-
деление относительно исходной выделенной 
области.

5 Команда Вставить в  (Paste Into) 
создает слой-маску. Слой является 
активным, на  что указывает гра-
ница вокруг миниатюры на панели 
Слои (Layers). Это говорит о  воз-
можности редактирования слоя. 
Для редактирования маски щелкните мышью по ее миниатюре 
на панели Слои (Layers). Вокруг появится граница, указывающая 
на то, что слой-маска выделен.

При вставке в выделенную 
область содержимое буфера об-
мена отображается в разреше-
нии документа назначения. Это 
означает, что размер выделе-
ния, скопированного из исход-
ного документа, изменяется при 
наличии разницы в разрешении 
этих двух документов.

Убедитесь в том, что слой-маска 
выделен, а затем нарисуйте 
черным цветом, чтобы доба-
вить к маске, или белым —  для 
вычитания из нее (см. раздел 
«Слои-маски» главы 11).
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Заливка  
выделенной области
Вы можете использовать диалоговое окно Заполнить (Fill) для заполне-
ния всего слоя или выделенной области.

1 Чтобы заполнить выделенную область, сначала необходимо 
определить нужный основной или фоновый цвет, а затем создать 
выделение. Выберите команду меню Редактирование → Выпол-
нить заливку (Edit → Fill). Выберите тип заполнения в раскры-
вающемся списке Содержание (Use). Вы также можете задать 
значение параметра Непрозрачность (Opacity) и определить ре-
жим наложения. Щелкните мышью по кнопке ОК.

2 Чтобы заполнить выделенную область 
узором, сначала выберите рисунок для 
узора, а  затем используйте команду 
меню Редактирование → Определить 
узор (Edit → Define Pattern).

3 Создайте выделение, которое хотите 
заполнить выбранным узором.

4 Выберите 
команду 
меню Редак-
тирование →  
Выполнить 
заливку 
(Edit → Fill). 
Выберите вариант Регулярный 
(Pattern) в раскрывающемся списке 
Содержание (Use). Используйте 
раскрывающийся список Заказной 
узор (Custom Pattern) для получе-
ния доступа к библиотеке узоров. Выберите рисунок. Щелкните 
мышью по кнопке ОК в диалоговом окне, чтобы заполнить 
узором выделенную область.

Режимы наложения описаны 
в разделе «Режимы наложения» 
главы 5.

Если вы не создадите выде-
ление перед использованием 
команды Выполнить заливку 
(Fill), то заполнен будет весь 
слой.
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Заполнение с учетом содержимого

Вариант заполнения С  учетом со-
держимого (Content-Aware) в  рас-
крывающемся списке Содержание 
(Use) позволяет быстро добавить 
в  изображение отсутствующие де-
тали и  обеспечить бесшовное уда-
ление нежелательных пикселей.

1 Чтобы добавить в  изображение области, исходя из  уже суще-
ствующих в  нем деталей, сначала создайте выделение, охваты-
вающее область отсутствующей детали так, чтобы она немного 
перекрывала существующую деталь.

2 Выберите команду меню Редактирование → Выполнить залив-
ку (Edit → Fill). Выберите пункт С учетом содержимого (Content-
Aware) в  раскрывающемся списке Содержание (Use), а  затем 
щелкните мышью по кнопке ОК.

3 Чтобы удалить деталь из изображения, создайте вокруг нее об-
ласть выделения, а затем используйте вариант С учетом содер-
жимого (Content-Aware) в диалоговом окне Заполнить (Fill).

Установите флажок Цветовая 

адаптация (Color Adaptation), 
чтобы использовать адаптив-
ные алгоритмы смешивания 
цвета заливки с окружающей 
областью изображения.
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Копирование и вставка 
выделенной области
Вы можете использовать буфер обмена для копирования и вставки вы-
деленных областей в то же самое или другое изображение. Вы также 
можете перетаскивать выделенные области между изображениями.

1 Чтобы скопировать выделение, сначала со-
здайте его с  помощью соответствующего 
инструмента. Выберите команду Редакти-
рование → Копировать (Edit → Copy).

2 Чтобы вставить выделенную область 
в то же самое изо-
бражение, выберите 
команду Редактирова-
ние → Вставить (Edit → 
Paste). Выделение 
будет вставлено в изо-
бражение на новый 
отдельный слой. (Для 
получения информации о работе со слоя-
ми обратитесь к главе 8.)

3 Чтобы вставить выделенную область 
в другое уже открытое изображение, 
щелкните мышью в его окне, чтобы 
сделать его активным. Выберите команду 
Редактирование →  
Вставить (Edit → Paste), чтобы 
вставить выделенную область 
из буфера обмена на новый слой 
активного изображения.

4 Вы также можете перетащить 
выделение из одного плавающе-
го окна изображения в  другое. 
Вам нужно иметь два открытых 
окна —  источник и целевое окно. 
Создайте область выделения 
в  окне-источнике, выберите ин-
струмент Перемещение (Move), 
установите указатель мыши 
в  выделенную область, а  затем, 
нажав и удерживая кнопку мыши, перетащите выделение в це-
левое окно. Выделение отобразится на своем собственном слое.

Полезной техникой для выде-
ления простого объекта, такого, 
как цветок в этом примере, 
является применение команды 
Инверсия (Inverse). Исполь-
зуйте инструмент Волшебная 

палочка (Magic Wand) для вы-
деления фона, а затем выберите 
команду меню Выделение → 
Инверсия (Select → Inverse), что-
бы обратить выделение. Теперь 
области, которые представляют 
собой цветок, выделены.

При работе с окнами изображе-
ний, представленными вклад-
ками, вы можете перетащить 
выделение из одного изображе-
ния в другое. Для этого убеди-
тесь в том, что вы работаете 
с инструментом Перемещение 
(Move). Перетащите выделен-
ную область из исходного 
документа на вкладку с именем 
документа назначения. Когда 
вкладка с именем документа 
назначения станет активной, пе-
ретащите указатель мыши вниз 
в окно изображения, а затем 
отпустите кнопку мыши.

При копировании и вставке 
содержимого в то же самое 
изображение вставленное со-
держимое появляется на новом 
слое в том же самом месте, что 
и скопированный оригинал. 
В данном примере вставлен-
ный цветок смещен с исходной 
позиции для того, чтобы копия 
была четко видна на рисунке.
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Область фокусировки
Диалоговое окно Область фокусировки (Focus Area) позволяет созда-
вать области выделения, исходя из участков изображения, которые на-
ходятся в фокусе. Это быстрый и эффективный способ выделения, по-
зволяющий изолировать находящийся в фокусе передний план от фона.

1 Выберите команду меню Выделение → Область фокусировки 
(Select → Focus Area). Появится одноименное диалоговое окно, 
программа Photoshop автоматически начнет анализировать изо-
бражение на предмет находящихся в фокусе областей и отобра-
зит результаты на белом фоне.

2 Используйте раскрываю-
щийся список Вид (View) 
для просмотра результатов 
на разном фоне, что позво-
лит вам оценить проблем-
ные области, которые вам, 
вероятно, следует отредак-
тировать для достижения 
лучшего результата. Напри-
мер, применение к данному 
цветку режима Черно-бе-
лое (Black & White) показы-
вает невыделенные области 
цветка. Вы можете исполь-
зовать инструмент Добавление области 
фокусировки (Focus Area Add), чтобы 
выделить эти области вручную.

3 Используйте инструмент Добавление об-
ласти фокусировки (Focus Area Add) ( ),  
чтобы вручную добавить области к первоначальному выделению. 
Используйте инструмент Вычитание области фокусировки 
(Focus Area Subtract) ( ) для удаления областей из выделения.

Создайте копию оригинального 
фонового слоя, а затем приме-
ните диалоговое окно Область 

фокусировки (Focus Area) 
к скопированному слою —  это 
позволит вам легко вернуться 
к оригинальному изображению 
или использовать пиксели ори-
гинального изображения для 
восстановления проблемных 
областей.

Установите флажок Просмотр 

(Preview), чтобы переключаться 
между исходным изображени-
ем и выделением для оценки 
состояний «до» и «после».

Вы можете использовать ком-
бинации клавиш Ctrl/�+Z для 
отмены/повтора последнего 
действия, совершенного в диа-
логовом окне Область фокуси-

ровки (Focus Area).



7
. 

В
ы

д
е

л
е

н
и

е
1

4
0

4 В разделе Атрибуты слоя (Parameters) для параметра Сфокуси-
рованный диапазон (In-Focus Range) по умолчанию установлен 
флажок Авто (Auto). Чтобы вручную настроить значение дан-
ного параметра, перетащите ползунковый регулятор влево для 
включения менее сфокусированных областей изображения или 
право —  для создания более ограниченной области выделения, 
основываясь на областях, находящихся в фокусе.

5 При необходи-
мости щелк-
ните мышью 
по треугольнику в разделе Дополнительно (Advanced), чтобы 
отобразить ползунковый регулятор Уровень шума изображе-
ния (Image Noise Level). Если в «шумном» изображении выделе-
но слишком много нежелательного шума, перетащите данный 
ползунковый регулятор вправо для удале-
ния шума из области выделения.

6 Установите флажок Смягчить 
край (Soften Edge), чтобы 
немного растушевать край вы-
деленной области.

7 Щелкните мышью по  кнопке 
Уточнить край (Refine Edge) для открытия 
соответствующего диалогового окна и дальнейшего уточнения 
первоначального выделения. После щелчка по кнопке ОК в диа-
логовом окне Уточнить край (Refine Edge) вы вернетесь в окно 
изображения, а  не  в  диалоговое окно Область фокусировки 
(Focus Area). См.  также раздел «Растушевка выделенной обла-
сти» данной главы для получения информации об использова-
нии диалогового окна Уточнить край (Refine Edge).

При использовании инстру-
ментов Добавление области 

фокусировки (Focus Area Add)/
Вычитание области фокуси-

ровки (Focus Area Subtract) вы 
можете использовать клавиши 
[и] для уменьшения и увеличе-
ния размера кисти с заданным 
шагом.

Шум может проявиться 
в изображении как область 
изменения пикселей или в виде 
цветовых артефактов, которые 
не являются деталью изображе-
ния, и поэтому нежелательны.

Чаще всего в изображениях 
появляется либо яркостный 
шум, делающий изображение 
внешне неоднородным, либо 
цветовой шум, из-за которого 
в картинке возникают хаотич-
ные цветовые артефакты.

 �

!����
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Трансформирование 
выделенной области
Широкие возможности преобразования и настройки рамки выделения 
позволят вам создать область выделения любой сложности.

1 Чтобы преобразовать выделение, выберите команду меню Вы-
деление → Трансформировать выделенную область (Select → 
Transform Selection). Вокруг выделенной области появится огра-
ничительный прямоугольник с  восемью маркерами. В  центре 
ограничительной рамки появится опорная точка.

2 Для масштабирования области выделения, на-
жав и удерживая кнопку мыши на маркере, пе-
ретащите его. Указатель мыши примет вид дву-
направленной стрелки. Для пропорционального 
масштабирования нажмите и удерживайте кла-
вишу Shift при перетаскивании углового маркера.

3 Чтобы повернуть выделенную область, устано-
вите указатель мыши сразу за ее границей. Он 
примет вид двунаправленной изогнутой стрел-
ки. Нажав и  удерживая кнопку мыши, перета-
щите ее по кругу.

4 Для искажения границы выделенной области 
перетащите угловой маркер, удерживая нажа-
той клавишу Ctrl/�.

5 Для применения эффекта перспективы к грани-
це выделенной области нажмите и удерживайте 
клавиши Ctrl/�+Alt/�+Shift, а  затем перета-
щите угловой маркер.

6 Для сдвига границы выделенной области на-
жмите и удерживайте клавишу Ctrl/�, а затем, 
нажав и удерживая кнопку мыши, перетащите 
центральный верхний/нижний или централь-
ный левый/правый маркер.

7 Щелкните мышью по  кнопке Отмена (Cancel) 
на  панели параметров, чтобы отклонить изме-
нения. Нажмите кнопку Подтвердить (Commit), 
чтобы применить преобразование.

Команда Трансформиро-

вать выделенную область 
(Transform Selection) оказывает 
влияние только на границу 
выделенной области. Она 
не преобразует находящиеся 
в ее пределах пиксели.

Перетащите опорную точку ( )  
в новую позицию, чтобы опре-
делить точку, вокруг которой 
будет происходить трансформи-
рование.

Нажмите клавишу Enter, чтобы 
принять преобразование. 
Нажмите клавишу Esc, чтобы 
отказаться от изменений. Вы 
также можете дважды щелкнуть 
в пределах рамки трансфор-
мирования, чтобы принять 
преобразование.



8 Слои

Слои обеспечивают 
большую гибкость при 

работе с изображением. 
Они позволяют держать 

различные элементы 
изображения отдельно 
друг от друга, так что 

вы можете изменять 
пиксели в одном слое, 

не затрагивая пиксели 
другого. Дополнительные 
слои увеличивают размер 

файла изображения. 
По окончании 

редактирования вы 
можете выполнить 

сведение, чтобы 
объединить все слои 

в единый фоновый слой.

Работа со слоями

Сведение и объединение слоев

Перемещение слоев между изображениями

Выделение и связывание слоев

Закрепление слоев

Группы слоев

Стили слоя

Трансформирование слоев

Создание слоев

Смарт-объекты

Связанные смарт-объекты

Деформация

Автоматическое выравнивание  

и наложение слоев

Стили

Масштабирование с учетом содержимого

Марионеточная деформация

Деформация перспективы
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Работа со слоями
При первичном открытии или создании, изображение по умолчанию 
состоит из одного слоя, называемого фоновым и обозначаемого на па-
нели Слои (Layers) именем Фон (Background). Фоновый слой закреплен 
по умолчанию.

1 Чтобы создать новый 
слой, выберите пункт 
Новый слой (New 
Layer) в меню ( ) 
панели Слои (Layers). 
Введите имя нового слоя в соответствующее поле ввода. При 
необходимости на данном этапе вы также можете задать значе-
ния параметров Непрозрачность (Opacity) и Режим (Blending).

2 Кроме того, вы може-
те создать новый слой 
с настройками по умолчанию, щелкнув один раз по кнопке Создать 
новый слой (New Layer) в    нижней части панели Слои (Layers). 
Для получения доступа к диалоговому окну Новый слой (New 
Layer) щелкните мышью по значку Создать новый слой (New 
Layer), удерживая нажатой клавишу Alt/�.

3 Щелкните мышью по  кнопке ОК в  диалоговом окне. Так вы со-
здадите новый пустой слой, который отобразится на панели Слои 
(Layers) над ранее активным слоем. Также обратите внимание на то, 
что при рисовании в этом слое и при добавлении в него пикселей, 
размер файла, указанный в строке состояния, увеличивается.

4 Чтобы переименовать слой, установите указатель мыши на его имя, 
а затем дважды щелкните мышью по нему кнопкой мыши. Введите 
новое имя в поле ввода, а затем нажмите клавишу Enter/�.

5 Чтобы удалить активный слой, 
выберите пункт Удалить слой 
(Delete Layer) в меню пане-
ли Слои (Layers). Щелкните 
мышью по кнопке Да (Yes) 
или Нет (No) в появившемся 
окне с предупреждением. Или 
перетащите имя слоя на зна-
чок в виде мусорной корзины 
в нижней части панели Слои 
(Layers). В этом случае сооб-
щение с предупреждением 
не появится.

Новые слои создаются автома-
тически при использовании тек-
стового инструмента, когда вы 
перетаскиваете или копируете 
в изображение выделенную об-
ласть из другого файла, а также 
при перетаскивании слоя из од-
ного документа в другой.

Одним из наиболее полезных 
методов создания нового слоя 
является выделение всей или 
нужной области изображения 
на фоновом слое и выбор 
пункта меню Слои → Новый → 
Скопировать на новый слой 
(Layer → New → Layer Via Copy) 
(Ctrl/�+J). Выделенные пиксели 
будут скопированы на но-
вый слой. Теперь вы можете 
редактировать и преобразо-
вывать пиксели на новом слое, 
не затрагивая оригинальные 
пиксели фонового слоя.
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Выделение, сокрытие и отображение слоев

Вы можете рисовать, редактировать пиксели или производить настрой-
ку цветов только на одном слое, который часто называется «целевым» 
или активным слоем.

1 Щелкните мышью по имени слоя на панели Слои (Layers), чтобы 
сделать слой активным. Имя активного слоя отобразится в стро-
ке заголовка окна изображения.

2 Чтобы скрыть содержимое слоя, щелкните мышью 
по  переключателю видимости слоя в  левом столб-
це панели Слои (Layers). Чтобы отобразить слой, 
щелкните мышью по  пустому квадрату, чтобы вер-
нуть индикатор видимости ( ).

Изменение порядка очередности слоев

Очередность расположения слоев определяет внешний вид изображе-
ния, которое они составляют. Вы не можете изменить расположение 
фонового слоя в «стопке» слоев. Однако часто бывает необходимо изме-
нить порядок очередности других слоев, чтобы определить, какие слои 
должны находиться поверх других.

Чтобы изменить порядок очередности слоя, 
нажав и  удерживая кнопку мыши на  его 
имени, перетащите слой в новую позицию. 
Обратите внимание на  горизонтальную 
полосу, которая появляется при перемеще-
нии слоя вверх или вниз. Отпустите кноп-
ку мыши, когда данная горизонтальная 
полоса окажется в нужном месте.

Перемещение  
содержимого слоя

Вы можете перемещать все содержимое 
слоя с помощью инструмента Перемещение (Move).

Щелкните мышью по  слою, который нужно передвинуть, на  панели 
Слои (Layers). Выберите инструмент Перемещение (Move), а  затем 
установите курсор на любую часть изображения. Нажав и удерживая 
кнопку мыши, перетащите курсор, чтобы переместить слой.

Щелкните мышью по переклю-
чателю видимости ( ), чтобы 
скрыть/отобразить группу 
слоев и стиль слоя.

Чтобы выделить все пиксели 
слоя, щелкните мышью по ми-
ниатюре слоя на панели Слои 
(Layers), удерживая нажатой 
клавишу Ctrl/�.

Вы можете перемещать со-
держимое выделенного слоя 
с шагом в 1 пиксель, выбрав ин-
струмент Перемещение (Move) 
и используя клавиши �, �, � и �

Обратите внимание на панель 
с показаниями, которая появля-
ется при перетаскивании слоя. 
Данная панель отображает 
величину вертикального и гори-
зонтального смещения и по-
могает вам добиться нужной 
точности при работе.
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Сведение  
и объединение слоев
Используйте команды Объединить (Merge) для объединения двух или 
более слоев в один слой. Это полезно для консолидации элементов раз-
личных слоев в единый управляемый слой или блок, а также для пред-
отвращения сильного увеличения размера файла.

1 Чтобы объединить все 
видимые слои в докумен-
те, сначала скройте те слои, 
которые вы не хотите объ-
единять. Убедитесь в том, что 
один из слоев, нуждающихся 
в объединении, активен, а за-
тем выберите в меню ( )  
панели пункт Объединить 
видимые (Merge Visible) или 
выполните команду меню 
Слои → Объединить види-
мые (Layer → Merge Visible).

2 Чтобы объединить слой 
с находящимся под ним 
слоем, сначала выберите слой, 
а затем выберите в меню 
панели пункт Объединить 
с предыдущим (Merge Down) 
или выполните команду меню 
Слои → Объединить с преды-
дущим (Layer → Merge Down).

Сведение слоев изображения

При сведении слоев у вас остается только фоновый слой. Это приво-
дит к уменьшению размера файла. Выполните сведение слоев изобра-
жения, когда вы закончите работу по созданию и позиционированию 
элементов композиции и будете готовы сохранить файл в подходящем 
формате для дальнейшего использования в программе предпечатной 
подготовки или других целей.

Перед сведением слоев убедитесь, что все нужные слои видимы. Выбе-
рите пункт Выполнить сведение (Flatten Image) в меню панели Слои 
(Layers) или выберите команду меню Слои → Выполнить сведение 
(Layer → Flatten Image).

Команда Объединить види-

мые (Merge Visible) в меню па-
нели производит объединение 
только видимых в настоящий 
момент слоев.

При применении команды 
Выполнить сведение (Flatten 
Image) к документу, с котором 
есть скрытые слои, появится 
окно с запросом:

Щелкните мышью по кнопке 
ОК, чтобы выполнить сведение 
и удалить скрытые слои. Щелк-
ните мышью по кнопке Отмена 
(Cancel), чтобы вернуться к изо-
бражению без сведения слоев.

При изменении режима изобра-
жения вам будет предложено 
выполнить сведение. Сначала 
сохраните копию файла, чтобы 
иметь возможность изменить 
слои в будущем.



1
4

7

Перемещение слоев между 
изображениями
При работе с плавающими окнами (Окно → Упорядочить → Свобод-
но перемещать все окна (Window → Window Arrange → Float All in 
Windows)) вы можете скопировать целый слой из  одного документа 
Photoshop в другой подобно тому, как вы перемещаете из одного доку-
мента в другой выделенную область.

1 Убедитесь в том, что у вас 
есть два открытых доку-
мента —  документ-ис-
точник и «целевой» доку-
мент. Документ-источник 
содержит слой, который 
вы хотите скопировать. 
Целевой документ —  это то изображение, 
в которое вы хотите поместить скопиро-
ванный слой.

2 Щелкните кнопкой мыши 
в окне документа-источ-
ника, чтобы сделать его 
активным. Установите 
указатель мыши на слой 
на панели Слои (Layers), 
а затем перетащите слой, 
который вы хотите скопи-
ровать, из документа-ис-
точника в окно целевого 
документа. При этом 
затемненный слой будет 
соответствовать копируе-
мому.

3 Расположите слой, а затем 
отпустите кнопку мыши. 
Слой будет помещен по-
верх ранее активного слоя 
на панели Слои (Layers) це-
левого документа. Целевой 
документ станет активным 
окном изображения.

Слой, который вы перемещаете 
в целевое окно, отображается 
в разрешении, используемом 
в данном окне. Это может 
привести к тому, что элементы 
на перемещенном слое окажут-
ся больше или меньше по срав-
нению с оригинальным окном. 
Чтобы избежать сюрпризов, 
убедитесь в том, что исходный 
и целевой документ имеют одно 
и то же разрешение. Кроме того, 
если режимы двух изображе-
ний различаются между собой, 
то перемещаемый слой пре-
образуется в режим целевого 
документа.

При необходимости используйте 
команду Убрать кайму (De-
fringe) (выберите команду меню 
Слои → Обработка краев →  
Убрать кайму (Layer → Matting →  
Defringe)) для удаления каймы 
вокруг пикселей слоя, который 
вы скопировали из одного изо-
бражения в другое.
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Выделение  
и связывание слоев
Выделение нескольких слоев приводит к созданию временной группы, 
позволяющей одновременно манипулировать двумя и  более слоями. 
Связывание слоев поддерживает группировку слоев до  момента их 
разъединения. Вы можете перемещать, выравнивать и трансформиро-
вать несколько выделенных или связанных слоев, а также применять 
стили, используя панель Styles (Стили).

1 Для выделения нескольких 
идущих подряд слоев выберите 
первый слой, а затем, удержи-
вая нажатой клавишу Shift, 
щелкните мышью по послед-
нему слою диапазона. Для 
выделения нескольких слоев, 
не идущих по порядку, выбери-
те первый слой, а затем, удер-
живая нажатой клавишу Ctrl/�, щелкните 
мышью по каждому слою, который вы 
хотите выделить.

2 Чтобы удалить несколько выделенных слоев, щелкните мышью 
по любому слою на панели Слои (Layers). Или щелкните мышью 
по пустой области под самым нижним слоем на панели.

3 Чтобы связать слои, выделите два или более 
последовательных или не идущих по поряд-
ку слоя. Затем щелкните мышью по кнопке 
Связать (Link) ( ) в нижней части пане-
ли Слои (Layers). Справа от связанного слоя 
появится соответствующий значок. При 
выделении связанного слоя на панели Слои 
(Layers) рядом со всеми другими связанными с ним слоями отобра-
жается значок, указывающий на то, что они связаны между собой.

4 Чтобы отменить связь для одного слоя, выберите его, а  затем 
щелкните мышью по  кнопке Связать (Link). Остальные слои 
в наборе останутся связанными.

5 Чтобы отменить связь между всеми слоями в  наборе, выбери-
те каждую ссылку вручную или выделите один связанный слой, 
а затем выберите команду меню Слои → Выделить связанные 
слои (Layer → Select Linked Layers). Щелкните мышью по кнопке 
Связать (Link), чтобы отменить связь между слоями.

Свяжите слои, если вам нужно 
сохранить элементы изобра-
жения на отдельных слоях, 
но требуется редактировать их 
как единое целое.

Используйте инструмент Пере-

мещение (Move) для перемеще-
ния элементов всех связанных 
слоев.

Выберите команду меню Вы-

деление → Все слои (Select → 
All Layers), чтобы выделить все 
слои в изображении; выберите 
пункт Выделение → Отменить 

выделение слоев (Select → 
Deselect Layers), чтобы снять 
выделение со всех слоев.
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Закрепление слоев
Существуют четыре вида закрепления, которые вы може-
те применить к  слоям. При выборе одного из вариантов 
закрепления справа от  названия слоя появляется зна-
чок в виде затененного замка. Когда слой полностью закреплен, 
значок замка заполнен сплошным цветом. Фоновый слой закреплен 
по умолчанию.

1 Чтобы полностью закрепить слой, вы-
делите его на  панели Слои (Layers), а  за-
тем щелкните мышью по кнопке Закрепить все (Lock All). Вы 
не сможете переместить слой или внести какие-либо изменения, 
включая режим наложения, непрозрачность и стиль.

2 Чтобы предотвратить смещение слоя 
с помощью инструмента Перемещение 
(Move), щелкните мышью по кнопке Закрепить положение 
(Lock Position).

3 Чтобы предотвратить применение к слою 
инструментов рисования, выберите вари-
ант Закрепить цвета пикселей (Lock Image Pixels). В этом случае 
вы по-прежнему сможете редактировать любую примененную 
к  слою маску и  перемещать слой. Выбор варианта Закрепить 
цвета пикселей (Lock Image) автоматически блокирует прозрач-
ность слоя.

4 Щелкните мышью по  кноп-
ке Закрепить прозрач-
ность (Lock Transparency) 
для закрепления прозрач-
ных областей слоя. Вы можете изменять существующие пиксели 
слоя, но не можете вносить изменения в какие-либо прозрачные 
области. Например, при выборе варианта Закрепить прозрач-
ность (Lock Transparency) фильтры для обеспечения размыто-
сти, примененные к  слою, работают неэффективно, поскольку 
пиксели не могут распространяться в области прозрачности для 
создания эффекта размытия.

Когда фоновый слой скрыт, про-
зрачные области слоя заполне-
ны узором в виде шахматной 
доски.

Вы можете изменить порядок 
следования закрепленных 
слоев, но не можете удалить 
полностью закрепленный слой.

Настройки Закрепить про-

зрачность (Lock Transparency) 
и Закрепить цвета пикселей 
(Lock Image Pixels) автома-
тически включены для всех 
текстовых слоев. Вы не можете 
отключить их.
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Группы слоев
При создании сложных изображений, содержащих несколько слоев, 
можно упорядочить содержимое панели Слои (Layers) путем объеди-
нения соотносящихся между собой слоев в группу. Создание группы 
слоев при работе со сложными многослойными изображениями упро-
щает процесс управления элементами.

1 Для создания новой группы слоев щелк-
ните мышью по кнопке Создать новую 
группу (Create New Group) ( ) в ниж-
ней части панели Слои (Layers), чтобы 
использовать текущие 
параметры по умол-
чанию, или выберите 
пункт Новая группа 
(New Group) в меню панели.

2 Чтобы создать группу из существующих слоев, сначала выдели-
те нужные слои. Выберите пункт Новая группа из слоев (New 
Group from Layers) в меню панели Слои (Layers) ( ) или коман-
ду меню Слои → Новый → Группа из слоев (Layer → New → Group 
from Layers).

3 Чтобы переместить слой в группу, 
перетащите его на папку группы 
слоев. Отпустите кнопку мыши, 
когда эта папка окажется выделена. 
Перемещенный слой будет рас-
положен под слоями, уже нахо-
дящимися в группе. Если группа 
слоев развернута, перетащите слой 
в нужное положение. 
Отпустите кнопку 
мыши, когда полоса 
окажется в соответ-
ствующей позиции.

4 Щелкните мышью 
по треугольнику слева 
от названия группы, 
чтобы отобразить или 
скрыть слои, содержа-
щиеся в группе.

В диалоговом окне Новая груп-

па из слоев (New Group from 
Layers) в раскрывающемся спис-
ке Режим (Mode) оставьте вы-
бранным вариант Пропустить 
(Pass Through), чтобы гаранти-
ровать применение параметров 
наложения и непрозрачности 
ко всем слоям в изображении, 
а не только к слоям в наборе.

Чтобы вложить одну группу 
слоев в другую, перетащите 
подлежащую вложению группу 
на существующую папку с груп-
пой слоев.

Чтобы удалить папку группы, 
не удаляя содержащихся в ней 
слоев, выберите команду 
Удалить группу (Delete Group) 
в меню панели. В диалоговом 
окне подтверждения щелкните 
мышью по кнопке Только груп-

па (Group Only).
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Стили слоя
Используйте диалоговое окно Стиль слоя (Layer Style), чтобы легко 
и быстро создать такие сложные эффекты, как тени, тиснение, а также 
внутреннее и внешнее свечение. В следующем примере используется 
изображение, состоящее из  трех слоев  —  белого фона, слоя фигуры 
с  цветным кругом, а  также слоя фигуры с  цветным треугольником. 
В этом примере для демонстрации принципов создания стиля слоя ис-
пользуется стиль Тиснение (Bevel & Emboss).

1 Для применения стиля щелкните мышью по  слою на  панели 
Слои (Layers), чтобы сделать его активным. Выберите команду 
меню Слои → Стиль слоя → Тиснение (Layer → Layer Style → Bevel 
& Emboss). В группе элементов управления Структура (Structure) 
выберите подходящие варианты в  раскрывающихся списках 
Стиль (Style) и  Метод (Technique). Установите переключатель 
в  положение Вверх (Up) или Вниз (Down), чтобы подсветить 
эффект сверху или снизу.

2 Используйте поле ввода или ползунковый регулятор Глубина 
(Depth), чтобы отрегулировать высоту эффекта. Используйте 
ползунковый регулятор Размер (Size), чтобы настроить размер 
скоса. Ползунковый регулятор Смягчение (Soften) контролирует 
интенсивность эффекта и помогает уменьшить неровности или 
артефакты для обеспечения плавного 
результата.

3 В группе элементов управления Затенение (Shading) введите 
значение в поле ввода Угол (Angle), чтобы контролировать на-
правление источника света. Введите значение в поле ввода Вы-
сота (Altitude), чтобы определить очевидную глубину источника 
света. Если вы предпочитаете настраивать данные параметры 
вручную, нажав и удерживая кнопку мыши, перетащите указа-
тель мыши по диску Угол (Angle)/Высота (Altitude).

Вы также можете выбрать стиль 
слоя, используя кнопку До-

бавить стиль слоя (Add Layer 
Style) в нижней части панели 
Слои (Layers).

Убедитесь в том, что в диало-
говом окне Стиль слоя (Layer 
Style) установлен флажок Про-

смотр (Preview), чтобы увидеть 
эффект применения стиля 
к изображению в процессе 
настройки его параметров.

Каждый стиль слоя предусма-
тривает диапазон параметров, 
характерных для данного стиля. 
Поэкспериментируйте с этими 
параметрами для достижения 
нужного эффекта.
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4 Параметр Контур глянца (Gloss Contour) позволяет изменить 
характер перехода эффекта по затронутым пикселям слоя.

5 Настройте параметры Ре-
жим подсветки (Highlight) 
и Режим тени (Shadow). 
Хорошей идеей является 
сохранение изначальных 
вариантов Экран (Screen) 
и Multiply (Умножение) соответственно. Поэкспериментируйте 
с ползунковыми регуляторами Непрозрачность (Opacity) для 
более точной настройки эффекта.

6 Щелкните мышью по кнопке ОК 
в диалоговом окне, когда будете 
довольны результатами. На пане-
ли Слои (Layers) обратите внима-
ние на значок ([зн]), 
указывающий на то, 
что к слою применен 
эффект. Пока этот 
значок присутствует, 
эффект остается доступным для 
редактирования.

Управление стилями слоя

После создания стиля слоя вы можете продолжить редактирование эф-
фектов и использовать параметры в диалоговом окне Стиль слоя (Layer 
Style) для управления ими.

1 Для изменения параме-
тров стиля слоя выбери-
те слой, а затем щелкните 
мышью по треугольнику 
Развернуть (Expand), чтобы отобразить эффекты слоя в ка-
честве отдельных элементов на панели Слои (Layers). Дважды 
щелкните мышью по названию эффекта, который вы хотите 
отредактировать. Для достижения желаемого результата вы 
можете настраивать параметры сколь угодно часто.

2 Чтобы обеспечить один и тот же угол источника света при при-
менении эффектов более чем к  одному слою, выберите пункт 
Слои  → Стиль слоя → Глобальное освещение (Layer → Layer 
Style  → Global Light). Введите значение в  поле Угол (Angle). 

Вы не можете применить стиль 
к фоновому или закрепленному 
слою.

Щелкните мышью по пере-
ключателю видимости слева 
от названия эффекта, чтобы 
отобразить или скрыть его.

Щелкните мышью по треуголь-
нику Развернуть (Expand)/
Свернуть (Collapse), чтобы 
отобразить или скрыть приме-
ненные к слою стили:
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Щелкните мышью по кнопке 
ОК в  диалоговом окне. Убе-
дитесь в том, что в диалого-
вом окне Стиль слоя (Layer 
Style) установлен флажок 
Глобальное освещение (Use 
Global Light) при примене-
нии эффектов к нескольким 
слоям.

3 Чтобы скопировать кон-
кретные параметры стиля 
одного слоя для применения 
их к другому слою, сначала 
выделите слой с эффектом, 
а затем выберите пункт 
Скопировать стиль слоя 
(Copy Layer Style) в подменю 
Стиль слоя (Layer Style). Щелкните мышью по другому слою 
на панели Слои (Layers). Выберите пункт Вставить стиль слоя 
(Paste Layer Style) в подменю Стиль слоя (Layer Style).

4 Чтобы безвозвратно удалить стили 
слоя, убедитесь в том, что вы 
выбрали соответствующий слой, 
а затем используйте команду меню 
Слои → Стиль слоя → Очистить 
стили слоя (Layer → Layer Style → 
Clear Layer Styles).

5 Стили слоя позволя-
ют автоматизировать 
выполнение процедур, 
которые раньше вам 
приходилось выпол-
нять самостоятельно. 
Используйте команду 
Создать слои (Create 
Layer) из подменю Стиль 
слоя (Layer Style), чтобы 
разделить эффект слоя 
по нескольким слоям, которые программа Photoshop использует 
для создания эффекта. Это может быть полезно при необходи-
мости вручную отредактировать конкретные его части.

Чтобы временно отключить 
эффекты слоя на всех слоях, 
а не только на активном, выбери-
те команду меню Слои → Стиль 

слоя → Скрыть все эффекты 
(Layer → Layer Style → Hide All 
Effects). Выберите команду меню 
Слои → Стиль слоя → Показать 

все эффекты (Layer → Layer 
Style → Show All Effects), чтобы 
добиться противоположного 
результата.

Вы также можете перетащить 
эффекты слоя с одного на дру-
гой, чтобы скопировать эффект. 
Убедитесь в том, что вы можете 
видеть строку эффекта, который 
вы хотите скопировать, уста-
новите указатель мыши на эту 
строку, нажмите и удерживайте 
клавишу Alt/�, а затем перета-
щите эффект на слой, куда вы 
хотите скопировать выбранные 
параметры.

После сведения слоев с приме-
ненными эффектами, вы не смо-
жете изменять параметры этих 
эффектов.
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Трансформирование слоев
После перемещения пикселей на новый слой вы можете трансформи-
ровать этот слой. Используя инструмент Свободное трансформирова-
ние (Free Transform), вы можете масштабировать, поворачивать, иска-
жать, наклонять, а также использовать эффекты перспективы.

1 Убедитесь в том, что слой является ак-
тивным. Выберите пункт Редактирова-
ние → Свободное трансформирование 
(Edit → Free Transform). Вокруг пиксе-
лей появится ограничивающий прямо-
угольник с  маркерами. Чтобы масшта-
бировать слой, перетащите маркер. Для 
пропорционального масштабирования 
перетащите угловой маркер, удерживая нажатой клавишу Shift.

2 Чтобы повернуть слой, установите ука-
затель мыши сразу за пределами огра-
ничительной рамки. Курсор примет 
вид двунаправленной стрелки. Нажав 
и  удерживая, перетащите указатель 
мыши по кругу. Вы можете перетащить 
контрольную точку в новую позицию, чтобы указать 
место, вокруг которого происходит вращение.

3 Чтобы наклонить слой, нажмите 
и удерживайте клавишу Ctrl/�+Shift, 
а  затем перетащите центральный 
верхний/нижний или центральный 
левый/правый маркер.

4 Чтобы создать эффект перспекти-
вы, нажмите и удерживайте клавишу 
Ctrl/�+Alt/�+Shift, а  затем перета-
щите угловой маркер. Для искажения 
слоя нажмите и удерживайте клавишу 
Ctrl/�, а  затем перетащите угловой 
маркер. Это позволяет перемещать уг-
ловые маркеры отдельно друг от друга.

5 Щелкните мышью по  кнопке Отменить (Cancel) 
на панели параметров или клавишу Esc, чтобы вос-
становить исходное состояние без внесения измене-
ний. Щелкните мышью по кнопке Подтвердить (Commit) или 
нажмите клавишу Enter/�, чтобы применить преобразование 
и убрать ограничительную рамку трансформирования.

Чтобы применить команды Пер-

спектива (Perspective) и Иска-

жение (Distort) к текстовому 
слою, вам сначала необходимо 
его растрировать (преобра-
зовать в пиксели): Слои → 
Растрировать → Текст (Layer → 
Rasterize → Type).

Установите курсор в пределах 
ограничительной рамки, а за-
тем, нажав и удерживая кнопку 
мыши, перетащите, чтобы 
переместить слой, пока рамка 
трансформирования все еще 
активна.

Меню Редактирование → 
Трансформирование (Edit → 
Transform) содержит дополни-
тельные команды для преобра-
зования слоев.
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Создание слоев
Команды Вырезать на  новый слой (Layer Via Cut) (Ctrl/�+Shift +J) 
и Скопировать на новый слой (Layer Via Copy) (Ctrl/�+J) имеют пер-
востепенное значение при создании слоев. Используйте эти команды 
для вырезания или копирования выбранных пикселей на новый слой.

1 Начните с создания 
выделения. Затем 
выберите команду 
меню Слои → Но-
вый → Скопировать 
на новый слой (Layer 
→ New → Layer Via 
Copy), чтобы со-
здать новый слой, 
содержащий копию 
выделенных пиксе-
лей. Новому слою 
будет автомати-
чески присвоено 
имя Слой 1, 2 и т. д. 
в зависимости от количества уже 
присутствующих в документе сло-
ев. Новый слой будет расположен 
поверх того слоя, который был 
активным при выборе команды 
Скопировать на новый слой 
(Layer Via Copy).

2 Создайте область выде-
ления, а затем выберите 
команду Вырезать 
на новый слой (Layer 
Via Cut), чтобы вырезать 
выделенные пиксели 
на новый слой. Обра-
тите внимание на то, 
что при перемещении 
пикселей на новом слое 
область фонового слоя, из которого они были вырезаны, оказы-
вается заполненной текущим фоновым цветом.

По мере добавления в документ 
слоев различного типа услож-
няется процесс их идентифи-
кации и управления ими. Вы 
можете использовать кнопки для 
фильтрации в верхней части па-
нели Слои (Layers) для быстрого 
обнаружения нужных слоев.

Щелкните мышью по переклю-
чателю ( ), чтобы включить или 
выключить фильтрацию слоев. 
Щелкните мышью по одной 
из кнопок фильтрации, чтобы 
отобразить только слои конкрет-
ного типа. В данном примере 
на панели Слои (Layers) видны 
только текстовые слои.

Вы также можете использовать 
раскрывающийся список 
фильтрации для поиска 
по таким критериям, как Имя 
(Name), Эффект (Effect) и Ре-

жим (Mode).
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Смарт-объекты
Слои типа Смарт-объект (Smart Object) обеспечивают дополнитель-
ную гибкость при работе в программе Photoshop, поскольку они могут 
редактироваться вне родительского файла как независимые компо-
ненты. Кроме того, вы можете совершать повторное редактирование 
и  преобразование в  смарт-объект без ухудшения качества изображе-
ния. Вы можете импортировать векторные смарт-объекты из приложе-
ния Adobe Illustrator или создавать смарт-объекты из отдельных слоев 
в программе Photoshop.

Векторные смарт-объекты из приложения 
Illustrator

Photoshop позволяет вставлять элементы, созданные в Adobe Illustrator, 
в  виде векторных смарт-объектов, которые вы можете модифициро-
вать не затрагивая оригинал. Это достигается путем сохранения ссылки 
на  оригинальный объект приложения Illustrator, продолжающей ссы-
латься на него в процессе его редактирования и преобразования.

1 Работая в программе Illustrator, выберите элемент, который вы 
хотите использовать в  качестве смарт-объекта в  программе 
Photoshop. Выберите команду меню Редактирование → Копиро-
вать (Edit → Copy), чтобы скопировать элемент в буфер обмена.

2 В окне программы Photoshop 
выберите команду меню Редак-
тирование → Вставить (Edit → 
Paste). В диалоговом окне 
Вставить (Paste) выбери-
те вариант Смарт-объект 
(Smart Object). Щелкните 
мышью по кнопке ОК.

3 Элемент, созданный 
в программе Illustrator, 
появится в ограничитель-
ной рамке в центральной 
области экрана. Расположите 
указатель мыши внутри рам-
ки, а затем, нажав и удерживая 
кнопку мыши, перетащите объект, 
если это необходимо. Перетащите 
маркеры рамки, чтобы отмас-
штабировать элемент до нужного 

Работа со смарт-объектами вне 
родительского документа мо-
жет облегчить процесс редакти-
рования конкретных элементов 
в сложном проекте Photoshop.

Считайте смарт-объекты дочер-
ними элементами или встроен-
ными файлами, которые суще-
ствуют в главном родительском 
документе Photoshop.

Вы должны сохранить файл 
Illustrator в той же папке и под 
тем же именем, чтобы програм-
ма Photoshop могла работать 
с ним как со смарт-объектом.
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размера. Удерживая нажатой клавишу Shift, перетащите угло-
вой маркер для пропорционального масштабирования объекта.

4 Щелкните мышью по  кнопке Подтвердить 
(Commit) на панели параметров, когда вы будете 
готовы поместить объект на  новый слой в  ка-
честве смарт-объекта. Вы также можете нажать 
клавишу Enter. В результате создастся слой век-
торного смарт-объекта. В миниатюре слоя на панели Слои 
(Layers) появится значок, указывающий на то, что данный слой 
является смарт-объектом.

5 Чтобы отредактировать оригинальный элемент в  программе 
Illustrator, дважды щелкните мышью по  миниатюре векторного 
смарт-объекта или убедитесь в том, что слой является активным, 
а затем выберите пункт Редактировать содержимое (Edit Contents) 
в меню панели Слои (Layers). Диалоговое окно с предупреждением 
напомнит вам о необходимости сохранить изменения, сделанные 
в  программе Illustrator, чтобы документ Photoshop был соответ-
ствующим образом обновлен, когда вы к нему вернетесь.

Смарт-объекты из слоев Photoshop

1 Чтобы создать смарт-объект из существующих 
слоев Photoshop, сначала выделите один или 
несколько слоев. Выберите пункт Преобразовать 
в смарт-объект (Convert to Smart 
Object) в меню панели Слои (Layers). 
Выделенные слои будут преобразо-
ваны в единый слой смарт-объекта.

2 Чтобы отредактировать слой смарт-
объекта как независимый файл, 
дважды щелкните мышью по со-
ответствующей миниатюре. Пред-
упреждение напомнит о необходимости 
выбрать пункт меню Файл → Сохранить 
(File → Save), чтобы подтвердить любые 
изменения, произведенные во внешнем 
смарт-объекте.

3 Чтобы вернуться к родительскому доку-
менту Photoshop и обновить его с учетом измене-
ний, внесенных в смарт-объект извне, закройте 
окно смарт-объекта. Сохраните изменения, если 
это будет предложено.

Вы не можете применить к смарт-
объекту трансформирование 
типа Перспектива (Perspective), 
Искажение (Distort) или Дефор-

мация (Warp).

Вы также можете создавать 
смарт-объекты, используя коман-
ду Поместить встроенные 
(Place Embedded). (См. раздел 
«Открытие и помещение файлов 
в формате EPS» главы 3.)

Выберите команду меню 
Файл → Открыть как смарт-

объект (File → Open As Smart 
Object), чтобы открыть век-
торный или растровый файл 
в качестве смарт-объекта.
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Связанные смарт-объекты
Команда Поместить связанные (Place Linked) позволяет поместить 
содержимое в файл Photoshop путем создания ссылки на внешний до-
кумент Photoshop или Illustrator вместо того, чтобы встраивать содер-
жимое в файл Photoshop.

1 Выберите команду меню Файл → Поместить связанные (File → 
Place Linked). Перейдите к файлу в своей системе. Щелкните мы-
шью по файлу один раз, чтобы выделить его, а затем щелкните 
мышью по кнопке Поместить (Place).

2 Щелкните мышью по кнопке ОК в диало-
говом окне Открыть как смарт-объект 
(Open As Smart Object). Внешний файл 
будет добавлен в  изображение в  ограни-
чительной рамке. Используйте маркеры 
масштабирования, чтобы изменить раз-
мер помещенного содержимого, и  пере-
тащите ограничительную рамку на  новое место, 
если это необходимо. Щелкните мышью по кнопке Подтвердить 
(Commit) на панели параметров, нажмите клавишу Enter/� или 
дважды щелкните мышью внутри ограничительной рамки, что-
бы поместить содержимое.

3 Смарт-объект 
появится на новом 
слое на панели Слои 
(Layers). Значок в виде 
цепочки в нижнем правом углу миниатюры указывает на то, 
что это слой связанного смарт-объекта,  то есть содержимое 
файла не помещается в документ Photoshop.

4 Если вы редактируете 
исходный файл в  сто-
роннем приложении, 
не  закрыв связанный объект в  Photoshop, то  слой связанного 
смарт-объекта обновится автоматически. Если вы редактируете 
исходный файл при закрытом файле Photoshop то при следую-
щем открытии файла Photoshop, на слое связанного смарт-объ-
екта появляется значок предупреждения, указывающий на  то, 
что исходный документ был изменен. Убедитесь в том, что слой 
выделен, а  затем выберите команду меню Слои → Смарт-объ-
ект → Обновить измененное содержимое (Layer → Smart Object → 
Update Modified Content).

Такие преобразования, как мас-
штабирование, наклон, эффект 
перспективы и деформация 
оказывают влияние на внешний 
вид связанного объекта только 
в вашем документе Photoshop, 
но не изменяют исходный свя-
занный объект.

Поскольку связанный смарт-
объект является внешним 
файлом, вы не можете внести 
изменения в данные пикселей, 
например, изменить цвет, освет-
лить, повысить резкость или 
клонировать его в документе 
Photoshop.
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Деформация
Деформация  —  это вид трансформирования, позволяющий сгибать 
объекты на слоях для создания необходимых эффектов, а также накла-
дывать изображение на изогнутые поверхности. Вы можете создать эф-
фекты деформации самостоятельно или выбрать из множества стилей, 
которые вы можете настроить в соответствии со своими требованиями.

1 Для деформирования выбранного слоя выберите команду 
меню Редактирование → Трансформирование → Деформация 
(Edit → Transform → Warp). На содержимом слоя появится сетка 
по умолчанию.

2 Чтобы создать пользова-
тельский эффект дефор-
мации, вы можете пере-
тащить любую из линий, 
сегментов, угловых 
маркеров или направ-
ляющих точек, располо-
женных на краях сетки. 
Эти направляющие 
точки работают так же, 
как направляющие точки 
на кривом сегменте контура 
(см. главу 10 для получения 
более подробной информа-
ции).

Использование 
предустановок деформации

1 Для деформирования выбранно-
го слоя, используя предустанов-
ленный стиль, выберите команду 
меню Редактирование → Транс-
формирование → Деформация 
(Edit → Transform → Warp).

2 Выберите предустановку 
в раскрывающемся списке 
Деформация (Warp) на панели 
параметров.

Вы не можете применить де-
формацию к слоям векторных 
смарт-объектов.

Вы можете использовать пункт 
меню Редактирование → Отме-

нить (Edit → Undo), чтобы отме-
нить последнюю деформацию.
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3 Чтобы настроить стиль 
деформации, перетащите 
узловую точку, которая 
находится на сетке, или 
введите значение в поле 
ввода Изгиб (Bend) на па-
нели параметров.

4 На панели параметров вы 
можете ввести значения 
в поле ввода Г (H) (–100–
100), чтобы применить 
горизонтальное искажение. 
Введите значение в поле 
ввода В (V) (–100–100), 
чтобы применить верти-
кальное искажение.

5 Щелкните мышью 
по кнопке Изменить 
ориентацию дефор-
мации (Change Warp 
Orientation) на панели 
параметров, чтобы 
применить деформацию 
с противоположной 
стороны.

6 Щелкните мышью 
по кнопке Отмена 
(Cancel) на панели 
параметров или кла-
вишу Esc, чтобы вернуться к исход-
ному состоянию без внесения изме-
нений. Щелкните мышью по кнопке 
Подтвердить (Commit) или нажмите 
клавишу Enter/�, чтобы принять 
результат деформации и убрать сетку.

Щелкните мышью по кнопке 
Переключение (Switch Warp) 
на панели параметров, чтобы 
переключиться между свобод-
ной трансформацией и режима-
ми деформации.
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Автоматическое 
выравнивание  
и наложение слоев
Автоматическое выравнивание и наложение слоев применяется к  со-
держимому, расположенному на различных слоях в изображении. Для 
использования данных команд следует выделить два или более слоя 
на панели Слои (Layers).

Автоматическое выравнивание слоев

Команда Автоматическое вырав-
нивание слоев (Auto-Align Layers) 
обеспечивает выравнивание слоев 
на основе сходства в содержимом 
изображения. Эта функция может 
использоваться для создания пано-
рамных эффектов или выравнива-
ния слоев с похожим содержимым, 
что позволяет создавать составное 
изображение путем добавления 
нужного содержимого из другого 
выровненного слоя.

1 Для выравнивания двух или более выделенных слоев выбери-
те Редактирование → Автоматическое выравнивание слоев 
(Edit → Auto-Align Layers). Выберите один из вариантов в разделе 
Проекция (Projection) диалогового окна Автоматическое вы-
равнивание слоев (Auto-Align Layers).

2 Для создания составного изо-
бражения из выровненных слоев 
добавьте слой-маску к верхнему 
слою (см. раздел «Слой-маски» 
главы 11 для получения инфор-
мации о слоях-масках). Выделите 
слой-маску и выберите инструмент 
Кисть (Paintbrush). Выберите кисть 

В зависимости от итогов 
анализа слоев для достижения 
наилучшего результата исполь-
зуется вариант Перспектива 

(Perspective) или Цилиндр 
(Cylindrical). Начните с варианта 
Авто (Auto), который, как пра-
вило, дает хороший результат, 
однако будьте готовы поэкспе-
риментировать с другими вари-
антами в зависимости от ваших 
оригинальных изображений.

Установите флажок Удаление 

виньетирования (Vignette 
Removal), чтобы уменьшить 
затемнение, которое может воз-
никнуть в углах и вдоль краев 
изображения. Установка флажка 
Геометрическое искажение 
(Geometric Distortion) может 
помочь компенсировать иска-
жения типа «бочка», «подушка» 
или «рыбий глаз».
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с мягкими краями, а затем закрасьте черным цветом, чтобы 
скрыть пиксели на маске и позволить проглядывать пиксели 
нижележащего слоя.

Автоналожение слоев

Функция автоналожения слоев применяет маски к слоям. Она может 
быть полезна при создании панорамы, а также в ситуации, когда у вас 
есть несколько изображений одной и  той  же композиции, в  фокусе 
которых находятся различные области, и вам нужно, чтобы итоговое 
изображение представляло собой совокупность правильно сфокусиро-
ванного содержимого.

1 Используйте команду Автоналожение слоев (Auto-Blend Layers) 
для создания панорамы или стека содержимого изображения пу-
тем сопоставления перекрывающегося контента двух или более 
выбранных слоев. Когда вы будете довольны результатом нало-
жения, выберите команду меню Редактировать → Автоналоже-
ние слоев (Edit → Auto-Blend Layers).

2 Для создания панорамы, выберите 
одноименный метод наложения. 
Программа Photoshop создает 
маски для каждого слоя, чтобы 
применить их к областям, где 
экспозиция может варьироваться. 
В результате получаются плавные 
переходы между деталями изображения на отдельных слоях.

3 Выберите вариант Стековые изображе-
ния (Stack Images), если вы хотите, чтобы 
программа Photoshop проанализировала 
вариации одной и той же композиции 
и скомбинировала сфокусированные 
части для создания 
итогового изображения 
с увеличенной глубиной 
резкости. Для достиже-
ния результата программа 
Photoshop будет также 
использовать слой-маску.

Команду Автоналожение сло-

ев (Auto-Blend Layers) можно 
применять только к изображе-
ниям в режиме RGB или Града-

ции серого (Grayscale).

Перед использованием коман-
ды Автоматическое выравни-

вание слоев (Auto-Align Layers) 
убедитесь в том, что вы выбрали 
два или больше незакреплен-
ных слоя.

Установите флажок Плав-

ные переходы цвета и тона 
(Seamless Tones), чтобы сгладить 
разницу в цвете и тоне для 
уменьшения видимых швов 
в итоговом изображении.
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Стили
Если вы хотите последовательно и быстро применять к слою эффекты 
стиля, вы можете сохранить стили слоя на панели Стили (Styles) для 
последующего использования. Программа Photoshop содержит раз-
нообразные предустановленные стили, которые можно использовать 
в качестве основы для экспериментов.

Вы можете применить стили к  любым слоям, кроме фонового слоя 
по умолчанию.

Создание стилей

1 Щелкните мышью по значку панели Стили (Styles), если она рас-
полагается в доке панелей, или выберите команду меню Окно → 
Стили (Window → Styles), чтобы отобразить соответствующую 
панель.

2 Создайте стиль слоя, исполь-
зуя пользовательские эффек-
ты, которые вы хотите вклю-
чить при сохранении стиля 
(см. раздел «Стили слоев» 
данной главы для получения информации о работе со стилями 
слоя). Убедитесь в том, что слой остается активным.

3 Выберите пункт 
Новый стиль (New 
Style) в меню панели 
Стили (Styles) ( ).  
Введите название 
стиля в появившемся диалоговом 
окне, щелкните мышью по кнопке 
ОК. Новый стиль появится на па-
нели Стили (Styles).

Применение стилей

1 На панели Слои (Layers) выберите слой, к которому вы хотите 
применить стиль.

2 Щелкните мышью по стилю на панели Стили (Styles), чтобы при-
менить его к  выделенному слою. Для удаления примененного 
к слою стиля щелкните мышью по кнопке Нет стиля (No Style)  
( ) на панели Стили (Styles).

Вы можете применять стили 
к текстовым слоям и слоям-фи-
гурам без их растеризации.
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3 На панели Слои (Layers) 
значок ( ) указывает 
на примененный к слою 
стиль. Щелкните мышью 
по треугольнику, чтобы ото-
бразить/скрыть примененные к данному слою 
эффекты.

4 Щелкните мышью по кноп-
ке видимости ( ), чтобы 
скрыть или отобразить 
отдельные или все эффекты 
слоя.

Редактирование стилей

Чтобы отредактировать 
конкретный эффект 
слоя, дважды щелкните 
мышью по  имени эф-
фекта на  панели Слои 
(Layers). Это приведет 
к  открытию диалого-
вого окна Стиль слоя 
(Layer Style), в  кото-
ром отображены текущие настройки. Откорректируйте значения па-
раметров для создания нужного эффекта. Убедитесь в том, что флажок 
Просмотр (Preview) установлен, чтобы увидеть, как изменение настро-
ек влияет на изображение.

Добавление стилей

Используйте меню панели Стили (Styles) 
( ) для загрузки коллекций предуста-
новленных стилей, предусмотренных 
программой Photoshop. Щелкните мы-
шью по кнопке Добавить (Append), что-
бы сохранить стили по умолчанию и до-
бавить в панель выбранную коллекцию.

Применение предустановлен-
ного стиля из панели Стили 
(Styles) и последующее изуче-
ние и изменение параметров, 
используемых для создания 
общего эффекта, —  это отлич-
ный способ получить представ-
ление о возможностях, которые 
предоставляют стили слоя.

Выберите пункт Восстановить 

стили (Reset Styles) на панели 
Стили (Styles), чтобы вернуть-
ся к оригинальным стилям 
по умолчанию.
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Масштабирование с учетом 
содержимого
Команда Масштаб с учетом содержимого (Content Aware Scale) предо-
ставляет интеллектуальный метод масштабирования, который анали-
зирует содержимое изображения так, что ключевые области, имеющие 
большое значение для визуального восприятия, сохраняются в процес-
се масштабирования. Используя эту технику, можно придать изображе-
нию в пейзажной ориентации пропорции портрета и наоборот.

1 Для масштабирования 
слоя убедитесь в  том, 
что выбранный слой 
не  является фоновым. 
При необходимости 
вы можете дважды щелкнуть по фоновому слою на панели Слои 
(Layers), а затем щелкнуть по кнопке ОК в диалоговом окне Но-
вый слой (New Layer), чтобы преобразовать его в обычный слой, 
например, Слой 0 (Layer 0).

2 Выберите команду меню Редактирование → Масштаб с учетом со-
держимого (Edit → Content Aware Scale). Вокруг содержимого слоя 
появится ограничительная рамка с восемью маркерами. В центре 
ограничительной рамки появится контрольная точка. Это та точка, 
вокруг которой осуществляется масштабирование по умолчанию.

3 Перетащите маркер 
масштабирования, 
чтобы изменить 
общий размер изо-
бражения, сохраняя 
при этом значимые 
визуальные детали. 
Удерживайте нажа-
той клавишу Shift 
при перетаскивании 
углового маркера для 
пропорционального масштабирования.

4 После выбора команды Масштаб с  учетом содержимого 
(Content Aware Scale) вы можете также использовать настройки 
на панели параметров для контроля над процессом масштабиро-
вания. Вы можете использовать элемент управления Положение 
центра преобразования (Reference Point Location), чтобы указать 
точку, вокруг которой осуществляется масштабирование, а затем 

Вы можете применять масшта-
бирование с учетом содержи-
мого ко всем выделенным обла-
стям и слоям, кроме фонового 
слоя.

Щелкните мышью по кнопке За-

щищать телесные тона (Protect 
Skin Tones) ( ) на панели пара-
метров, чтобы предотвратить 
нежелательное масштабирова-
ние изображений людей.

При масштабировании с учетом 
содержимого, предприни-
мается попытка ограничить 
масштабирование только теми 
областями, которые не содер-
жат отличительных визуальных 
деталей.
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использовать поля ввода X/Y-координат, чтобы отмасштабировать 
изображения до конкретного размера, или поля ввода процентных 
значений высоты/ширины для масштабирования изображение 
в процентах от текущего размера. Используйте поле ввода Количе-
ство (Amount), чтобы указать соотношение между масштабирова-
нием с учетом содержимого и обычным масштабированием.

Защита областей от масштабирования

Вы можете использовать альфа-канал, чтобы задать ту область изобра-
жения, масштабирование которой необходимо предотвратить.

1 Для дополнительной защиты областей изображения при мас-
штабировании с  учетом содержимого создайте область выде-
ления, а затем сохраните ее в качестве альфа-канала (см. раздел 
«Сохранение и загрузка выделенных областей» главы 11 для по-
лучения дополнительной информации).

2 Перед началом 
перетаскивания 
маркера масшта-
бирования, для 
изменения разме-
ра содержимого 
слоя, выберите 
альфа-канал 
в раскрывающемся 
списке Защищать 
(Protect).

При использовании полей 
ввода процентных значений 
Ш (W)/В (H) щелкните мышью 
по кнопке Сохранить про-

порции (Maintain Aspect Ratio) 
([зн]) для пропорционального 
масштабирования.

До После

Вы не можете применять 
масштабирование с учетом со-
держимого к корректирующим 
слоям, слоям-маскам, каналам, 
смарт-объектам, нескольким 
выделенным слоям или группам 
слоев.
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Марионеточная  
деформация
Марионеточная деформация предусматривает применение сетки к  со-
держимому слоя. Вы можете добавить на сетку так называемые булавки, 
вокруг которых можно сгибать и трансформировать части изображения.

1 Выберите нужный слой 
на панели Layers (Слои).

2 Выберите команду меню Ре-
дактирование → Марионе-
точная деформация (Edit → 
Puppet Warp). На содержи-
мом слоя появится сетка. 
Для контроля над точностью 
деформации, путем создания 
более тонкой или грубой 
сетки, выберите подходящий 
вариант в раскрывающемся 
списке Частота (Density) 
на панели параметров.

3 Используйте меню Режим 
(Mode) на панели параме-
тров для управления степе-
нью эффекта деформации. Режим Искажение (Distort) обеспе-
чивает наиболее явно выраженный и заметный результат.

4 Введите значение в поле ввода Расшире-
ние (Expansion) или перетащите соответ-
ствующий ползунковый регулятор, чтобы 
расширить или сжать сетку вокруг содер-
жимого слоя.

5 Щелкните мышью по сетке, чтобы добавить булавку. Добавьте 
две или более булавки. Щелкните мышью по булавке, чтобы сде-
лать ее активной, на что указывает 
черный круг в центре.

6 Перетащите активную булавку, что-
бы деформировать сетку. Неактив-
ные булавки выступают в качестве 
точек, удерживающих изображение 
на месте.

Для осуществления неразрушаю-
щего искажения слоя с помощью 
марионеточной деформации 
сначала преобразуйте слой 
в слой смарт-объекта (см. раздел 
«Смарт-объекты» ранее в главе). 
Если в дальнейшем необходи-
мость в деформации отпадет, вы 
сможете просто удалить эффект 
марионеточной деформации 
из слоя смарт-объекта.

Установите флажок Сетка (Show 
Mesh), чтобы при необходимо-
сти скрыть или отобразить сетку 
деформации. Скрытие сетки 
не приводит к скрытию булавок.
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7 Для выхода из  режима Марионеточная 
деформация (Puppet Warp) и применения 
изменений щелкните мышью по  кноп-
ке Подтвердить (Commit) на панели параметров или нажмите 
клавишу Enter/�. Для отмены изменений щелкните мышью 
по кнопке Отменить (Cancel) или нажмите клавишу Esc.

Работа с булавками

1 Чтобы выделить несколько була-
вок, щелкните мышью по булавке, 
а затем, удерживая нажатой клави-
шу Shift, щелкните мышью по дру-
гим булавкам, чтобы добавить их 
к выделенным ранее. Перетаскива-
ние любой из выделенных булавок 
затрагивает все остальные.

2 Выделите булавку, а затем используйте клавиши �, �, � и � для 
ее перемещения с шагом в 1 пиксель. Используйте эти же клави-
ши, удерживая нажатой клавишу Shift, для перемещения выде-
ленной булавки с шагом в 10 пикселей.

3 Выделите булавку, а затем нажми-
те и  удерживайте клавишу Alt/� 
(убедитесь при этом, что указатель 
мыши не  находится непосред-
ственно над булавкой), чтобы по-
лучить доступ к  элементу управ-
ления вращением булавки. Нажав 
и  удерживая кнопку мыши, пере-
тащите по кругу, чтобы повернуть 
сетку вокруг булавки. Вы также можете ввести значение в поле 
Поворот (Rotate) на  панели параметров, чтобы повернуть вы-
бранную булавку на конкретный угол.

4 Чтобы удалить булавку, выделите ее, а затем нажмите клавишу 
Backspace или Delete. Также вместо этого вы можете навести 
указатель мыши на булавку, а затем, удерживая нажатой клавишу 
Alt/�, щелкнуть в тот момент, когда курсор примет вид ножниц.

5 Чтобы удалить все булавки и  вернуть 
сетку в  исходное состояние, щелкните 
мышью по  кнопке Удалить все булавки 
(Remove All Pins) на панели параметров.

Если вы создаете эффект де-
формации, при котором одна 
область изображения перекры-
вает другую, то вы можете кон-
тролировать то, какая область 
будет находиться впереди, 
используя кнопки Глубина 
(Pin Depth) для перемещения 
выбранной булавки вперед или 
назад.
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Деформация перспективы
Режим деформации перспективы позволяет скорректировать перспек-
тиву изображения. Он может быть полезен для исправления перспек-
тивы архитектурных объектов. При этом сначала создается сетка, а за-
тем на нее добавляются точки и плоскости для настройки.

Формирование сетки

1 Выберите команду меню Редактирование → Деформация пер-
спективы (Edit → Perspective Warp). На  панели параметров по-
явятся инструменты для деформации перспективы, а в окне изо-
бражения появится соответствующий курсор.

2 Определите подходящие 
вертикальные или горизон-
тальные линии в изображе-
нии (например, угол здания 
на следующем рисунке), 
затем, нажав и удерживая 
кнопку мыши, перетащите 
по картинке, чтобы создать 
первый четырехугольник.

3 Перетащите угловые точки 
четырехугольника ( ),  
чтобы выровнять сетку 
перспективы в соответ-
ствии с изображением. 
В случае с изображением 
архитектурных объек-
тов использование таких 
архитектурных деталей, 
как крыши, карнизы, колонны и вертикальные предметы может 
помочь точно настроить перспективу.

4 Для создания второго четырех-
угольника, определяющего дополни-
тельную перспективную плоскость, 
перетащите курсор деформации пер-
спективы внутрь к вертикали первого 
четырехугольника. При приближении 
курсора к начальной вертикали оба 
элемента выделяются синим цветом 
(см. рис.), что указывает на замок.

Хорошей идеей является со-
здание копии слоя (см. раздел 
«Создание слоев» ранее в гла-
ве), прежде чем осуществлять 
деформацию перспективы, что-
бы при необходимости иметь 
возможность легко вернуться 
к оригиналу.

При определении начальных 
четырехугольников нажмите 
и удерживайте клавишу Shift, 
а затем перетащите один из вер-
тикальных или горизонтальных 
краев, чтобы расширить сетку 
перспективы, сохраняя текущую 
сетку перспективы.



5 Перетащите точки на  вто-
ром четырехугольнике, как 
вы делали это на первом.

Манипулирование сеткой

После создания готовой к  исполь-
зованию сетки перспективы вы 
можете начать настраивать ее в соответствии с вашими требованиями.

1 Щелкните мышью по  кнопке Деформа-
ция (Warp) на панели параметров, чтобы 
активировать соответствующий режим. 
Внутренние линии сетки исчезнут, а каждая угловая булавка бу-
дет выделена.

2 Перетащите отдельные булавки, чтобы деформиро-
вать перспективу в изображении. Вы также можете 
использовать клавиши �, �, � и � для передвижения 
выделенной булавки с заданным шагом.

3 Удерживая нажатой клави-
шу Shift, щелкните мышью 
по краю, чтобы привязать 
его к вертикали или гори-
зонтали, которая выделит-
ся желтым цветом. При 
перетаскивании булавки 
в какой-либо конец край 
останется вертикальным/горизонтальным.

4 Щелкните мышью по кнопке Автоматически 
выпрямлять вблизи вертикальных линий 
(Automatically straighten near vertical lines) или Ав-
томатически выравнивать вблизи горизонтальных 
линий (Automatically level near horizontal lines), чтобы 
программа Photoshop произвела анализ изображения 
и выполнила автоматическую настройку. Щелкните мышью 
по кнопке Удалить все четырехугольники (Remove Warp), что-
бы восстановить состояние в момент щелчка по кнопке Дефор-
мация (Warp).

5 По окончании используйте кнопку Отменить (Cancel)/Подтвер-
дить (Commit), чтобы принять или отклонить результаты де-
формации перспективы.

Щелкните мышью по кноп-
ке Макет (Layout) на панели 
параметров, если вам нужно 
вернуться к первоначальным 
четырехугольникам для их 
корректировки.

До автоматического выпрямле-
ния вблизи вертикальных линий

После
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9 Работа с текстом

Возможно, не каждое 
изображение, с которым 

вы будете работать, 
потребует вставки 

текста. Но при 
необходимости Photoshop 
предоставляет широкий 

спектр возможностей для 
управления начертанием 

и форматированием 
текстовых надписей.

Создание обычного текста

Создание текста абзаца

Редактирование и выделение текста

Форматирование текста

Форматирование абзаца

Текст-маска

Стили текста и слоя

Текстовые эффекты
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Создание обычного текста
В программе Photoshop вы можете создать «текст» двух видов: обычный 
текст и текст абзаца. Если вам необходимо набрать короткую надпись, 
содержащую одно или несколько слов, используйте обычный текст. Для 
набора одного или нескольких предложений следует применять текст 
абзаца.

1 Чтобы создать 
обычный текст, 
выберите ин-
струмент Гори-
зонтальный текст 
(Horizontal Type). Вы 
можете настроить 
шрифт с помощью 
панели параметров или панелей Символ (Character) и Абзац 
(Paragraph) перед добавлением текста, или отформатировать его 
после ввода.

2 Установите указатель мыши в окне изображения, а затем щелкни-
те кнопкой мыши для отображения текстового курсора. Щелчок 
кнопкой мыши при выбранном инструменте Горизонтальный 
текст (Horizontal Type) активизирует режим редактирования 
текста.

3 Введите текст с помощью клавиатуры. Для начала новой строки 
необходимо нажать клавишу Enter (Windows) или � (macOS). 
Имейте в виду, что обычный текст не переносится автоматически.

4 Закончив ввод текста, щелкните мышью по кноп-
ке Подтвердить (Commit) на панели параметров, 
чтобы завершить создание 
текстового слоя. Это деак-
тивирует режим редакти-
рования текста, и теперь вы 
можете продолжить работу 
с изображением. Текст будет 
расположен на отдельном 
слое. Щелкните мышью 
по кнопке Отменить 
(Cancel), чтобы удалить текст.

Вы также можете подтвердить 
введение текста, нажав клавишу 
Enter на цифровой клавиату-
ре или выбрав любой другой 
инструмент на панели инстру-
ментов.

Сервис Typekit, доступный 
в программе Photoshop CC, 
предоставляет и синхронизиру-
ет шрифты с внешнего сервера 
Typekit, с которым вы связы-
ваетесь через Creative Cloud. 
Шрифты Typekit не устанав-
ливаются локально на вашем 
компьютере. Чтобы добавить 
шрифт из сервиса Typekit, вы-
берите команду меню Текст → 
Добавить шрифты из Typekit 
(Type → Add fonts from Typekit). 
В списке шрифтов появится зна-
чок Typekit ( ), указывающий 
на соответствующий шрифт.

Чтобы иметь возможность 
вводить, редактировать или 
форматировать текст, вы 
должны находиться в режиме 
редактирования текста.



1
7

3

Создание текста абзаца
При работе с текстом абзаца вы задаете ширину столбца текста. Текст 
переносится на новую строку при достижении края ограничительной 
рамки.

1 Для создания текста абзаца выберите инструмент Горизон-
тальный текст (Horizontal Type). Вы можете настроить шрифт 
с помощью панели параметров или панелей Символ (Character) 
и Абзац (Paragraph) перед добавлением текста, либо отформати-
ровать его после ввода.

2 Установите курсор на угол созда-
ваемой текстовой области. Нажав 
и удерживая кнопку мыши, перета-
щите курсор по диагонали, чтобы за-
дать размер ограничительной рамки.

3 Кроме того, при выбранном ин-
струменте Горизонтальный текст 
(Horizontal Type) вы можете щелк-
нуть по изображению, удерживая 
нажатой клавишу Alt/�, чтобы 
получить доступ к диалоговому 
окну Размер текстового блока 
(Paragraph Text Size). Введите значе-
ния ширины и высоты, а затем щелкните мышью по кнопке ОК.

4 Введите текст с  помощью клавиа-
туры. Обратите внимание, что 
текст переносится при достиже-
нии края рамки. Нажмите клави-
шу Enter/� на  основной клавиа-
туре, если вам необходимо начать новый абзац.

5 Щелкните мышью по кнопке Подтвердить (Commit) на панели 
параметров, чтобы завершить создание текстово-
го слоя. Щелкните мышью по кнопке Отменить 
(Cancel), чтобы отказаться 
от изменений. Обе кнопки 
деактивируют режим редак-
тирования текста и дают вам 
возможность продолжить 
работу с изображением. 
Текст будет расположен 
на отдельном слое.

Если введенный текст не поме-
щается в ограничительную рам-
ку, вы увидите символ перепол-
нения в ее правом нижнем углу:

Уменьшите размер шрифта или 
увеличьте рамку, чтобы отобра-
зить весь текст.

Для изменения размера 
текстовой области выберите 
инструмент Горизонтальный 

текст (Horizontal Type), щелкни-
те мышью по текстовому слою 
в соответствующей панели, а за-
тем щелкните мышью по самому 
тексту. Перетащите маркер мас-
штабирования, чтобы изменить 
размер текстовой области.
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Редактирование  
и выделение текста
Чтобы изменить текст, вам необходимо перейти в режим его редактиро-
вания. Для изменения формата символов или абзаца сначала выделите 
фрагмент текста, а затем внесите необходимые изменения.

Редактирование текста

Чтобы изменить текст, выберите ин-
струмент Горизонтальный текст 
(Horizontal Type). Щелкните мышью 
по  тексту, который вы хотите изме-
нить. Это активирует режим редак-
тирования текста. Внесите нужные 
изменения с  помощью клавиатуры. 
Щелкните мышью по  кнопке Под-
твердить (Commit) на  панели пара-
метров, чтобы принять изменения 
и  оставить активным режим редактирования текста. 
Щелкните мышью по кнопке Отмена (Cancel) на панели 
параметров, если вы не хотите сохранять изменения.

Выделение текста

1 Убедитесь в  том, что активен 
режим редактирования текста, 
а  затем, нажав и  удерживая 
кнопку мыши, перетащите кур-
сор для выделения фрагмента 
текста. Дважды щелкните мы-
шью по слову, чтобы выделить 
только его. Трижды щелкните для выделения строки текста. Для 
выделения абзаца щелкните четыре раза.

2 В режиме редактирования текста используйте сочетание кла-
виш Ctrl/�+А, чтобы выделить весь текст на слое, или выберите 
команду меню Выделение → Все (Select → All).

3 После выделения нужного текстового фрагмента вы можете из-
менить значения параметров форматирования. Внесенные вами 
изменения повлияют только на выделенный текст.

При возникновении сложностей 
с установкой текстового курсо-
ра в текст, который вы хотите 
отредактировать, щелкните 
мышью по текстовому слою 
на панели Слои (Layers) для его 
активации.

Для перемещения текста 
выберите инструмент Переме-

щение (Move). Убедитесь в том, 
что текстовый слой выделен 
на панели Слои (Layers), а затем 
перетащите текстовый слой как 
любой другой.

Редактируемые текстовые слои 
на панели Слои (Layers) можно 
определить по миниатюре 
с буквой «Т». Дважды щелкните 
мышью по миниатюре, чтобы 
выделить весь текст на слое.
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Форматирование текста
Чтобы изменить формат выделенного фрагмента текста, используйте 
настройки на панели параметров или панели Символ (Character) при 
активном текстовом инструменте.

Шрифт и начертание

Для установки шрифта текстовой надписи используйте раскрывающий-
ся список Шрифт (Font), чтобы выбрать шрифт из  числа доступных 
в вашей системе. При установке указателя мыши на название шрифта 
в списке выделенный текст отобразится соответствующим шрифтом. 
Вы также можете выбрать стиль начертания, например, полужирный 
или курсив, в раскрывающемся списке Начертание (Font Style).

Размер

Введите значение в поле Размер (Size), чтобы изменить размер шрифта. 
В программе Photoshop единицей измерения размера шрифта по умол-
чанию является пункт.

Интерлиньяж

Интерлиньяж определяет расстояние 
между базовыми линиями шрифта. 
Введите значение данного параме-
тра в пунктах в поле Интерлиньяж 
(Leading). Программа Photoshop 
по умолчанию применит значение 
120% от размера выбранного шрифта, если вы оставите для данного 
параметра значение Авто (Auto).

Кернинг и трекинг

На панели Символ (Character) вы можете настроить кернинг и трекинг. 
Выбранная по  умолчания Метрическая (Metric) система использует 
встроенную таблицу кернинговых пар для шрифта.

1 Чтобы настроить параметр кернинга, 
щелкните кнопкой мыши между сим-
волами для установки текстового курсора. Вы можете ввести 
значение в поле ввода Кернинг (Kerning) или выбрать в со-
ответствующем раскрывающемся списке предустановленное 

Вы можете выбрать пункт меню 
Окно → Символ (Window → 
Character), чтобы отобразить 
панель Символ (Character), или 
щелкнуть по кнопке ( ) на па-
нели параметров, если у вас 
выбран текстовый инструмент.

Перед изменением параметров 
на панели Символ (Character) 
убедитесь в том, что вы выдели-
ли нужный фрагмент текста.

Если вы не можете разобраться 
в параметрах панели Символ 
(Character), установите указа-
тель мыши на значок слева 
от поля ввода, чтобы отобра-
зить всплывающую подсказку.
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значение. Отрицательные значения уменьшают расстояние 
между символами, а положительные —  увеличивают. Нажмите 
клавишу Enter/�, чтобы применить изменения.

2 Для настройки трекинга выделите нужный фрагмент текста. 
Введите значение в поле ввода Трекинг (Tracking) или выберите 
вариант в соответствующем раскрывающемся списке.

Смещение базовой линии

Параметр Смещение базовой линии (Baseline Shift) позволяет сдви-
нуть выделенные символы вверх или вниз по отношению к исходной 
базовой линии для создания различных эффектов.

1 Для смещения базовой линии в  режиме 
редактирования текста выделите символы, 
которые вы хотите сместить.

2 Введите положительное значение для 
смещения базовой линии вверх, введите 
отрицательное значение для смещения 
базовой линии вниз.

Сглаживание

Настройка сглаживания на панели параметров 
позволяет создать символы с  мягкими края-
ми. Это достигается путем размывания пик-
селей, образующих край символа. В  то  время 
как символы без сглаживания могут казаться 
неровными, сглаживание позволяет избежать 
появления неровных краев.

Будьте внимательны при сглаживании символов, набранных мелким 
шрифтом, поскольку это может привести к не-
нужному смешению с фоном.

Вы можете выбрать степень сглаживания в со-
ответствующем меню на панели параметров.

Если применить сглаживание к очень мелкому 
шрифту, то он может показаться размытым.

Искусственный (псевдо) стиль 
позволяет имитировать начер-
тание шрифта, отсутствующее 
в вашей системе. Вы не можете 
применить псевдополужирное 
начертание к перенесенному 
тексту.

Чтобы изменить цвет выделен-
ного текста, щелкните мышью 
по индикатору цвета на панели 
параметров или на панели 
Символ (Character) (см. раздел 
«Палитра цветов» главы 4 для 
получения дополнительной 
информации об использовании 
диалогового окна Палитра 

цветов (Color Picker)).

Для продолжения работы 
с изображением необходимо 
подтвердить или отменить 
изменения шрифта.

"���
�#�$�%�

"���
�#�$�&�'
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Форматирование абзаца
Элементы управления панели Абзац (Paragraph) наиболее полезны при 
работе с текстовым блоком, состоящим из одного или нескольких абза-
цев. Щелкните мышью по кнопке панели Абзац (Paragraph) или выбе-
рите команду меню Окно → Абзац (Window → Paragraph), если панель 
еще не отображена.

Перед применением настроек на панели 
Абзац (Paragraph) необходимо выделить 
текст, с которым вы хотите работать (см. 
раздел «Редактирование и выделение тек-
ста» данной главы).

Выравнивание

1 Чтобы изменить метод выравнивания выделенных 
абзацев или всего текста на слое, щелкните мышью 
по одной из кнопок Влево (Left), Вправо (Right) или По центру 
(Center) на панели Абзац (Paragraph) или на панели параметров.

2 Вы также можете выбрать один из  вариантов 
Выключка последней строки (Justify), чтобы 
выровнять оба края столбца. Выключка последней строки при-
менима только к  тексту абзаца, но  не  к  обычному тексту. Вы-
бранный вариант оказывает влияние на  выключку последней 
строки абзаца. При наведении указателя мыши на значок вы мо-
жете увидеть всплывающую подсказку.

Отступы

Чтобы установить Отступ от левого 
края (Left), Отступ от правого края 
(Right) или Отступ первой строки (First Line) для выбранных абзацев, 
введите значение в соответствующее поле ввода.

Отступ перед и после абзаца

Для создания дополнительного от-
ступа перед или после абзаца для вы-
деленного текста введите значение в полях ввода Отступ перед абзацем 
(Space Before) и/или Отступ после абзаца (Space After).

Выберите текстовый слой 
на панели Слои (Layers), чтобы 
применить настройки ко всем 
абзацам этого слоя.

Чтобы установить значение 
отступа в миллиметрах, введите 
число и символы mm.

Установите флажок Перенос 

(Hyphenate), чтобы разрешить 
или запретить автоматический 
перенос слов для выделенного 
текста.
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Текст-маска
Инструмент Текст-маска (Type Mask) позволяет создать сложное вы-
деление, контуры которого повторяют текст. Вы можете использовать 
этот мощный и гибкий инструмент для того, чтобы создать выделение 
области изображения, контуром повторяющим текст, выбранного вами 
начертания.

1 Выберите инструмент Горизонтальный текст-маска (Horizontal 
Type Mask). Установите указатель мыши на то место изображе-
ния, где вы хотите поместить текст. Это позволит задать точку 
ввода текста. На  изображении появится полупрозрачная цвет-
ная маска.

2 Введите текст 
на клавиатуре. 
По мере ввода 
текста в цветной 
маске появят-
ся прозрачные 
области в форме 
букв. Щелкните 
мышью по кноп-
ке Подтвердить 
(Commit) на па-
нели параметров, 
чтобы создать область выделения.

3 Выделенная область в виде букв появится в окне изображения. 
Обратите внимание на  то, что инструмент Текст-маска (Type 
Mask) не приводит к созданию нового слоя.

4 Теперь вы можете пере-
тащить выделение в но-
вое окно изображения, 
создать из выделенной 
области новый слой или использовать любые команды, которые, 
как правило, к ней применяются.

Перед тем как принять изме-
нения вы можете выделить, от-
форматировать и переместить 
текст-маску, как стандартный 
текст.

После создания текста-маски 
используйте один из инстру-
ментов выделения, чтобы пере-
местить границу выделенной 
области, если необходимо.

Инструмент Текст-маска (Type 
Mask) создает область выделе-
ния. Вы можете перемещать, 
копировать, заполнять или 
добавлять контур к этому выде-
лению, как к любому другому.
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Стили текста и слоя
При работе с текстовым слоем вы также можете применять стили слоя, 
как описано в предыдущей главе.

1 Чтобы применить стиль слоя к тесто-
вому слою, сначала щелкните мышью 
по текстовому слою, чтобы сделать его 
активным.

2 Выберите команду меню Слои → Стили 
слоя (Layer → Layer Styles). Выберите 
стиль в соответствующем подменю. На-
стройте параметры в диалоговом окне 
Стиль слоя (Layer Style). После щелчка 
по кнопке ОК в диалоговом окне на ми-
ниатюре текстового 
слоя на панели Слои 
(Layers) появится 
значок ( ), указы-
вающий на то, что 
к этому измененному 
текстовому слою 
применен эффект.

Вы также можете выбрать стиль 
слоя, используя кнопку До-

бавить стиль слоя (Add Layer 
Style) в нижней части панели 
Слои (Layers).

См. раздел «Стили слоя» главы 8 
для получения дополнительной 
информации о работе со стиля-
ми слоя. См. раздел «Редактиро-
вание и выделение текста» этой 
главы для получения информа-
ции о редактировании тексто-
вого слоя.

Редактируемый текстовый 
слой со стилем, отделенный 

от фонового слоя.
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Текстовые эффекты
Программа Photoshop предоставляет разнообразные способы создания 
интересных текстовых эффектов.

Текст по контуру

Вы можете создать текст, который располагается по контуру, с помо-
щью инструмента Перо (Pen) и Произвольная фигура (Shape).

1 Выберите инструмент Горизонтальный 
текст (Horizontal Type) или Вертикаль-
ный текст (Vertical Type). Установите 
указатель мыши на контур. Важно 
установить на контур черную стрелку 
текстового курсора. Щелкните мышью 
по контуру. Начните вводить текст в точ-
ке вставки. Щелкните мышью по кноп-
ке Подтвердить (Commit)/Отменить 
(Cancel) на панели параметров, чтобы 
принять или отказаться от изменений. После щелчка по кнопке 
Подтвердить (Commit) текст оказывается на новом слое на па-
нели Слои (Layers).

2 Чтобы переместить текст вдоль контура, выберите инструмент 
Выделение контура (Path Selection) или Прямое выделение 
(Direct Selection). Установите курсор в начале текста. Когда он 
примет вид ([зн]), нажав и удерживая кнопку мыши, перетащите 
его, чтобы переместить текст вдоль контура.

Тип деформации

Программа Photoshop предусматривает различные предустановленные 
типы деформации, которые вы можете настроить в соответствии с ва-
шими требованиями.

Для деформации текста убедитесь в  том, что вы выбрали текстовый 
слой на панели Слои (Layers). Щелкните мышью по кнопке Деформи-
рованный текст (Warp Type) ( ) на  панели параметров. Выберите 
предустановленный эффект деформации в  раскрывающемся списке 
Стиль (Style). Используйте ползунковые регуляторы Изгиб (Bend), Ис-
кажение по горизонтали (Horizontal Distortion) и Искажение по вер-
тикали (Vertical Distortion) для настройки эффекта. Щелкните мышью 
по кнопке ОК. Деформированный текст остается доступным для редак-
тирования. Выберите вариант Не показывать (None) в раскрывающем-
ся списке Стиль (Style), чтобы удалить деформацию с текстового слоя.

См. главу 10 для получения ин-
формации о создании контуров 
и работе с инструментами Перо 
(Pen) и Произвольная фигура 
(Shape).

Индикатор базовой линии 
представляет собой волнистую 
линию, которая пересекает 
курсор в точке, находящейся 
на расстоянии в три четверти 
от его верха.

Чтобы отразить текст относи-
тельно контура, выберите ин-
струмент Выделение контура 
(Path Selection) или Прямое 

выделение (Direct Selection). 
Установите курсор на текст. 
Когда он примет вид ( ), нажав 
и удерживая кнопку мыши, пе-
ретащите его поперек контура.
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Контуры позволяют 
создавать точные 

области выделения, 
а также могут быть 
полезны при создании 

вырезок в таких 
приложениях  

как Adobe InDesign.

Преобразование выделенных областей 

в контуры

Использование инструмента Перо

Выделение контуров и точек

Управление точками

Операции с точками

Экспорт контуров

Быстрые направляющие

Создание слоев-фигур

Заливка и обводка фигур
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Преобразование  
выделенных областей 
в контуры
Быстрый метод создания контура заключается в том, чтобы выделить 
область, преобразовать ее во временный рабочий контур, а затем со-
хранить этот контур.

1 Сначала создайте выделенную об-
ласть с помощью удобного для вас 
инструмента выделения. Затем 
в меню панели Контуры (Paths) 
выберите пункт Образовать ра-
бочий контур (Make Work Path).

2 Появится диалоговое окно Об-
разовать рабочий контур (Make 
Work Path). Укажите значение 
параметра Допуск (Tolerance) 
(в диапазоне 0,5–10).

3 Щелкните мышью 
по кнопке ОК в диа-
логовом окне. На па-
нели Контуры (Paths) 
появится временный 
рабочий контур с ми-
ниатюрой. При этом 
выделенная область 
исчезнет. Выберите 
пункт Сохранить 
контур (Save Path) 
в меню панели, если 
вы хотите сохранить 
этот контур перед его 
изменением, и введите 
имя. Щелкните мы-
шью по кнопке ОК в диалоговом окне. Новый контур появится 
вместо рабочего на панели Контуры (Paths).

Параметр Допуск (Tolerance) 
определяет то, насколько 
близко контур соответствует 
выделенной области. Чем ниже 
значение этого параметра, 
тем более точно контур будет 
повторять выделенную об-
ласть, включая в себя большее 
количество точек. Чем выше 
значение параметра Допуск 
(Tolerance), тем менее подробно 
контур будет повторять выде-
ленную область, включая в себя 
меньше точек.
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4 Чтобы скрыть контур, щелкните 
мышью по пустому пространству 
на панели Контуры (Paths). Для 
отображения контура щелкните 
мышью по его имени, что также 
сделает контур активным.

Преобразование контуров  
в выделенные области

Вы также можете преобразовать контур в область выделения. 
Это бывает полезно, когда вам нужно создать очень точное 
выделение.

Чтобы преобразовать контур в выделение, щелкните мышью по конту-
ру на панели Контуры (Paths). Затем выберите пункт Выделить область 
(Make Selection) в меню панели или щелкните мышью по кнопке Загру-
зить контур как выделенную область (Load Path as Selection).

В любой момент времени 
на панели Контуры (Paths) 
у вас может быть только один 
рабочий контур, который имеет 
временный характер. Чтобы 
при сохранении файла контур 
не пропал, вам необходимо 
сохранить контур.
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Использование  
инструмента Перо
Для создания контуров вы можете использовать инструмент Pen 
(Перо). Когда вы начинаете создавать контур, он отображается в каче-
стве «рабочего контура» на панели Контуры (Paths). Рабочий контур 
является временным.

Инструмент Pen (Перо) создает опорные точки, соединенные прямы-
ми отрезками или изогнутыми сегментами. Вы можете использовать 
другие инструменты в  группе Pen (Перо) для добавления, удаления 
или перемещения опорной точки, а также изменения ее вида с гладкой  
на угловую и наоборот. Вы также можете редактировать изогнутые сег-
менты, перетаскивая направляющие Безье.

1 Чтобы создать контур, выберите инстру-
мент Pen (Перо) на панели инструментов. 
Выберите вариант Контур (Path) в  рас-
крывающемся списке Режим инструмен-
та (Tool Mode) на панели параметров. Вы 
можете установить флажок Просмотр (Preview) в  раскрываю-
щемся списке Настройки (Settings) ( ) на панели параметров, 
чтобы обеспечить предварительный просмотр отрезков в  про-
цессе рисования.

2 Установите указатель мыши 
на точку, в которой собираетесь 
начать рисовать контур, щелкните 
и отпустите кнопку, переместите 
мышь и щелкните еще раз, чтобы 
создать прямолинейный отрезок. 
Продолжайте передвигать ука-
затель и щелкать кнопкой мыши, 
чтобы создать дополнительные прямые 
отрезки.

3 Кроме того вы можете, нажав и  удержи-
вая кнопку мыши, перетащить последнюю 
для создания опорной точки и  направ-
ляющих изогнутого сегмента. Отпустите 
кнопку и переместите указатель, а  затем, 
снова нажав и удерживая кнопку, перета-
щите мышь, создавая следующую опорную точ-
ку с направляющими. Продолжайте выполнять 
эти действия, чтобы очертить нужный контур. 

Используйте меню панели Кон-

туры (Paths) ( ) для создания 
нового контура, прежде чем 
использовать инструмент Pen 
(Перо), чтобы автоматически 
сохранить контур, минуя про-
межуточный этап, связанный 
с созданием рабочего контура.

В процессе создания контура 
вы можете нажать клавишу 
Delete, чтобы удалить послед-
нюю опорную точку. Нажмите 
клавишу Delete два раза, чтобы 
удалить весь контур.

Используйте инструмент Сво-

бодное перо (Freeform Pen), 
чтобы создать контур, нажав 
и удерживая кнопку мыши и пе-
ретащив указатель. Это похоже 
на рисование карандашом. 
В данном случае вы не кон-
тролируете местоположение 
опорных точек, однако легко 
сможете изменить контур после 
его создания.
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Установите флажок Автомати-

ческое добавление/удаление 
(Auto Add/Delete) на панели 
параметров, чтобы иметь 
возможность использовать 
инструмент Перо (Pen) для до-
бавления и удаления опорных 
точек на выделенный контур. 
Курсор инструмента будет изме-
нять вид в зависимости от того, 
на что вы его навели —  на опор-
ную точку или на отрезок.

В файле может быть только 
один рабочий контур. Реко-
мендуется сохранить контур 
и присвоить ему имя, чтобы 
случайно не удалить его после 
создания другого рабочего 
контура. См. раздел «Преобра-
зование выделенных областей 
в контуры» данной главы для 
получения более подробной 
информации о сохранении 
рабочего контура.

На представленных иллюстра-
циях контуры располагаются 
вдали от объекта, чтобы их мож-
но было легче различить. При 
создании обтравочного контура 
лучше позиционировать его 
на расстоянии примерно в один 
пиксель внутрь от края фигуры, 
которую вы хотите вырезать, 
чтобы избежать включения не-
желательных крайних пикселей.

Установите курсор инструмента Pen (Перо) на начальную точку. 
Обратите внимание на  небольшой круг около него. Щелкните, 
чтобы замкнуть контур. Он появится на панели Контуры (Paths) 
с названием по умолчанию Рабочий контур (Work Path).

4 Чтобы создать незамкнутый 
контур, следуйте инструкции, 
описанной на шагах 1–3, только 
вместо щелчка по начальной точке 
щелкните мышью по инструменту 
Pen (Перо) на панели инстру-
ментов, чтобы завершить контур. 
Теперь у вас есть незамкнутый контур, к которому вы можете 
применить обводку.

Создание угловых точек

При использовании инструмента Pen (Перо) для создания 
контура вы можете добавлять угловые точки в сочетании 
с прямыми отрезками, а также гладкие точки. Во многих 
случаях с  помощью одних только гладких точек невоз-
можно создать нужный контур.

Угловая точка обеспечивает резкое изменение направле-
ния линии. При этом направляющими маркерами можно 
манипулировать независимо друг от  друга. Именно это 
делает угловые точки незаменимыми при создании кон-
туров с резкими изменениями в направлении.

1 Чтобы создать угловую точку, перетащите мышь, 
нажав и  удерживая ее кнопку, как при создании 
гладкой точки. Сконцентрируйтесь на  создании 
правильной формы сегмента, предшествующего 
точке. Не отпускайте кнопку мыши.

2 Удерживая нажатой клавишу Alt/�, перетащи-
те направляющий маркер. Это преобразует точку 
в  угловую. Теперь вы можете контролировать на-
правление следующего сегмента. При перетаски-
вании второго направляющего маркера обратите 
внимание на то, что он больше не влияет на первый. 
Отпустите кнопку мыши.

3 Переместите указатель мыши в  новое положение, 
а затем продолжите добавлять гладкие или угловые 
точки.
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Выделение контуров  
и точек
Используйте следующие техники для выделения, снятия выделения 
и удаления контуров.

1 Чтобы выделить контур, сначала 
его необходимо отобразить. Для 
этого щелкните по  нему мышью 
на панели Контуры (Paths). Теперь 
контур виден в окне изображения.

2 Чтобы выделить и переместить 
весь контур, выберите инстру-
мент Выделение контура (Path 
Selection), а затем щелкните мышью 
в любом месте контура. Все его опорные 
точки примут вид заполненных цветом 
квадратов. Перетащите опорную точку 
или какую-либо часть выделенного кон-
тура, чтобы изменить ее местоположение. Чтобы снять выделение 
с контура, щелкните мышью в каком-либо месте вне контура, 
используя инструмент Выделение 
контура (Path Selection). Контур 
по-прежнему виден, но не выделен.

3 Чтобы выделить и отредактировать опор-
ные точки, а также связанные с ними на-
правляющие маркеры, выберите инстру-
мент Прямое выделение (Direct Selection). 
Щелкните мышью по  видимому, но  не  выделенному контуру, 
чтобы сделать его активным. Теперь отображаются образующие 
контур кривые и прямые сегменты вместе с опорными точками.

4 Щелкните мышью по  опорной точке ис-
кривленного сегмента, чтобы выделить 
ее. Опорная точка, по которой вы щелк-
нули, заполнится цветом, и вы увидите ее 
направляющие маркеры.

5 Чтобы удалить контур, используя 
инструмент Прямое выделение (Direct 
Selection), при выделенной точке или 
отрезке контура, дважды нажмите клавишу Delete. Кроме того, 
вы можете перетащить имя контура на значок в виде мусорной 
корзины на панели Контуры (Paths).

Выделенная опорная точка 
имеет вид заполненного цветом 
квадрата, невыделенная точка 
представляет собой пустой 
квадрат.

Для повышения наглядности 
контур был передвинут от края 
изображения.
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Управление точками
Для создания точного контура часто требуется добавлять, удалять 
и преобразовывать его опорные точки.

1 Чтобы добавить точку, убедитесь 
в  том, что контур выделен, выбе-
рите инструмент Перо+ (добавить 
опорную точку) (Add Anchor Point) 
из группы инструмента Перо (Pen), 
а затем щелкните. Если вы щелкнете 
по искривленному или прямому сегменту, вы автоматически со-
здадите опорную точку с направляющими маркерами.

2 Чтобы удалить точку, убедитесь в том, 
что контур выделен, выберите ин-
струмент Перо- (удалить опорную 
точку) (Delete Anchor Point), устано-
вите указатель мыши на  существую-
щую опорную точку и щелкните. Кон-
тур будет перерисован без нее.

3 Чтобы преобразовать гладкую точ-
ку в  угловую, выделите опорную точ-
ку с  помощью инструмента Прямое 
выделение (Direct Selection). Выберите 
инструмент Угол (Convert Point), уста-
новите курсор на  направляющий мар-
кер, а затем, нажав и удерживая кнопку мыши, перетащите его. Ис-
пользуйте инструмент Прямое выделение (Direct Selection), чтобы 
внести дополнительные изменения в направляющие маркеры.

4 Для преобразования опорных точек 
на  прямых отрезках в  гладкие точки вы-
берите инструмент Угол (Convert Point), 
установите курсор на опорную точку, а за-
тем перетащите мышь, нажав и удерживая 
ее кнопку. Вокруг точки появятся направ-
ляющие линии. Используйте инструмент 
Прямое выделение (Direct Selection) для 
дальнейшего изменения точек.

5 Чтобы преобразовать гладкую точку в уг-
ловую без направляющих линий, выбери-
те инструмент Угол (Convert Point), а за-
тем щелкните мышью по опорной точке.

В случае с гладкой точкой, при 
перетаскивании одного направ-
ляющего маркера по кругу с по-
мощью инструмента Прямое 

выделение (Direct Selection) 
другой маркер уравновешивает 
ее, обеспечивая сглаженность 
кривой в опорной точке.

В угловой точке происходит 
резкая смена направления. 
Обратите внимание на то, что 
перетаскивание одного из на-
правляющих маркеров угловой 
точки не оказывает влияния 
на другой маркер, таким 
образом, вы можете управлять 
маркерами независимо друг 
от друга.

Курсор инструмента Перо+ 

(добавить опорную точку) 
(Add Anchor Point) имеет вид 
пустой стрелки до тех пор, пока 
вы не установите его на кон-
тур. После этого он примет 
вид инструмента Перо (Pen) 
с дополнительным символом 
«плюс» (+). Точно так же курсор 
инструмента Перо- (удалить 

опорную точку) (Delete Anchor 
Point) появляется только тогда, 
когда вы установите указатель 
мыши на существующую опор-
ную точку.
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Операции с точками
Часто контуры необходимо изменять и  дорабатывать для получения 
нужного результата.

1 Чтобы изменить гладкую точ-
ку, убедитесь в том, что контур 
выделен. Затем, используя инстру-
мент Прямое выделение (Direct 
Selection), щелкните мышью 
по опорной точке. Направляющие 
маркеры появятся по обе стороны 
от нее. Они контролируют форму 
и длину искривленного сегмента.

2 В процессе перетаскивания 
направляющего маркера гладкой 
опорной точки, при изменении 
угла с одной стороны, второй 
маркер уравновешивает первый. 
Это обеспечивает сглаженность 
кривой в опорной точке.

3 Чем дальше от опор-
ной точки вы пере-
таскиваете направ-
ляющий маркер, тем 
длиннее становится 
соответствующий 
сегмент кривой. 
Поскольку он ограничен опорными точками с обоих концов, 
сегмент выгибается еще сильнее. Переместите направляющий 
маркер ближе к опорной точке, и участок кривой станет короче.

4 При перетаскивании направляю-
щих маркеров угловой опорной 
точки каждый из них передви-
гается совершенно независимо 
от другого, что обеспечивает 
резкое изменение направления 
в точке.

Выберите инструмент Прямое 

выделение (Direct Selection) 
для редактирования контуров 
и точек (см. раздел «Выделе-
ние контуров и точек» данной 
главы).        

 

Выделите опорную точку и ис-
пользуйте клавиши �, �, � и � 
для перемещения выделенной 
точки с шагом в один пиксель.

При выбранном инструменте 
Перо (Pen) нажмите и удержи-
вайте клавишу Ctrl/�, чтобы 
временно переключиться на ин-
струмент Прямое выделение 
(Direct Selection). Когда указа-
тель мыши будет находиться 
непосредственно над опорной 
точкой или направляющим 
маркером, нажмите и удержи-
вайте клавишу Alt/�, чтобы 
переключиться на инструмент 
Угол (Convert Point).
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Экспорт контуров

Экспорт контуров в приложение Adobe Illustrator

Иногда бывает полезно экспортировать контур из программы Photoshop 
в Adobe Illustrator для его дальнейшего использования.

1 Чтобы экспортировать контур в  приложение Adobe Illustrator, 
убедитесь в том, что он сохранен и присутствует на панели Кон-
туры (Paths).

2 Выберите команду меню 
Файл → Экспортировать → 
Контуры в Illustrator (File → 
Export → Paths to Illustrator). 
Если в вашем документе 
Photoshop содержится более 
одного сохраненного контура, то в диалоговом окне Экспорт кон-
туров в файл (Export Paths to File) выберите нужный в раскрываю-
щемся списке Контуры (Paths). Щелкните мышью по кнопке ОК.

3 Укажите место, где вы хоти-
те сохранить файл в диало-
говом окне Выберите имя 
файла для сохранения кон-
туров (Choose File Name). Нажмите кнопку Сохранить (Save).

4 Выполните 
команду меню 
Файл →  
Открыть (File → Open) в про-
грамме Adobe Illustrator, чтобы 
импортировать контур. Если он 
изначально не виден, используйте 
инструмент выделения в рабо-
чей области, а затем примените 
к выделенному контуру заливку 
или обводку.

5 См. раздел «Открытие и  помеще-
ние файлов в  формате EPS» гла-
вы  3 для получения информации 
о  помещении файлов Illustrator 
EPS в документ Photoshop.

Вы также можете скопировать 
выделенный контур из про-
граммы Photoshop в Illustrator. 
Для обеспечения максимальной 
гибкости при вставке конту-
ра в приложение Illustrator 
выберите вариант Составная 

фигура (доступна для редак-

тирования) (Compound Shape 
(fully editable)).
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Быстрые направляющие
Быстрые направляющие облегчают и  повышают точность процессов 
рисования, манипулирования и  позиционирования объектов, фигур 
и слоев без использования дополнительных линеек.

1 Если при работе с инстру-
ментом Перемещение (Move) 
вы удерживаете нажатой 
клавишу Alt/� при перета-
скивании содержимого слоя, 
то на время отобразятся ин-
терактивные подсказки со значениями (светло-пурпурного цвета), 
которые позволяют точно позиционировать дубликат слоя.

2 Быстрые направляющие обозначают одинаковое расстояние 
между объ-
ектами при 
дублирова-
нии и переме-
щении слоев.

3 Выберите целевой слой. Работая с инструментом Перемещение 
(Move), установите указатель мыши на другой, невыделенный слой 
(не щелкайте по нему и не пытайтесь его перетащить). Удерживая 
нажатой клавишу 
Ctrl/�, вы сможете 
увидеть значения, 
определяющие 
отношения объек-
тов на целевом слое, 
и «парящий» над ним 
слой. Используйте 
клавиши �, �, � и �, 
чтобы переместить 
содержимое целевого слоя.

4 Работая с инструментом Перемещение (Move), отведите 
указатель мыши от объекта/пикселей выделенного целевого 
слоя. Затем нажмите 
и удерживайте кла-
вишу Ctrl/�, чтобы 
отобразить быстрые 
направляющие, 
показывающие рас-
стояния до каждого 
из краев холста.

Работая с инструментом Пе-

ремещение (Move), нажмите 
и удерживайте клавишу Alt/�, 
чтобы создать копию слоя при 
перетаскивании указателя 
мыши.
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Создание слоев-фигур
Инструменты фигур позволяют создавать линии, прямоугольники, овалы, 
многоугольники и  произвольные фигуры. Используйте панель параме-
тров, чтобы задать настройки для каждого инструмента по отдельности.

1 Чтобы создать прямоугольник в качестве слоя-фигу-
ры, выберите инструмент Прямоугольник (Rectangle). 
Убедитесь в том, что в раскрывающемся списке 
Режим инструмента выбора (Pick tool mode) 
на панели параметров выбран вариант Фигура 
(Shape). Используйте раскрывающуюся панель 
Заливка (Fill) на панели параметров для выбора оттенка, если хоти-
те, чтобы при создании прямоугольника он заполнялся цветом.

2 Расположите курсор в окне изображения. Нажав и удерживая 
кнопку мыши, перетащите его по диагонали, 
чтобы задать размер фигуры. На панели Слои 
(Layers) появится новый слой-фигура. Используй-
те элементы управления на панели параметров, 
чтобы настроить созданную фигуру. Для создания 
дополнительных фигур на этом же 
слое либо выберите новый ин-
струмент фигур на панели, либо 
используйте тот же, но удерживайте 
нажатой клавишу Shift, когда начне-
те выполнять перетаскивание для 
определения новой фигуры.

3 При создании фигуры с помощью инструментов Прямоуголь-
ник (Rectangle), Прямоугольник со скругленными углами 
(Rounded Rectangle) и Эллипс (Ellipse) также появляется панель 
Свойства интерактивной формы (Live Shape Properties). (Более 
подробная информация представлена в следующем разделе.)

4 При выделенном слое-фигуре исполь-
зуйте инструмент Прямое выделение 
(Direct Selection), чтобы выделить и из-
менить форму объекта в окне изобра-
жения. При редактировании интерак-
тивной формы появится окно, 
оповещающее о том, что если 
вы продолжите, то фигура будет 
преобразована в контур, и у вас 
больше не останется доступа 
к параметрам панели Свойства 
интерактивной формы (Live 
Shape Properties).

Используйте раскрывающийся 
список [зн] на панели параме-
тров, чтобы при необходимо-
сти настроить инструменты. 
Например, вы можете добавить 
стрелки к концам линий.

Чтобы создать квадрат, удер-
живайте нажатой клавишу Shift 

при перетаскивании курсора 
инструмента Прямоугольник 
(Rectangle). Отпустите кнопку 
мыши, прежде чем отпустить 
клавишу Shift, в противном 
случае эффект ограничения 
будет потерян. Удерживая на-
жатой клавишу Alt/� и кнопку 
мыши, перетащите курсор 
инструмента Прямоугольник 
(Rectangle), чтобы нарисовать 
прямоугольник из центра к кра-
ям. Вы можете использовать 
эти же клавиши-модификаторы 
с инструментом Эллипс (Ellipse) 
для создания окружностей.
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Заливка и обводка фигур
При работе со  слоями-фигурами вы можете применять разнообраз-
ный и гибкий набор атрибутов заливки и обводки, используя элементы 
управления на  панели параметров и  панели Свойства интерактив-
ной формы (Live Shape Properties) для инструментов Прямоугольник 
(Rectangle) и Эллипс (Ellipse).

Используйте параметры заливки для заполнения рисуемой фигуры 
цветом. Вы можете заполнить слой-фигуру сплошным цветом, гради-
ентом и узором. Обводка —  это видимый контур фигуры. Допустимо 
применить к обводке сплошной цвет, градиент и узор, а также указать 
значение толщины и выбрать стиль линии, например, сделать ее пунк-
тирной или точечной.

1 При создании фигуры к ней сразу применяются настройки за-
ливки и обводки, заданные на панели параметров.

2 Чтобы изменить цвет 
заливки для активного 
слоя-фигуры, щелкните 
мышью по раскрывающе-
муся списку Задать тип 
заливки фигуры (Set fill 
type) на панели параметров 
или на панели Свойства 
интерактивной формы 
(Live Shape Properties), тогда 
отобразится соответствую-
щая панель.

3 Используйте верхний ряд 
кнопок, чтобы указать тип заливки: сплошной цвет, градиент 
или узор (см. в главе 5 раздел «Градиент», где говорится о рабо-
те с градиентами и раздел «Заливка» —  о работе с узорами).

4 Чтобы залить фигуру сплошным цветом, щелкни-
те мышью по  кнопке Чистый цвет (Solid Color), 
затем  —  по  одному из  предустановленных цветов 
на панели с образцами или выберите 
один из  недавно использованных об-
разцов цвета. Вы можете щелкнуть 
по  кнопке Палитра цветов (Color 
Picker) ( ) для выбора цвета с помо-
щью одноименного диалогового окна 
(см. раздел «Палитра цветов» главы 4 

Щелкните мышью 
по кнопке Нет заливки 
(None), если вы хотите 
удалить заливку из слоя-фигуры.

Дважды щелкните мышью 
по миниатюре слоя-фигуры 
на панели Слои (Layers), чтобы 
изменить цвет заливки, исполь-
зуя диалоговое окно Палитра 

цветов (Color Picker).

При создании фигуры с помо-
щью инструментов Прямо-

угольник (Rectangle), Прямо-

угольник со скругленными 

углами (Rounded Rectangle) 
и Эллипс (Ellipse) появляется 
панель Свойства интерак-

тивной формы (Live Shape 
Properties).
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для получения подробной информации об использовании диа-
логового окна Палитра цветов (Color Picker)).

5 После выбора цвета заливки снова щелкните 
мышью по треугольнику, чтобы закрыть па-
нель выбора типа заливки.

Создание обводки

1 Убедитесь в том, что у вас все еще выбран один из инструмен-
тов фигур, слой-фигура является активным, а в раскрывающем-
ся списке Режим инструмента выбора (Pick tool mode) выбран 
вариант Фигура (Shape). Вы можете задать нужные показатели 
на панели параметров, а в случае с прямоугольниками и эллип-
сами еще и  на  панели Свойства интерактивной формы (Live 
Shape Properties).

2 Введите значение толщины штриха 
в соответствующее поле ввода или ис-
пользуйте ползунковый указатель, чтобы 
задать значение параметра. Цветом об-
водки по умолчанию является черный.

3 Используйте раскрывающийся список 
Задать тип штриха фигуры (Set stroke 
type), чтобы применить сплошной цвет, 
градиент или узор. Для 
этого щелкните мышью 
по кнопке Чистый цвет 
(Solid Color), затем —  
по одному из образцов 
цвета или выберите один 
из недавно использован-
ных цветов. Щелкните 
мышью по кнопке Пали-
тра цветов (Color Picker) 
( ) для выбора оттенка 
с помощью одноименного 
диалогового окна.

4 Щелкните мышью по рас-
крывающемуся списку 
Задать стиль штриха 

При создании прямоугольников 
используйте элементы управле-
ния на панели Свойства интер-

активной формы (Live Shape 
Properties), чтобы настроить 
радиус скругления углов.

Щелкните мышью 
по кнопке Нет цве-

та (None) на панели 
Задать тип штриха фигуры 
(Set stroke type), если вы хотите 
удалить обводку из слоя-фигуры.
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фигуры (Set stroke style), 
а затем выберите один 
из предусмотренных ва-
риантов, чтобы изменить 
стиль штриха со сплошной 
линии на пунктирную или 
точечную.

Чтобы создать свой собствен-
ный пунктирный или точечный 
стиль обводки, щелкните мы-
шью по кнопке Другие пара-

метры (More options) в нижней 
части панели Параметры 

обводки (Stroke Options).



11 Каналы и маски

Каналы и маски 
предоставляют мощные 

и гибкие возможности 
для полной или 

частичной защиты 
фрагментов изображения 

при редактировании 
немаскированных 

областей.

Режим быстрой маски

Каналы

Сохранение и загрузка выделенных областей

Слои-маски

Пиксельные и векторные маски

Свойства маски
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Режим быстрой маски
В режиме быстрой маски вы создаете наложение красного цвета с 50%-ным 
значением прозрачности. Оно представляет собой защищенную об-
ласть изображения и работает подобно красному фотофильтру. Режим 
быстрой маски особенно удобен благодаря тому, что в процессе ее со-
здания и точной настройки вы видите и изображение, и маску.

1 Чтобы создать быструю маску, щелкните мышью 
по кнопке Редактирование в режиме «Быстрая 
маска» (Edit in Quick Mask Mode) на панели инстру-
ментов. Убедитесь в том, что в качестве основного и фонового 
цвета по умолчанию выбраны соответственно черный и белый.

2 На панели кистей выберите нуж-
ный размер. Используйте жесткую 
кисть для создания области выде-
ления с четкими краями, и мягкую 
для выделения с более размытыми 
краями. Выберите инструмент 
рисования и перетащите по изо-
бражению, чтобы «рисовать» 
в маске. Рисование черным цветом 
добавляет к маске. Несмотря 
на то, что вы можете видеть сквозь 
полупрозрачную красную маску, 
покрытые ею пиксели полностью 
защищены от редактирования.

3 Чтобы удалить области маски, вы можете 
использовать инструмент Ластик (Eraser) 
или рисовать белым цветом.

4 По окончании работы над маской 
щелкните мышью по кнопке Редак-
тировать в стандартном режиме 
(Edit in Standard Mode). Это превра-
тит участки изображения, которые 
не были частью вашей быстрой 
маски, в область выделения. Теперь 
вы можете изменить выделенные 
области (на изображении слева 
показан эффект применения филь-
тра Размытие при малой глубине 
резкости (Lens Blur)), не затраги-
вая фрагменты, которые не были 
частью быстрой маски.

Вы можете сначала создать 
приблизительное выделение, 
а затем перейти в режим бы-
строй маски и отредактировать 
ее, если это необходимо.

Рисование серым или любым 
другим цветом создает полу-
прозрачную (частичную) маску.
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Каналы
Панель Каналы (Channels) (команда меню Окно → Каналы (Window → 
Channel)) отображает цветовые компоненты, объединенные в цветное 
изображение, с которым вы работаете большую часть времени.

Например, в  режиме RGB существуют 
четыре канала —  составное изображение 
(объединение всех каналов) и  каналы 
для красного, зеленого и синего цветово-
го компонента изображения. В  режиме 
CMYK предусмотрено пять каналов.

Используя панель Каналы (Channels), вы 
можете избирательно изменять цветовые 
компоненты вашего изображения.

1 Чтобы переключиться на определенный 
канал, щелкните мышью по его назва-
нию на панели Каналы (Channels). Канал 
окажется выделен. Окно изображения 
изменится в зависимости от выбранного 
канала.

2 Вы можете про-
смотреть каналы, 
щелкнув по со-
ответствующей 
кнопке видимо-
сти. Окно изо-
бражения изме-
нится, но ваши 
возможности 
редактирования 
будут ограничены 
выбранным кана-
лом.

3 Щелкните мышью по составному каналу 
RGB, чтобы вернуться в обычный режим 
редактирования изображения.

Вы можете изменить способ 
отображения каналов с града-
ций серого на цвет, который 
они представляют, выбрав 
в меню Редактирование 
(Edit) или Photoshop коман-
ду Настройки → Интерфейс 
(Preferences → Interface), а затем 
установив флажок Показывать 

каналы в цвете (Show Channels 
in Color).

Режимы Индексированные 

цвета (Indexed Color), Градации 

серого (Grayscale) и Битовый 

формат (Bitmap) предусматри-
вают только один канал.
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Сохранение и загрузка 
выделенных областей
Поскольку только одна выделенная область изображения способна быть 
активной в определенный момент времени, возможность сохранить выде-
ление, которое будет загружено позднее, имеет огромное значение. Особен-
но если создание области выделения потребовало некоторого времени. Вы-
деление сохраняется в качестве дополнительного канала на панели Каналы 
(Channels). Такие дополнительные каналы называются «альфа-каналами».

Сохранение выделенных областей

1 Чтобы сохранить выделенную 
область в качестве канала, выделите 
нужную часть изображения, а затем 
выберите команду меню Выделе-
ние → Сохранить выделенную 
область (Select → Save Selection). 
Откроется одноименное диалоговое 
окно. Укажите документ, в кото-
ром вы хотите сохранить 
канал (можете сохранить его 
в другом документе, чтобы 
предотвратить увеличение 
размера файла). Установи-
те переключатель Канал 
(Channel) в положение Новый 
(New). Введите имя для ка-
нала. Щелкните мышью по кнопке ОК. Другой метод заключается 
в том, чтобы после выделения нужной области щелкнуть по кнопке 
Сохранить выделенную область в новом 
канале (Save Selection as Channel) на панели 
Каналы (Channels).

2 На панели Каналы (Channels) по-
явится дополнительный канал. Это 
новый «альфа-канал», который явля-
ется полутоновым.

3 После сохранения области выделения 
в качестве альфа-канала вы може-
те сбросить выделение, поскольку 
теперь вы можете в любое время по-
вторно выбрать ту же самую область, 
используя альфа-канал.

Альфа-канал —  это 8-битовый 
полутоновый канал. При каждом 
сохранении выделения в каче-
стве канала, вы увеличиваете 
размер файла изображения.

К форматам файлов, позволяю-
щих сохранять информацию 
об альфа-канале, относятся: 
Photoshop, PDF, PICT и TIFF.

Когда вы работаете в режи-
ме быстрой маски, можете 
преобразовать быструю маску 
в альфа-канал, перетащив соот-
ветствующую запись, которая 
отображается на панели Кана-

лы (Channels), на кнопку Новый 

канал (New Channel).
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Загрузка выделенной области

Используйте следующую процедуру для повторного выделения обла-
сти, используя альфа-канал.

1 Чтобы загрузить канал как выделенную область, убедитесь 
в  отображении составного изображения. Вы можете сделать 
это, щелкнув по верхнему названию канала на панели Каналы 
(Channels). Затем выберите команду меню Выделение → Загру-
зить выделенную область (Select → Load Selection). Откроется 
одноименное диалоговое окно.

2 В раскры-
вающемся 
списке Канал 
(Channel) 
укажите канал, 
который хоти-
те загрузить. 
Выберите 
нужный вари-
ант в разделе 
Операция 
(Operation). Операции позволяют вам определить способ взаи-
модействия загружаемого выделения с существующей выделен-
ной областью (добавляет к ней, вычитает из нее или пересека-
ется с ней). Щелкните мышью по кнопке ОК.

3 Другой способ заключа-
ется в перетаскивании 
названия нужного кана-
ла на кнопку Загрузить 
выделение (Load Selection) 
на панели Каналы 
(Channels).

4 Чтобы удалить канал, 
перетащите его назва-
ние на значок в виде 
мусорного бачка в нижней 
части панели.

Допустимо отобразить альфа-
канал, не загружая его в изо-
бражение в качестве области 
выделения. После этого вы 
можете отредактировать маску, 
рисуя черным, белым или се-
рым цветом.

На панели Каналы (Channels) 
щелкните мышью по названию 
альфа-канала, который вы хоти-
те отобразить.

Белая область соответствует 
выделению, а черные участки 
представляют собой защи-
щенные от редактирования 
области.

Рисуйте черным цветом, чтобы 
удалить части маски выделения. 
Рисуйте белым цветом по лю-
бой черной части маски, чтобы 
добавить ее к выделенной 
области.
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Слои-маски
Используйте слои-маски, чтобы скрыть или отобразить области слоя. 
Слой-маска очень полезен, поскольку вы можете использовать его, что-
бы опробовать эффекты без фактического изменения пикселей. После 
достижения нужного результата разрешается применить маску в  ка-
честве постоянного изменения. Если результат вас не устраивает, вы 
можете удалить маску, не затрагивая пиксели слоя.

Этот пример начинается с изобра-
жения, состоящего из двух слоев: 
исходного фонового слоя и дру-
гого слоя, созданного с исполь-
зованием фильтра Рендеринг → 
Волокна (Render → Fibres).

1 Чтобы создать слой-маску для 
слоя, к которому применен 
фильтр Волокна (Fibres), сна-
чала активируйте этот слой, 
щелкнув по нему. Выбери-
те команду меню Слои → 
Слой-маска → Показать все 
(Layer → Layer Mask → Reveal 
All). Команда Показать 
все (Reveal All) делает все пиксели 
слоя видимыми. Слой с фильтром 
Волокна (Fibres) теперь полностью 
скрывает фоновый.

2 Миниатюра активного слоя-маски 
на панели Слои (Layers) выделе-
на границей. Щелкните по ней 
мышью, если хотите сделать слой 
активным. Щелкните по самой 
миниатюре, чтобы продолжить 
редактирование слоя-маски.

3 После выделения миниатюры убеди-
тесь в том, что в качестве основного 
цвета выбран черный. Выберите 
инструмент для рисования и при-
ступайте. Рисование черным цветом 
скрывает пиксели слоя, к которому 
применен фильтр Волокна (Fibres), 
выявляя пиксели находящегося под 
ним фонового слоя.

Для получения информации 
о создании слоев обратитесь 
к главе 8. Информацию об ис-
пользовании фильтров можно 
найти в главе 13.

Вы можете добавить слой- 
маску Показать все (Reveal All) 
к выделенному слою, щелкнув 
по кнопке Добавить слой-ма-

ску (Add Layer Mask) ( )  
в нижней части панели Слои 
(Layers). Щелкните мышью 
по этой кнопке, удерживая 
нажатой клавишу Alt, чтобы 
добавить слой-маску Скрыть 

все (Hide All).
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4 Пиксели слоя, к  которому при-
менен фильтр Волокна (Fibres), 
не удаляются безвозвратно при ри-
совании черным цветом. Рисуйте 
белым, чтобы отобразить пиксели 
на слое с фильтром Волокна (Fibres), 
по  сути, скрывая пиксели фоново-
го слоя. (При выборе пункта меню 
Слои → Слой-маска → Скрыть все 
(Layer → Layer Mask → Hide All) вы 
начинаете со  сценария, обратного 
описанному выше. Теперь все пик-
сели слоя, к  которому применен 
фильтр Волокна (Fibres), скрыты. Рисуйте белым цветом, чтобы 
выявить пиксели на этом слое, а черным —  чтобы скрыть их.)

5 Чтобы временно отключить слой-ма-
ску, выберите команду меню Слой-
маска → Выключить (Layer → Layer 
Mask → Disable) или щелкните мы-
шью по миниатюре слоя-маски, удер-
живая нажатой клавишу Shift. Чтобы 
снова активировать маску, выберите 
команду меню Слои → Слой-маска 
→ Включить (Layer → Layer Mask → 
Enable) или снова щелкните мышью 
по миниатюре слой-маски, удерживая нажатой клавишу Shift.

6 Чтобы приме-
нить слой- маску 
в качестве 
постоянного изменения, 
выберите команду меню Слои → Слой-ма-
ска → Применить (Layer → Layer Mask → 
Apply).

7 Чтобы удалить слой-маску, не затрагивая пиксели слоя, вы-
берите команду меню Слои → Слой-маска → Удалить (Layer → 
Layer Mask → Delete). Или 
перетащите миниатюру 
слой-маски (но не ми-
ниатюру слоя) на значок 
в виде мусорного бака 
в нижней части панели. Щелкните мышью по кнопке Применить 
(Apply) или Удалить (Delete). После применения слоя-маски вы 
не сможете вносить дальнейшие изменения. Щелкните мышью 
по кнопке Удалить (Delete), только если хотите удалить маску.

Вы можете рисовать оттенками 
серого, чтобы частично скрыть 
пиксели слоя, к которому при-
менен фильтр Волокна (Fibres).

Освоив принципы использо-
вания слоя-маски, начинай-
те использовать элементы 
управления Свойства маски 
(Mask Properties) для его точной 
настройки (см. следующий 
раздел).
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Пиксельные  
и векторные маски
Панель Свойства маски (Mask Properties) обеспечивает удобный и эф-
фективный способ работы со слоями-масками благодаря набору разно-
образных и гибких элементов управления. Используйте панель Свой-
ства маски (Mask Properties) в сочетании с панелью Слои (Layers).

Пиксельные маски

Пиксельные маски —  это слои-маски. Для скрытия и отображения пик-
селей маски вы можете рисовать черным или белым цветом, а также от-
тенками серого. В результате выборочно отображается или скрывается 
содержимое расположенных ниже слоев.

1 Чтобы создать пиксельный 
слой-маску, убедитесь в том, 
что вы выбрали слой, который 
хотите использовать в качестве 
маски, затем щелкните мышью 
по кнопке Добавить слой-маску 
(Add Layer Mask) ( ) в ниж-
ней части панели Слои (Layers). 
Миниатюра слоя-маски появит-
ся справа от миниатюры слоя.

2 В окне изображения рисуйте белым, черным или оттенком серо-
го цвета, чтобы скрыть или отобразить пиксели, формирующие 
маску. Добавьте черно-белый градиент, как в приведенном ниже 
примере, чтобы создать постепенный переход, который скрыва-
ет или отображает пиксели маски.

3 Для дальнейшего манипулирования и точной настройки маски 
щелкните мышью по кнопке Свойства (Properties), чтобы ото-
бразить панель Свойства маски (Mask Properties). Используйте 

Если вы примените слой-маску 
к фоновому слою, то программа 
Photoshop автоматически пре-
образует этот слой в «Слой 0», 
поскольку вы не можете создать 
слой-маску или векторную 
маску на фоновом слое.

Когда вы начинаете работать 
со слоем-маской и векторной 
маской, важно отличать миниа-
тюру слоя, которая отобража-
ется слева, от миниатюры слоя-
маски или векторной маски, 
которая отображается справа 
от миниатюры слоя.

Щелкните мышью по кнопке 
Применить маску (Apply Mask) 
( ) на панели Свойства 

маски (Mask Properties), когда 
закончите вносить изменения 
и решите сделать их постоян-
ными. После этого вы больше 
не сможете редактировать 
маску и манипулировать ей.
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параметры Плотность (Density), Растушевка (Feather), Край 
маски (Mask Edge), Цветовой диапазон (Color Range) и Инвер-
тировать (Invert) на панели Свойства маски (Mask Properties), 
чтобы настроить маску в соответствии со своими требованиями 
(см. следующий раздел).

Векторные маски

Векторные маски используют точно определенную векторную фигуру 
для создания маски. Как и в случае с пиксельной маской, вы используе-
те данную фигуру для выборочного отображения или скрытия содер-
жимого расположенных ниже слоев.

1 Чтобы создать векторную маску, выберите нужный слой на па-
нели Слои (Layers). В окне изображения нарисуйте векторный 
контур, используя инструмент Перо (Pen) или один из инстру-
ментов группы Произвольная фигура (Shape).

2 Выберите команду меню Слой → Векторная маска → Активный 
контур (Layer → Vector Mask → Current Path) (контур необязатель-
но должен быть выделен), чтобы создать векторную маску. Вме-
сто этого после создания векторного контура нажмите и  удер-
живайте клавишу Ctrl/�, а затем щелкните мышью по кнопке 
Добавить слой-маску (Add Layer Mask) ( ) в  нижней части 
панели Слои (Layers). Миниатюра векторной маски отобразится 
справа от миниатюры слоя. Векторный контур выявляет пиксели 
слоя, которые попадают в область, ограниченную этим контуром, 
и скрывает те пиксели, что в нее не попадают. То есть, по сути, 
создает области прозрачности за пределами контура.

3 Хотя векторная маска определяется с помощью точных матема-
тических кривых, вы можете использовать ползунковые регу-
ляторы Плотность (Density) и Растушевка (Feather) на панели 
свойств для дополнительного контроля над видом маски.

Вы можете создать векторную 
маску, используя инструмент 
Произвольная фигура (Shape) 
или Перо (Pen). Как правило, 
векторные маски имеют четко 
определенные края, однако 
при необходимости вы можете 
использовать ползунковый 
регулятор Растушевка (Feather) 
на панели Свойства (Properties) 
для смягчения и размытия век-
торной маски.

Для обеспечения дополни-
тельного контроля над видом 
векторной маски убедитесь 
в том, что миниатюра векторной 
маски является активной, а за-
тем щелкните мышью по кнопке 
Свойства (Properties) ( ), 
чтобы отобразить соответствую-
щую панель.
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Свойства маски
Используйте элементы управления на панели Свойства маски (Mask 
Properties) для изменения и точной настройки маски.

Плотность

Ползунковый регулятор Плотность 
(Density) позволяет вам контролировать 
степень непрозрачности слоя-маски. На-
стройка данного параметра обеспечива-
ет едва заметные эффекты смешивания 
в изображениях.

Растушевка

Используйте ползунковый регулятор 
Растушевка (Feather), чтобы смягчить 
и размыть маску.

Край маски

Щелкните мышью по кнопке Край маски (Mask Edge), чтобы получить 
доступ к диалоговому окну для уточнения маски. Это диалоговое окно 
содержит набор гибких элементов управления, с  помощью которых 
вы можете доработать пиксели, образующие край маски. Элементы 
управления аналогичны настройкам в диалоговом окне Уточнить край 
(Refine Edge), описанном в разделе «Уточнить край» главы 7.

Цветовой диапазон

Команда Цветовой диапазон (Color Range) позволяет создавать слож-
ные слои-маски на основе диапазонов похожих цветов в изображении.

1 При активном слое-маске щелкните мышью по  кнопке Цвето-
вой диапазон (Color Range). В  открывшемся диалоговом окне 
выберите вариант Изображение (Image), чтобы обеспечить 
предварительный просмотр в диалоговом окне, а затем выберите 
один из пунктов раскрывающегося списка Просмотр (Selection 
Preview), например, В  градациях серого (Grayscale), чтобы на-
строить предварительный просмотр в окне изображения.

Одна из основных причин 
использования слоев-масок 
заключается в необходимости 
работать над изображениями, 
не внося в них перманентных 
изменений, —  до тех пор, пока 
вы не решите применить или 
удалить маску, вы можете про-
должать настраивать параме-
тры для достижения нужного 
эффекта.

Щелкните мышью по кнопке 
Инвертировать (Invert), чтобы 
инвертировать слой-маску, в ре-
зультате чего черные области 
маски станут белыми, и наобо-
рот. Теперь скрыто то, что маска 
отображала, а ранее скрытое 
стало видимым.
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2 Щелкните мышью в  обла-
сти предварительного про-
смотра, используя инстру-
мент Пипетка (Eyedropper), 
чтобы начать выбирать 
цвета. Используйте пол-
зунковый регулятор Раз-
брос (Fuzziness) для уве-
личения или уменьшения 
диапазона похожих цветов, 
включенных в  маску. Ис-
пользуйте режимы До-
бавить (Add to)/Вычесть 
(Subtract from) инструмент 
Пипетка (Eyedropper), что-
бы увеличить или умень-
шить количество цветов в маске.

Установите флажок Локали-

зованные наборы цветов 
(Localized Color Clusters), чтобы 
ограничить выбор пикселя-
ми, цвета которых находятся 
в пределах значения параметра 
Разброс (Fuzziness), и смежны-
ми с ними, а затем используйте 
ползунковый регулятор Диа-

пазон (Range), чтобы расши-
рить область набора, если это 
необходимо.



12 Цветовая коррекция

Цветовая 
коррекция включает 

в себя изменение 
уровня яркости 

и контрастности, 
а также цветового 

баланса в изображении. 
С ее помощью вы можете 

исправить тональные 
и цветовые недостатки 

оригинала.

Яркость/Контрастность

Автоматическе тоновая и цветовая 

коррекция

Уровни

Кривые

Гистограмма

Коррекция

Настройка сочности

Цветовой баланс

Черно-белое

Тень/Свет
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Яркость/Контрастность
Команда Яркость/Контрастность (Brightness/Contrast) предоставляет 
наименее сложные элементы управления для изменения общей ярко-
сти/контрастности изображения. Она не меняет отдельных цветовых 
каналов, а применяет одни те же корректировки ко всем пикселям то-
нального диапазона изображения.

1 Чтобы изменить 
яркость и контраст-
ность всего изобра-
жения или области 
выделения, выберите 
команду меню Изо-
бражение → 
Коррекция → 
Яркость/
Контраст-
ность (Image → 
Adjustments → 
Brightness/
Contrast). 
Перетащите 
ползунковые регуляторы Яркость (Brightness) и Контрастность 
(Contrast) или введите значения в поля ввода. Щелкните мы-
шью по кнопке ОК в диалоговом окне.

2 Выберите команду меню Изображение → Коррекция → Авто-
контраст (Image → Adjustments → Auto Contrast), чтобы автомати-
чески отрегулировать контрастность изображения или области 
выделения. Когда области светов кажутся светлее, а области те-
ней —  темнее, общее качество изображения улучшается. Команда 
Автоконтраст (Auto Contrast) не оказывает влияния на отдельные 
каналы. Она приводит к тому, что области светов кажутся светлее, 
а области теней —  темнее, заменяя самые светлые и темные пик-
сели изображения на белые и черные соответственно.

Установите флажок Просмотр 
(Preview) в диалоговом окне 
Яркость/Контрастность 
(Brightness/Contrast), чтобы 
в режиме реального времени 
видеть на экране результат 
применения выбранных пара-
метров.

Щелкните мышью по кноп-
ке Яркость/Контрастность 
(Brightness/Contrast) ( ) на па-
нели Коррекция (Adjustments), 
чтобы настроить соответствую-
щий корректирующий слой. 
Корректирующие слои обес-
печивают «неразрушающее» 
редактирование изображения. 
(См. раздел «Коррекция» далее 
в главе).

Для изображений, созданных 
в предыдущих версиях про-
граммы Photoshop, автомати-
чески устанавливается флажок 
Использовать прежние (Use 
Legacy) при работе с коррек-
тирующим слоем Яркость/

Контрастность (Brightness/
Contrast). Установка флажка 
Использовать прежние (Use 
Legacy) не рекомендуется для 
высококачественной печати, 
поскольку в этом случае в диа-
пазонах светов и теней может 
произойти «отсечение» или 
потеря детализации.
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Автоматические тоновая 
и цветовая коррекции
Автоматическая тоновая коррекция позволяет автоматически регули-
ровать яркость и контрастность изображения. Эта функция проверяет 
каждый цветовой канал по отдельности и изменяет самые темные пик-
сели на черные, а самые светлые пиксели —  на белые, а затем перерас-
пределяет остальные оттенки серого между этими двумя точками.

Функция Автоматическая тоновая коррекция (Auto Tone) лучше всего рабо-
тает на изображениях, отличающихся достаточно равномерным распределе-
нием тональных значений, поскольку она перераспределяет пиксели на осно-
ве белых и черных точек, что обычно приводит к увеличению контрастности.

Функция Автоматическая цветовая коррекция (Auto Color) удаляет 
нежелательные цветовые оттенки в  изображении, не  затрагивая сте-
пень его контрастности.

1 Чтобы применить функцию Автоматическая тоновая коррекция 
(Auto Tone), выберите команду меню Изображение → Коррекция → 
Автоматическая тоновая коррекция (Image → Adjustments → Auto 
Tone). (Выберите команду меню Редактирование → Отменить 
(Edit → Undo), если результат окажется неудовлетворительным.)

2 Чтобы применить функцию Автоматическая цветовая коррекция 
(Auto Color), выберите команду меню Изображение → Коррекция → 
Автоматическая цветовая коррекция (Image → Adjustments → Auto 
Color). (Выберите команду меню Редактирование → Отменить 
(Edit → Undo), если результат окажется неудовлетворительным.)

Вы также можете использовать 
команду Автоматическая то-

новая коррекция (Auto Tone), 
щелкнув по кнопке Авто (Auto) 
в диалоговых окнах Уровни 
(Levels) и Кривые (Curves).

Функция Автоматическая 

тоновая коррекция (Auto Tone) 
настраивает каждый цветовой 
канал изображения по отдель-
ности. В результате на изобра-
жении могут исчезнуть или 
появиться некоторые цветовые 
оттенки.

Функции Автоматическая 

тоновая коррекция (Auto Tone) 
и Автоматическая цветовая 

коррекция (Auto Color), как пра-
вило, дают хорошие результаты 
при их применении к RGB-изо-
бражениям, однако они не обес-
печивают такую же степень 
точности, как при настройке 
вручную, когда вы используете 
диалоговые окна Уровни (Levels) 
и Кривые (Curves) или коррек-
тирующие слои.Исходное изображение Автоматическая 

тоновая коррекция
Автоматическая 

цветовая коррекция
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Уровни
Используйте диалоговое окно Уровни (Levels) (Изображение → Кор-
рекция → Уровни (Image → Adjustments → Levels)) для настройки то-
нового баланса цветных и черно-белых изображений. Вы можете на-
строить диапазоны светов, теней и полутонов выделенной области или 
всего изображения, или изменить только отдельные каналы.

Входные значения

Ползунковые регуляторы и поля ввода Входные значения (Input Levels) 
позволяют улучшить контрастность «плоского» изображения.

1 Выберите канал в  раскрывающемся списке Канал (Channel). 
Если вы не выберете отдельный канал, вы будете работать с со-
ставным изображением и влиять на все каналы.

2 Чтобы 
затемнить 
изображение, 
перетащите 
ползунковый 
регулятор 
черного 
цвета вправо. 
Также можно 
ввести соот-
ветствующее 
значение 
в крайнее 
левое поле 
ввода в группе Входные значения (Input Levels). Это приводит 
к тому, что пиксели становятся черными. Например, если вы 
перетащите черный ползунковый регулятор до значения 15, 
то все пиксели с исходным значением в диапазоне от 0 до 15 
станут черными. В результате изображение станет темнее.

3 Для осветления изображения перетащите влево белый ползунко-
вый регулятор в группе Входные значения (Input Levels). Вместо 
этого можно ввести соответствующее значение в крайнее правое 
поле ввода. В результате пиксели станут белыми. Например, если 
вы перетащите белый ползунковый регулятор до значения 245, 
то все пиксели с исходным значением в диапазоне от 245 до 255 
станут белыми. В результате изображение станет светлее.

Наиболее гибкий способ работы 
с диалоговыми окнами Уровни 
(Levels), Кривые (Curves) и Цве-

товой баланс (Color Balance) 
заключается в добавлении кор-
ректирующих слоев (см. раздел 
«Коррекция» далее в главе). 
Корректирующие слои позволя-
ют вам многократно изменять 
настройки в соответствующих 
диалоговых окнах до получения 
нужного результата.

Перетаскивание любого или 
обоих крайних ползунковых 
регуляторов по направлению 
к середине гистограммы приво-
дит к увеличению контрастно-
сти изображения

График в диалоговом окне 
Уровни (Levels) —  это гисто-
грамма, описание которой 
можно найти в разделе «Гисто-
грамма» далее в главе.
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Гамма

Серый треугольник и среднее поле ввода в разделе Входные значения 
(Input Levels) позволяет контролировать гамма-значение изображения. 
Гамма-значение —  это уровень яркости средних серых пикселей изо-
бражения.

1 Для осветле-
ния полутонов 
перетащите 
серый ползун-
ковый регу-
лятор влево 
или увеличьте 
гамма-зна-
чение в поле 
ввода в раз-
деле Входные 
значения 
(Input Levels) 
со значе-
ния 1.00, используемого по умолчанию.

2 Чтобы затемнить средние тона, перетащите серый ползунковый 
регулятор вправо или уменьшите гамма-значение в поле ввода 
в разделе Входные значения (Input Levels).

Выходные значения

Вы можете использовать поля ввода или ползунковые регуляторы в раз-
деле Выходные значения (Output Levels) для уменьшения контрастно-
сти изображения. Как правило, это делается для приведения значений 
светов и теней в соответствие с возможностями вывода конкретного 
печатного устройства, чтобы сохранить детализацию в диапазонах све-
тов и теней.

1 Перетащите черный ползунковый регулятор в  разделе Выход-
ные значения (Output Levels) вправо, чтобы осветлить изобра-
жение и уменьшить контрастность.

2 Перетащите белый ползун-
ковый регулятор в разде-
ле Выходные значения 
(Output Levels) вправо, 
чтобы затемнить изобра-
жение и уменьшить контрастность.

Предустановки параметров 
доступны в раскрывающемся 
списке Набор (Presets). Если 
в диалоговом окне Уровни 
(Levels) вы зададите параметры, 
которые решите использовать 
повторно, выберите пункт 
Сохранить набор (Save Preset) 
в меню панели ( ). Укажите 
имя и расположение сохраняе-
мой предустановки. Сохра-
ненная предустановка станет 
доступна в раскрывающемся 
списке Набор (Presets).

Обратитесь к разделу «Автома-
тические тоновая и цветовая 
коррекции» ранее в главе 
для получения информации 
о команде Автоматическая 

тоновая коррекция (Auto Tone) 
и кнопке Авто (Auto).

Для изображений в режимах 
RGB и CMYK используйте рас-
крывающийся список Канал 
(Channel), чтобы осуществить 
тоновую коррекцию отдельных 
каналов. Работайте с откали-
брованным монитором для 
обеспечения последовательных 
и предсказуемых результатов.
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Кривые
Диалоговое окно Кривые (Curves), 
которое вы можете вызвать 
командой меню Изображение → 
Коррекция → Кривые (Image → 
Adjustments  → Curves), содержит 
набор элементов управления для 
осуществления тоновой коррекции 
изображения. График яркости в  диалоговом окне отображает ориги-
нальные и  откорректированные значения яркости пикселей в  изо-
бражении. До  внесения изменений этот график представляет собой 
прямую линию от 0 (черный) до 255 (белый) —  входные и выходные 
значения одинаковы.

На горизонтальной оси графика представлены оригинальные или вход-
ные значения, а на вертикальной оси —  выходные или скорректирован-
ные значения. Регулируя кривую яркости, вы производите сопоставле-
ние значений яркости пикселей изображения.

1 Чтобы добавить точку на кривую, 
удостоверьтесь в том, что выбран 
инструмент Точка (Point) (вы мо-
жете добавить до 14 точек). Щелк-
ните мышью по  кривой. Перета-
щите одну или несколько точек, 
чтобы отредактировать кривую. 
Кроме того, вы можете щелкнуть 
в любой точке над или под кривой, 
для ее настройки.

2 Чтобы удалить точку, выделите ее с помощью щелчка, а  затем 
нажмите клавишу Delete/Backspace. Также для этого вы можете 
перетащить ее за пределы графика яркости.

3 Для осветления или затемнения 
изображения выберите инстру-
мент Точка (Point), установите 
указатель мыши на середину гра-
фика, а затем щелкните кнопкой 
мыши, чтобы добавить новую 
точку. Нажав и удерживая кнопку 
мыши, перетащите эту точку 
вверх, чтобы сделать изображение более светлым, или вниз, 
чтобы затемнить его.

Для RGB-изображений инди-
катор яркости по умолчанию 
начинается с черного цвета 
и переходит к белому. В этом 
состоянии кривая показыва-
ет значения яркости цветов 
в изображении. Кривая яркости 
начинается со значения 0 (чер-
ный) и оканчивается значением 
255 (белый).

В группе элементов управления 
Показать эффект для (Show 
Amount of ) установите пере-
ключатель в положение Пиг-

мент/Краска% (Pigment/Ink%), 
чтобы изменить способ отобра-
жения на противоположный.

Выберите нужный размер сетки, 
щелкнув по одной из кнопок ( ), 
чтобы отобразить сетку с шагом 
25% или 10% соответственно.
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4 Для увеличения контрастно-
сти изображения поместите 
точку в правой верхней чет-
верти графика и перетащите 
ее вверх, чтобы осветлить 
тона в  диапазоне светов. За-
тем поместите точку в левой 
нижней четверти графика. 
Перетащите ее вниз, чтобы 
затемнить области теней. Ре-
зультатом будет являться увеличение контрастности изображе-
ния за счет осветления тонов в диапазоне светов и их затемнения 
в диапазоне теней. При этом полутона практически не затраги-
ваются. Вы также можете выбрать предустановку Повышение 
контрастности (Increase Contrast) в  раскрывающемся списке 
Стиль (Preset) для достижения аналогичного эффекта.

5 Для уменьшения контрастности изображения выполните дей-
ствия, противоположные предыдущему шагу.

6 Чтобы ограничить изме-
нения только диапазонами 
полутонов и светов, щелк-
ните мышью по графику, 
чтобы поместить точку 
в левой нижней четверти 
графика. Поместите точку 
в правой верхней четверти 
графика и перетащите ее 
вверх. Выполните обрат-
ную процедуру, чтобы изменить диапазоны полутонов и теней, 
не затрагивая диапазон светов.

7 Перетащите черный/белый ползунковый регулятор к  середи-
не, чтобы увеличить общую контрастность изображения, как 
при использовании диалогового окна 
Уровни (Levels) (см. раздел «Уровни» 
ранее в главе). Сбросьте флажок Гисто-
грамму (Histogram) в группе элементов 
управления Показать (Show), чтобы 
скрыть гистограмму.

8 Используйте элементы управления 
в правой части диалогового окна для 
контроля над способом отображения 
графика при изменении параметров.

Удерживая нажатой клави-
шу Alt/�, щелкните мышью 
по кнопке Сбросить (Reset) 
(появившейся на месте кнопки 
Отмена (Cancel)), чтобы вос-
становить исходные настройки 
в диалоговом окне.

Выделите точку на графике, 
а затем используйте клавиши �, 
�, � и � для перемещения этой 
точки с заданным шагом.

Используйте раскрывающий-
ся список Канал (Channel) 
для редактирования базовой 
кривой отдельных цветовых 
каналов. Важно работать с от-
калиброванным монитором, 
чтобы точно оценить влияние 
изменений, которые вы вносите 
в отдельные цветовые каналы. 
При установленном флажке 
Перекрытие каналов (Channel 
Overlays) в разделе Показать 
(Show) изменения отдельных 
цветовых каналов будут видны 
в сводном графике яркости.
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Гистограмма
Гистограмма —  это график, представляющий распределение тонов пиксе-
лей в изображении. Тени располагаются в левой части гистограммы, све-
та —  в правой, а полутона —  в середине. Распределение пикселей в диапа-
зонах теней, полутонов и светов определяет тоновый баланс изображения.

При работе с изображением панель Гистограмма (Histogram) позволяет 
оценить влияние вносимых вами изменений и корректировок.

1 Выберите команду меню 
Окно → Гистограмма 
(Window → Histogram), 
чтобы отобразить эту 
панель. Изначально панель 
Гистограмма (Histogram) 
сгруппирована с панелью 
Навигатор (Navigator). 
Панель Гистограмма (Histogram) открывается 
в режиме Компактный просмотр (Compact 
View), однако вы можете расширить ее, чтобы 
отобразить статистическую информацию и гистограммы для 
цветовых каналов.

2 Выберите пункт Расширенный просмотр (Expanded View) 
в меню панели ( ), чтобы обеспечить доступ к раскрывающе-
муся списку Канал (Channel). Выберите среди вариантов Крас-
ный (Red), Зеленый (Green), Синий (Blue), Яркость (Luminosity) 
и Цвета (Colors), чтобы просмотреть гистограмму для выбран-
ного канала. Для изображения, содержащего более одного слоя, 
вы можете выбрать вариант Выделенный слой (Selected Layer) 
из  раскрывающегося списка Источник (Source), чтобы про-
смотреть гистограмму пик-
сельного содержимого слоя, 
который в настоящее время 
является активным.

3 Для изображений в ре-
жимах RGB и CMYK вы 
можете выбрать вариант 
Свечение (Luminosity) 
в раскрывающемся списке 
Канал (Channel), чтобы 
отобразить только график 
соответствующего канала.

На горизонтальной оси гисто-
граммы расположены уровни 
цвета или свечения (0–255). 
Вертикальная ось показывает 
количество пикселей на каждом 
уровне.

Выберите вариант Показать 

каналы в цвете (Show Channels 
in Color) в меню панели, чтобы 
отобразить гистограммы для 
красного, зеленого и синего 
канала.
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4 Чтобы показать статисти-
ческую информацию для 
гистограммы, выберите 
пункт Показать статисти-
ку (Show Statistics) в меню 
панели. Проведите указа-
телем мыши по гистограм-
ме, чтобы просмотреть 
данные по таким параме-
трам, как Уровень (Level), 
Счетчик (Count) и Процентиль (Percentile).

5 Выберите вариант Просмотр 
всех каналов (All Channels view), 
чтобы отобразить расширенную 
панель с гистограммами для всех 
каналов в изображении за ис-
ключением альфа-каналов, кана-
лов плашечных цветов и масок. 
Верхняя гистограмма отображает 
свечение или общие значения 
яркости для составного канала. 
Выберите пункт Показать кана-
лы в цвете (Show 
Channels in Color) 
в меню панели, 
чтобы отобразить 
цветовые каналы 
в цвете.

6 Значок предупреждения о кэшировании данных ( ) появляется 
тогда, когда отображенные на панели Гистограмма (Histogram) 
данные основываются на  информации, содержащейся в  кэше 
(в  кратковременной памяти), а  не  на фактическом текущем 
состоянии изображения. Чтобы удостовериться в  том, что ги-
стограмма отображает все пиксели изображения в их текущем 
состоянии, щелкните мышью по значку предупреждения, либо 
по кнопке обновления ( ). Программа Photoshop использует 
кэшированные данные для быстрого отображения информации. 
Иногда кэшированные данные могут содержать устаревшую ин-
формацию о пикселях изображения.

При работе в диалоговых окнах 
Уровни (Levels) и Кривые 
(Curves), при установленном 
флажке Просмотр (Preview), па-
нель Гистограмма (Histogram) 
обновляется, когда вы изме-
няете параметры в диалоговом 
окне.

В режиме Просмотр всех ка-

налов (All Channels view) выбор 
варианта в раскрывающемся 
списке Канал (Channel) изменя-
ет только верхнюю гистограмму.
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Коррекция
Применение корректирующего слоя к  изображению подобно нало-
жению линзы поверх пикселей слоя для изменения их внешнего вида. 
Если вам не нравится результат, вы можете отредактировать корректи-
рующий слой для достижения нужного эффекта или удалить его. После 
достижения необходимого результата вы можете применить корректи-
рующий слой в качестве постоянного изменения.

Наиболее эффективный способ создания корректирующих слоев за-
ключается в использовании панели Коррекция (Adjustments). Вы мо-
жете изменять параметры корректирующего слоя, используя панель 
Свойства (Properties).

1 При необходимости щелкните 
мышью по вкладке Коррекция 
(Adjustments) в доке панелей, 
чтобы отобразить соответствую-
щую панель. Установите ука-
затель мыши на значок, чтобы 
увидеть название корректировки 
во всплывающей подсказке и в верхней части панели.

2 Выберите слой на  панели Слои 
(Layers), поскольку корректи-
рующие слои создаются поверх 
активного слоя. Щелкните мы-
шью по  кнопке корректирую-
щего слоя, чтобы отобразить 
панель Свойства (Properties), со-
держащую элементы управления 
для корректирующего слоя. Как 
только вы щелкнете по  кнопке, 
корректирующий слой появится 
на панели Слои (Layers) с автома-
тически присвоенным названием, 
соответствующим типу выбран-
ной корректировки.

3 Новый корректирующий слой 
появляется на  панели Слои 
(Layers) в  качестве активного 
слоя. Настройки, которые вы 
создадите, будут применены 
ко всем слоям, расположенным 
под корректирующим слоем.

Как и в предыдущих верси-
ях программы Photoshop, 
вы также можете применить 
корректирующие слои, вы-
полнив команду меню Слой → 
Новый корректирующий слой 
(Layer → New Adjustment Layer), 
а затем выбрав тип корректи-
рующего слоя из соответствую-
щего подменю.

Корректирующий слой добав-
ляется поверх активного слоя. 
Его параметры применяются 
к расположенным ниже слоям, 
но не влияют на слои, располо-
женные поверх него.

Снижение степени непро-
зрачности корректирующего 
слоя может уменьшить эффект 
от применения настроек, задан-
ных в диалоговом окне.



2
1

7

4 В качестве альтернативы вы можете щелкнуть по  кнопке Со-
здать новый корректирующий слой или слой-заливку (Create 
New Fill or Adjustment Layer) ( ) в нижней части панели Слои 
(Layers), а затем выбрать тип корректирующего слоя. Корректи-
рующий слой появится под ранее активным слоем, а на панели 
Свойства (Properties) отобразятся соответствующие элементы 
управления.

5 Щелкните мышью по кноп-
ке видимости ( ) слева 
от корректирующего слоя 
на панели Слои (Layers) 
или в нижней части панели 
Коррекция (Adjustments), 
чтобы скрыть/отобразить 
результаты применения 
настроек корректирующего 
слоя.

6 Щелкните мышью по  другой кнопке корректирующего слоя 
на  панели Коррекция (Adjustments), если вы хотите добавить 
дополнительные корректирующие слои. Чтобы вернуться к ре-
дактированию настроек существующего корректирующего 
слоя, дважды щелкните мышью по  его значку, 
и на панели Свойства (Properties) отобразятся 
соответствующие элементы управления.

7 Для некоторых типов корректировок на панели Свойства 
(Properties) предусмотрены наборы параметров (предустанов-
ки). Щелкните мышью по раскрывающемуся списку Набор 
(Preset), чтобы отобразить предустановки, предусмотренные 
для выбранной корректи-
ровки. Когда вы щелкаете 
по названию предустанов-
ки, соответствующие пара-
метры применяются в ка-
честве корректирующего 
слоя, а на панели Свойства 
(Properties) отображаются 
элементы управления для 
выбранного типа предуста-
новок.

8 Щелкните мышью по переключателю ( ), чтобы активировать 
функцию корректировки изображения, позволяющую навести 
курсор на пиксели в окне изображения, а затем перетащить его 

Параметры корректирующего 
слоя не оказывают на пиксели 
необратимого влияния, пока 
слой не объединен с другими 
слоями, то есть пока не выпол-
нено сведение.

Для увеличения размера пане-
ли Свойства (Properties) устано-
вите указатель мыши на нижний 
или левый край или угол пане-
ли. Нажав и удерживая кнопку 
мыши, перетащите мышь, когда 
ее указатель примет вид двуна-
правленной стрелки.

Если вы создадите пользова-
тельские настройки, которые вы 
намерены использовать в даль-
нейшем, выберите пункт Сохра-

нить набор (Save preset) в меню 
панели Свойства (Properties). 
Наборы (предустановки) следу-
ет сохранять в папке Presets в ка-
талоге Photoshop СС. Присвойте 
имя предустановке и убедитесь 
в том, что расширение файла 
по умолчанию осталось без 
изменений.
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вверх или вниз, чтобы изменить цветовые или тоновые значения 
в месте нахождения курсора.

9 Создайте область выделения перед 
добавлением корректирующего 
слоя, чтобы применить его эффек-
ты только к определенной части 
изображения.

 После изменения параметров на панели Коррекция (Adjustments) 
станет доступной кнопка Просмотр предыдущего состояния 
(View Previous State) ( ). Нажмите и удерживайте кнопку мыши 
на  этой кнопке, чтобы временно отменить изменения параме-
тров и  сравнить состояния «до» и  «после». Щелкните мышью 
по кнопке Сбросить (Reset) ( ), чтобы восстановить настрой-
ки корректировки по умолчанию.

 Перетащите корректирующий слой на значок в виде мусорного 
бака, если вы хотите удалить настройки.

 Когда вы будете готовы оконча-
тельно применить настройки 
корректирующего слоя, исполь-
зуйте одну из команд для объеди-
нения слоев из меню панели или 
выполните сведение изображе-
ния.

Чтобы применить корректи-
рующий слой только к слою, 
расположенному непосред-
ственно под ним, щелкните 
мышью по кнопке Отсечение 

по слою (Clip to Layer) ( ) 
в нижней части панели Коррек-

ция (Adjustments).

Вы можете копировать и встав-
лять корректирующие слои 
в другие документы, чтобы 
обеспечить соответствие изме-
нений цвета и тона в различных 
изображениях.
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Настройка сочности
Параметр Сочность (Vibrance) позволяет увеличить интенсивность 
цвета в  изображении без перенасыщения областей с  интенсивными 
цветами. Он предотвращает возникновение «ненатуральных» цветов 
на фотографиях.

1 Убедитесь в том, что панель 
Коррекция (Adjustments) видна. 
Щелкните один раз по значку Соч-
ность (Vibrance), чтобы отобра-
зить соответствующие параметры 
на панели Свойства (Properties) 
и создать корректирующий слой 
на панели Слои (Layers).

2 Перетащите пол-
зунковый регулятор 
Сочность (Vibrance) 
вправо, чтобы увели-
чить насыщенность 
цвета, или влево, чтобы 
уменьшить ее.

3 Перетащите ползунковый 
регулятор Насыщенность 
(Saturation) для увеличе-
ния или уменьшения на-
сыщенности всех цветов 
независимо от текущих 
значений данного параме-
тра.

Использование параметра Соч-

ность (Vibrance) позволяет пред-
отвратить перенасыщенность 
тонов кожи в изображении.

Создайте область выделения, 
прежде чем добавить коррек-
тирующий слой, если вы хотите 
одновременно создать слой-
маску, который обеспечивает 
применение корректирующего 
эффекта только к выделенной 
области, как на приведенном 
здесь изображении.
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Цветовой баланс
Диалоговое окно Цветовой баланс (Color Balance) содержит элемен-
ты управления для коррекции цветового оттенка в изображении. Оно 
обеспечивает самый легкий способ цветокоррекции.

Диалоговое окно Цветовой баланс (Color Balance) работает по принци-
пу дополнительных цветов. Если в изображении слишком много голубого 
цвета, перетащите ползунковый регулятор Голубой-Красный (Cyan-Red) 
в сторону красного, чтобы удалить голубой оттенок. Если в изображении 
слишком много пурпурного, перетащите ползунковый регулятор Пурпур-
ный-Зеленый (Magenta-Green) в сторону зеленого цвета.

1 Чтобы настроить цветовой баланс изображения, выберите коман-
ду меню Изображение → Коррекция → Цветовой баланс (Image → 
Adjustments → Color Balance). Щелкните мышью по переключателю 
Тени (Shadows), Полутона (Midtones) или Света (Highlights), что-
бы указать диапазон тонов, который вы хотите изменить.

2 Перетащите цвет-
ные ползунковые 
регуляторы, чтобы 
уменьшить или уве-
личить количество 
того или иного цве-
та в изображении.

Сохранение свечения

Установите флажок Сохранить свечение (Preserve Luminosity), чтобы 
предотвратить изменение значений свечения при изменении цветовых 
уровней. Это помогает поддерживать общий цветовой баланс изобра-
жения.

Добавьте корректирующий 
слой для настройки цветового 
баланса, щелкнув по кноп-
ке Цветовой баланс (Color 
Balance) ( ) на панели Коррек-

ция (Adjustments), если вы хо-
тите применить к изображению 
недеструктивные изменения. 
Используя корректирующий 
слой, вы можете изменять па-
раметры, пока не будете готовы 
принять их.

При использовании диалогово-
го окна Цветовой баланс (Color 
Balance) работайте с составным 
изображением.

Используйте диалоговое 
окно Цветовой баланс (Color 
Balance) с осторожностью, 
и только если ваш монитор 
точно откалиброван, поскольку 
вам необходимо быть уве-
ренным в том, что откоррек-
тированные цвета, которые 
вы видите на экране, точно 
соответствуют цветам, получаю-
щимся в итоге.
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Черно-белое
При преобразовании изображения в черно-белое команда Черно-белое 
(Black & White) обеспечивает большую гибкость и контроль по срав-
нению командой меню Изображение → Режим → Оттенки серого 
(Image → Mode → Grayscale). Настраивая значения конкретных цвето-
вых компонентов изображения, при необходимости вы можете усилить 
или смягчить области изображения.

1 Чтобы преобразовать 
изображение в черно-белое, 
выберите команду меню 
Изображение → Коррек-
ция → Черно-белое (Image → 
Adjustments → Black & White).

2 Выберите предустановку 
в раскрывающемся списке 
Набор параметров (Preset) 
или используйте цветные 
ползунковые регуляторы, 
чтобы настроить пропорции 
каждого цвета, которые бу-
дут использоваться при преобразовании. Перетащите ползун-
ковые регуляторы вправо, чтобы затемнить, или влево, чтобы 
осветлить серые тона в изображении.

3 При необходимости вы можете установить флажок Оттенок (Tint), 
чтобы применить цветовой тон к изображению. Перетащите пол-
зунковый регулятор Цветовой тон (Hue), чтобы изменить цвето-
вой оттенок. Используйте ползунок Насыщенность (Saturation), 
чтобы увеличить/уменьшить количество или силу оттенка.

Вы можете применять команду 
Черно-белый (Black&White) 
в качестве корректирующего 
слоя (см. раздел «Коррекция» ра-
нее в этой главе для получения 
дополнительной информации).

Щелкните мышью по кнопке 
Авто (Auto), чтобы создать 
преобразование, которое 
максимизирует распределение 
значений серых цветов в ис-
ходном изображении. После 
этого вы можете продолжить 
настраивать ползунковые регу-
ляторы до достижения нужного 
результата.

Установите курсор на изобра-
жение, а затем, нажав и удержи-
вая кнопку мыши, перетащите 
влево или вправо, чтобы наце-
литься и настроить конкретные 
цветовые диапазоны в пределах 
изображения. Если вы работае-
те с корректирующим слоем, 
сначала щелкните мышью 
по кнопке ( ).Исходное  

изображение
Изображение → 

Режим → Оттенки 
серого

Черно-белое (вы-
сококонтрастный 
красный фильтр)

Оттенок
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Тени/Света
Команда Тени/Света (Shadow/Highlight) применяется к изображениям 
с  сильной подсветкой, из-за которой у  элементов на  переднем плане 
возникает эффект силуэта. Параметры по  умолчанию в  диалоговом 
окне Тени/Света (Shadow/Highlight) предназначены для улучшения ка-
чества изображения с проблемами, вызванными подсветкой. Вы также 
можете использовать команду Тени/Света (Shadow/Highlight), чтобы 
осветить диапазон теней.

1 Чтобы настроить диапазоны теней и светов в изображении, вы-
берите команду меню Изображение → Коррекция → Тени/Света 
(Image → Adjustments → Shadow/Highlight).

2 Перетащите ползунко-
вый регулятор Эффект 
(Amount) в разделе Тени 
(Shadows) вправо или вве-
дите значение в диапазоне 
от 0 до 100 в поле ввода, чтобы осветить пиксели в диапазоне 
теней. Чем выше значение, тем больше степень осветления.

3 Перетащите ползунковый регулятор Эффект (Amount) в разделе 
Света (Highlights) вправо, чтобы затемнить пиксели в диапазоне 
светов. Вы также можете ввести значение в поле ввода. Чем выше 
значение, тем больше степень затемнения.

Убедитесь в том, что флажок 
Просмотр (Preview) установлен, 
чтобы видеть, как изменение 
параметров в диалоговом окне 
влияет на изображение.

Выберите команду меню 
Изображение → Коррек-

ция → Фотофильтр (Image → 
Adjustments → Photo Filter) для 
получения доступа к соответ-
ствующему диалоговому окну. 
(Фотофильтры также доступ-
ны на панели Коррекция 
(Adjustments). Фотофильтры 
имитируют традиционные 
фильтры для объектива, 
используемые для того, чтобы 
сделать цветовое содержимое 
изображения более теплым или 
холодным. Фильтры Теплый 

фильтр (85) (Warming (85)) 
и Холодный фильтр (80) 
(Cooling Filter (80)) регулируют 
цветовую температуру изо-
бражения. Фильтры Теплый 

фильтр (81) (Warming (81)) 
и Холодный фильтр (82) 
(Cooling Filter (82)) —  это филь-
тры для коррекции баланса 
яркости, которые оказывают 
на изображение меньшее воз-
действие.

Используйте ползунковый 
регулятор Плотность (Density), 
чтобы контролировать силу 
эффекта фильтра.

 �

!����



13 Фильтры

Фильтры обеспечивают 
огромную гибкость при 

работе с изображениями, 
и вам стоит 

потратить некоторое 
время на то, чтобы 

поэкспериментировать 
с ними. Вы можете 

применять фильтры 
ко всему изображению 

целиком, или только 
к выделенным областям 

или слоям, чтобы 
ограничить их эффект.

Элементы управления фильтрами

Контурная резкость и Усиление резкости

«Умная резкость»

Размытие

Размытие контура и Размытие вращения

Шум

Автоматическая стабилизация изображения

Пластика

Галерея фильтров

Исправление перспективы

Смарт-фильтры
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Элементы  
управления фильтрами
Используйте меню Фильтр (Filter) для получения доступа к фильтрам 
программы Photoshop. Многие из  них предусматривают стандартные 
элементы управления, которые описаны далее. Некоторые фильтры, на-
пример, Соляризация (Solarize), не вызывают диалоговое окно и приме-
няют свой эффект незамедлительно. Выбор других фильтров приводит 
к открытию диалогового окна галереи фильтров, где вы можете настраи-
вать параметры и осуществлять предварительный просмотр результата.

1 Установите флажок Просмотр (Preview), чтобы увидеть резуль-
тат применения выбранных параметров в главном окне изобра-
жения, а также в области предварительного просмотра в диало-
говом окне фильтра.

2 Нажав и удерживая кнопку 
мыши, перетащите курсор 
по изображению в области 
предварительного просмо-
тра, чтобы увидеть различ-
ные части изображения. 
Кроме того, при активном 
диалоговом окне фильтра 
вы можете навести указа-
тель мыши на главное окно 
изображения (он примет 
вид пустой рамки), а затем щелкнуть для показа в окне предва-
рительного просмотра нужной части картинки.

3 Щелкните мышью по  кнопке + или −, чтобы увеличить или 
уменьшить масштаб частей изображения. Вы также можете 
использовать сочетания клавиш Ctrl+Пробел (Windows) или 
�+Пробел (macOS) в пределах области предварительного про-
смотра или окна изображения.

4 Удерживая нажатой клавишу Alt/�, щелкните мышью по кноп-
ке Сбросить (Reset) (ранее Отменить (Cancel)), чтобы восстано-
вить исходные параметры в диалоговом окне.

5 После щелчка по кнопке ОК в диалоговом окне фильтра исполь-
зуйте комбинацию клавиш Ctrl+F (Windows) или �+F (macOS), 
чтобы повторно применить последний использовавшийся 
фильтр и его параметры.

Нажмите и удерживайте кнопку 
мыши в области предваритель-
ного просмотра в диалоговом 
окне фильтра, чтобы увидеть 
изображение без применения 
соответствующего эффекта.

Выберите команду меню Редак-

тирование → Ослабить (Edit → 
Fade), чтобы уменьшить эффект, 
оказываемый фильтром на изо-
бражение.

Используйте смарт-фильтры 
(см. раздел «Смарт-фильтры» 
далее в главе), если вы хоти-
те работать с изображением 
неразрушающим способом. 
Смарт-фильтры позволяют вам 
изменять параметры фильтра, 
не затрагивая фактических 
значений пикселей изображе-
ния, пока вы не будете готовы 
их принять.
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Контурная резкость 
и Усиление резкости
Эти фильтры позволяют повысить степень детализации ваших изобра-
жений.

Контурная резкость

Это функция помогает повысить резкость конкретных областей раз-
мытых изображений. Например, если вы повернете изображение, из-
мените его размер или разрешение, оно может стать размытым из-за 
интерполяции, примененной программой Photoshop. Там, где фильтр 
Контурная резкость (Unsharp Mask) обнаруживает края (области 
с высокой степенью контрастности), он увеличивает контраст между 
соседними пикселями. Результатом является заметное улучшение фо-
кусировки изображения.

1 Чтобы использовать фильтр 
Контурная резкость 
(Unsharp Mask) для усиле-
ния резкости изображения, 
выберите команду меню 
Фильтр → Усиление резко-
сти → Контурная резкость 
(Filter → Sharpen → Unsharp 
Mask). Появится одноимен-
ное диалоговое окно.

2 Настройте параметры 
Эффект (Amount), Ради-
ус (Radius) и Изогелия 
(Threshold). Оцените ре-
зультат изменения параметров в области предварительного про-
смотра диалогового окна и в самом окне изображения. Щелкните 
мышью по кнопке ОК или нажмите клавишу Enter/�.

Эффект (Amount).  Используйте этот параметр, чтобы контролировать 
степень увеличения резкости краев (минимальное значение = 1, а мак-
симальное = 500). При слишком высоких значениях изображение ста-
нет пикселизированным.

Значения ниже 50% производят едва заметный эффект, значения от 50% 
до 200% производят умеренный эффект, а значения от 200% до 500% со-
здают впечатляющие, преувеличенные результаты.

Установите масштаб на 100%, 
чтобы точно увидеть эффект 
применения фильтра к изобра-
жению. Кроме того, следует 
оценить результаты в окне до-
кумента, а не только в области 
предварительного просмотра.
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При настройке параметра Эффект (Amount) следует учитывать значе-
ния Радиус (Radius) и Изогелия (Threshold) (см. далее).

Радиус (Radius) —  этот параметр контролирует глубину подвергаемых 
изменениям пикселей вдоль высококонтрастных краев.

Низкое значение данного параметра ограничивает эффект фильтра, а бо-
лее высокие значения  увеличивают его воздействие. Значения ниже 2.0, 
как правило, производят приемлемый эффект увеличения резкости.

Изогелия (Threshold)  устанавливает минимальную степень контраст-
ности между пикселями, которой должна отличаться область изобра-
жения, чтобы подвергнуться изменениям. Значение этого параметра 
представляет собой разницу между двумя соседними пикселями, из-
меряемую в  уровнях яркости  —  это необходимо, чтобы программа 
Photoshop могла распознать края.

Высокие значения параметра Изогелия (Threshold) ограничивают измене-
ния областями с большой разницей в цветах. Используйте низкие значения, 
чтобы применить фильтр более общим способом ко всему изображению.

Усиление резкости и Резкость +

Применяйте фильтры Усиление резкости (Sharpen) и  Резкость + 
(Sharpen More) к изображению, которое стало размытым после пере-
дискретизации. Оба фильтра увеличивают контрастность между со-
седними пикселями по  всему изображению или области выделения. 
Фильтр Резкость + (Sharpen More) производит более выраженный эф-
фект, чем фильтр Усиление резкости (Sharpen).

Резкость на краях

Данный фильтр обеспечивает более специфический эффект, усили-
вая резкость высококонтрастных краев. Он оказывает менее глобаль-
ное влияние на выделенную область или изображение по сравнению 
с фильтрами Усиление резкости (Sharpen) и Резкость + (Sharpen More).

При работе над изображениями 
с высоким разрешением ис-
пользуйте значение параметра 
Изогелия (Threshold) около 8 
или выше, чтобы ограничить эф-
фект усиления резкости только 
конкретными областями.

Фильтры для усиления резкости 
увеличивают контрастность 
там, где уже присутствуют края. 
Чрезмерное увеличение резко-
сти изображения может приве-
сти к возникновению эффекта 
сияния и других нежелательных 
артефактов в изображении.

Усиление  
резкости

Резкость  
на краях

Усиление 
резкости

Контурная  
резкость
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«Умная» резкость
Фильтр «Умная» резкость (Smart Sharpen) позволяет вам применить 
сложные алгоритмы для достижения лучших результатов, с помощью 
простого в использовании диалогового окна с расширенной областью 
предварительного просмотра, которое облегчает оценку эффекта при-
менения параметров к изображению.

1 Выберите команду меню Фильтр → Усиление резкости → «Ум-
ная» резкость (Filter → Sharpen → Smart Sharpen).

2 Установите значения параметров Эффект (Amount) и  Радиус 
(Radius). Параметр Эффект (Amount) контролирует степень уси-
ления резкости. Высокие значения увеличивают контрастность 
между соседними пикселями, что производит видимый эффект 
увеличения резкости между пикселями краев в изображении. Па-
раметр Радиус (Radius) определяет, на какое количество соседних 
пикселей распространяются результаты усиления резкости.

3 Используйте ползунковый регулятор Уменьшить шум (Reduce 
Noise), чтобы свести к  минимуму нежелательный шум. Высо-
кие значения могут привести к снижению степени детализации 
в изображении. Как правило, более высокие значения параметра 
Эффект (Amount) требуют использования более высоких значе-
ний параметра Уменьшить шум (Reduce Noise).

4 Выберите один из  вариантов в  раскрывающемся списке Уда-
лить (Remove). Каждый вариант использует особый алгоритм 
усиления резкости изображения. Вариант Размытие по Гауссу 
(Gaussian Blur) применяет тот же метод, что и фильтр Контур-
ная резкость (Unsharp Mask). Вариант Размытие при малой глу-
бине резкости (Lens Blur) подразумевает попытку обнаружения 
деталей, резкость которых затем увеличивается, что приводит 
к  возникновению меньшего количества ореолов. Используйте 
вариант Размытие в движении (Motion Blur), чтобы уменьшить 
размытость, вызванную движением предмета. При выборе ва-
рианта Размытие в движении (Motion Blur) задайте угол, чтобы 
указать направление размытия.

В картинке может появиться 
шум в виде областей изменения 
пикселей или цветовых арте-
фактов, не являющихся дета-
лями изображения, и поэтому 
нежелательных.

Как правило, шум в изобра-
жении появляется либо как 
яркостный, из-за которого 
картинка выглядит неоднород-
ной, либо как цветовой, прояв-
ляющийся в виде хаотических 
цветовых артефактов.

Для большего контроля над 
усилением резкости в диапазо-
нах теней и светов, щелкните 
мышью по кнопке Тени/Света 
(Shadows/Highlights). Исполь-
зуйте ползунковый регулятор 
Ослабить (Fade) на вклад-
ках Тени (Shadows) и Света 
(Highlights), чтобы уменьшить 
общее влияние параметров, 
в соответствующих тоновых 
диапазонах.

Уменьшить  
шум 0%

Уменьшить  
шум 27%

Уменьшить  
шум 100%
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Размытие
Фильтры Размытие (Blur) уменьшают контрастность между соседними 
пикселями вдоль краев, где имеют место значительные изменения цвета, 
чтобы создать смягчающий эффект расфокусирования. Размытие про-
изводит эффект, обратный эффекту усиления резкости, при котором 
происходит увеличение контрастности между соседними пикселями.

Фильтры Размытие (Blur) и  Размытие + (Blur More) размывают вы-
деленную область в  заданной степени, предоставляя ограниченный 
контроль над этим процессом. Для получения большего контроля вы 
можете использовать вариант Размытие по Гауссу (Gaussian Blur), про-
изводящий размытие в соответствии с параболической кривой распре-
деления по Гауссу.

Размытие слоя или выделения

Создайте выделение, если вы хотите ограничить влияние фильтра опре-
деленной областью вашего изображения. Выберите в меню Фильтр → 
Размытие (Filter → Blur) команду Размытие (Blur) или Размытие+ (Blur 
More).

Размытие в движении

Вы можете использовать фильтр Размытие в движении (Motion Blur), 
чтобы создать эффект движущегося объекта или камеры.

1 Для создания эффекта раз-
мытия в движении задайте 
область выделения, если 
это необходимо. Выберите 
команду меню Фильтр → 
Размытие → Размытие 
в движении (Filter → Blur → 
Motion Blur).

2 Введите значение в поле 
Угол (Angle) или перета-
щите соответствующий 
индикатор, чтобы указать 
угол или направление 
размытия. Введите значение в поле Смещение (Distance), чтобы 
задать расстояние в пикселях для эффекта размытия. Щелкните 
мышью по кнопке ОК в диалоговом окне.

Фильтр Размытие + (Blur More) 
производит примерно в три 
раза более сильный эффект 
по сравнению с фильтром Раз-

мытие (Blur).

Угол 53°
Смещение  
26 пикселей

Угол 45°
Смещение  
12 пикселей

Угол 0°
Смещение  
49 пикселей
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Радиальное размытие

Фильтр Радиальное размытие (Radial Blur) создает эффект масштаби-
рования при съемке.

1 Чтобы создать эффект радиаль-
ного размытия, отметьте область 
выделения, если это необходимо. 
Выберите команду меню Фильтр → 
Размытие → Радиальное размы-
тие (Filter → Blur → Radial Blur).

2 Выберите метод и качество раз-
мытия, а также укажите значение 
параметра Количество (Amount) (0–100). 
Нажав и удерживая кнопку мыши, пе-
ретащите ее в окне Центр (Blur Center), 
чтобы задать центральную точку эффекта 
масштабирования и вращения. Щелкните 
мышью по кнопке ОК в диалоговом окне.

Количество (Amount) —  это значение определяет 
расстояние, на которое смещаются пиксели для создания эффекта раз-
мытия. Более высокие значения производят более интенсивные эффекты.

Увеличение (Zoom) —  создает эффект размытия, подобный тому, кото-
рый происходит при масштабировании в момент съемки.

Вращение (Spin)  —  поворачивает и  размывает пиксели вокруг цен-
тральной точки.

Качество (Quality)  —  варианты Хорошее (Good) и  Наилучшее (Best) 
обеспечивают лучшие сглаженные результаты благодаря использованию 
методов интерполяции, однако требуют больших временных затрат.

Размытие по Гауссу

Используйте фильтр Размытие по Га-
уссу (Gaussian Blur), чтобы контроли-
ровать степень размытия. Этот фильтр 
добавляет в изображение или область 
выделения низкочастотные детали. Вы-
берите команду меню Фильтр → Размы-
тие → Размытие по Гауссу (Filter → Blur 
→ Gaussian Blur). Используйте ползунко-
вый регулятор Радиус (Radius), чтобы 
отрегулировать степень размытия.

Работая со слоем, убедитесь 
в том, что кнопка сохранения 
прозрачности пикселей не на-
жата, если вы хотите, чтобы 
размытие применялось по кра-
ям пикселей слоя (см. раздел 
«Закрепление слоев» главы 8).

Фильтр Размытие по рамке 
(Box Blur) размывает изображе-
ние или область выделения, ис-
пользуя среднее цветовое зна-
чение соседних пикселей. Более 
высокие значения параметра 
Радиус (Radius) обеспечивают 
более сильное размытие. Этот 
фильтр может производить 
интересные эффекты.
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Размытие контура  
и Размытие вращения
Создайте интересные эффекты размытия в движении, применяя филь-
тры Размытие контура (Path Blur) и Размытие вращения (Spin Blur). 
Вы можете использовать элементы управления наложением или на-
стройки степени размытия на панели Инструмент «Размытие» (Blur 
Tools) в правой части окна для создания желаемого эффекта.

Размытие контура

Используйте команду Размытие контура (Path Blur), чтобы создать эф-
фект размытия вдоль определенных пользователем контуров. Вы мо-
жете несколько раз применить эффект Размытие контура (Path Blur) 
к одному и тому же изображению.

1 Выберите команду меню Фильтр → Галерея размытия → Раз-
мытие контура (Filter → Blur Gallery → Path Blur), чтобы перейти 
в соответствующий режим. Изначальный контур отображается 
на изображении в виде стрелки, указывающей направление раз-
мытия по умолчанию. Настройки по умолчанию отображаются 
на панели Инструмент «Размытие» (Blur Tools) в правой части 
окна, когда панель Размытие контура (Path Blur) развернута.

2 Чтобы изменить направление 
размытия контура, нажав и удер-
живая кнопку мыши, перетащите 
первую или последнюю булавку. 
Для создания изогнутого контура, 
нажав и удерживая кнопку мыши, 
перетащите центральную булавку 
по стрелке контура размытия.

3 Поэкспериментируйте с элементами управления панели Размы-
тие контура (Path Blur) для создания нужного эффекта. Уста-
новите указатель мыши на каждый элемент управления, чтобы 
увидеть соответствующую подсказку с описанием.

Щелкните мышью 
по кнопке Удалить все 

булавки (Remove All Pins) 
на панели параметров, чтобы 
удалить все эффекты размытия. 
Вернуться к настройке пара-
метров эффектов размытия 
можно, дважды щелкнув мышью 
по треугольнику Развернуть/

Свернуть (Expand/Collapse): 
первый раз для того, чтобы 
скрыть, а второй раз —  для 
того, чтобы отобразить пара-
метры используемого типа 
размытия.

Чтобы скрыть элементы управ-
ления наложением, предусмо-
тренным эффектом размытия 
контура, щелкните мышью 
по треугольнику ( ), чтобы 
свернуть панель Размытие 

контура (Path Blur) на панели 
Инструмент «Размытие» (Blur 
Tools). Настройки эффекта 
размытия останутся в силе. Ис-
пользуйте флажок ( ) справа 
от контура размытия для отклю-
чения и включения настроек.

Чтобы удалить контур размы-
тия, убедитесь в том, что он вы-
делен, а затем нажмите клавишу 
Delete.
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4 Когда вы будете готовы, щелкните мышью по кнопке ОК, чтобы 
принять параметры размытия, или по кнопке Отменить (Cancel), 
чтобы вернуться к работе с изображением без внесения изменений.

Размытие вращения

Используйте команду Размытие вращения (Spin Blur) для того, что-
бы повернуть и  размыть содержимое изображения вокруг централь-
ной опорной точки. Вы можете несколько раз применять эту команду 
к изображению.

1 Для создания эффекта размытия вращения выберите команду 
меню Фильтр → Галерея размытия → Размытие вращения (Filter → 
Blur Gallery → Spin Blur). На изображении появится исходный ради-
ус размытия вращения. На панели Размытие вращения (Spin Blur) 
в правой части окна отобразятся параметры по умолчанию.

2 Чтобы переместить радиус размытия, установите 
указатель мыши на  середину радиуса, а  затем, нажав 
и удерживая кнопку мыши, перетащите появившуюся 
центральную булавку.

3 Используйте ползунковый регу-
лятор Угол размытия (Blur Angle) 
на панели Размытие вращения 
(Spin Blur) для управления силой эффекта 
размытия. Аналогично установите курсор 
на центральную точку размытия, а затем, 
нажав и удерживая кнопку мыши на внешнем 
сером круге, перетащите его.

4 Чтобы пропорционально изменить 
размер радиуса размытия, установите 
курсор на край радиуса. Нажав и удер-
живая кнопку мыши, перетащите ука-
затель, когда он примет вид двунаправ-
ленной стрелки.

5 Перетащите маленькие белые круглые 
маркеры, расположенные по краям радиуса размытия, чтобы со-
здать эффект размытия вращения. Нажав и удерживая кнопку 
мыши, перетащите большие белые маркеры растушевки, чтобы 
задать расстояние, в пределах которого эффект размытия будет 
переходить в неразмытые области изображения.

Удерживайте нажатой клави-
шу H, чтобы на время скрыть 
элементы управления наложе-
нием.

Чтобы удалить эффект размытия 
вращения, убедитесь в том, что 
радиус размытия выделен, а за-
тем нажмите клавишу Delete.

Вы можете использовать 
элементы управления, распо-
ложенные на вкладке Эффекты 

размытия в движении (Motion 
Blur Effects), для создания стро-
боскопических эффектов.
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Шум

Добавить шум

Фильтр Добавить шум (Add Noise) случайным образом распределяет 
высококонтрастные пиксели в  изображении, создавая эффект зерни-
стости.

Чтобы добавить шум, создайте 
область выделения, выберите 
слой или работайте со всем изо-
бражением. Выберите команду 
меню Фильтр → Шум → Доба-
вить шум (Filter → Noise → Add 
Noise). Укажите значение параме-
тра Эффект (Amount), Распреде-
ление (Distribution) и Монохром-
ный (Monochromatic).

Эффект (Amount) —  этот параметр определяет степень изменения ис-
ходного цвета пикселей. Введите значение от 1 до 400.

Равномерная (Uniform) —  обеспечивает равномерное распределение 
пикселей.

По Гауссу (Gaussian) —  производит более выраженный результат.

Монохромный (Monochromatic) —  включите этот флажок, чтобы обес-
печить распределение точек оттенков серого.

Исходный градиент

Эффект = 20, Равномерная, 
Монохромный

Эффект = 20, По Гауссу,  
Монохромный

Вы можете использовать фильтр 
Добавить шум (Add Noise), 
чтобы уменьшить степень выра-
женности полос в градиентных 
заливках.

Команда Добавить шум (Add 
Noise) —  это хорошее начало 
для создания текстурированных 
фонов.
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Пыль и Царапины

Используйте фильтр Пыль и Царапины (Dust & Scratches) для удале-
ния небольших дефектов и  пятен в  отсканированном изображении, 
появившихся из-за пыли и  царапин. Успех от  применения данного 
фильтра в значительной степени зависит от изображения или области 
выделения, к которой вы его применяете.

Для удаления пыли и  царапин создайте 
область выделения или работайте со всем 
изображением. Выберите команду меню 
Фильтр → Шум → Пыль и  Царапины 
(Filter → Noise → Dust & Scratches). Укажи-
те значения параметров Радиус (Radius) 
и  Изогелия (Threshold). Щелкните мы-
шью по кнопке ОК.

Радиус (Radius)  —  определяет мини-
мальный размер пятна, к которому будет 
применен данный фильтр. Например, при радиусе в 3 пикселя данный 
фильтр не станет предпринимать попытки исправить дефекты, размер 
которых превышает данное значение.

Изогелия (Threshold)  —  определяет минимально необходимую для 
внесения изменений степень контрастности между пикселями.

Ретушь
Фильтр Ретушь (Despeckle) производит эффект обратный тому, кото-
рый создается фильтром Добавить шум (Add Noise), сглаживая и раз-
мывая изображение, но практически не влияя на края.

Медиана
Фильтр Медиана (Median) также устра-
няет шум в некачественно отсканирован-
ных изображениях. Он работает путем 
усреднения цветовых значений соседних 
пикселей в изображении.

Для использования фильтра Медиана 
(Median) создайте область выделения или 
работайте со  всем изображением. Выбе-
рите команду меню Фильтр → Шум → Ме-
диана (Filter → Noise → Median). Укажите значение параметра Радиус 
(Radius) (1–100). Щелкните мышью по кнопке ОК в диалоговом окне.

Параметры Радиус (Radius) 
и Изогелия (Threshold) свя-
заны друг с другом. Оба эти 
параметра следует принимать 
во внимание перед внесением 
изменений.
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Автоматическая  
стабилизация изображения
При работе с правильно сфокусированными изображениями, в кото-
рых присутствует небольшое размытие, вызванное дрожанием камеры 
или движением объекта, фильтр Стабилизация изображения (Shake 
Reduction) может улучшить изображение путем автоматического обна-
ружения и дальнейшего уменьшения степени размытия.

1 Выберите пункт Фильтр → Усиление резкости → Стабилизация 
изображения (Filter → Sharpen → Shake Reduction). Программа 
Photoshop автоматически обнаруживает область изображения, 
в которой применение фильтра обеспечит оптимальный эффект.
Photoshop определяет область размытия, выделяя ее пунктир-
ной рамкой. Кроме того, программа анализирует тип размытия, 
и производит автоматическую коррекцию для его уменьшения.

2 Используйте флажок Просмотр (Preview), чтобы увидеть изо-
бражение до и после применения фильтра Стабилизация изо-
бражения (Shake Reduction).

3 Вы можете вручную задать границы области трассировки размы-
тия. Чтобы переместить эту область, перетащите центральную бу-
лавку ( ). Перетащите маркеры масштабирования ( ), чтобы 
увеличить или уменьшить область. Для обеспечения наилучших 
результатов задайте часть изображения с ярко выраженным кон-
трастным краем.

Выберите команду меню 
Фильтр → Преобразовать 

для смарт-фильтров (Filter → 
Convert for Smart Filters) перед 
использованием фильтра 
Стабилизация изображения 
(Shake Reduction), чтобы ваши 
изменения не были постоянны-
ми, и вы могли бы отредактиро-
вать параметры позднее.

Артефакты —  это скопления 
пикселей, создающие области 
нежелательных искажающих 
изображение деталей. Устано-
вите флажок Подавление по-

мех (Artifact Suppression) и, при 
необходимости, используйте 
одноименный ползунковый 
регулятор, чтобы уменьшить 
количество артефактов.

Если вы не удовлетворены 
результатом применения 
к изображению автоматически 
установленных настроек, попро-
буйте увеличить или уменьшить 
значение параметра Границы 

трассируемого размытия (Blur 
Trace Bounds), проявляя осто-
рожность, пока не освоитесь.
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Пластика
Диалоговое окно Пластика (Liquify) позволяет создавать разнообраз-
ные виды искажений для ретуширования или достижения впечатляю-
щих эффектов. Данное диалоговое окно предусматривает инструменты, 
которые позволяют растягивать, сдвигать, поворачивать, сморщивать 
и  раздувать области изображения. Флажок Расширенный режим 
(Advanced Mode) в  правой части окна Пластика (Liquify) позволяет 
отобразить более сложные инструменты и элементы управления.

1 Для искажения всего слоя выделите слой или создайте область 
выделения на слое, чтобы задать область для искажения. Выбе-
рите команду меню Фильтр → Пластика (Filter → Liquify).

2 Заморозьте области изображения, которые вы не  хотите изме-
нять, используя инструмент Заморозить (Freeze Mask). Задай-
те размер кисти, а  затем перетащите указатель мыши поперек 
областей изображения, которые необходимо заморозить. Замо-
роженные области выглядят как полупрозрачная красная маска. 
Используйте инструмент Разморозить (Thaw Mask), чтобы сде-
лать замороженные области вновь редактируемыми.

3 Выберите 
инструмент 
искажения, а за-
тем настройте 
его параметры 
(см. следующий 
раздел). Выбери-
те размер кисти, 
используя со-
ответствующий 
ползунковый регулятор. Укажите значение параметра Нажим 
(Pressure). Более низкие значения параметра Нажим (Pressure) 
вызывают более медленное искажение изображения, давая вам 
больший контроль над этим процессом. Параметр Плотность 
(Density) контролирует степень мягкости края кисти.

4 Перетащите указатель мыши по  изображению, чтобы создать 
искажение. Вы можете щелкнуть левой кнопкой мыши, не пере-
таскивая ее указатель, чтобы создать эффекты с помощью таких 
инструментов, как Скручивание (Twirl). Установите значение 
параметра Скорость (Brush Rate), чтобы контролировать ско-
рость процесса искажения при неподвижности мыши. Щелкните 
мышью по кнопке ОК, чтобы принять изменения.

Используйте инструменты 
Масштаб (Zoom) и Рука (Hand) 
так же, как при работе в стан-
дартном окне изображения 
Photoshop.

Инструменты Плавный 

(Smooth), Скручивание по ча-

совой стрелке (Twirl Clockwise) 
и Разморозить (Thaw Mask) 
становятся доступными после 
установки флажка Расширен-

ный режим (Advanced Mode).

Вы должны растрировать тек-
стовый слой или слой-фигуру, 
прежде чем сможете использо-
вать команду Пластика (Liquify).
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Инструменты для искажения

Вы можете выбрать один из пяти инструментов, доступных в диалого-
вом окне Пластика (Liquify). Перед использованием не забудьте настро-
ить параметры Размер (Brush Size) и Нажим (Brush Pressure). Дополни-
тельными настройками являются Скорость (Brush Rate) и Плотность 
(Density). Искажение является наиболее выраженным в центре области 
применения кисти. Вы можете создать искажения, осуществляя пере-
таскивание поперек пикселей, или просто удерживая нажатой левую 
кнопку мыши.

1 Используйте инструмент Деформация 
(Forward Warp) для искажения пик-
селей в прямом направлении путем 
перетаскивания курсора мыши.

2 Используйте инструмент Скручивание 
по часовой стрелке (Twirl Clockwise) 
для вращения области пикселей по ча-
совой стрелке. Удерживайте нажатой 
клавишу Alt/� для осуществления 
поворота против часовой стрелки.

3 Используйте инструмент Сморщива-
ние (Pucker) для сосредоточения пиксе-
лей в центре области кисти.

4 Используйте инструмент 
Вздутие (Bloat), чтобы 
сдвинуть детали изобра-
жения по направлению 
от центра кисти.

5 Используйте инструмент Смещение 
пикселей (Push Left) для смещения 
пикселей влево при перетаскивании 
указателя мыши вверх или вправо 
при перетаскивании указателя мыши 
вниз.

Используйте инструмент Ре-

конструировать (Reconstruct) 
для восстановления исходного 
состояния пикселей путем пере-
таскивания указателя мыши 
в области предварительного 
просмотра изображения.

Это может быть особенно 
полезно, когда вы хотите 
постепенно уменьшить эффект 
применения инструмента 
Пластика (Liquify), не возвра-
щаясь к исходному состоянию 
изображения.

Щелкните мышью по кнопке 
Восстановить все (Restore All), 
чтобы вернуть изображение 
в исходное состояние.

Для отмены или повтора 
изменений в диалоговом окне 
Пластика (Liquify) исполь-
зуйте комбинации клавиш: 
Alt/�+Ctrl/�+Z (шаг назад) или 
Shift+Ctrl/�+Z (шаг вперед).
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Галерея фильтров
Галерея фильтров позволяет осуществить предварительный просмотр 
и применить один или несколько эффектов фильтра к области выделе-
ния, слою или всему изображению.

1 Чтобы открыть галерею фильтров, выберите команду меню 
Фильтр → Галерея фильтров (Filter → Filter Gallery). В левой части 
окна появится область предварительного просмотра изображения, 
к которому применен выбранный в данный момент фильтр.

2 Щелкните мышью по треугольнику ( ) в каждой категории, что-
бы отобразить или скрыть содержащиеся в ней фильтры.

3 Щелкните мышью по ми-
ниатюре фильтра, чтобы 
применить его к изобра-
жению в области пред-
варительного просмотра. 
Используйте элементы 
управления в правой части 
окна для экспериментов 
и создания параметров, которые вы хотите использовать. Каж-
дый эффект фильтра предусматривает особый набор элементов 
управления.

4 В области предварительного про-
смотра используйте кнопки  [−]  
и [+] или раскрывающийся список 
со значениями масштаба для увеличения или уменьшения раз-
мера области предварительного просмотра. Установите курсор 
на область предварительного просмотра, а затем, нажав и удер-
живая кнопку мыши, перетащите, чтобы изменить отображен-
ный фрагмент изображения.

Галерея фильтров недоступна 
для изображений в цветовом 
режиме CMYK.

Не все фильтры программы 
Photoshop доступны в галерее 
фильтров.
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5 При необходимости используй-
те кнопку Показать/Скрыть 
(Reveal/Hide) ( ), чтобы 
скрыть область с миниатюрами 
фильтров для создания боль-
шей области предварительного 
просмотра. Вы можете вы-
брать фильтры по их названию 
в соответствующем раскры-
вающемся списке, если скроете 
область миниатюр.

6 Чтобы применить более одного 
фильтра к изображению в обла-
сти предварительного просмо-
тра, щелкните мышью по кноп-
ке Новый слой эффектов (New 
Effect) ( ) внизу окна, а затем 
щелкните мышью по другой 
миниатюре фильтра. Новый 
фильтр будет добавлен в конец 
списка.

7 В области эффектов 
фильтра щелкните мышью 
по кнопке видимости, что-
бы применить или скрыть 
эффект фильтра. Пере-
тащите эффект фильтра 
вверх или вниз, чтобы изменить порядок, в котором применя-
ются фильтры. Чтобы удалить эффект фильтра, перетащите его 
на значок в виде мусорной корзины.

8 Щелкните мышью по  кнопке ОК в  диалоговом окне Галерея 
фильтров (Filter Gallery), когда будете готовы применить пара-
метры.

Команда Преобразовать для 

смарт-фильтров (Convert for 
Smart Filters) в меню Фильтр 
(Filter) позволяет применять 
фильтры к изображению «не-
разрушающим» способом, при 
котором вы можете вернуться 
и изменить параметры фильтра 
на более позднем этапе.  
(См. следующий раздел/)
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Исправление перспективы
Фильтр Исправление перспективы (Vanishing Point) позволяет под-
держивать точную и  правильную перспективу при редактировании 
изображения, содержащего перспективные плоскости. Используйте 
этот фильтр для определения сетки перспективы или плоскости, чтобы 
установить точку схода. Затем вы можете изменять сетку так, чтобы она 
соответствовала правильной перспективе.

1 Чтобы изменить перспективу, выберите команду 
меню Фильтр → Исправление перспективы (Filter → 
Vanishing Point). Для определения сетки перспективы 
выберите инструмент Создать плоскость (Create Plane).

2 Установите указатель мыши на изображение, а затем щелкните, 
чтобы установить первый узел плоскости. Переместите указа-
тель мыши на  новое место (не  перетаскивайте, удерживая на-
жатой кнопку мыши). Щелкните кнопкой мыши для установки 
следующего узла. Повторите процедуру, чтобы установить тре-
тий и четвертый угловой узел. В диалоговом окне Исправление 
перспективы (Vanishing Point) отобразится синяя сетка.

3 Синяя ограничительная рамка показывает действующую сет-
ку. Если сетка или ограничительная рамка становится желтой 
или красной в  процессе ее создания или изменения, это гово-
рит о проблеме с выравниванием перспективной плоскости. Как 
правило, плоскость точно не совпадает с перспективой в изобра-
жении. Чтобы это исправить, выберите инструмент Редактиро-
вать плоскость (Edit Plane) ( ), установите указатель мыши 
на угловой узел сетки перспективы, а затем настройте сетку, вы-
ровняв ее с элементами изображения.

Чтобы удалить сетку, выберите 
инструмент Редактировать 

плоскость (Edit Plane), а затем 
нажмите клавишу Backspace 
или Delete.

Выберите инструмент Создать 

плоскость (Create Plane), 
а затем, удерживая нажатой 
клавишу Ctrl/�, перетащите 
центральный верхний/нижний 
или центральный левый/пра-
вый узел, чтобы определить 
дополнительную перпендику-
лярную плоскость.

Работая с инструментом Со-

здать плоскость (Create Plane), 
используйте раскрывающийся 
список Размер сетки (Grid Size), 
чтобы указать частоту сетки.

Выберите пункт Показать края 
(Show Edges) в меню панели  
( ) для контроля над видимо-
стью сетки перспективы.
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4 Чтобы изменить размер сетки перспективы, передвигайте цен-
тральный левый/правый или центральный верхний/нижний 
узел.

Удаление объектов в перспективе

1 Создайте сетку перспективы, а  затем выберите инструмент 
Штамп (Stamp). Сетка исчезнет, чтобы облегчить процесс редак-
тирования, однако ограничивающая рамка останется видимой. 
Задайте значения параметров Диаметр (Diameter), Жесткость 
(Hardness) и  Непрозрачность (Opacity) на  панели параметров 
(см. главу 5 для получения информации об  этих элементах 
управления).

2 Установите указатель мыши на область пикселей, которую вы хо-
тите использовать в качестве образца. Удерживая нажатой кла-
вишу Alt/�, щелкните кнопкой мыши, чтобы установить кон-
трольную точку, а затем отпустите клавишу Alt/�.

3 Переместите курсор на область целевых пикселей, в которую вы 
хотите добавить детали, используя пиксели, расположенные во-
круг контрольной точки. Обратите внимание на то, как при пере-
мещении указателя мыши в направлении задней части сетки пер-
спективы изменяется его размер для обеспечения соответствия 
сетке и  поддержа-
ния правильной 
перспективы.

4 Нажав и удерживая 
кнопку мыши, пе-
ретащите ее, чтобы 
удалить нежела-
тельные детали. 
При необходи-
мости повторите 
шаги 2–4, используя другие 
контрольные точки, чтобы 
результат соответствовал 
остальной части изобра-
жения и был максимально 
естественным.

Инструмент Штамп (Stamp) 
использует методы и элементы 
управления? очень похожие 
на те, которые используются 
для инструментов Штамп (Clone 
Stamp) и Восстанавливаю-

щая кисть (Healing Brush) (см. 
главу 6, чтобы получить более 
подробную информацию).

Используйте раскрывающийся 
список Восстановление (Heal), 
чтобы указать метод наложе-
ния для выбранных пикселей. 
Выберите вариант Вкл (On), 
чтобы сохранить текстуру 
выбранных пикселей и смешать 
со значениями цвета, освеще-
ния и затенения окружающих 
пикселей целевой области. 
Выберите вариант Светимость 
(Luminance) для сохранения 
цвета выбранных пикселей 
и смешивания со значениями 
светимости пикселей, окружаю-
щих целевую область.
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Редактирование плоскостей перспективы

Использование фильтра Исправление перспективы (Vanishing Point) 
позволяет создавать дополнительные плоскости перспективы, которые 
соответствуют той  же перспективе, что и  исходная плоскость. Изна-
чально плоскости создаются под углом 90°. Вы можете вставить содер-
жимое в фильтр Исправление перспективы (Vanishing Point) и мани-
пулировать им так, чтобы оно соответствовало сетке перспективы.

1 Начните с создания исходной родительской плоскости перспек-
тивы. Выберите инструмент Редактировать плоскость (Edit 
Plane). Удерживая нажатой клавишу Ctrl/�, перетащите цен-
тральный левый/правый или центральный верхний/нижний 
узел, чтобы создать новую дочернюю плоскость под углом 90°.

2 Если вам нужно изменить угол новой плоскости, чтобы обеспечить 
соответствие содержимому изображения, введите значение в поле 
ввода Угол (Angle) или перетащите ползунковый регулятор. Чтобы 
изменить угол вручную, перетащите центральный узел, расположен-
ный напротив оси вращения, удерживая нажатой клавишу Alt/�.

3 Чтобы вставить содержимое в плоскости перспективы, опреде-
ленные в фильтре Исправление перспективы (Vanishing Point), 
убедитесь в том, что вы копируете содержимое в буфер обмена 
до выбора пункта меню Фильтр → Исправление перспективы 
(Filter → Vanishing Point). При вставке содержимого в фильтр Ис-
правление перспективы (Vanishing Point) оно имеет вид «пла-
вающей» области выделения. Перетащите эту область выделе-
ния на плоскость, и она превратится в плоскость перспективы. 
Щелкните за пределами области выделения, чтобы снять выде-
ление и применить преобразование перспективы.

Если в фильтре Исправление 

перспективы (Vanishing Point) 
присутствуют перекрываю-
щиеся плоскости, щелкните 
кнопкой мыши, удерживая 
нажатой клавишу Ctrl/�, чтобы 
перебрать плоскости по поряд-
ку их следования в стопке.

Вы не можете изменить угол 
«родительской» плоскости пер-
спективы после создания на ее 
основе «дочерней» плоскости.

Вы должны растрировать 
текстовый слой (команда меню 
Текст → Растрировать тексто-

вый слой (Type → Rasterize Type 
Layer)) перед тем, как вставлять 
его в плоскость перспективы.
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Смарт-фильтры
Смарт-фильтры применяются к слоям смарт-объектов. Использование 
смарт-фильтров позволяет применять фильтры к изображению нераз-
рушающим способом, изменяя параметры фильтра так часто, как это 
необходимо.

1 Если вы работаете с изображением, состоящим только из фоново-
го слоя, сначала создайте дубликат фона. После этого вы сможете 
выделить слой, к которому хотите применить смарт-фильтр.

2 Выберите команду меню 
Фильтр → Преобразовать для 
смарт-фильтров (Filter → Convert 
for Smart Filters). Это преобразует 
слой в слой типа смарт-объект, 
к которому вы затем сможете 
применить смарт-фильтры.

3 Примените фильтр, выбрав вари-
ант из  соответствующего меню. 
На  слое смарт-объекта появится 
значок, указывающий на наличие 
смарт-фильтров. Значки слоя-
маски и смарт-фильтра появятся 
на  панели слоев под слоем смарт-объекта, к  которому 
они применены. Щелкните мышью по  треугольнику Развер-
нуть/Свернуть (Expand/Collapse), чтобы отобразить или скрыть 
смарт-фильтры для этого слоя.

4 Дважды щелкните мышью по названию смарт-фильтра, чтобы из-
менить его параметры. Щелкните мышью по кнопке видимости  
( ), чтобы скрыть или отобразить параметры смарт-фильтра.

5 Используя слой-маску смарт-фильтра, вы можете выборочно 
применять смарт-фильтры к слою смарт-объекта. Щелкните мы-
шью по значку слоя-маски, чтобы выделить его, прежде чем из-
менять слой-маску. Например, вы 
можете загрузить область выделе-
ния, а затем заполнить ее черным 
цветом, чтобы удалить эффект 
смарт-фильтра из  этой области  
(см. раздел «Слои-маски» главы 11 
для получения информации о  ра-
боте со слоями-масками).

Вы не можете использовать 
в качестве смарт-фильтров 
фильтры Пластика (Liquify) 
и Исправление перспективы 
(Vanishing Point).

Вы можете применить более 
одного фильтра в качестве 
смарт-фильтра.

Вы можете контролировать сте-
пень непрозрачности и режим 
наложения для смарт-фильтра, 
дважды щелкнув по кнопке 
редактирования параметров 
наложения ( ) для слоя, к ко-
торому применен смарт-фильтр.



14 Интернет 
и мультимедиа

Здесь рассматриваются 
некоторые аспекты 

эффективного 
использования различных 

типов изображений 
в форматах, подходящих 

для публикации 
в Интернете. Кроме 
того, тут описаны 

методы использования 
изображений 

в мультимедийных 
проектах.

Сохранение для публикации в Интернете

Параметры оптимизации для формата GIF

Параметры оптимизации для формата JPEG

Формат PNG

Цветовые палитры

Размытие
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Сохранение для публикации 
в Интернете
Команда Сохранить для Web (Save for Web) имеет удобные элементы 
управления для сохранения изображений, предназначенных для пуб-
ликации в Интернете. Применяйте команду Сохранить для Web (Save 
for Web), если вы хотите создать файл изображения минимального раз-
мера, чтобы гарантировать максимально быструю загрузку, и при этом 
не слишком потерять в качестве.

1 Выберите команду меню Файл → Сохранить (File → Save), чтобы 
сохранить изменения, внесенные в изображение, в текущем фор-
мате. Затем выберите команду меню Файл → Экспортировать → 
Сохранить для Web (File → Save for Web).

2 В открывшемся диалоговом окне перейдите 
на вкладку 2 варианта (2-Up), чтобы сравнить 
исходный рисунок и изображение с применен-
ными параметрами оптимизации. Для озна-
комления с последним перейдите на вкладку 
Оптимизация (Optimized). При просмотре вкладок 2 варианта 
(2-Up) и 4 варианта (4-Up) в нижней части каждой панели с изо-
бражением указаны формат файла, размер и  приблизительное 
время загрузки при заданной скорости соединения.

3 При использовании вкладок 2 варианта (2-Up) и  4 варианта  
(4-Up) убедитесь в  том, что панель с  оптимизированным изо-
бражением выделена серой рамкой. Здесь выберите формат ито-
гового файла в раскрывающемся списке Набор (Preset). Панель 
с  оптимизированным изображением обновится, и  вы сможете 
оценить разные варианты.

Команду Сохранить для 

Web (Save for Web) несложно 
вызвать, используя сочетание 
клавиш Ctrl/�+Alt/�+Shift+S. 
Помимо этого вы можете 
использовать новую в СС 2015 
команду Экспортировать как 
(Export as), нажав сочетание 
клавиш Ctrl/�+Alt/�+Shift+W.

Используйте инструменты Мас-

штаб (Zoom) и Рука (Hand) для 
масштабирования и прокрутки 
изображения в окне предвари-
тельного просмотра.
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4 При использовании вкладки 
4 варианта (4-Up), когда вы 
изменяете параметры опти-
мизации для панели с опти-
мизированным изображени-
ем, выберите пункт Переопределить виды (Repopulate Views) 
в меню диалогового окна, чтобы обновить остальные панели 
с более низкими значениями параметров оптимизации.

Оптимизация: вкладка 4 варианта

Вкладка 4 варианта (4-Up) особенно полезна, поскольку она позволяет 
просматривать изображения, используя различные уровни оптимиза-
ции, прежде чем выбрать один из них.

1 Перейдите 
на вкладку  
4 варианта 
(4-Up), чтобы 
просмотреть ис-
ходную картинку, 
изображение, 
оптимизирован-
ное с использо-
ванием текущих 
настроек, а также два менее качественных варианта с текущими 
настройками оптимизации.

2 Чтобы использовать одну из панелей с менее качественным вари-
антом оптимизированного изображения, выделите ее, щелкнув 
в ее пределах кнопкой мыши. Серая рамка вокруг панели указы-
вает на то, что она выделена. Выберите пункт Переопределить 
виды (Repopulate Views) в меню диалогового окна. В выделенной 
панели отобразится оптимизированное изображение. Параме-
тры появятся в области оптимизации. В панелях для сравнения 
отобразятся изображения, к которым применены более низкие 
значения параметров оптимизации.

3 Для сравнения разных параметров оптимизации, не имеющих 
друг к другу отношения, выделите панель, щелкнув по ней, а за-
тем выберите параметр оптимизации в раскрывающемся списке 
Установки (Settings). При этом убедитесь, что вы не используете 
команду Переопределить виды (Repopulate Views).

Расположение панелей 
на вкладке 4 варианта (4-Up) 
варьируется в зависимости 
от размера диалогового окна 
Сохранить для Web (Save for 
Web), а также от размеров 
и ориентации изображения.

При работе с изображением, 
содержащим фрагменты, щелк-
ните мышью по кнопке отобра-
жения фрагментов раскройки 
в диалоговом окне Сохранить 

для Web (Save for Web).
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Сохранение оптимизированных изображений

Вы можете просмотреть оптимизированное изображение в веб-брау-
зере, прежде чем принять окончательное решение относительно того, 
какие параметры оптимизации следует использовать. Это может быть 
полезно перед сохранением файла.

1 Выберите браузер в раскрывающемся 
списке, расположенном в нижней части 
диалогового окна. Он запустится и ото-
бразит картинку из выделенной панели. 
Под ней будут перечислены такие пара-
метры, как формат 
и размер файла, а так-
же высота и ширина 
изображения. Под па-
раметрами изображе-
ния окажется HTML-
код, необходимый для 
его отображения.

2 Чтобы сохранить 
оптимизированное 
изображение, выде-
лите панель с пара-
метрами, которые вы хотите использовать. Щелкните мышью 
по кнопке Сохранить (Save) в диалоговом окне Сохранить для 
Web (Save for Web).

3 Используйте 
стандартные для 
Windows/macOS 
методы выбора пап-
ки, в которой вы хотите сохранить изображение. Введите имя 
файла. Расширение для настроек оптимизации автоматически 
добавится к имени файла. Файл будет сохранен с использова-
нием текущих параметров оптимизации, указанных в соответ-
ствующей панели.

4 Выберите вариант 
HTML и изобра-
жения (HTML and 
Images) в раскры-
вающемся списке 
Формат (Format), 
чтобы сгенерировать 
код, необходимый 

Чтобы указать браузеры, кото-
рые вы хотите использовать для 
предварительного просмотра 
оптимизированных изобра-
жений, выберите вариант 
Редактировать список (Edit 
List) в раскрывающемся списке 
выбора браузера.

В открывшемся диалоговом 
окне щелкните мышью по кноп-
ке Добавить (Add), а затем 
перейдите к папке Program 
Files (Windows) или Applications 
(macOS), чтобы найти нужные 
браузеры.

Выберите файл приложения 
(.exe) для браузера, а затем 
щелкните мышью по кнопке 
Открыть (Open), чтобы внести 
его в диалоговое окно выбора 
браузеров. Повторите процеду-
ру для добавления дополни-
тельных программ.

Щелкните мышью по кнопке 
ОК в диалоговом окне, чтобы 
поместить браузеры в соответ-
ствующий список диалогового 
окна Сохранить для Web (Save 
for Web).
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для отображения картинки в отдельном HTML-файле. Этот 
файл будет автоматически назван и сохранен в указанной вами 
папке. Оптимизированное изображение сохраняется в папке 
с изображениями, которую программа Photoshop автоматиче-
ски создает в том же каталоге.

5 Чтобы указать, ис-
пользует ли HTML-
файл таблицу или 
каскадные таблицы 
стилей (CSS) для 
отображения карти-
нок с фрагментами, 
укажите вариант 
Другое (Other) 
в раскрывающемся 
списке Настройки 
(Settings). Выберите вариант Фрагменты раскройки (Slices). За-
дайте необходимые параметры в группе элементов управления 
Целевой фрагмент (Slice Output) диалогового окна Настройки 
экспорта (Output Settings).

6 Для картинок, содержащих фрагменты, используйте пункт 
Фрагменты раскройки (Slices) в раскрывающемся списке, что-
бы указать, следует  ли сохранять все фрагменты в  изображе-
нии, или только те, что выделены в настоящий момент. Каждый 
фрагмент сохраняется в качестве отдельного файла и называется 
в соответствии с настройками, указанными в диалоговом окне 
Настройки экспорта (Output Settings).

7 Чтобы изменить 
способ именова-
ния фрагментов 
в диалоговом окне 
Настройки экспор-
та (Output Settings), 
выберите в раскры-
вающемся списке вариант Сохранение файлов (Saving Files). 
Используйте раскрывающиеся списки в разделе Именование 
файлов (File Naming), чтобы внести изменения.



1
4

. 
И

н
т

е
р

н
е

т
 и

 м
у

л
ь

т
и

м
е

д
и

а
2

4
8

Параметры оптимизации  
для формата GIF
Формат файла GIF поддерживает методы оптимизации, предназначенные 
для изображений, в которых содержатся области сплошного цвета с четки-
ми краями и текстом, как часто бывает в случае с логотипами и кнопками.

1 Чтобы оптимизировать изображение, используя формат файла 
GIF, выделите панель с изображением, параметры которого вы хо-
тите настроить. Чтобы задать параметры для фрагмента, выделите 
его с помощью инструмента Выделение фрагмента (Slice Select).

2 Выберите одну из  предустановок 
в  соответствующем раскрываю-
щемся списке. Для создания поль-
зовательских настроек выберите 
пункт GIF в  раскрывающемся 
списке Формат (Format), а  затем 
укажите значения параметров.

3 Перетащите ползунковый регу-
лятор Потери (Lossy) или введите 
значение, чтобы уменьшить размер 
файла путем удаления информации о цвете. Значения в диапа-
зоне 5–10 часто не приводят к заметному ухудшению качества 
изображения. Выберите цветовую палитру (см. раздел «Цвето-
вые палитры» далее в главе) и метод размытия (см. раздел «Раз-
мытие» далее в главе).

4 Используйте раскрывающийся список Цвета (Colors), чтобы ука-
зать максимальное количество цветов в палитре. Увеличьте зна-
чение параметра Web-цвета (Web Snap), чтобы заменить цвета их 
ближайшими эквивалентами из веб-палитры, это позволит пре-
дотвратить дизеринг (размытие) при отображении в браузере.

5 Установите флажок Прозрачность 
(Transparency), чтобы сохранить 
любые прозрачные области в  изо-
бражении. Вы можете указать фоно-
вый цвет, если хотите смешать края 
прозрачных областей с  фоном веб-
страницы. При необходимости ис-
пользуйте раскрывающийся список 
Прозрачность (Transparency), чтобы 
выбрать модель дизеринга (размы-
тия) для смешиваемых областей.

Вы не можете использовать ва-
риант Потери (Lossy) совместно 
с установленным флажком 
Чересстрочно (Interlaced), или 
выбранной моделью размытия 
Шум (Noise), или Регулярный 
(Pattern).

Избегайте использования 
формата GIF, если ваше изобра-
жение содержит градиенты или 
полутона. Вместо этого исполь-
зуйте формат JPEG (см. следую-
щий раздел).

При установке флажка Черес-

строчно (Interlaced) создается 
изображение, которое сначала 
загружается в качестве миниа-
тюры с низким разрешением, 
в процессе чего загружается 
полная информация о файле.
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Параметры оптимизации  
для формата JPEG
Параметры оптимизации JPEG лучше всего подходят для полутоно-
вых изображений, фотографий. Алгоритм сжатия JPEG позволяет со-
хранить больше деталей в фотографиях, по сравнению с алгоритмом 
сжатия GIF, и при этом обеспечить значительное уменьшение размера 
файла.

1 Чтобы оптимизировать картинку, используя формат файла JPEG, 
выделите панель с изображением, параметры которого вы хоти-
те настроить. Чтобы задать параметры для фрагмента, выделите 
его с помощью инструмента Выделение фрагмента (Slice Select).

2 Выберите одну из  предустановок в  соответствующем раскры-
вающемся списке. Для создания пользовательских настроек вы-
берите пункт JPEG в раскрывающемся списке Формат (Format), 
а затем укажите значения параметров.

3 Используйте 
раскрывающийся 
список Качество 
(Quality) для выбора 
значения соответ-
ствующего параме-
тра или перетащите 
одноименный ползунковый регулятор. Используйте высокое 
значение, чтобы сохранить большую часть деталей изображе-
ния в файле большего размера. Уменьшите значение параметра 
Качество (Quality) для обеспечения большей степени сжатия, 
при меньшем размере файла более низкого качества.

4 Установите флажок Оптимизация (Optimized), чтобы создать 
файл JPEG меньшего размера. Некоторые старые браузеры 
не распознают этот параметр. Установите флажок Прогрессив-
ный (Progressive), чтобы изображение загружалось в несколько 
этапов, каждый из которых добавлял бы дополнительные детали 
до его полной загрузки. При необходимости используйте пара-
метр Размытие (Blur), чтобы обеспечить высокую степень сжа-
тия файла. Рекомендуется использовать значения меньше 0.5.

5 Алгоритм сжатия JPEG не поддерживает прозрачность в изобра-
жениях. Вы можете заполнить соответствующие области фоно-
вым цветом для имитации прозрачности, если вам известен цвет 
фона, на котором будет размещено изображение.

Для средних и высоких значе-
ний параметра сжатия JPEG вы 
можете использовать неболь-
шое значение параметра Раз-

мытие (Blur), например, 0.1–0.5, 
чтобы размыть артефакты, 
которые могут появиться вдоль 
четких краев. Более высокие 
значения могут значительно 
уменьшить степень детализа-
ции изображения.

Алгоритм сжатия JPEG преду-
сматривает «потерю» в качестве 
картинки. Для уменьшения 
размера файла некоторые дан-
ные изображения удаляются, 
что приводит к снижению его 
качества.
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Формат PNG
PNG —  это относительно новый формат файла, используемый при со-
хранении изображений для использования в Интернете. Существуют 
два варианта формата файла PNG: PNG-8 и PNG-24.

PNG-8

Формат файла PNG-8 задействует 8-битный цвет, который допускает 
наличие в изображении максимум 256 цветов. Он наиболее эффектив-
но сжимает области сплошного цвета, обычно присутствующие в век-
торных иллюстрациях и логотипах.

Формат PNG-8 обеспечи-
вает сжатие без потерь, 
то есть информация 
о цвете не теряется. В за-
висимости от изображе-
ния, применение формата 
PNG-8 может произво-
дить файлы на 10–20% 
меньше по сравнению 
с форматом GIF.

Формат файла PNG-8 поддерживает прозрачность фона и  фоновую 
подложку. Фоновая подложка позволяет смешивать края изображения 
с фоновым цветом веб-страницы.

PNG-24

Формат PNG-24 поддерживает 24-битный цвет, что допускает исполь-
зование миллионов цветов в изображении. Как и формат JPEG, этот 
формат позволяет сохранить тонкие переходы тонов и цветов в изобра-
жениях, таких как фотографии.

Формат PNG-24 осуществляет сжатие без потерь, при котором инфор-
мация о цвете не удаляется. В результате размеры файла PNG-24, как 
правило, превышают размеры файлов, сохраненных в формате JPEG.

Формат PNG-24 поддерживает фоновую прозрачность и фоновую под-
ложку, а также многоуровневую прозрачность, которая позволяет луч-
ше контролировать способ смешивания изображения с фоновым цве-
том веб-страницы.

В случае с изображениями, 
в которых применяется очень 
ограниченный диапазон цветов, 
формат GIF может произво-
дить файлы меньшего размера 
по сравнению с форматом 
PNG-8. Используйте вкладку 
4 варианта (4-Up) при сохра-
нении изображений, чтобы 
выбрать лучший уровень опти-
мизации.

Многоуровневая прозрачность 
поддерживается не всеми брау-
зерами.
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Цветовые палитры
Цветовая палитра контролирует 256 возможных 
цветов, которые присутствуют в изображении в ре-
жиме индексированных цветов, GIF или PNG-8. 
Программа Photoshop использует три способа созда-
ния таблиц цветов в  изображении: динамический, 
фиксированный и заказной.

Системные палитры

Это стандартные 8-битные палитры ОС Windows или Mac OS.

Точная

Если преобразуемое вами изображение уже содержит менее 256 цветов, 
то эта палитра используется по умолчанию. Фактическое количество 
цветов указано в поле ввода Цвета (Colors). Данная палитра не позво-
ляет применять дизеринг.

Ограниченная

Эта палитра содержит 216 или менее цветов. Используйте ее для обес-
печения согласованности между различными платформами, а также если 
хотите использовать более одного изображения на одной и той же веб-
странице. Картинки, основанные на различных палитрах цветов, могут 
выглядеть несколько искусственными при сравнении друг с другом.

Однородная

Эта палитра основана на однородной выборке цветов спектра.

Адаптивная

Эта палитра создается на основе цветов, которые на самом деле при-
сутствуют в изображении. В случае с отдельными картинками эта па-
литра обеспечивает лучшие результаты по сравнению с ограниченной, 
поскольку таблица цветов создается путем выборки наиболее распро-
страненных в изображении образцов цвета.

Используйте раскрывающийся 
список Палитра цветов (Color 
palette) в левой части диалого-
вого окна Сохранить для Web 
(Save for Web), чтобы выбрать 
палитру цветов при оптимиза-
ции изображений.

Динамические цветовые пали-
тры (Перцепционная (Percep-
tual), Селективная (Selective) 
и Адаптивная (Adaptive)) 
создаются динамически. Каждый 
раз, когда вы оптимизируе-
те изображение, создается 
палитра, основанная на цветах, 
присутствующих в изображении. 
Различные изображения генери-
руют различные палитры.

К фиксированным цветовым 
палитрам относятся Ограничен-

ная (Web), Mac OS, Windows, 
Черно-белое (Black & White) 
и Grayscale (Оттенки серого). 
Такие палитры отличаются огра-
ниченным или фиксированным 
набором цветов. Если в настрой-
ках оптимизации указано менее 
256 цветов, то этот сокращенный 
диапазон основан на фиксиро-
ванной цветовой палитре.

В заказных палитрах исполь-
зуются оттенки, созданные или 
измененные пользователем. 
В существующих файлах GIF 
и PNG-8 также применяются 
заказные палитры.
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Заказная

Этот вариант позволяет вам создать свою собственную пользователь-
скую таблицу цветов. Вы можете добавить цвета ( ), закрепить ( ),  
а  также заменить их ближайшими безопасными эквивалентами веб-
цветов ( ) или преобразовать выбранные цвета в прозрачность ( ), 
используя кнопки в нижней части таблицы цветов.

Перцепционная

Вариант Перцепционная (Perceptual) создает палитру, смещенную 
в сторону цветов, к которым человеческий глаз наиболее чувствителен.

Селективная

Этот вариант подобен варианту Перцепционная (Perceptual), но сме-
щен в сторону обширных цветовых областей в изображении, а также 
в сторону сохранения веб-цветов. Вариант Селективная (Selective) вы-
бирается по умолчанию.
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Размытие
Размытие (дизеринг) —  метод, используемый для симуляции оттенков, 
которые отсутствуют в цветовой палитре. На компьютерных монито-
рах, поддерживающих только 256 цветов, дизеринг позволяет имитиро-
вать более широкий диапазон цветов в изображении, чем монитор спо-
собен отобразить. В случае 
с  веб-изображениями дан-
ный метод известен, как 
«сглаживание в  браузере». 
Дизеринг сочетает пиксе-
ли разного цвета, чтобы 
создать иллюзию наличия 
дополнительных оттенков.

Вы можете выбрать метод размытия для изображения в процессе его 
оптимизации. При этом происходит подмешивание цвета для имита-
ции отсутствующих в палитре приложения полутонов.

Для изображений в формате GIF в диалоговом 
окне Сохранить для Web (Save for Web) выбе-
рите вариант в раскрывающемся списке Размы-
тие (Dither). При выборе варианта Случайное 
(Diffusion) укажите значение параметра Дизе-
ринг (Dither). Более высокие значения обеспечи-
вают большую степень размытия, что приводит к по-
явлению в изображении большего количества цветов. Более высокие 
значения также могут привести к увеличению размера файла в зависи-
мости от изображения.

Без дизеринга

При выборе варианта Без дизеринга (No Dither) размытие к изображе-
нию не применяется.

Регулярный

Вариант Регулярный (Pattern) создает квадратный узор, подобный по-
лутонам, для имитации оттенков, отсутствующих в таблице цветов.

Вы можете минимизировать 
сглаживание в браузере, созда-
вая изображения с использова-
нием только веб-совместимых 
цветов.

Картинки, содержащие области 
сплошного цвета, лучше всего 
сжимаются без использова-
ния дизеринга. Изображения 
с градиентами обычно требуют 
применения размытия для 
предотвращения появления 
полос.
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Случайное

Результаты применения варианта Случайное (Diffusion) обычно менее 
заметны, чем результаты применения варианта Регулярный (Pattern), 
поскольку эффект размытия распространяется по диапазону пикселей.

Шум

Вариант Шум (Noise) применяет случайный узор размытия и может ис-
пользоваться для изображений, содержащих фрагменты.



15 Анимация 
и фрагменты

GIF-анимация 
и раскройка 

изображения —  это 
два очень мощных 

инструмента, которые 
вы можете использовать 

при подготовке 
изображений для 

публикации в Интернете 
и мультимедийных 

проектах.

Создание простой анимации

Воспроизведение и управление кадрами

Оптимизация и сохранение анимации

Создание промежуточных кадров

Раскройка изображений

Работа с фрагментами

Оптимизация и сохранение фрагментов
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Создание  
простой анимации
Анимация может быть как очень простой, так и очень сложной. Внача-
ле старайтесь создавать простые примеры. Помните о том, что анима-
ционные эффекты, если они используются на веб-страницах неразумно, 
могут отвлекать внимание и, как следствие, не обеспечивать нужного 
воздействия.

1 Создайте изображение в  программе Photoshop. Используйте 
слои в качестве основы для анимации. Создаваемые вами слои 
являются основными строительными блоками для анимации. 
Поместите элементы, которые вы хотите анимировать, на  от-
дельные слои.

2 Скройте любые слои, содержащие 
элементы, которые не должны быть 
видны в начале анимации.

3 Выберите команду меню Окно → 
Шкала времени (Window → 
Timeline), чтобы отобразить соот-
ветствующую панель. После этого 
программа Photoshop добавит до-
полнительную строку параметров 
на панель Слои (Layers). Текущее 
состояние изображения отобра-
зится в данной панели в качестве 
кадра 1.

Чтобы избежать путаницы при 
создании анимации, убеди-
тесь в том, что вы подготовили 
и отредактировали все объекты 
и слои, которые хотите исполь-
зовать, прежде чем начинать 
работу над анимацией.

После открытия панели Шкала 

времени (Timeline) щелкните 
мышью по кнопке Создать 

шкалу времени для видео 
(Create frame Animation).

Выберите пункт Преобразо-

вать в шкалу времени видео 
(Convert to Video Timeline) 
в меню панели Шкала времени 
(Timeline), чтобы получить до-
ступ к соответствующей шкале 
времени. Вы также можете 
щелкнуть по кнопке Преобра-

зовать в шкалу времени ви-

део (Convert to Video Timeline) 
в нижней части панели Шкала 

времени (Timeline).

Чтобы восстановить вид панели 
Шкала времени (Timeline) 
по умолчанию, вы можете щелк-
нуть по кнопке Преобразовать 

в анимацию кадров (Convert to 
Frame Animation).
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4 Выберите пункт Новый кадр (New 
Frame) в меню панели или щелкни-
те мышью по одноименной кнопке. 
Это приведет к  созданию кадра 2, 
который представляет собой дуб-
ликат предыдущего кадра.

5 Внесите изменения в слой. Измене-
ния слоя, касающиеся его ви-
димости, положения, непро-
зрачности или примененных 
к  нему эффектов, обеспечи-
вают анимацию, когда кадры 
просматриваются в быстрой 
последовательности. В  дан-
ном примере один текстовый слой скрыт, а другой отображен.

6 При необходимости повторите шаги 4–5.

7 Сохраняйте анимацию в фор-
мате Photoshop по мере ее 
создания и изменения. При необходимости вы сможете вер-
нуться к исходному файлу для осуществления дополнительных 
корректировок (см. раздел «Оптимизация и сохранение анима-
ции» далее в главе для получения информации о сохранении 
оптимизированной версии анимации, предназначенной для 
публикации в Интернете).

Анимация сохраняется в файле 
формата GIF. Форматы JPEG 
и PNG не могут использоваться 
для создания анимации.

Любые изменения слоя, затра-
гивающие реальные значения 
пикселей, как при рисовании, 
изменении цвета или тона, 
а также при трансформиро-
вании, влияют на все кадры ани-
мации, в которых присутствует 
этот слой.
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Воспроизведение 
и управление кадрами
В процессе создания анимации вам нужно будет осуществлять пред-
варительный просмотр и контролировать такие аспекты, как цикличе-
ское воспроизведение и частота кадров.

1 Для воспроизведения анимации щелк-
ните мышью по кнопке Запуск (Play). 
Анимация начнет воспроизводиться в окне изображения, 
и каждый кадр на панели Шкала времени (Timeline) будет по-
следовательно выделяться в процессе воспроизведения. Щелк-
ните мышью по кнопке Стоп (Stop), чтобы остановить анима-
цию на текущем кадре.

2 Для выбора кадра щелкните мышью по его миниатюре на панели 
Шкала времени (Timeline). Кадр будет выделен в качестве теку-
щего. Текущий кадр отображается в окне изображения. Это кадр, 
который можно редактировать в данный момент.

3 Чтобы удалить кадр, сначала выделите его, щелк-
нув по нему. Затем щелкните мышью по значку 
в виде мусорного бака в нижней 
части панели. Также вы можете пе-
ретащить кадр на этот значок или 
выбрать пункт Удалить кадр (Delete Frame) в меню панели.

4 Чтобы изменить положение кадра, выделите его, а затем пере-
тащите на новое место. Отпустите кнопку мыши, когда черный 
курсор вставки окажется в том месте, куда вы хотите поместить 
выделенный кадр.

Для выбора нескольких после-
довательных кадров щелкните 
мышью по первому, а затем, 
удерживая нажатой клавишу 
Shift, щелкните по последнему 
кадру нужного диапазона. Для 
выбора непоследовательных 
кадров, выделите кадр, щелкнув 
по нему, а затем, удерживая на-
жатой клавишу Ctrl/�, щелкните 
мышью по нужным кадрам, что-
бы добавить их к выделенным.

Когда вы выбираете несколько 
кадров, текущий кадр можно 
отличить по окружающей его 
белой рамке.
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5 Чтобы установить значение 
задержки (время отображения 
кадра), сначала выделите один 
или несколько кадров. Используя 
раскрывающийся список, распо-
ложенный под каждым кадром, 
выберите одно из предустановлен-
ных значений или щелкните мышью по пункту Другое (Other), 
а затем укажите нужное значение в диалоговом окне Задать 
время отображения кадра (Set Frame Delay).

6 Для указания параметров цикли-
ческого воспроизведения исполь-
зуйте соответствующий раскры-
вающийся список в нижнем 
левом углу панели Шкала 
времени (Timeline). Вари-
ант Постоянно (Forever) 
обеспечивает непрерывное 
воспроизведение анимации. Выберите вариант Другое (Other), 
чтобы задать количество повторов. Введите значение в поле 
Воспроизведение (Play).

Копирование и вставка кадров

Вы можете скопировать один или несколько кадров, а затем вставить 
скопированные кадры в новое место этой же или другой анимации.

1 Чтобы скопировать кадр, сначала выделите его. Синяя рамка 
указывает на  то, что кадр выделен. Выберите пункт Скопиро-
вать кадр (Copy Frame) в меню панели ( ).

2 Выделите кадр, расположен-
ный в том месте, куда вы хо-
тите вставить скопирован-
ный кадр. Выберите пункт 
Вставить кадр (Paste Frame) 
в меню панели Шкала вре-
мени (Timeline). Выберите метод вклеивания, а затем щелкните 
мышью по кнопке ОК.

Выделив диапазон кадров, вы 
можете выбрать пункт Обрат-

ный порядок кадров (Reverse 
Frames) в меню панели, чтобы 
изменить порядок следования 
кадров. Это бывает полезно 
после вставки кадров, как 
в приведенном здесь примере.
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Оптимизация и сохранение 
анимации
Если вас устраивает результат создания кадров, вы можете оптимизи-
ровать и затем сохранить анимацию.

1 Для оптимизации анимации 
выберите пункт Оптимизировать 
анимацию (Optimize Animation) 
в меню панели Шкала времени 
(Timeline). Рекомендуется оставить установленными флажки в раз-
деле Оптимизировать по (Optimize By) для обеспечения наиболее 
качественной оптимизации. Щелкните мышью по кнопке ОК.

2 Выберите команду меню 
Файл → Экспортировать → 
Сохранить для Web (File 
→ Export → Save for Web). 
Выберите одну из преду-
становок оптимизации GIF 
в раскрывающемся списке 
Набор (Preset) или задайте 
свои собственные параметры.

3 Для осуществления 
предварительно-
го просмотра результатов оптимизации различных кадров 
анимации в диалоговом окне Сохранить для Web (Save for Web) 
используйте кнопки Предыдущий/Следующий кадр (Previous/
Next Frame), Первый/Последний кадр (First/Last Frame) или 
щелкните мышью по кнопке Запуск (Play), чтобы воспроизве-
сти все кадры.

4 Выберите браузер в раскры-
вающемся списке, распо-
ложенном в нижней части 
диалогового окна. Браузер 
будет запущен, и в его окне 
воспроизведется анимация. 
Информация о формате файла и HTML-код отобразится под 
анимацией. Закройте браузер.

5 Щелкните мышью по кнопке Сохранить (Save) в диалоговом 
окне Сохранить для Web (Save for Web). Укажите расположение 
и имя файла. Расширение файла.GIF добавится автоматически.

Для обеспечения согласован-
ности цвета во всех кадрах 
анимации используйте адаптив-
ную, селективную или перцеп-
ционную цветовую палитру при 
задании параметров оптимиза-
ции в формате GIF.
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Создание  
промежуточных кадров
Команда Создание промежуточных кадров (Tween) обеспечивает 
плавность анимации за счет создания дополнительных кадров между 
существующими кадрами анимации. Эти промежуточные кадры созда-
ют эффект плавной анимации.

1 Для создания промежуточных кадров щелкните мышью по кноп-
ке Новый кадр (New Frame) для создания дубликата первого 
кадра. Измените слой, с которым вы работаете (например, пере-
местите объект).

2 Щелкните мышью по кнопке создания промежуточных кадров  
( ) на панели Анимация (Animation) или выберите пункт Со-
здание промежуточных кадров (Tween) в меню панели.

3 В разделе Слои (Layers) выберите 
вариант Выделенные слои (Selected 
Layers), если вы хотите изменить 
только выделенный в настоящее вре-
мя слой, в противном случае оставь-
те выбранным вариант Все слои (All 
Layers). Установите флажки в разделе Атрибуты слоя (Parameters), 
чтобы указать, к  каким элементам вы хотите применить эффект. 
В приведенном примере важно установить флажок Положение (Po-
sition), поскольку в процессе анимации изменяется именно положе-
ние слоев. Установите флажки Непрозрачность (Opacity) и Эффек-
ты (Layer Effects), если эти параметры изменяются от кадра к кадру.

4 Используйте раскрывающийся список Промежуточные кадры 
(Tween With) для выбора кадра, который вы хотите использо-
вать для создания промежуточных кадров наряду с выделенным 
в настоящее время кадром. Введите значение в поле Добавить 
кадров (Frames to Add), чтобы указать количество промежуточ-
ных кадров. Чем больше кадров вы добавите, тем более плавной 
станет анимация, и тем больше окажется размер файла.

5 Щелкните мышью по кнопке ОК в диалоговом окне. Промежу-
точные кадры добавятся в качестве новых. Последующие кадры 
будут перенумерованы соответствующим образом.

Термин «tweening» происходит 
от традиционного анимацион-
ного термина «in betweening», 
означающего создание между 
ключевыми кадрами допол-
нительных кадров, обеспечи-
вающих плавность эффектов 
анимации.

Создавайте промежуточные 
кадры, чтобы значительно со-
кратить время, необходимое для 
создания плавной анимации.

Промежуточные кадры ани-
мации не требуют создания 
нового слоя для каждого нового 
кадра. Этот эффект присутству-
ет на каждом отдельном слое.
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Раскройка изображения
Вы можете разбить изображение на фрагменты —  прямоугольные обла-
сти изображения, которые можно автоматизированно сохранять в виде 
набора отдельных изображений, предназначенных для публикации 
в Интернете или в мультимедийных проектах. Изначально все изображе-
ние представляет собой один фрагмент. Это становится очевидным при 
выборе инструмента Выделение фрагмента (Slice Select), когда в левом 
верхнем углу изображения появляется серый значок ( ). При со-
здании нового фрагмента остальная часть изображения автоматически 
разделяется на дальнейшие фрагменты.

1 Чтобы создать фрагмент с помощью инструмента Раскрой-
ка (Slice), выберите этот инструмент, щелкнув по нему. Уста-
новите курсор на изображение, а затем, нажав и удерживая 
кнопку мыши, перетащите, чтобы определить область фрагмента. 
Определенный вами фрагмент является пользовательским ( ).

2 Когда вы отпустите кнопку 
мыши, программа Photoshop 
автоматически сгенерирует до-
полнительные фрагменты для 
остальных областей изобра-
жения, которые не определены 
в  качестве пользовательских 
фрагментов. Дополнительные 
фрагменты являются автома-
тически созданными ( ).

Фрагменты на основе направляющих

Быстрый и удобный метод раскройки изображения заключается в со-
здании фрагментов на основе направляющих, которые вы располагаете 
на изображении.

1 Перетащите направляющие, чтобы указать области, где вы хоти-
те создать фрагменты (см. раздел «Направляющие и сетки» гла-
вы 2 для получения информации о создании направляющих).

2 Выберите инструмент Раскройка (Slice), 
а затем щелкните мышью по кнопке Фрагменты по направляю-
щим (Slices From Guides) на панели параметров. В изображении 
отобразятся пронумерованные фрагменты. Фрагменты, создан-
ные на  основе направляющих, являются пользовательскими  
(см. следующий раздел для получения информации о  пользова-
тельских и автоматически созданных фрагментах).

Инструменты Раскройка (Slice) 
и Выделение фрагмента (Slice 
Select) расположены в группе 
инструментов Рамка (Crop).

После выбора инструмента 
Раскройка (Slice) существую-
щие фрагменты отображаются 
автоматически.

При использовании коман-
ды Фрагменты по направ-

ляющим (Slices From Guides) 
программа Photoshop удаляет 
ранее созданные фрагменты.

Для использования интерак-
тивных направляющих, по-
зволяющих точно выровнять 
фрагменты, выберите команду 
меню Просмотр → Показать → 
Быстрые направляющие 
(View → Show → Smart Guides). 
Эти направляющие появляются 
по мере того, как вы рисуете 
и перемещаете фрагменты 
в изображении с несколькими 
слоями и/или существующими 
фрагментами. Для эффектив-
ной работы с направляющими 
используйте их совместно 
с пунктами Привязка (Snap) 
и Привязать к (Snap To) меню 
Просмотр (View).
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Работа с фрагментами
Используйте следующие методы, чтобы скрыть и отобразить фрагмен-
ты, а также манипулировать ими.

1 Чтобы скрыть фрагменты, значки их типа и такую ин-
формацию,   как их количество, выберите команду меню 
Просмотр → Показать → Фрагменты (View → Show → 
Slices). Чтобы отобразить фрагменты, снова выберите тот  же 
пункт меню или инструмент Выделение фрагмента (Slice Select).

2 Чтобы выделить пользовательский фраг-
мент, выберите инструмент Выделение 
фрагмента (Slice Select). Щелкните мы-
шью по фрагменту. Вокруг выделенного 
фрагмента появится ограничивающая 
рамка с восемью маркерами.

3 Чтобы переместить пользовательский фрагмент, выберите ин-
струмент Выделение фрагмента (Slice Select), установите указа-
тель мыши на нужный фрагмент, а затем перетащите его.

4 Чтобы изменить размер пользо-
вательского фрагмента, выберите 
инструмент Выделение фрагмента 
(Slice Select). Выберите фрагмент, 
а затем перетащите боковой или 
угловой маркер масштабирования.

5 Чтобы выбрать несколько пользовательских фрагментов, выде-
лите один фрагмент, а затем, удерживая нажатой клавишу Shift, 
щелкните мышью по  другому пользовательскому фрагменту, 
чтобы добавить его к выделенному ранее.

Пользовательские и автоматически  
созданные фрагменты
Фрагмент может быть пользовательским либо созданным автоматиче-
ски. Пользовательские фрагменты предусматривают большее количе-
ство возможных модификаций. Фрагменты, создаваемые с  помощью 
направляющих или инструмента Раскройка (Slice), являются пользо-
вательскими. К  другому типу относятся фрагменты, автоматически 
создаваемые программой Photoshop. Изначально изображение состоит 
из одного автоматически созданного фрагмента.

Вы можете превратить автоматически созданный фрагмент в  поль-
зовательский. Это бывает полезно, поскольку пользовательским 

Фрагменты отображаются авто-
матически при выборе инстру-
мента Выделение фрагмента 
(Slice Select).

Чтобы удалить пользователь-
ский фрагмент, сначала выдели-
те его, а затем нажмите клавишу 
Backspace или Delete. Для 
заполнения освободившейся 
области добавляются автомати-
чески созданные фрагменты.
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фрагментам могут быть назначены разные параметры оптимизации. 
Автоматически созданные фрагменты изображения изначально связа-
ны между собой, на что указывает соответствующий значок ( ), и, сле-
довательно, имеют одни и те же параметры оптимизации.

Существуют два типа фрагментов: Изо-
бражение (Image) или Без изображения 
(No Image). Фрагменты типа Изображение 
(Image) содержат информацию об изображе-
нии —  данные о пикселях. Фрагменты типа 
Без изображения (No Image) могут содер-
жать сплошной цвет или HTML-код. Фрагменты типа Изображение 
(Image) отличает значок ( ), когда они видимы.

Фрагменты нумеруются слева направо и сверху вниз, начиная с верх-
него левого угла. По мере добавления, удаления и изменения порядка 
следования фрагментов их номера обновляются автоматически.

Когда вы выбираете фрагменты с помо-
щью инструмента Выделение фрагмен-
та (Slice Select), пользовательские фраг-
менты окружаются сплошной линией 
с  маркерами, а  автоматически создан-
ные — пунктирной линией.

Параметры фрагмента

Диалоговое окно Параметры фрагмента (Slice Options) позволяет на-
строить такие параметры, как URL-адрес, если вы хотите преобразо-
вать фрагменты в  нажимаемые кнопки, а  также указать, должны  ли 
фрагменты обрабатываться как изображения, или как область, которая 
будет заполнена фоновым цветом или HTML-кодом.

1 Чтобы открыть диалоговое окно Параметры фрагмен-
та (Slice Options), выберите фрагмент, а затем щелкните 
мышью по одноименной кнопке на панели параметров 
или дважды щелкните мышью в пределах фрагмента. В поле вво-
да Имя (Name) появятся имя и номер фрагмента по умолчанию. 
При необходимости вы можете отредактировать имя.

2 Чтобы превратить фрагмент в кнопку, введите URL-адрес в поле 
ввода URL. Для абсолютных путей вы должны включить в нача-
ле адреса часть http://. Вы также можете указать относительные 
пути. Введите текст, который будет отображаться в  строке со-
стояния браузера, а также текст атрибута изображения alt, если 
это необходимо.

Чтобы удалить все фрагменты 
изображения, выберите коман-
ду меню Просмотр → Удалить 

фрагменты (View → Clear Slices).

Пользовательские фрагменты 
обозначаются голубыми значка-
ми. Автоматически созданные 
фрагменты обозначаются серы-
ми значками.

Вы можете преобразовать авто-
матически созданный фрагмент 
в пользовательский, выделив 
его и щелкнув по кнопке Пре-

образовать (Promote) на пане-
ли параметров.

Программа Photoshop может 
генерировать фрагменты в виде 
HTML-таблицы или при помощи 
каскадных таблиц стилей (CSS). 
В диалоговом окне Сохранить 

оптимизированный как (Save 
Optimized As) (см. следующий 
раздел) вы можете открыть 
дополнительное диалоговое 
окно Настройки экспорта 
(Output Settings), чтобы указать 
используемый метод.
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Оптимизация  
и сохранение фрагментов
После создания и настройки фрагментов вы можете использовать диа-
логовое окно Сохранить для Web (Save for Web), чтобы оптимизиро-
вать и  сохранить отдельные фрагменты или целые изображения для 
дальнейшего использования во Всемирной паутине.

1 Для оптимизации фрагментов в  изображении выберите коман-
ду меню Файл → Экспортировать → Сохранить для Web (File → 
Export → Save for Web). Границы фрагментов видимы по умолча-
нию. Щелкните мышью по кнопке видимости фрагментов на пане-
ли инструментов слева, чтобы скрыть или отобразить их границы.

2 Чтобы выделить и  оптимизировать отдельный фрагмент, вы-
берите инструмент Выделение фрагмента (Slice Select), а  за-
тем щелкните мышью по видимому фрагменту на панели с ре-
зультатом оптимизации. Выделенный фрагмент отобразится 
в  обычном виде, окруженный цветной границей. Чтобы выде-
лить несколько фрагментов для последующего применения со-
гласованных параметров оптимизации, нажмите и удерживайте 
клавишу Shift, а  затем щелкните мышью по  дополнительным 
фрагментам, чтобы добавить их в исходное выделение, или пере-
тащите указатель мыши по нужным фрагментам, выбрав перед 
этим инструмент Выделение фрагмента (Slice Select).

3 Для легкого повторного 
выделения связанных между 
собой групп фрагментов 
выделите два или более 
фрагмента, а затем выберите 
пункт Связать фрагменты 
раскройки (Link Slices) 
в меню диалогового окна. 

Невыделенные фрагменты 
в диалоговом окне Сохра-

нить для Web (Save for Web) 
выглядят немного тусклыми, 
чтобы вы могли отличить их 
от выделенных фрагментов, 
которые выглядят как обычно. 
Это наложение не оказывает ни-
какого влияния на вид или цвет 
изображения.
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Значки, обозначающие состояние 
фрагмента ( ), приобре-
тут другой цвет, чтобы указать 
на наличие ссылки. Вы можете 
отсоединить некоторые или все 
выделенные фрагменты, исполь-
зуя соответствующий пункт меню 
диалогового окна.

4 Автоматически созданные фрагменты являются связанными 
по  умолчанию. Когда вы применяете параметры оптимизации 
к  автоматически созданному фрагменту, эти параметры приме-
няются ко  всем фрагментам данного типа. При необходимости 
вы можете выделить автоматически созданный фрагмент, а затем 
выбрать пункт Отменить связь фрагментов (Unlink Slice) в меню 
диалогового окна. Это приведет к преобразованию выделенного 
фрагмента в пользовательский фрагмент, который вы затем смо-
жете оптимизировать, используя отдельные параметры.

5 Задайте параметры оптимизации для каждого фрагмента изо-
бражения, используя предустановленные или пользовательские 
настройки на панели оптимизации (см. раздел «Сохранение оп-
тимизированных изображений» главы 14 для получения допол-
нительной информации об оптимизации изображений).

6 Щелкните мышью по  кнопке Готово (Done), чтобы вернуться 
к  изображению, сохранив изменения параметров, внесенные 
в  диалоговом окне. Щелкните мышью по  кнопке Сохранить 
(Save), чтобы сохранить оптимизированные фрагменты.

7 В диалоговом окне Сохранить оптимизированный как (Save 
Optimized As) выберите вариант в раскрывающемся списке 
Фрагменты (Slices). Выберите вариант Выделенные фрагменты 
(Selected Slices), 
если вы выбра-
ли конкретные 
фрагменты перед 
нажатием кнопки 
Сохранить (Save) 
и не хотите сохра-
нять все фрагмен-
ты в изображении 
(см. раздел «Со-
хранение для Web» 
главы 14  
для получения информации 
о сохранении изображений).

Используя инструмент Выде-

ление фрагмента (Slice Select), 
дважды щелкните мышью 
по фрагменту, чтобы отобразить 
диалоговое окно Параметры 

фрагмента (Slice Options).

Для предотвращения появле-
ния швов между фрагментами 
при оптимизации с помощью 
форматов GIF или PNG-8 убеди-
тесь в том, что вы используете 
одну и ту же цветовую палитру 
и настройки размытия, особен-
но для соседних фрагментов.
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Заливка с учетом содержимого, 

команда 136
Заливка, инструмент 96
Замена цвета, инструмент 115
Заплатка с учетом содержимого, 

команда 113
Заплатка, инструмент 114
Заполнение выделенной области 

узором 135
Заполнение слоя-фигуры 191
Заполнить, диалоговое окно 59, 135
Затемнитель, инструмент 108
Значок предупреждения 

о невоспроизводимости цвета 77, 
79

Инструментов, панель 30–31
Инструменты фигур 100, 190
Интерполяция 66, 71
Инфо, панель 35
Исправление перспективы, фильтр 

239–241
История, панель 41

Очистка 41
Снимки 42
Удаление состояний 41
Удаление состояний из памяти 42

Калибровка монитора 24
Каналы, панель 197, 198
Карандаш, инструмент 92

Кисти
Включить эффекты аэрографа, 

кнопка 85, 89
Влажные края 86, 89
Двойная кисть 89
Динамика формы 88
Динамика цвета 89
Жесткость 84, 87
Защита текстуры 89
Нажим 85, 93
Непрозрачность 85
Положение кисти 89
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Размер 84
Рассеивание 86, 88
Сглаживание 89
Текстура 89
Угол 87
Форма 87
Шум 89

Кисть, панель 86–87
Ключевые слова, панель 49
Контурная резкость, фильтр 225
Контуры

Искривленные сегменты 187
Опорные точки 183
Перо, инструмент 183
Плавные точки 184
Преобразование выделенных 

областей 182
Прямолинейные сегменты 183
Рабочий контур 182
Скрытие 182
Сохранение 182
Угловые точки 184
Экспорт 188–189

Контуры, панель 47

Корректирующие слои 210

Коррекция, панель 216–217
Красные глаза, инструмент 114
Края 225, 228
Кривые, диалоговое окно 209, 212–213
Лассо, инструмент 125, 132
Ластик, инструмент 109
Линиатура растра 20
Магнитное лассо, инструмент 125–126
Максимизация совместимости 54
Марионеточная деформация 167–168
Маски 196–205
Маски, панель 200–202
Масштаб с учетом содержимого, 

команда 165
Масштаб, инструмент 34, 244
Масштабирование 65
Медиана, фильтр 233
Метаданные, панель 49
Микс-кисть, инструмент 92

Наборы кистей, панель 91
Навигатор, панель 34

Накладка, эффект 89

Наложение, режим 144
Направляющие 33
Настройка страницы 40
Нацеливание на изображение 211

Непрозрачность 144
Новый, диалоговое окно 59
Обводка слоев-фигур 191
Области выделения

Вставить в, команда 134
Вставка 137
Загрузка 198–199
Искажение 140
Копирование 137
Масштабирование 140
Модификация 132
Область фокусировки 138
Параметры рамки выделения 123
Перемещение 124
Перепозиционирование 122
Поворот 140
Подобные оттенки, команда 133
Растушевка 125, 131
Сглаженные 123
Снятие выделения 122
Сохранение 198–199
Стиль, меню 123
Увеличение 133

Образец со всех слоев, флажок 128
Образцы, панель 80
Овальная область, инструмент 

122–123
Оптимизации, панель 244
Оптимизация 245–247
Оптимизация для формата GIF 248
Осветлитель, инструмент 108
Ослабить, команда 226
Основная рабочая среда 36
Основной цвет 75–77, 80
Открытие изображения 44
Отменить, кнопка 154, 160, 172
Палец, инструмент 106
Палитра цветов, диалоговое окно 77, 

191
Панель переключения рабочего 

пространства 36
Передискретизация 65, 71
Перемещение с учетом содержимого, 

инструмент 116
Перемещение, инструмент 124, 134, 

148
Перо, инструмент 183
Печатать, диалоговое окно 40
Печать
Пиксели 18, 20
Пиксельная маска 202
Пипетка, инструмент 76
Плавающее окно изображения 29, 38

Пластика
Вздутие, инструмент 236
Деформация, инструмент 236
Диалоговое окно 235
Заморозить, инструмент 235
Разморозить, инструмент 235
Скручивание по часовой стрелке, 

инструмент 236
Смещение пикселей, инструмент 

236
Сморщивание, инструмент 236

Плоскости перспективы 241
Поворот 64
Подтвердить преобразование, 

кнопка 47, 144, 150, 172

Полосы в градиенте 232
Поместить встроенные, команда 47
Поместить связанные, команда 158
Понижение частоты дискретизации 68
Попиксельная пропорция 59
Предварительный просмотр 

в браузере 246
Преобразовать для смарт-фильтров, 

команда 234, 238, 242
Привязка к направляющим 33
Приложения для редактирования 

векторной графики 18
Применение цветового тона 

к изображению 221
Профиль монитора 24
Прямолинейное лассо, инструмент 

135
Прямоугольная область, инструмент 

122–123
Пыль и Царапины, фильтр 233
Рабочие диски 32
Рабочий контур 182–183
Радиальное размытие, фильтр 229
Размер холста, диалоговое окно 72
Размеры документа 32
Размеры рабочих дисков 32
Размытие в движении, фильтр 228
Размытие по Гауссу, фильтр 229

Размытие, инструмент 106
Размытие, фильтры 228–229
Разрешение 19, 20, 65–68
Рамка, инструмент 70
Ранжирование изображений 50
Раскройка, инструменты 260

Растровые изображения 18–19
Растушевка выделенной области 131
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Расширение области выделения 116
Редактирование в режиме «Быстрая 

маска», кнопка 194
Редактировать в стандартном 

режиме, кнопка 194
Редактировать плоскость, 

инструмент 239, 241
Режимы изображения 73–74

CMYK 73
Lab 74
RGB 73
Битовый формат 74
Градации серого 74
Дуплекс 73
Индексированные цвета 73
Многоканальный 74

Режимы наложения
Жесткий свет 98
Замена светлым 98
Затемнение 97
Затемнение основы 97
Затухание 97
Исключение 99
Линейный затемнитель 98
Линейный осветлитель 98
Линейный свет 99
Мягкий свет 98
На заднем плане 97
Насыщенность 99
Осветление 98
Осветление основы 98
Очистить 97
Перекрытие 98
Разница 99
Светлее 99
Свечение 99
Темнее 99
Точечный свет 99
Умножение 97
Цветность 99
Цветовой тон 99
Яркий свет 99

Режимы экрана 28–29
Резкость, инструмент 106
Резкость, фильтр 226
Ретушь, фильтр 233
Рука, инструмент 34, 244
Тени/Света, команда 222
Свойства интерактивной формы, 

панель 191–192
Связанные смарт-объекты 158

Сглаживание
Области выделения 123
Шрифт 176

Сетка перспективы 239
Сетки 33

Сканирование изображения 
в программе Photoshop 45

Слой
Автоматическое выравнивание 161
Автоматическое наложение 161–162
Выделение 145, 148
Группы слоев 150
Деформация 159
Закрепление 149
Значок в виде глаза 145
Изменение порядка следования 145
Корректирующий слой 216–217
Непрозрачность 144
Новый слой, команда 155
Объединение 146
Отображение 145
Перемещение 147
Перепозиционирование 145
Присвоение имен 144
Режим наложения 144
Сведение 146
Связать, кнопка 148
Связывание 148
Скрытие 145
Слой смарт-объекта 46, 157, 242
Слой-маска 200–201
Слой-фигура 190
Создание 144
Стили слоя 153–155, 179
Трансформирование 154
Удаление 144
Фоновый 124, 144

Слои (Layers), панель 144–155
Слои-маски 200
Слой-фигура 191–194
Смарт-объекты 46, 156–157
Смарт-фильтры 242
Создать плоскость, инструмент 239
Сохранение пользовательских 

настроек 39
Сохранение файлов

GIF, формат файла 248
JPEG, формат файла 249
Photoshop EPS, формат файла 57
Photoshop, формат файла 54
TIFF, формат файла 55
Сохранить для Web, диалоговое 

окно 246
2 варианта, вкладка 244
4 варианта, вкладка 245
Оптимизация 244

Сочность, параметр 219
Стабилизация изображения, фильтр 

234
Стабилизация изображения, фильтр 

234
Стереть уточнение, инструмент 130

Стили штриха 192
Стили, панель 163
Текст-маска, инструмент 178
Техники работы с панелями 36
Тип заливки (Fill type), панель 191
Тон, насыщенность и яркость 77
Точечная восстанавливающая кисть, 

инструмент 113
Трансформирование областей 

выделения 140
Трансформирование слоев 154
Убрать кайму, команду 147
Удалить все булавки, кнопка 168
Быстрые направляющие 189

Упорядочить, подменю 38
Управление цветом 40
Уровни (Levels), диалоговое окно 210
Уточнение края 129
Уточнить маску, диалоговое окно 204
Уточнить радиус, инструмент 130
Фильтр, меню 224

Фоновый ластик, инструмент 111

Фоновый цвет 75–77, 80

Форма отпечатка кисти 90–91
Жесткость 90
Интервалы 90
Угол 90
Форма 90

Формат файла
DNG 52
EPS 22
GIF 58, 248
JPEG 58
Photoshop 22
PNG 250
TIFF 22

Фотофильтр, диалоговое окно 222
Фрагменты

Автоматически созданные 260
Видимости, кнопка 245
Выделение 261
Перемещение 261
Пользовательские 260
Создание 260

Фрейм приложения 38
Цвет

CMYK, режим 197
RGB, режим 197
Web-цвета, вариант 248
Библиотеки цветов, кнопка 78
Гамма 22, 35
Система управления 23
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Составной цвет 77
Только Web-цвета, вариант 78
Удалить образец 80
Цветовой баланс 220
Цветовые Модели

CMYK 21
RGB 21

Цветовые палитры 251
Web 251
Перцепционная 251
Пользовательская 251
Селективная 251
Точная 251

Черно-белое, команда 221
Цвет, панель 79
Цветовой эталон, инструмент 76

Черно-белое, диалоговое окно 221
Шкала времени, панель

Кадры
Воспроизведение 256
Задержка 257
Копирование 257

Удаление 256
Управление 256

Новый кадр, кнопка 255
Оптимизация анимации 258
Пуск, кнопка 256
Создание анимации 254
Создание промежуточных кадров 

259
Сохранение анимации 258

Шрифт
Выделение 174
Деформация 180
Обычный текст 172
Параметры абзаца  177

Выравнивание 177
Отступы 177
Отступ перед абзацем и после 

абзаца  177
Параметры символов 175–176

Сглаживание 176
Сдвиг базовой линии 176
Цвет 176
Шрифт 175

Кернинг 175
Интерлиньяж 175
Размер 175

Трекинг 175
Редактирование 174
Символ переполнения 173
Текст абзаца  173
Текст-маска, инструмент 178
Эффекты 180

Штамп, инструмент 240
Штамп, инструмент 107
Штриха, стиль 192
Штриха, тип 192
Шум, артефакты 139, 227
Шум, фильтры 232–233
Щетинные кисти 90
Элементы управления фильтром 224

Яркость, график 212

Яркость/Контрастность, команда 208
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Полный ассортимент книг издательства для оптовых покупателей:
Москва. Адрес: 142701, Московская область, Ленинский р-н, 

г. Видное, Белокаменное шоссе, д. 1. Телефон: +7 (495) 411-50-74.
Нижний Новгород. Филиал в Нижнем Новгороде. Адрес: 603094,

 г. Нижний Новгород, улица Карпинского, дом 29, бизнес-парк «Грин Плаза». 
Телефон: +7 (831) 216-15-91 (92, 93, 94). 

Санкт-Петербург. ООО «СЗКО». Адрес: 192029, г. Санкт-Петербург, пр. Обуховской Обороны,
 д. 84, лит. «Е». Телефон: +7 (812) 365-46-03 / 04. E-mail: server@szko.ru
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